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Preface

The Preface provides you with the following information:

« Content contained in each of the three major sections of the reference guide
« Technology and applications supporting Budgeting & Planning

« Overview of each chapter

« Naming and typographical conventions used

«  Customer support

Reference Guide Content

This guide is divided into three sections. Each section contains information for
specific groups of application users.

Part | Administering Budgeting & Planning

Part | is for DBAS, System Administrators, and the Super Administrator. This part
provides information on the relationship between Express Server, Oracle Financial
Analyzer (OFA) and Budgeting & Planning. Also included in this section is
information on how to administer the application and how to use the tools and
programs provided to enhance the functionality of the application for your
organization.

Part 1l Using Budgeting & Planning

Part Il is for end users, including the Super Administrator, sub-administrators, and
business unit managers. This section of the guide describes how to log in to the
application and use the tools provided to perform budget-related tasks.
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Part Il Appendixes

Part 11l is primarily for the Super Administrator and others within your
organization who need in-depth information about the programs and architecture
of the application.

Applications Supporting Budgeting & Planning

Applications and technology supporting Budgeting & Planning are included in the
following table:

Component Application User
Application Oracle Express Server 6.3.0.1 DBA, System Administrator,
database Super Administrator
Application Oracle Express Administrator 6.3.0.1 DBA, System Administrator,
database Super Administrator,
administration Administrators
Application server  Oracle Application Server 4.0.8.1 DBA, System Administrator,
Super Administrator

Oracle Financial Financial Data Manager relational Database:
Services database, OFSA applications

7 ! . DBA, System
g?ﬁ“g?\gg?: (OFSA) Administrator, Super

P Administrator
(optional o
component) OFSA applications:

. Super Administrator,
Administrators, Business
Unit Managers

Web enablement Oracle Express Web Agent 6.3.0.1 DBA, System Administrator,

with patch owa630_pl.exe Super Administrator

Web access Browser: Internet Explorer 5.0 or Super Administrator,
Netscape 4.72 or later Administrators, Business Unit
Managers, DBA, System

Java plug-in: JInitiator 1.1.7.29 Administrator

Business Oracle Financial Analyzer 6.3.0.0 Super Administrator,

environment setup  with patch 6325_2.exe Administrators, OFA power

and configuration users

Budget-related tasks Oracle Budgeting & Planning Super Administrator,
Administrators, Business Unit
Managers
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Budgeting & Planning Naming Conventions and Terminology

Note the following, general naming conventions and terminology used in this
guide.

Planning Item

The key database structure for Budgeting & Planning is the planning item. In
Express this database object is referred to as a variable and in OFA as a financial
data item. This guide uses the term planning item, as in Financial Plans planning
item, the majority of the time when referring to this database object. Otherwise the
term variable is used.

Data Relationships

Data relationships enable you to group data into meaningful categories. In Express
you set up data relationships using a database object called a relation. In OFA this
object is called an attribute. This guide uses both terms, depending on whether the
usage is in the context of Express or OFA.

Selected Data

End users retrieve data from the database and access it through the Budgeting &
Planning interface using a tool called the Selector. The slice of data an end user
selects using this tool is called ‘currently selected’ data. This data is temporarily
stored in such a way that it is accessible during the end user’s session.

An additional distinction needs to be made between currently selected data and
‘active' data. Active data is the data that the end user actually sees at any point in
time in the visible page of the interface. The active data is a subset of the currently
selected data.

Chapter Overview
This section provides a brief content overview for each chapter.

Part | Administering Budgeting & Planning

Chapter 1 New Features

This chapter describes software enhancements for this release.

Chapter 2 The Data Model

This chapter lays the conceptual foundation for the database design and its internal
structure, discussing both the business (logical) model and physical data model.
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Chapter 3 Administering the Application

This chapter presents detailed information on how to set up external users for the
Web-enabled version of the application, moving data from the Oracle Financial Data
Manager (FDM) relational database to Express, configuring Express and OFA to
reflect your business practices and distributing database objects and data
throughout the Budgeting & Planning environment.

Chapter 4 Administering Reports

This chapter provides important information for administrators on how to set up
and configure the application environment for report production. It also contains a
list of the seeded financial reports provided with the application and detailed
formulas used to produce the reports that rely on formula variables.

Chapter 5 Administering Planning Item Access and Programs

This chapter explains how to augment seeded planning items with user-defined
variables by making your user-defined variables accessible through the Budgeting
& Planning interface.

Chapter 6 Creating Custom Cash Flow Calculations

This chapter explains how to incorporate custom cash flow programs that you may
create for use in Budgeting & Planning.

Chapter 7 Running the LEDGER_STAT Writeback Procedure

This chapter explains how to prepare your data for the writeback procedure and
execute the specific Express program that completes the initial step of moving your
data from Express to a staging table in the FDM relational database. From this
staging table the FDM LEDGER_STAT load utility moves data into the LEDGER _
STAT table.

This chapter may be applicable to your budgeting process if you have installed
FDM in addition to Budgeting & Planning.

Chapter 8 Setting up the Express Server

Before end users can use Budgeting & Planning you need to establish connectivity
for Express Server and set it in run mode. This chapter describes the steps to
perform both tasks.



Part Il Using Budgeting & Planning

Chapter 9 Logging In

This chapter describes how to log in to the application and, if necessary, download
the required Java plug-in.

Chapter 10 Features of the Main Forecasting Window

This chapter describes the components of the main forecasting window.

Chapter 11 Functions Available Through the Interface

This chapter describes key end-user functionality associated with the application.
This functionality includes: allocating node-level values to subordinate leaves,
distinguishing between the three available calculation routines and how to launch
each, using the copy and paste functionality, saving your inputs and calculations,
submitting your changes to the database, and accessing the Interest Rate interface.

Chapter 12 Using the Selector

This chapter describes how to use the Selector tool. This tool retrieves the slice of
data from Express that you want to view and work with in either the main
forecasting window or other interfaces of the application. The Selector’s design
includes a structured interface to simplify data selection and a group of tools to
retrieve data using filtering criteria and analytical processes.

Chapter 13 Using Input and Calculation Tools

These tools enable end users to enter data and run budget-related calculations
across multiple combinations of organizational units, chart of accounts and other
dimensions, in a single operation.

The two interfaces designed to support this feature combine predefined methods
for entering and calculating data with point-and-click functionality for data
selection.

Chapter 14 Using the Maturity Mix End-User Interface

Sometimes the default maturity assumptions created by administrators do not
accurately reflect the maturity characteristics of a product for a particular
organizational unit. This feature gives end users, such as business unit managers, a
way of modifying an administrator’s assumptions to more accurately reflect the
organizational unit’s business environment.
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This interface is also used by business unit managers and sub-administrators to
input maturity characteristics if other administrators have not defined default
characteristics.

Chapter 15 Generating Reports

This chapter explains how end users access and generate financial reports provided
with the application, as well as reports created by your organization. This chapter
also includes a list of seeded reports provided with the application, along with a
description of the basic formats of those reports.

Part Ill Appendixes

Appendix A Financial Elements
This appendix lists the Financial Elements used in Budgeting & Planning, sorted

two ways - by alpha-numeric identifier and by description.

Appendix B Cash Flow Calculations

This appendix presents the logic and mathematical formulas used to calculate cash
flow forecasts for anticipated new business, and the combination of those cash flow
results with current position data to derive total account results.

Appendix C Express and OFA Object Descriptions

This appendix lists the correlations between Express and OFA for the following:

« Dimensions

« Relations (Attributes in OFA)

« Planning Items (Financial data items in OFA, variables in Express)

This appendix also lists the Express database objects that are exclusive to the
Budgeting & Planning application. These database objects are not found in OFA.
Appendix D Details of the Maturity Mix Data Model

Details of the three key variables comprising the maturity mix data model, FS.MIX_
OVERRIDE, FS.MIX_MAP and FS.MIX_DEFAULT are presented in this appendix.



Appendix E Express Programs, Objects and Processes

This appendix lists, in alphabetical order, significant Express programs, objects and
processes used in the Budgeting & Planning application.

Product Design for Future Functionality

In anticipation of future funtionality certain application-related objects have been
included in the design for this release but are not functional. The documentation
notes this, where applicable by the following:

Caution: Itis important that you do not modify these objects as
changes may cause the functionality that is incorporated in a future
release to fail.

Documentation Conventions
The following documentation conventions are used in this guide:

Symbol Explanation

<, > Text enclosed by the these brackets indicates user-defined entries.

Note that these brackets are intended to designate information you
supply; the brackets should not be included in any of your entries.

UPPERCASE Terms in uppercase denote database objects.

-> This symbol, between menu selections, means that you should follow
the sequence of steps provided, such as File -> Save As.

Alt +C This text identifies the short-cut key strokes that mimic
mouse-related actions.

Note, Caution, and  Text introduced with 'Note’ provides helpful information.

Warning Text introduced with 'Caution’ indicates an action that could cause

serious problems for your system or application environment,
including loss of data.

Text introduced with "Warning’ indicates the possibility of personal
injury.
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Customer Support Information

Product support is available through Oracle Support Services. Contact your project
manager for information about using the following support options:

=  World Wide Web sites
=  Global Solutions Exchange and Fax-on-Demand services
« Electronic mail to a Virtual Support Analyst

« Telephone support
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Part |

Administering Budgeting & Planning

Part | provides detailed information on how to administer the application.

Audience

This section of the reference guide is written for individuals within your
organization responsible for configuring and maintaining the application for end
users, including:

«» DBAs
« System Administrator

«  Super Administrator

Content
This section includes the following chapters:

« Chapter 1, "New Features"

« Chapter 2, "The Data Model"

« Chapter 3, "Administering the Application"

= Chapter 4, "Administering Reports"

« Chapter 5, "Administering Planning Item Access and Programs"
« Chapter 6, "Creating Custom Cash Flow Calculations"

« Chapter 7, "Running the LEDGER_STAT Writeback Procedure"
« Chapter 8, "Setting up the Express Server"
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New Features

This chapter describes software enhancements for this release and a condensed
description of enhancements from Release 4.0.2.

Web-Enablement

Release 4.5 marks the introduction of Web-based access for the Oracle Budgeting &
Planning solution. Using a Netscape or Internet Explorer Web browser, the typical
end user can log in to Oracle Budgeting & Planning and use the organization’s
intranet to perform budgeting calculations, view and refine results, and submit
budgets.

As part of Web enablement, Budgeting & Planning now supports Oracle Financial
Analyzer’s External user type. Users can also submit their data to their
administrator's shared database directly from within Budgeting & Planning. See
"Creating External Users" in Chapter 3, "Administering the Application” for more
information on External Users and submitting data.

Reporting in Budgeting & Planning

Effective with the release of the Web-enabled version of Budgeting & Planning,
users can now access reports that have been defined in Oracle Financial Analyzer
(OFA) directly from the Budgeting & Planning interface. Web users who have
received report access through the OFA distribution functionality can open a list of
available reports from within the main Budgeting & Planning interface, select the
desired report(s), and produce those reports for both viewing and printing. Users
now need to launch only one application to enter, calculate, submit, and report on
their data.
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Input and Calculation Tools

This release also includes additional, seeded standard reports created specifically
for use with the Web-enabled version of the application.

For information on administering reports for the application see Chapter 4,
"Administering Reports" and to access and generate reports see Chapter 15,
"Generating Reports".

Input and Calculation Tools

New tools are available to assist users in the creation of initial forecast or budget
projections, the adjustment of existing projection values, and to make adjustments
to source values while copying from one location in the main Financial Plans
planning item to another. Users can take advantage of these tools to generate
projections for all data types including balance sheet and non-interest income and
expense line items, and can trigger the processing of cash flow and solve
calculations based on the generated values. For more information on how to use
these tools see Chapter 13, "Using Input and Calculation Tools".

This release also provides the ability to copy and paste data values from a
spreadsheet directly into Budgeting & Planning. Values can also be pasted into any
planning item accessible through the interface, and calculations subsequently be
launched based on the newly pasted values. The ability to copy data values from
Budgeting & Planning into a spreadsheet has also been added. For more
information on this feature see "Using the Copy and Paste Functionality" in
Chapter 11, "Functions Available Through the Interface".

Expanded Planning Item Access

Budgeting & Planning’s new catalog-driven approach to planning item access
enables administrators to grant end users access to any planning item used in the
budgeting cycle. Taking advantage of this capability, access to the forecasted interest
rates planning item has been seeded to allow users to view the rate environment
being employed in the development of their budget. In addition, administrators can
define custom programs and make them available to users by simply maintaining a
series of entries in a catalog. See Chapter 5, "Administering Planning Item Access
and Programs" for more information.

Data Movement Routines

Administrators have a new data movement routine for writing budget and forecast
data back to the FDM relational database LEDGER_STAT table. The routine writes
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Software Enhancements for Release 4.0.2

data to a staging table after validating the leaves, looking up COMMON_COA _ID
values, and transforming the information into the format the LEDGER_STAT load
utility requires. For information on exporting data to the LEDGER_STAT table, see
Chapter 7, "Running the LEDGER_STAT Writeback Procedure".

The interest rate data movement routine has been completely rewritten to
accommodate FDM data model changes, improve performance, and to add support
for loading currency exchange rates. For more information see "Interest and
Exchange Rate Forecasts" in Chapter 3, "Administering the Application”.

Changes have been made to all of the remaining data movement routines to
accommodate database changes implemented in FDM to support new
multi-currency based functionality. The routines also have been enhanced to allow
for any FDM leaf field to be mapped and loaded into virtually any dimension in the
Express database. See"Data Movement Routines" in Chapter 3, "Administering the
Application" for more information on the data movement routines.

Software Enhancements for Release 4.0.2

The 4.0.2 patch release to version 4.0 contained many significant improvements. All
of the those new features were incorporated into the 4.5 release, including:

« Full Selector functionality
« Multiple hierarchy support

« A new Maturity Mix Assumption interface that enables end users to adjust or
modify maturity mix assumptions used in the generation of financial
projections.

See the appropriate chapters in this reference guide for more information on these
features.
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2

The Data Model

The data model is the foundation of the Budgeting & Planning application.

There are two ways of thinking about the data model: The logical data model and
the physical data model. The logical data model shows how your organization’s
budgeting policies, multiple corporate data sources, and external business
influences are arrayed around and feed data to a uniform database to create and
maintain your budget. The physical data model describes the components of the
Express multidimensional database and how these components are organized and
structured, within the context of the Budgeting & Planning application, to store and
analyze your data.

Logical Data Model

The key to the logical data model is the financial forecast. The illustration that
follows shows how a variety of factors such as internal allocation rules, accounting
principals, your business strategies, and interest rate fluctuations are assimilated
into the budgeting process. At the center of these influences is the financial forecast,
where the accumulated data is factored and processed to create your organization’s
budget. The financial forecast also provides a starting point for creating scenarios
that can project the anticipated benefits from introducing a new product or how
interest rate fluctuations will impact your institution’s profitability.

In the context of the Budgeting & Planning application the financial forecast is
termed the Financial Plans planning item or FS.FIN_DATA. It is the repository of
data results from both budget creation and forecasting.
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Logical Data Model

The following diagram shows the key factors and business influences that were
taken into consideration in designing the logical data model for the Budgeting &
Planning application.

Internal Influences External Influences

Current Momentum Interest Rates

New Products Currencies
Maturity Strategy Prepayments
Strategic Goals Costs of Activities

YOUR FINANCIAL FORECAST
(FS.FIN_DATA)

Accouting Rules / \ Human Resource Plans
Allocation Rules Capital Budgets

Management Guidelines Account Officer Plans

Models Supporting Data

Each of these components is described in the following sections.

Financial Forecast

The financial forecast is the ultimate destination for all budgets and forecasts. This
information is stored in the Financial Plans planning item (FS.FIN_DATA).

Internal Influences

Your organization directly controls internal influences. The base line is current
momentum. Current momentum is defined as the budgeting reality if you have
done nothing to affect change. This position is useful because it serves as the base
line from which events such as new product offerings or customer marketing
campaigns can be measured.
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Logical Data Model

The other components associated with internal influences are used to project

profitability margins based on the undertaking of specific actions. Included in this is

a dimension called Strategy, which enables you to create multiple, independent
business strategies from your current momentum or base-line projection.

External Influences
External influences affect the financial performance of your institution, but they are

Models

also beyond your control. Interest rate or currency exchange rate fluctuations,

activity costs, and prepayment assumptions are external influences that can be used

in the Budgeting & Planning application to create budgets and forecasts.

Models are sets of logic such as accounting rules, business allocation rules, or other

corporate financial policies that tend to be enterprise-wide and affect how the
budget is created. Models can be driven either from the top of your organization
down to the lowest organizational unit or from the bottom of your organization
upwards.

Human Resource Plans

Human resource data generally resides in a separate, secure database and is
brought into the budgeting process at a summarized level. The Budgeting &
Planning application is designed to allow both the top-down allocation of
administrative salaries and benefits and the bottom-up projections from business
unit managers regarding projected staffing requirements and salary changes.

Capital Budgets

Capital budgets are budgeting projections for fixed and other assets.

Account Officer Plans

Account officer plans can be factored into budget projections to estimate new
business growth over your budgetary year. Because the Budgeting & Planning
application does not rely on general ledger summarizations of business units but
instead can organize instrument level data in any suitable fashion, organizational
hierarchies can reflect individual account officers or even the customers they
service.

The Data Model
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Physical Data Model

Physical Data Model

The physical data model describes the internal structure of the database, including
organizational hierarchies, database objects, calculation engines, and metadata. The
physical data model also describes how your organization’s data is stored,
retrieved, and analyzed.

This data is stored in a database object referred to as a financial data item in OFA, a
variable in Express and a planning item in Budgeting & Planning. In this reference
guide planning item is the term most commonly used when conveying information
to end users. Variable is used most often in the context of application-specific
activities for DBAs, System Administrators, or the Super Administrator

The physical data model for Budgeting & Planning is designed with multiple,
predefined planning items. These planning items, in turn, are designed to support
the primary planning item, which is called FS.FIN_DATA or the Financial Plans
planning item.

The Financial Plans Planning Item

The Financial Plans planning item (FS.FIN_DATA) is the repository for all of your
budgeting data. Data residing in this planning item is modified through data
movement routines, cash flow engine calculations, feeds from supporting planning
items and other calculations your organization defines.

Dimensions of the Financial Plans Planning Item

The planning item is seeded with seven pre-defined dimensions. The following
table provides the names of these dimensions as they appear in OFA/Budgeting &
Planning and Express.

OFA/Budgeting & Planning Express Name

Chart of Accounts FS.CHRT_OF _ACCT
Organizational Unit FS.ORG_UNIT

Time TIME

Financial Element FS.FIN_ELEM
Forecast FS.FORECAST
Strategy FS.STRATEGY
Currency FS.CURRENCY
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Notice that six of the seven dimensions begin with the letters 'FS’. The only
exception is the Time dimension. The prefix 'FS’ is the object naming convention
established for the Budgeting & Planning application.

Also, all dimension values that, in the previous versions of the Budgeting &
Planning application, began with a number now begin with a letter such as 'F’ or
'N.” For example, an organizational unit stored as 12345 in FDM is stored as F12345
in Express.

In addition to the seven pre-defined dimensions you can also create a user-defined
dimension for the Financial Plans planning item. Refer to the Oracle Financial
Services Installation and Configuration Guide for detailed information on creating a
user-defined dimension.

Caution: If you plan to create a user-defined dimension, you
should create your dimension before your first data load. It is very
difficult to successfully add a user-defined dimension after
implementing the Budgeting & Planning application.

The seven pre-defined dimensions and the user-defined dimension are described in
this table:

Dimension Description

Chart of Accounts Chart of accounts is the lowest level of detail for planning

purposes and includes balance sheet, income statement, and
(FS.CHRT_OF_ACCT) statistical accounts. Chart of accounts is organized following a
hierarchical structure that is provided either through the data
movement routine from FDM to Express or is set up manually
within Express and OFA.

Hierarchically organized? Yes

Organizational Unit With this dimension you represent, in the Express database,

the organizational structure of your institution. The
(FS.ORG_UNIT) organizational structure is created in the database either
through data movement routines that move the hierarchical
structures from FDM to Express or is set up manually within
the Express and OFA.

Hierarchically organized? Yes
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Dimension

Description

Time

The lowest common denominator or unit of time, for the
Budgeting & Planning application, is the month. All
time-based measurements are in multiples of months. For
example, a 30-year amortizing loan is expressed as 360 months.

This dimension also enables end users to select the number of
historical periods as well as the number of future periods to be
tracked in the database.

Hierarchically organized? Yes

Financial Element
(FS.FIN_ELEM)

This dimension contains financial values, such as average
balance, ending balance, interest rates, and rate spreads.
Financial elements are used primarily in conjunction with
balance sheet items.

Hierarchically organized? No

Forecast
(FS.FORECAST)

The Forecast dimension enables your organization to label
multiple views of future performance so that each forecast
view is maintained independent of other forecasts and your
final budget.

Hierarchically organized? No

Strategy
(FS.STRATEGY)

The Strategy dimension organizes the contents of a forecast by
the plan your organization executes to achieve forecast targets.
Strategies are the internal influences that impact future
performance.

Hierarchically organized? Optionally

Currency
(FS.CURRENCY)

Budget balances are represented in the currency you select.
However, in the case of multi-currency budgeting the
currencies used for local budgeting activities can be converted
and rolled up to a base-line or single currency.

Hierarchically organized? Optionally
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Dimension Description

Dimension-N This dimension is user defined and is available to meet unique
budgeting requirements for your organization. This dimension
is not pre-defined during the installation of the Budgeting &
Planning application.
Hierarchically organized? Optionally

Attributes

Attributes (relations in Express) are the elements that relate one dimension value to
another. Attributes give you sorting, grouping, and data filtering capabilities for

dimensions values.

When you create relationships between dimension values one value type is called
the grouping dimension and the other value type is the called the base dimension.
The following example illustrates how dimension values function as attributes to

create relationships.

Example

In this example, Chart of Account dimension values are grouped by account type.
The Chart of Account dimension values are the base dimensions and the account
types are the grouping dimensions. The name of this attribute is FS.COA.ACCT _

TYPE.

Chart of Account

Account Type

Auto Loans
Residential Loans
Certificates of Deposit

DDAs

Asset
Asset
Liability
Liability

The grouping dimensions in this example are Asset or Liability. The base dimension
consists of the four dimension values under Chart of Accounts.
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Pre-Defined Dimension Values

The Budgeting & Planning application seeds specific dimension values, used as
attributes, during the installation process. You can also create additional,
user-defined dimension values that function as attributes. It is important, however,
not to alter the seeded dimension values.

Caution: Do not change the pre-defined dimension values
installed with the Budgeting & Planning application. Doing so
could cause the application to return inaccurate data.

The next section lists the pre-defined attributes for the following three dimensions
in FS.FIN_DATA:

= Chart of Accounts
« Forecast

« Organizational Unit
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Pre-Defined Attributes for the Chart of Accounts Dimension

The following attributes are pre-defined for the Chart of Accounts dimension:

Chart of Accounts
Attributes

Description

COA Account Type

The account type includes one of the following characteristics
listed. Account types generally indicate how additional data
values are computed.

These are the available characteristics for the Account Type
attribute:

«  Asset
« Liability
« Capital

. Direct non-interest income

« Allocated non-interest income
«  Direct non-interest expense

« Allocated non-interest expense
. Income taxes

« Statistical: Count

. Statistical: Ratio

« Statistical: Factor

COA Accrual Method

The accrual method determines how interest is accrued on a
monthly basis. This information is particularly important in
computing either the interest financial element or reporting
yields.

The Budgeting & Planning application supports the following
accrual methods:

« Actual # of days in period/Actual # of days in year
« Actual # of days in period/365
« Actual # of days in period/360

-« 30/360
«  30/Actual # of days in year
= 30/365
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Chart of Accounts
Attributes

Description

COA Market Rate

The market rate indicates which interest rate forecast, in the
Interest Rate variable, is used as the market index rate for new
business and for repricing outstanding balances.

The Budgeting & Planning application has been designed to allow
you to input a spread above or below the market interest rate as
well as to input a spread above or below the transfer rate.
However, the use of the market rate currently requires custom
cash flow model type development.

COA Balance Sheet
Model

This model type represents the cash flow template that your
organization uses. The standard model types available include:

« Bullet Fixed

« Amortizing Fixed

=« Amortizing Reprice

«  Non-interest Income
. Non-interest Expense
«  Non-term

=« Non-rate Related

« Rollovers

« Statistical Data

COA Product

Bundles two or more accounts into one customer product. An
example of bundling is a loan product, checking account, and safe
deposit box for a single customer.

Note that a seeded calculation is currently not in place for this
attribute.

COA Transfer Price
Method

The transfer pricing methodology indicates how the transfer rate
is determined, based on the term and repricing characteristics of
the product. The Budgeting & Planning application supports the
following methodologies:

«  Zero Coupon
. Duration Based
«  Weighted Average Term
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Pre-defined Attributes for the Forecast Dimension

The following attributes are pre-defined for the Forecast dimension:

Forecast Attributes

Description

FCST Data As Of Date

Use this attribute to define the point in time that divides
historical or actual data from forecast data. Note that different
forecasts can have different as-of-dates.

FCST Interest Rate
Scenario

The interest rate forecast used in calculations.

FCST Currency Scenario

The currency exchange rate forecast used in calculations.

FCST Maturity Mix
Scenario

The specific collection of mix assumptions used in cash flow
calculations.

FCST Calculation Status

This attribute is a tracking mechanism for scenario changes. It
has been designed for functionality planned for a future release.

To avoid problems during upgrades to a future release, do not
change this attribute.

FCST Forecast Status

This structure has been designed for functionality planned for a
future release. It will include the following, pre-defined
characteristics:

«  Complete

« InProcess

« Returned

«  Resubmitted
« Approved

To avoid problems during upgrades to a future release, do not
change this structure.
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Pre-Defined Attributes for the Organizational Unit Dimension

There is a single attribute for this dimension, with the following, pre-defined
characteristics.

Organizational Unit Attributes Descriptions

ORG Organizational Unit Type Core banking
Support unit
Overhead unit
Offset unit
Funding center
Wholesale

Pre-Defined Attributes for the Report Line Item Dimension

Report line item supports income statement reporting. The standard reports use this
attribute to identify Chart of Account line items included in the reports.

Report Line Iltem Attributes Descriptions

RPL Chart of Accounts Total Assets COA Value
Total Liabilities and Capital COA Value
Total Non Interest Income COA Value
Total Non Interest Expense COA Value

Loan Loss Provision COA Value
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Additional Forecast-Related Elements

This section lists additional variables you need to use to create your budget and

forecasts.

CUJO - Conjoint Variables
These are variables dimensioned by a conjoint.

Variable

Purpose

FS.CUJO.DECIMAL1
FS.CUJO.DELETE

FS.CUJO.DECIMAL2
FS.CUJO.SPREAD_MTH

Stores the data value entered in the user interface.

This is metadata maintained by the application. This variable
indicates whether or not the data has been processed and, if it
has been processed, can then be deleted.

Not used.

Defines the methodology for spreading node-level data to
subsidiary leaves.

Financial Element Access

Variable

Purpose

FS.FE_ENABLED

FS.FE_WRITEABLE

Used by the interface to determine if a financial element is
displayed for a cash flow.

Determines whether or not a user can change a value for a
financial element in the user interface.

Interest Rates

Variable

Purpose

FS.INTEREST_RATE

This is the interest rate forecast.
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Maturity Mix Variables

Variable

Purpose

FS.ME_ENABLED

FS.ME_WRITEABLE

FS.MIX_DEFAULT
FS.MIX_MAP

FS.MIX_OVERRIDE

Used by the interface to determine if a mix element is displayed
in the Maturity Mix Assumptions interface.

Determines whether or not a user can change a value for a mix
element in the user interface.

The default Maturity Mix Assumption set.

The map of default Maturity Mix Assumption sets to the Chart
of Accounts, Time, and Currency dimensions.

Stores maturity mix assumptions input by the end user.

Moving Average Rate Information

Variable

Purpose

FS.WGT_AVG_PER

FS.WGT_AVG_TERM

The number of historical periods used for the moving average
transfer pricing method.

The term used for the moving average transfer pricing method.

New Business Timing

Variable

Purpose

FS.NB_TIMING_PCT

Use this attribute to determine when you want new business
added to the database.

If you select 0% for new business timing, new business
projections are added on the last day of the month.

If you select 100%, then new business projections are added the
first day of the month, and 50% indicates that new business
projections are added in the middle of the month.

The default value is 50%.

Note that, while New Business Timing functions as an attribute,
it actually is a variable. You need to use an OFA worksheet to
edit New Business Timing; you cannot edit values through the
OFA Attribute interface.
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Run Off/Repricing Profiles for New Business

Variable

Purpose

FS.INCR_RUNOFF

The FS.INCR_RUNOFF variable stores run off and repricing data for
each origination month across time, for each individual organizational
unit / chart of accounts combination. The FS.INCR_RUNOFF variable is
dimensioned by:

« Time

« Organizational Unit

«  Chart of Accounts

« Incremental Runoff Financial Elements
«  Strategy

«  Maturity Mix Breakout

«  Origination Month

« Forecast

«  Currency

When a value for new business is entered or calculated for an individual
organizational unit / chart of accounts combination in a given month,
the future cash flows for that new business are calculated. The
calculated run off and repricing balance rate and transfer rate data is
written to the FS.INCR_RUNOFF variable in the particular origination
month dimension value in which the new business came in.

The following incremental financial elements are currently calculated
(where applicable) and stored in the FS.INCR_RUNOFF variable:

«  Runoff Maturity Balance

=« Runoff Maturity Rate

«  Runoff Maturity Transfer Rate
=«  Runoff Old Rate

«  Runoff Old Transfer Rate

«  Runoff New Balance

«  Runoff New Rate

=« Runoff New Transfer Rate

As an example, suppose you entered a value of 1000 in the New Add
Balance Financial Element for January, February, and March for a given
organizational unit / chart of accounts combination. Assuming that
there is only one mix break out defined, the values written to the
FS.INCR_RUNOFF variable might look similar to the following table.
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Variable Purpose

Incremental Element: Incremental Runoff Maturity Balance

Time

Origination Month |January |February |March |April

January 100 100 100
February 100 100
March 100

Once the run off information is calculated and stored, the application
totals the balance information across time and writes the sum back to
the Financial Plans planning item. It also calculates balance weighted
average rates and transfer rates that correspond to the balance totals,
and writes those values to Financial Plans.

In the event that a user decides to change the new business assumption
for one month, the run off is recalculated only for that month. The data
in the other months is not affected. Once the new run off information for
the revised month is calculated and stored, the application re-totals the
information across time and writes the new sums back to the Financial
Plan planning item.

Tax Equivalent Information

Variable Purpose

FS.TAX_EQUIV_PCT This variable is the percentage multiplied against the interest
financial element to calculate tax equivalent adjustment
balances.
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Time Aggregation and Annualization

Variable

Purpose

FS.DAYS_MONTH

FS.DAYS_YEARS

Sets the number of days in the monthly time period. This is used
to annualize and de-annualize balances.

Sets the number of days in the year. This is used to annualize
and de-annualize balances. This variable makes adjustments for
leap year.

Transfer Pricing Accrual Methods

Variable

Purpose

FS.TP_ACC_METH

The accrual method applied in the calculation of transfer pricing
charges and credits.

Transfer Rate

Variable

Purpose

FS.COA.TRAN_RATE

The transfer rate indicates which interest rate forecast in the
Interest Rate variable is used as the transfer rate for new
business and to reprice balances.

The Budgeting & Planning application has been designed to
allow you to input a spread above or below the market interest
rate as well as to input a spread above or below the transfer rate.

Note, however, that the use of the market rate currently requires
custom cash flow model type development.

Weighting Financial Elements

In order for Budgeting Planning to properly rollup and aggregate interest rates, it
needs to know the corresponding balances with which to weight the rates. This
information is stored in the FSWEIGHTING_FE variable.
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The FS.WEIGHTING_FE variable is dimensioned by FS.FIN_ELEM only and is
pre-defined with the following values.

FS.FIN_ELEM FS.WEIGHTIING_FE
F70 F60
F80 F60
F90 F60
F120 F100
F130 F100
F160 F140
F170 F140
F230 F210
F240 F210
F360 F340
F370 F340
F375 F340
C80 C60
C90 C60
C120 C100
C130 C100
C160 C140
C170 C140
C230 C790
C240 C790
C280 C250
C290 C255
C300 C250
C310 C255
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FS.FIN_ELEM

FS.WEIGHTIING_FE

N120
N130
N160
N170
N171
N230
N240
N280
N290
N300
N310
N395
N1395

N100
N100
N140
N140
F140

N210
N210
N250
N250
N250
N250
F380

F1342

Interest and Exchange Rate Percentages

The following three variables and two attributes are used to define a forecast
interest rate and exchange rate scenario:

Variables

Attributes

FS.INTEREST_RATE
FS.COA.TRAN_RATE

FS.EXCHANGE_PCT
FCST Interest Rate Scenario

FCST Currency Scenario

FS.INTEREST_RATE Variable

The Interest Rates variable (FS.INTEREST_RATE) houses your interest rate
forecasts. This is not to be confused with the actual customer rates assigned to
rate-related assets and liabilities. Rather it contains both external market rates
(Treasury Bill rates, Prime, LIBOR, and so forth) as well as centrally administered
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rates (such as your transfer rate curve). This separation allows you to easily swap
different interest rate environments in and out of your forecasts.

The variable FS.INTEREST_RATE is dimensioned by the following:

Dimension

Description

FS.RATE_TERM

TIME

FS.RATE_SCENARIO

FS.INT_RATE_TYPE

The term to maturity (in other words, the point on the yield
curve). These dimension values are predefined with values of
T.001 through T.360, representing 360 monthly terms.

Note: Do not alter these in anyway.

It is not necessary to populate a value for each term. The
application interpolates points on the yield curve for which you
do not have a value, using a straight-line interpolation method.

The time period. This is the same Time dimension as found in
the Financial Plans planning item.

The interest rate scenario name. You can have as many different
interest rate scenarios as you would like.

The market or internally administered interest rate code, such as
LIBOR, Prime, or the transfer pricing yield curve.

FS.COA.TRAN_RATE Variable

COA Transfer Rate Type is used to map values of the FS.INT_RATE_TYPE
dimension to Chart of Accounts line items. This variable is dimensioned by the

following:

Dimension

Description

FS.CHRT_OF_ACCT

FS.CURRENCY

This is the lowest level of detail for planning purposes and
includes balance sheet, income statement, and statistical
accounts.

Budget balances are represented in the currency you select.
Howvever, in the case of multi-currency budgeting the currencies
used for local budgeting activities can be converted and rolled
up to a base-line or single currency.

COA Transfer Rate Type (FS.COA.TRAN_RATE) is used to assign interest rate code
values to Chart of Account line items. In previous releases, this assignment was
performed by defining an attribute that had the same name.
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To populate this variable, create an OFA worksheet and populate the individual
cells with the appropriate values from the Interest Rate Type dimension (FS.INT_
RATE_TYPE).

FS.EXCHANGE_PCT Variable

The Exchange Percentages variable houses your exchange rate forecasts used in
multi-currency based budget and forecast reporting.

The Exchange Percentages variable is dimensioned by the following:

Dimension Description

From Currency In converting currency values for reporting purposes, the
currency denomination from which values are being converted.

To Currency In converting currency values for reporting purposes, the
currency denomination to which values are being converted.

TIME The time period. This is the same time dimension as found in the
Financial Plans planning item.

Currency Scenario The currency exchange rate scenario name. You can have as
many different currency exchange rate scenarios as you would
like.

Attributes for Interest and Exchange Rate Percentages

In addition, two attributes (relations in Express) exist that connect your forecasts to
an interest rate environment. They are:

Attribute Description
FCST Interest Rate This is an attribute between the interest rate forecast and the
Scenario forecast dimension associated with the Financial Plans planning

item. This attribute indicates which rate environment should be
used for the forecast scenario you are processing.

FCST Currency Scenario  This is an attribute between the exchange rate forecast and the
Forecast dimension associated with the Financial Plans planning
item. This attribute indicates which exchange rate environment
should be used for the Forecast scenario you are reporting on.

Maturity Mix Data Model for New Business

This section presents the data model for storing maturity mix and pricing spread
information for the new business components of cash flow processing. For detailed
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information on the Maturity Mix data model see Appendix D, "Details of the
Maturity Mix Data Model".

Business Requirements

As you define your maturity mix for your products, keep these key points in mind:

«  Optionally define one default maturity mix and pricing spread forecast for each
product and apply that forecast to all organizational units.

« Encourage your end users to modify the default mix percentages and spreads,
when necessary, to reflect their cost center’s particular business mix.

« Administrators have the option of creating multiple maturity mix scenarios to
support strategy development.

Creating a Maturity Mix Scenario

Creating maturity mix assumptions for your products is one of the first steps
towards creating a budget. A maturity mix scenario is a collection of one or more
assumption sets. The combination of these assumptions sets over all future time
periods for all products constitutes a maturity mix scenario.

An assumption set is a collection of terms, mix percentages, pricing spreads
(optional), and other applicable maturity characteristics that apply to a product for
a given time period.

Note: An assumption set includes a complete set of maturity and
pricing spread information.

Your maturity mix forecast is created when you have defined all of the assumption
sets for a product. This becomes the default maturity mix forecast for that product.

Distributing Default Maturity Mix Forecasts and Data

You create the default maturity mix forecasts in the Super Administrator’s personal
database and distribute it to the shared database and any sub-administrator
databases. The maturity mix forecasts are then accessed by the business unit
managers, who input forecast data and then submit their results to the shared
database.

Business unit managers may want to modify the default mix percentages, spreads,
or other maturity characteristics of an assumption set for a particular product. If
they do, these modified assumptions are stored in an "override" variable and then
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are submitted to the shared database. See Chapter 14, "Using the Maturity Mix
End-User Interface" for additional information on inputting values in this variable.

Time Values

Time values are always represented in months. For example, a 30-year adjustable
rate mortgage that reprices every three years appears in the interface with a term of
360 months and a repricing frequency of 36 months.

Process

This section provides a detailed explanation on how default maturity mix
information and modifications to the default information are stored in the database.

The Budgeting & Planning application accesses the variables FS.MIX_OVERRIDE
and FS.MIX_DEFAULT for maturity mix forecasting. FS.MIX_OVERRIDE stores
modifications entered by business unit managers and FS.MIX_DEFAULT stores the
default assumption set(s) for each product.

The application checks FS.MIX_OVERRIDE first, for modified values entered by an
end user. If none are found (Null), then values from FS.MIX_DEFAULT are used.

For spreads, if MIX_DEFAULT is also empty (Null), then values input to Financial
Elements for New Add Spread (for cash flow accounts) or Average Spread (for
non-term accounts) are used.

Note: If you have defined a spread value in MIX_DEFAULT or
MIX_OVERRIDE and then try to enter a value for spread in the
Spread Financial Element, date(s) in MIX_DEFAULT and/or MIX_
OVERRIDE will replace any value entered in the interface when
calculations are run.

The following table shows how data for an assumption set is stored in the FS.MIX_
DEFAULT variable.
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This example illustrates an assumption set with three mix breakout dimension

values (MIX.1, MIX.2 and MIX.3) and three maturity mix element dimension values

(term, mix percentage, and spread).

Maturity Mix Characteristics
(FS.MIX_ELEMENT)

Breakout

(FS.MIX_BREAKOUT)

MIX.1 MIX.2 MIX.3
Mix Percent 10 20 70
Term 6 12 18
Spread 3.00 2.00 1.00

This is a simplified example, with a complete assumption set consisting of only nine
cells. As administrators add more dimension values to the Mix Breakout dimension,
the number of cells increases. Note that 10 mix breakout dimension values are
pre-defined with the variable. If you need more, you can create them in OFA. Also,
complex products such as repricing instruments require additional values in the
maturity mix characteristics dimension, which also increases the number of cells in
the assumption set.

The FS.MIX_DEFAULT Variable

This is a dense variable storing all the default mix assumption sets.

This variable is dimensioned by the following three dimensions:

« FS.MIX_ASSUM_SET

« FS.MIX_ BREAKOUT

« FS.MIX_ELEMENT

The following table lists the dimension values for FS.MIX_ELEMENT:

Required/
Dimension Value Optional Description
TERM Required | The length, in months, of the term to
maturity for one corresponding
breakout.
MIX.PERCENT Required | The mix percentage for this term
number
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Required/
Dimension Value Optional Description
SPREAD Optional | The spread for this individual term
number
REP.FREQ Optional | The repricing frequency, in months
AMORT.TERM Optional | Amortization term length for balloon
maturities, in months
RES.VAL.PERCENT Optional | Residual value percentage
PREPAY.METHOD Optional | The following prepayment methods are
available:
«  NA for none
« 1forCPR
= 2 for PSA factor
« 3 for amonthly prepayment spread
PREPAY.VALUE Optional | The value for the particular prepayment
method
RATE.DECREASE.PERIOD | Optional | The maximum percentage the rate can
decrease each repricing period
RATE.INCREASE.PERIOD | Optional | The maximum percentage the rate can
increase each repricing period
RATE.DECREASE.LIFE Optional | The maximum percentage the rate can
decrease over the life of the product
RATE.INCREASE.LIFE Optional | The maximum percentage the rate can
increase over the life of the product
RATE.CAP.LIFE Optional | The maximum rate for the life of the
product
RATE.FLOOR.LIFE Optional | The minimum rate for the life of the
product
TEASE.DISCOUNT Optional | Tease discount percentage

The administrator can create assumption sets or load assumption sets from the
relational database. All default assumption sets are stored in FS.MIX_DEFAULT.
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See "Mix Element Dimension" in Chapter 14, "Using the Maturity Mix End-User
Interface" for additional information on the values in the Mix Element dimension.

The FS.MIX_MAP Variable

The FS.MIX_MAP variable stores the assignment of mix assumption sets to
products over time.

This variable is dimensioned by the following:
« TIME

«» FS.CHRT_OF_ACCT

» FS.MIX_SCENARIO

» FS.CURRENCY

Using this variable, an administrator can specify a particular assumption set for
product (the value in FS.CHRT_OF_ACCT) across any time bucket(s) (the value in
TIME), across maturity mix scenarios (the value in FS.MIX_SCENARIO), and across
currencies (the value in FS.CURRENCY).

The FS.MIX_OVERRIDE Variable

This is a typically sparse variable containing information, entered by a business unit
manager, that differs from the default maturity mix and pricing spread
assumptions. In addition to FS.MIX_BREAKOUT and FS.MIX_ELEMENT, this
variable is dimensioned by TIME, FS.CHRT_OF_ACCT, FS.ORG_UNIT, FS.MIX_
SCENARIO, FS.STRATEGY, FS.CURRENCY and any user-defined dimensions, if
applicable.

If business unit managers make no changes to the default maturity mix and pricing
spread assumptions, this variable is populated with null or NA values.

Administrative Processes

Administrators store system-wide maturity mix assumption sets in the FS.MIX_
DEFAULT variable. The administrator can create assumption sets or load
assumptions sets from the relational database. For more information on loading
maturity mix assumption sets from FDM, see the section entitled "Maturity Mix
Assumptions"” in Chapter 3, "Administering the Application". Maturity mix
Assumption sets are assigned to chart of account values in the FS.MIX_MAP
variable.

2-26 Oracle Budgeting & Planning Reference Guide



Physical Data Model

Locating the Particular Assumption Set During Cash Flow Processing

When an end user inputs a value and performs a cash flow calculation on that
value, the interface goes through a series of steps to determine the appropriate mix
assumption set to use.

The Budgeting & Planning application first checks the FCST Maturity Mix Scenario
(FS.FCST.MIX_SCN) attribute to determine which maturity mix scenario to use for
the particular forecast in which the value was input. Given the maturity mix
scenario, the application queries the Mix Map variable, using the value in the
variable for the time period, chart of accounts and currency in which the value was
input. The result of the query on the variable returns the value of the FS.MIX_
ASSUM_SET dimension that Budgeting & Planning uses to find the default mix
assumptions.

Then the application checks for any overrides to the default assumption set by
querying the FS.MIX_OVERRIDE variable using the time period, chart of accounts,
organizational unit, currency, and strategy in which the value was input.

For any values of the mix assumption set in the override variable that are null or
NA, the application next queries the FS.MIX_DEFAULT variable using the mix
scenario, currency, and chart of accounts in which the value was input.

The result of the query on FS.MIX_OVERRIDE and FS.MIX_DEFAULT comprises
the complete maturity mix assumptions the cash flow calculations use to generate
account results.

If values for the Spread MIX_ELEMENT dimension value exist in FS.MIX_
DEFAULT and/or in FS.MIX_OVERRIDE, these values are displayed and written to
the New Add Spread financial element (cash flow account). If there are null or NA
values in both variables, then the inputs to the New Add Spread financial element
or the Average Spread financial element (non-term account) in the Budgeting &
Planning interface are used.

Required Steps for Creating a Default Maturity Mix Scenario

Two steps are required to create a default maturity mix forecast for each value of the
Chart of Accounts dimension.

First, create (or load) an assumption set into the FS.MIX_DEFAULT variable.

Second, assign that assumption set to the chart of accounts value by populating the
FS.MIX_MAP variable. Optionally, users can modify the default maturity mix
assumptions by populating values in the FS.MIX_OVERRIDE variable.
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An alternative to creating a default Maturity Mix scenario is to not define the
defaults at the administrator level and require end users to input assumptions in the
Maturity Mix Assumption interface.

Cash Flow Processing Error

In the event that no maturity mix assumptions have been defined, a dialog box
appears informing the end user that cash flow calculations cannot be run until a
complete maturity mix forecast has been defined (in either the FS.MIX_DEFAULT
variable or the FS.MIX_OVERRIDE planning item).

Extended Definition Planning Items

The following planning items have been designed and incorporated in this release
for planned future functionality.

Caution: To avoid problems during upgrades to future releases of
the Budgeting & Planning application, do not modify these
financial data items.

Planning Item Description
Activity Units This planning item includes the following dimensions:
=« Activity

« Organizational Unit
. Forecast

«  Currency

«  Strategy

Activity Factors This planning item contains the same dimensions as Activity
Units

Activity Costs This planning item contains the same dimensions as Activity
Units
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Planning Item

Description

Capital Expenditures

This planning item provides data related to fixed assets, such as
buildings or equipment, and includes the following dimensions:

Time
Organizational Unit
Financial Element
Forecast

Currency

Strategy

Capital Asset

Employee Information

This planning item contains salary and benefit information that
will be used in the budgeting process. The following dimensions
are planned for this planning item:

Employee Info
Forecast
Currency
Strategy
Employee
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Administering the Application

This chapter describes changes in the way end users interact with the shared
database, which have implications for administering the application, and the
necessary processes that prepare Express for a planning cycle.

This chapter presents the following topics:

Creating External Users

Database Preparation Overview

Data Movement Routines

Time Dimension Management

Establishing Attributes

Forecast Management

Maturity Mix Information

New Business Timing

Controlling Which Financial or Mix Elements Appear in the Interface
Setting Read-Only and Read/Write Parameters
Transfer Pricing Accrual Methods

Distributing Express Database Objects and Data

Creating External Users

This release of Budgeting & Planning supports External Users defined with Oracle
Financial Analyzer (OFA). External Users have access to data entry forms used in
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OFA Web Client to collect budget or forecast values, which are written to an EIF file
and sent to the Task Processor for submission to the shared database. External Users
also have access to reports in the OFA Web Client interface that have been defined
and distributed to them using the OFA client/server application.

Saving to the Shared Database

Budgeting & Planning employs the same approach as the OFA Web Client interface
in saving data to the database.

As part of Web enablement, end users accessing the Budgeting & Planning interface
attach a copy of the shared database on a read-only basis rather than attaching to a
personal databases. When end users generate results in the interface and then save
those results the application creates an EIF file, which is sent to the Task Processor
queue for submission to the appropriate shared database.

Viewing Data from Personal Databases in the Interface

If you are upgrading from a previous version of the application, it is not necessary
to delete previously defined Budget workstation users.

Any valid user created in OFA can log into and use the Budgeting & Planning
interface, provided that database structure objects have been distributed to that end
user appropriately. In other words, OFA users can successfully run Budgeting &
Planning in the Web environment. However, these end users need to recognize that
any results generated using the Web-enabled version of Budgeting & Planning are
submitted to the shared database only and not directly to their personal workstation
databases.

Note: Prior to using the Web-enabled version of the application,
end users should submit any data residing in their personal
workstation database to the shared database in order to view that
data in the Budgeting & Planning interface.

Functionality Enhancements to the Application

Browser-based access along with the other functionality enhancements included in
this release of Budgeting & Planning enable the majority of end users to perform
their budgeting tasks using just the Budgeting & Planning interface. In previous
releases end users were required to use OFA to populate worksheets, run and print
reports, accept distributions, and create submissions. With this release, end users
can either perform these tasks directly from within the interface or no longer need
to perform them.
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If your organization has a subset of end users, such as power or analytical users,
who want to continue using OFA you can support the continued use of Budget
workstations. However, these users must create budget and forecast data
submissions to the appropriate shared database for their values to be consolidated.

Recommendation for Creating Budgeting & Planning Users

Oracle recommends that all new Budgeting & Planning users be created as External
Users.

Creating External Users minimizes the potential for confusion arising from the
existence of personal Budget workstation databases. If Budget workstations are
created, data generated using Budgeting & Planning is submitted to the shared
database only. In order for changes originating in Budgeting & Planning to be
visible in an end-user’s workstation database, the administrator must perform an
OFA data distribution from the shared database to the personal database.

The following table compares parameters for structure and database access
associated with workstation/user.

Administrator Budget External

Personal database with structure X X

Personal database with data X X

Associated shared database X

Can attach to shared read-only X X X

OFA Metadata

This release of Budgeting & Planning continues to maintain complete OFA
metadata for the Express data model and associated objects, ensuring consistency in
presentation whether using the Budgeting & Planning Java interface or the OFA
interface.

Database Preparation Overview

Summarized in the following table are the processes and routines you need to
follow to prepare the database. Each of these steps are described in detail in this
chapter.
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Before you run these steps you must have Oracle Express, OFA, and Oracle
Budgeting & Planning installed on your system.

Preparation Steps Sub-Steps (if applicable)

Execute the data movement routines FS.LOAD_HIER

. Chart of Account leaves and
hierarchies

. Organizational Unit leaves
and hierarchies

FS.LOAD_DATA
. LEDGER_STAT

. RES_DTL_XXXXXX (Risk
Manager results table)

. Interest and Exchange Rates

. MATURITY_AUXILIARY
(Maturity mix)

Establish attributes Chart of Accounts
Forecast

Report Line Item

Define maturity mix defaults and
overrides

Define new business timing

Distribute OFA structure and data

Data Movement Routines

If you are using FDM as the source of your data, it is necessary to move your
hierarchical structures, table-specific data, and forecasts and assumptions from
FDM to Express.
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Three categories of data movement routines have been created for this purpose:

Category 1 Hierarchies Movement of your organizational and chart of
account hierarchies from FDM to Express.

Category 2 Data Movement Movement of data from the LEDGER_STAT and
Risk Manager RES_DTL_XXXXXX tables to
seeded planning items created in Express during
the data creation process.

Category 3 Assumptions Movement of maturity mix assumptions and
interest and exchange rate forecasts that you
create in FDM.

Note: The data movement routines are launched from Express
Administrator, using command line entries. The individual(s) in
your organization who is responsible for running these routines
needs to be proficient in Express language.

This proficiency is necessary to customize the command line entries
for these routines as your business environment changes.

FDM Leaf and Express Dimension Compatibility

It is important to understand that the key fields or leaves that are used in FDM and
the dimensions that are used in Express can either exist simultaneously, in both
databases, or exist separately. There does not have to be a one-to-one relationship
between an FDM leaf and an Express dimension.
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The following illustrates this principal:

Dimension Occurring Only Dimensions Occurring in Dimensions Occurring

in FDM FDM and Express Only in Express

. GL_ACCOUNT_ID . BP_COA _ID* . CURRENCY

. COMMON_COA ID . TIME** . STRATEGY

. OTHER (User defined) . FIN_ELEM_ID . FORECAST

. CONSOLIDATION_CD . ORG_UNIT_ID . DIM-N (User defined)

*BP_COA_ID is an example of user-defined leaf field in FDM and, therefore, may have a
different name. Regardless of the name, it is the leaf used to represent the planning chart of
%cg%ql_nts. In the Budgeting & Planning application, this dimension is called FS.CHRT_OF _

**Time is not tyﬁically treated as a leaf value in FDM because it is physically stored in buckets
(columns within a record). However, it can be thought of as an identifier within the
relational database and, therefore, is treated as a dimension.

Executing the Data Movement Routines

Through data movement routines in Express, the sets of data listed in the following
table are transferred from FDM to Express.

Data Movement
Category Description Routine/Sub-routine

Hierarchies Primarily the hierarchical structure of your  FS.LOAD_HIER
organizational units and chart of accounts.

Data movement  Data associated with the following tables: FS.LOAD_DATA
« LEDGER_STAT
«  RES_DTL_XXXXXX

Assumptions Assumptions created in FDM that are FS.LOAD_DATA
components of cash flow calculations. These
include the following:

« Interest and exchange rate forecasts
«  Maturity mix assumptions
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The description of each of these routines includes the following:
« Purpose of each routine
« Sample call in Express

« Key actions of the routine

Prerequisites to Running Your Routines
Note the following before running your data movement routines:

« RunFS.LOAD_HIER and FS.LOAD_DATA from Express Administrator

« Attach the Super Administrator database and FSBPTOOL and FSLANG prior to
running the data movement routines

« Attach the OFA Super Administrator database first and attach this database
read/write

« Attach the FSBPTOOL and FSLANG databases read-only

Loading Hierarchies

Both FDM and Express rely heavily on hierarchical structures to perform their
functions. To ensure consistency and eliminate redundant efforts the FS.LOAD _
HIER routine provides a means of transferring your data from FDM to Express. The
essential structures created in FDM are the organizational units and chart of
accounts. However, additional hierarchies can be constructed in FDM to organize
user-defined leaves. These structures can also be transferred.

The hierarchy data movement routine reads data primarily out of the OFSA_IDT_
ROLLUP table, for the given system identification number of the desired Tree
Rollup ID. The balanced FDM Tree Rollup ID is converted into an unbalanced OFA
hierarchy. As the Tree Rollup ID values are recreated in OFA as dimension values,
the prefix letter 'F’ is appended to the value. When OFA hierarchies are refreshed
using the hierarchy data movement routine, leaves which have been deleted or
orphaned in FDM become unassigned or available (OFA’s equivalent of orphans) in
the OFA hierarchy.

Balanced and Unbalanced Trees

A key difference between FDM and Express in treating hierarchies is the
requirement, essential to FDM, that trees be balanced. This means that all nodes of a
tree in FDM must go down to a common level. Therefore dummy or placeholder
nodes are employed to retain this balanced structure. In Express, balanced trees are
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not a requirement. During the data movement routine, nodes with the same value
are collapsed into a single node on the tree.

Parameters

The call statement and parameters for the FS.LOAD_HIER routine are:

CGal | Fs. Load_H er (<user >/ <passwor d>@dbnane>, of adi mane, sysi dnum

[CGRPHANS] <H . ENTRY VALUE>)

The parameters are detailed in the following table:

Parameter

Description

ofadimname

OFA dimension name. This is the dimension
whose values are populated by the routine.
Usually the dimensions are FS.CHRT_OF_
ACCT or FS.ORG_UNIT.

sys_id_num

This is the Oracle Financial Services
Applications (OFSA) system ID number and is
the unique identifier in FDM that identifies the
hierarchical structure you want to transfer.

<user>/<password>@<dbname>

This is the OCI ConnectString, which is the
relational database user name and password
that allows access to FDM. It is provided in the
following format:
<user>/<password>@<dbname>.

Note that user, password, and dbname are
never stored so each must be specified on each
execution of FS.LOAD_HIER.
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Parameter

Description

ORPHANS

This is a flag that indicates whether or not to
transfer orphan leaves. Orphan leaves are
leaves without an associated node level point
in the hierarchical structure.

If you do not want to transfer orphan leaves,
replace ORPHANS with NOORPHANS.

If you exclude this parameter, the default is to
exclude orphans, essentially running the
routine as though you had entered the
parameter as NOORPHANS.

HLENTRY VALUE

This argument must be populated when the
destination dimension has multiple
hierarchies.

An HILENTRY dimension value is the
OFA-generated identifier for an individual
hierarchy.

To find an HLLENTRY value use the Report
command in Express Administrator and enter
a command such as:

report w80 HORG DESC

where ORG is the dimension prefix for
organizational unit.
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Sample Call
The following is an FS.LOAD_HIER sample call based on the parameters provided:
CGall fs.load_hier(’ GFSADEMD passwor d@BEMIDB , ' FS. G-RT_CF_ACCT , ' 102418’ , ' NOCRPHANS , ' H . AA1234’)

In the above sample call the FS.CHRT_OF_ACCT dimension is populated with
values found in the OFSADEMO database with the SYS_ID_NUM of 102418.

Note: The record in the Catalog of IDs corresponding to the SYS_
ID_NUM indicates the type of leaf (organizational unit, product, or
other) that this hierarchy contains.

Key Actions for the FS.LOAD_HIER Data Movement Routine

Step Action

Step 1 Queries OFSA_CATALOG_OF_LEAVES table

Step 2 Queries OFSA_CATALOG_OF _IDS for the given SYS_ID_NUM

Step 3 Loads the hierarchy for the given SYS_ID_NUM from OFSA_IDT_ROLLUP
Step 4 Loads top rollup level from OFSA_NODE_DESC

Step 5 Parses hierarchy by removing repeated nodes from balanced tree to make a
natural hierarchy

Step 6 Adds new leaf and node values and, optionally, adds orphan values to the
dimension. The supplied prefix letter is prepended to the original values when
added to the dimension except for those dimensions marked in
FS.DM.CATALOG for Currency Code Translation logic, which does not prepend
a character code to values upon load.

Step 7 Recalculates hierarchy structure and sequencing

Step 8 Populates any blank dimension value descriptors from OFSA_LEAF_DESC and
OFSA_NODE_DESC

Refreshing Hierarchies

As you add or delete either leaf or node values in your FDM Tree Rollup IDs, you
may want to refresh or reload those modified Tree Rollup IDs into your OFA
hierarchies. To refresh a hierarchy, issue the same call used to load the hierarchy in
the first place.
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Caution: If you have multiple hierarchies for the same dimension,
be sure you specify the exact HLLENTRY value for the hierarchy you
want to refresh.

The following chart outlines the refresh logic of the hierarchy data movement
routines.

If the following occurs ona  The data movement routine performs the following
source FDM Tree Rollup ID... maintenance on the OFA hierarchy...

An existing leaf value was The value has its former parentage stripped and it

orphaned. becomes an "available’ or unassigned value in the OFA
hierarchy.

An existing leaf value was The value has its former parentage stripped and it

deleted. becomes an "available’ or unassigned value in the OFA
hierarchy.

An existing node has all of its ~ The former parentage of an existing node is stripped and
leaves reassigned to other the node becomes an "available’ or unassigned value in the
nodes, orphaned, or is deleted. OFA hierarchy.

Note that any data which had been rolled up to that node
still exists. However, since the node no longer exists in the
hierarchy all the data associated with that node is
excluded from any subsequent database solve routines.

A childless node is created. The value is ignored if you use the 'NOORPHANS’ option.
The value comes over as an orphan if you use the
'ORPHANS’ option.

Note: The hierarchy data movement routines will never delete
dimension values in Express. To delete dimension values, use the
Maintain -> Dimension Value option in the OFA Client interface.

Loading Data From the LEDGER_STAT Table

The LEDGER_STAT table in FDM contains your institution’s general ledger
information and key statistical data. This step brings historical data from LEDGER _
STAT into Express through the use of filters, which identify the financial elements,
consolidation codes, and years you want to bring into Budgeting & Planning.
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Having accurate, reconciled LEDGER_STAT data available in Express permits
historical data to be available, which you can use to develop your future
projections. The routine allows you to update your forecasts with historical months
of actual data without affecting the forecast for future time periods.

The LEDGER_STAT data movement routine reads data out of the LEDGER_STAT
table, dividing balances by the currency factor (usually 1000) and writes the results
to the Financial Plans planning item. Users have the option to append any new leaf
values encountered during the read from the LEDGER_STAT table to the
dimensions in the Express database.

In addition, if you have other forecast or plan information stored in LEDGER_STAT,
this information can be transferred to the Express database by filtering on the
consolidation code you want to transfer. You may need to modify the as-of-date for
the Forecast dimension value that the forecast or plan information is being loaded
into.

Data Filtering and Forecasting

This step also enables you to filter on Organizational Unit and Chart of Account
leaves so that you can bring in defined subsets of data. This further refinement in
filtering enables you to refresh a subset of the Express database or filter out, for
example, organizational units found only in FDM, if you want those units excluded.

Regarding the Forecast dimension, you can perform the following functions:
= Select the forecast dimensions to which you want data applied
« Update multiple forecasts with a single execution of the routine

« Establish and maintain different as-of-dates for different forecasts and load
actual data according to those unique dates, without overriding forecasted data
with actual data

Data Map

The LEDGER_STAT table in FDM contains data organized by organizational unit
and chart of accounts. Additional dimensions such as Customer Segments may or
may not be identified in the LEDGER_STAT table. The routine is designed to handle
both situations.
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Key Actions for Loading LEDGER_STAT Data

Step The routine...

Step 1 Determines maximum as-of-date for all forecasts specified in the load call. The
as-of-date will be used to load only data whose date is less than or equal to the
as-of-date.

Step 2 Builds a SQL statement based on the free form where clause and filter parameters
of the load call.

Step 3 Determines which parameters map a column in FDM to an Express dimension
and which Express dimensions are being limited to a single dimension value.

Step 4 Builds the SQL logic to convert ‘002’ currency codes to the functional currency
stored in FS.ENV.CAT.

Step 5 Builds the SQL to prepend the argument-specified prefix to leaf values for the
corresponding dimensions.

Step 6 Runs SQL query and imports data into a temporary working area.
Step 7 Copies data into FS.FIN_DATA while dividing by currency factor.

Step 8 Copies data to all specified forecasts, excluding any time periods beyond the
as-of-date, per forecast.

Step 9 Populates any blank descriptions for all dimension values on FS.FIN_DATA.

Loading Current Position Data

The Risk Manager cash flow engine generates the cash flow run off projections and
repricing projections for your current book of business. The data on which the
projections are based is found at the customer account level in the FDM instrument
tables. This provides highly accurate cash flow results.

The account level data is used by Risk Manager to generate the run off and
repricing results. These results are then organized in summary form by key leaves
(usually organizational unit, chart of account, currency, and financial element) and
are then available for loading into Express.

The RES_DTL_XXXXXX data movement routine reads data out of the particular
result detail table, divides balances by the currency factor (usually 1000), converts
the rate extensions to whole rates by dividing the extensions by their corresponding
balances, and writes the results to the Financial Plans planning item. Users have the
option to append any new leaf values encountered during the read from the RES_
DTL_XXXXXX table to the dimensions in the Express database.
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In FDM this data is summarized and stored in tables using the following naming
convention: RES_DTL_<number>, where <number> is the Risk Manager Process ID
number.

Data Filtering and Forecasting

The data movement routine also enables you to filter on Organizational Unit and
Chart of Account leaves so that you can bring in defined subsets of data. This
further refinement in filtering enables you to refresh a subset of the Express
database or filter out, for example, organizational units found only in FDM, if you
want those units excluded.

Regarding the Forecast dimension, you can perform the following functions:
« Select the forecast dimension value to which you want data applied
« Update multiple forecasts with a single execution of the routine, provided that

all forecasts have the same as-of-date

Key Actions for Loading Current Position Data

Step The routine...

Step 1 Builds a SQL statement based upon the free form where clause and filter
parameters of the load call.

Step 2 Determines which parameters map a column in FDM to an Express dimension
and which Express dimensions are being limited to a single dimension value.

Step 3 Queries Bucket Start and End Dates from OFSA_RESULT_BUCKET for the
specified Risk Manager Process ID’s SYS_ID_NUM.

Step 4 Validates Bucket Start and End Dates to ensure that they span only consecutive
whole months.

Step 5 Validates that all Forecasts specified for the load have the same as-of-date.

Step 6 Verifies that the as-of-date is exactly one month prior to the first Bucket in the
Result Detail table.

Step 7 Loads data from RES_DTL_XXXXXX table where XXXXXX is the specified SYS_
ID_NUM.

Step 8 Calculates current position rates.

Step 9 Divides Current Position Balances by the currency factor.
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Step The routine...

Step 10  Copies data to all specified forecasts, excluding any time periods prior to and
exclusive of the as-of-date, per forecast.

Step 11  Populates any blank descriptions for all dimension values on FS.FIN_DATA.

Details of the LEDGER_STAT and Current Position Routines
The data movement routines used to move LEDGER_STAT and current position

data (RES_DTL_XXXXXX) are similar. This section describes important
considerations when creating and executing either routine and provides sample
calls for both.

Considerations When Using These Data Movement Routine Calls

This section provides information on the following:

« Matching or appending leaves

« Transforming Time columns to dimension values

« Deleting pre-existing values before executing a new routine

Matching or Appending Data

You can choose to either ignore or incorporate new leaves into the Express database
using one of the following options:

Option Functionality

MATCH  This option verifies that a dimension value exists in Express for the FDM leaf
value. If the leaf value does not already exist in Express then the data associated
with that leaf is not loaded. This option prevents the introduction of new
dimension values into Express.

APPEND This option creates new dimension values in Express when the data movement
routine encounters new leaf values and loads the data associated with that leaf.
This option allows the introduction of new dimension values into Express.

Transforming Time Columns to Dimension Values

In FDM, time periods are treated as separate columns. In Express, however, periods
of time are dimension values of the Time dimension. FS.LOAD_DATA executes this
transformation from columns to dimension values when transforming data.
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For Current Position data Time values are determined by evaluating the
corresponding row in OFSA_RESULT_BUCKET for the particular RES_DTL _
XXXXXX table.

Note: Datais moved, based on the following relationships between the
FDM tables and the forecast as-of-date:

« For LEDGER_STAT, the time periods are before or equal to the forecast
as-of-date

«  For RES_DTL_XXXXXX tables the time periods are after the forecast
as-of-date

Date is not moved from either tables if:

«  The value(s) is null or zero

Deleting Pre-Existing Data Before Executing a New Routine

The LEDGER_STAT and RES_DTL_XXXXXX routines do not delete any data before
loading. Administrators should delete data from the destination months by setting
them to NA before running either load process.

Sample Calls

The following two sample calls illustrate how these calls are used to move data
from the LEDGER_STAT table and the RES_DTL_XXXXXX tables in FDM to
Express.

Note: Line numbers appear in both sample calls. These are used to
identify specific lines in the calls as they are discussed in the
following sections. Do not include these numbers in the calls you
use.
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Sample Call for LEDGER_STAT

Gl | FS LOAD DATA(’ <user >/ <passwor d@dbnane>’
"FS. FI N DATA

" -ignored-’

" LEDGER STAT

"UsD

"YEAR S in (1996, 1997) and GONSCLI DATI QN (D=100°

"FINNT AL HEMID " -ignored-’ ' 100, 140, 420, 450, 455, 457’

' FS. STRATEGY "-ignored-’ " -ignored-’ " MOMENTUM

' FS. FARECAST ' -ignored-’ " -ignored-’ ' BASE
"FSGRGWINT " APPEND 'F "ARGWNTID

"FS. ORT_GF_ACCT " APPEND "F "BP. QA ID

"FS.FI N BLEM " APPEND "F "AINANOAL HEMID

"FS. QURRENCY " APPEND " -ignored-’

Sample Call for RES_DTL_XXXXXX Tables

CGal | FS LQOAD DATA(’ <user >/ <passwor d@dbnane>’
"FS. H N DATA d

' 1 SO ARRENCY_ D )

"-ignored-’

" RES DIL_10000003’

"-ignored-’

"-free formwhere cl ause-’

"FINANO AL HEMI D " -i gnored-’ ' 60, 80, 90, 100, 120, 130, 140, ...’
" SCENAR O NM " -ignored-’ "1

' FS. STRATEGY " -ignored-’ "-ignored-’ " MOMENTUM

' FS. FARECAST " -ignored-’ " -ignored-’ ' BASE
"FSGRGWNT " APPEND "F "ARGWINTID
"FS GRT_CGF_ACCT " APPEND "F "BP.CAID
"FS.FIN BEM " APPEND 'C "HNANOAL HEMID

"FS. AURRENCY " APPEND " -ignored-’

' 1 SO ARRENCY_ D )

Caution: Line 7 of the sample call for RES_DTL_XXXXXX uses
ellipsis to indicate the omission of additional financial elements
that should be present. Your sample call must list all financial elements
you want to include for this parameter. Using ellipsis as shown in this

example will cause your call to fail.
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Call Format Categories

The patterns within the data movement routine calls can be grouped into two
categories:

Category 1 Fixed-format These parameters are lines 1 through 5 of the
parameters sample calls.
Category 2 Flexible-format These parameters begin on line 6. The number

of parameters is variable, however, they must
follow a specified pattern

parameters

For the flexible format parameters, the first lines contain the filtering criteria for the
WHERE clause of the resulting SQL statement. The next section contains the data
sourcing information where the target dimension names are mapped to the source
column names from FDM. You must also include information to instruct the routine

on how to

populate the dimension values.

Fixed-Format Parameters

The first five parameters of the LEDGER_STAT and RES_DTL_XXXXXX loads are
fixed and cannot be expanded. The following table describes these parameters in
the order in which they are used.

Line

Number  Description Example

1 Database Connection String in the " GFSADEMD passwor d@BevDB
format '<user>/<password@<dbname>’

2 Variable name into which data will be "FS. FI N_DATA
loaded. This will always be FS.FIN_
DATA.

3 An ignored, although mandatory, ' -ignored-’
parameter. It is sufficient to use the
string -ignored-’ as a placeholder for
this parameter.

4 A directive to indicate what data source
is being loaded.
« For LEDGER_STAT loads this must ' LEDGER STAT

be 'LEDGER_STAT’

3-18 Oracle Budgeting & Planning Reference Guide



Data Movement Routines

Line
Number  Description Example
«  For Result_Detail loads, thisisthe ' RES DIL 123456’
table name in the format 'RES _
DTL_XXXXXX* where XXXXXX is
the SYS_ID_NUM
5 The currency code for translating ‘002’
currencies. This should be the functional
currency.
« For LEDGER_STAT loads use an " UsD

entry such as the example

«  For Result_Detail loads this " -i gnored-’
parameter is ignored

Flexible-Format Parameters

The flexible-format parameters can be grouped into two subcategories with each
subcategory performing a specific type of function.

Subcategory 1 Performs the filtering for the data extract by providing
criteria used to build the WHERE clause in the SQL statement
that extracts the data from FDM.

Subcategory 2 Contains data sourcing information to map the target
dimension names to the source column names in FDM.

WHERE Clause Parameters

There are two sections of parameters that filter the data extracted from FDM before
being loaded into Express.

The first section of parameters is a free form WHERE clause, all contained within
one single-quoted parameter. This parameter section can be eliminated by including
a placeholder argument with a dash preceding the text of the argument, as shown in
line 6 of the RES_DTL_XXXXXX sample call.

The second section of parameters provides an addition to the WHERE clause,
restricting the filter to specific values. This set of parameters can only be used when
the filtering criteria uses an equality operator for a fixed list of values. Wildcards are
not valid. There can be one or more sets in this section of parameters as needed.
Lines 7 and 8 of the RES_DTL_XXXXXX sample call illustrate this.
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Format Examples

This section uses lines from the sample calls to illustrate different ways that you can
create your WHERE clauses.

The basic format of these two sections is as follows:

Section1 <free form WHERE clause>

Section 2 <column name> <-ignored-> <a comma-separated list of values>

This second section consists of a set of three parameters, with the
ignored parameter being a required placeholder. Additional lines
for this section are optional, to include as needed. These
additional lines need to follow the format of line 7 in the sample
calls.

Caution: Entries for both line 6 and line 7 are required. For line 6
you can disable the free form WHERE clause by making it an
ignored parameter. See "Additional Notes" in this section for more
information on creating ignored parameters. For line 7, however,
you cannot make the first and third parameters ignored
parameters.

Example 1
This example illustrates a basic call:

6 "YEAR S in (1996, 1997) and QONSCLI DATI N (D=100’ -
T "HANANOAL HEMID " -ignored-’ ' 100, 140, 420, 450, 455, 457 -

Example 2
This example illustrates a more complex call, with additional filtering parameters:

6 '-free formwhere cl ause-’ -
7 "FINANDAL HEMID " -ignored-’ ' 60, 80, 90, 100, 120, 130, 140, ...’ -
8 " SCENAR O NWM " -i gnored-’ " -

Note that ellipses in line 7 have been inserted to indicate the omission of additional
financial elements. These omitted financial elements, rather than ellipses, need to be
present in your call.
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Dimension to Column or Value Mapping

The final section of parameters maps target Express dimensions to source relational
columns or to specific dimension value(s).

This section consists of parameters in sets of four where each set has an expected
format. Within this section, there is no required ordering of the sets.

The only requirements are that:
« The four parameters be in the expected format; and
« All dimensions within the FS.FIN_DATA variable be included in this list

For clarity, the following examples display all four parameters, each on one line.
This section of parameters is flexible, to accommodate installations that have
utilized user-defined fields in the Budgeting & Planning data model. The additional
dimensions for these user defined fields must be added to this section until all
dimensions in FS.FIN_DATA are addressed.

Format: Express Dimension Maps to a Relational Column

The following example illustrates the mapping between a dimension value in
Express and a column in the FDM relational database:

3 "ES FNHEM " APPEND "F "HNANJ AL HEMID -
Where... Represents...
"FS.FIN BLEM The Financial Element dimension in the FS.FIN_DATA
variable
" APPEND The selection from the options APPEND or MATCH. See

"Matching and Appending Data" in this section for
additional information.

'F The prefix character used for creating leaf values in
Express

"FINNNOAL HEMID The FDM relational column
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Format: Express Dimension Limited to a Dimension Value

When a dimension is limited to a dimension value, since it does not equate to a
relational column name, the parameters for APPEND, MATCH, and Prefix do not
apply and, therefore, are ignored.

The following example illustrates this approach:

9 ' FS STRATEGY " -ignored-’ " -ignored-’ " MOMENTUM -

Additional Notes

Note the following with regards to these data movement routines:

= The Express line continuation character is a dash (-)

« Parameters must be surrounded by single quotes

«  Quotes within the free form WHERE clause must be preceded with backlashes
« Currency values do not use a prefix therefore the prefix parameter is ignored

« FS.LOAD_DATA ignores parameters beginning with a dash (inside the single
quotes). For example, -free form SQL where clause-’ is ignored because
FS.LOAD_DATA will detect the dash in the first character of the parameter.

Caution: FS.LOAD_DATA does not update your OFA Super
Administrator database. You must update it manually using the
Express UPDATE command.

Analyzing the SQL Statement

For further analysis of how the SQL statement is constructed, you can review the
the system-generated program FS.SQLCURSOR. This program contains the actual
SQL command issued to FDM for extracting the data imported into Express.

After FS.LOAD_DATA has finished running, you can review the entire generated
SELECT statement by entering the following Express command:

DESCR BE FS. SQLARSCR
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Interest and Exchange Rate Forecasts

The Interest and Exchange Rates Forecast data movement routine reads data out of
the OFSA_INTEREST_RATES_AUDIT and OFSA_EXCHANGE_RATES_AUDIT
tables. The audit tables are created when a Risk Manager Process ID is run with the
Forecast Rates box checked in the Audit tab of the Process ID. Since rates are stored
as whole rates in the audit tables there is no need to perform any rate conversion.

The values are loaded into the Interest Rate Scenario and Exchange Rate Scenario
associated with the Forecast dimension value given in the call. Interest Rate Code
(IRC) values are converted to Interest Rate Type dimension values; the ID number
for the IRC is prefixed with the letter ‘F’ when it is converted to an Interest Rate
Type dimension value.

Note: This data movement routine will initialize both Express
database variables, FS.INTEREST_RATE and FS.EXCHANGE_PCT,
by deleting all rates associated with the destination scenario values.

Sample Call For Loading Interest and Exchange Rate Forecasts

A sample call for this routine follows:

CALL FS LQAD DATA( ' <user >/ <passwor d>@dbnane> ' RATES ' 122875 ' BASE "-ignored-’ '1)

Notes on the Sample Call for Loading Interest and Exchange Rate Forecasts
« Parameters must be surrounded by single quotes.

= The first parameter is the OCI ConnectString, shown as:
' <user > <passwor d>@dbnane>' .

« The second parameter must be 'RATES'.

« The third parameter is the SYS_ID_NUM for the Risk Manager Process ID that
generates the rates tables.

« The fourth parameter is the FS.FORECAST dimension value.
« The fifth parameter is ignored.

« The sixth parameter is the Risk Manager Forecast Rates ID scenario number
that is being loaded.

The argument for the FS.FORECAST dimension value determines the as-of-date to
use to filter interest rates, where the START_DATE in the OFSA_INTEREST _
RATES_AUDIT table must be equal to the as-of-date. The interest rate data is
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loaded into the FS.RATE_SCENARIO corresponding to the Forecast, as indicated by
the FCST Interest Rate Scenario attribute. Likewise, the exchange rate data is loaded
into the FS.CURRENCY_SCENARIO corresponding to the Forecast as indicated by

the FCST Currency Scenario attribute.

Caution: FS.LOAD_DATA does not update your OFA Super
Administrator database. You must update it manually using the
Express UPDATE command.

Key Actions for Loading Interest and Exchange Rate Forecasts

Step The routine...

Step 1 Verifies that the START_DATE is equal to the as-of-date for the specified forecast.

Step 2 Clears out forecasted interest and exchange rate data in Express for all interest
rate codes included in the audit tables for:

«  The specified Process Sys ID; where
« Start Date is equal to the Forecast as-of-date; and
«  Scenario Num is equal to the specified Scenario Num.

Step 3 Adds interest rate types corresponding to the data being loaded if they do not
exist already.

Step 4 Loads non-zero interest rates for day terms for terms over 15 days. Terms are
converted to monthly terms.

Step 5 Loads non-zero interest rates for year terms, with converted year-term rates
overwriting day term rates from step 4, where interest rate term and interest rate
code coincide. Terms are converted to monthly terms.

Step 6 Loads non-zero interest rates for month terms, with monthly terms overwriting
converted day and year term rates where interest rate term and interest rate code
coincide.

Step 7 Loads non-zero exchange rates from OFSA_EXCHANGE_RATES_AUDIT for the
specified Process Sys ID and Scenario Num. Loads into the FCST Currency
Scenario corresponding to the specified forecast

Step 8 Populates any blank descriptions for all related dimensions.

Maturity Mix Assumptions

The Maturity Mix data movement routine reads data out of OFSA_MATURITY _
AUXILARY and creates Mix Assumption Set dimension values by conjoining the
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MLS_CURRENCY_CODE, the Risk Manager product leaf value, and the bucket
value. The assumptions are then stored, for each Mix Assumption set, in the
Maturity Mix default.

Maturity mix assumptions are loaded using the sample call outlined in this section.
For a detailed discussion of maturity mix forecasting, see the section entitled
"Maturity Mix Data Model for New Business" in Chapter 2, "The Data Model" and
Appendix D, "Details of the Maturity Mix Data Model".

Sample Call For Loading Maturity Mix Assumptions

A sample call for this routine follows:

CALL FS LOAD DATA( ' <user >/ <passwor d>@dbnane> ' FS M X DEFALLT 1108156 )

Caution: The Maturity Mix data movement routine does not
delete any values before loading data. Administrators should delete
any unwanted data before running the Maturity Mix data
movement routine.

Notes on the Sample Call for Loading Maturity Mix Assumptions
« Parameters must be surrounded by single quotes.

= The first parameter is the OCI ConnectString, shown as:
' <user >/ <passwor d>@dbnane>’ .

« The second parameter must be 'FS.MIX_DEFAULT".

« The third parameter is the SYS_ID_NUM for the Risk Manager Maturity
Strategy ID containing the assumptions being loaded into Express.

Caution: FS.LOAD_DATA does not update your OFA Super
Administrator database. You must update it manually using the
Express UPDATE command.
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Key Actions for Loading Maturity Mix Data

Step

The routine...

Step 1

Step 2

Step 3
Step 4

Step 5

Loads all rows from OFSA_MATURITY_AUXILIARY for the specified Maturity
Sys ID. Converts ISO Currency Codes of ‘000’ to the FDM Functional Currency
when creating Maturity Mix Assumption set dimension values.

Adds new Maturity Mix Assumption sets, if found, to the Maturity Mix
Assumption Set dimension.

Converts any day or year terms to monthly terms.

For those Maturity Mix Assumption sets that have more than 10 mix breakouts,
the routine sorts all the mix breakouts by mix % in descending order, so that the
nine largest mix % are loaded intact. The remaining mix % are summed and
allocated to the tenth mix breakout.

Populates any blank descriptions for all related dimensions.

Using FS.DM.CATALOG to View and Adjust the Data Movement Routines

The catalog FS.DM.CATALOG stores information about data you have loaded using
the data movement routines and also provides options for adjusting that data. The
following tables list and describe the properties found in FS.DM.PROP:

BP.OFSA.COL Description and Explanation

Description: Relational column name of source data

Sample: COMMON_COA_ID

Seeded: Yes

Modified by: FS.LOAD_HIER

Source: Argument to FS.LOAD_HIER
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BP.OFSA.DESC

Description and Explanation

Description:

Sample:

Seeded:
Modified by:

Source:

Names of the relational database source table and
table columns containing descriptions for Tree
Rollup ID node values.

This entry is not customizable.

See "BP.OFSA.DESC" for additional information on
this property.

OFSA_LEAF_DESC

LEAF_NODE
DESCRIPTION

Yes
Not modified
Seeded

BP.LEAF_NUM_ID

Description and Explanation

Description:

Sample:
Seeded:
Modified by:

Source:

LEAF_NUM_ID value for the FDM leaf field
identified in BP.OFSA.COL. This value is obtained
from OFSA_CATALOG_OF_LEAVES.

3

No

FS.LOAD_HIER
OFSA_CATALOG_OF_LEAVES
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BP.ACT.HIER Description and Explanation
Description: This value contains the most recent internal
hierarchy ID in the Express database.
Refer to the section "BP.ACT.HIER" appearing later in
this chapter for additional information on this
property.
Sample: HI.AA80955
Seeded: Yes
Modified by: FS.LOAD_HIER
Source: Argument to FS.LOAD_HIER
BP.SIDN Description and Explanation
Description: This is the SYS_ID_NUM corresponding to the most
recently loaded hierarchy.
Sample: 100574
Seeded: No
Modified by: FS.LOAD_HIER
Source: Argument to FS.LOAD_HIER

BP.OFSA.USER

Description and Explanation

Description:

Sample:

Seeded:

Modified by:

Source:

Relational database User ID used to log into an OCI
connection during the most recent hierarchy load.

ORACLE
No
FS.LOAD_HIER

Database connection string
argument to FS.LOAD_HIER
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BP.DATE Description and Explanation
Description: Date and time of most recent hierarchy load.
Sample: 1999.01.01 12:00:52
Seeded: No
Modified by: FS.LOAD_HIER
Source: Express system date and time
BP.DESC.W.NODES Description and Explanation
Description:  YES if descriptions for new dimension values should
be appended with leaf or node values.
Sample: YES
Seeded: Yes
Modified by: User
Source: User or seeded
BP.UDF Description and Explanation

Description: YES if this dimension is a user-defined dimension in

FS.FIN_DATA.

This is for internal use - do not change
Sample: NO
Seeded: No

Modified by: FS.USER_DEF_DIMS

Source: [no entry for source]
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BP.CODE.TRANSL Description and Explanation

Description: Flag identifying what code translation logic to use
when importing dimension values. The default logic
prepends a user-supplied prefix to leaf values.

Options are NA <default> or CURRENCY.

See "BP.CODE.TRANSL" for additional information
on this property.

Sample: NA
Seeded: Yes
Modified by: User

Source: User or seeded

BP.OFSA.DESC
This is not a customizable entry. Only specific entries are valid.

BP.ACT.HIER

This value is seeded for FS.CHRT_OF_ACCT and FS.ORG_UNIT with the Express
HILENTRY values corresponding to the single hierarchies seeded for those
dimensions.

If additional hierarchies are desired other than the seeded ones the Administrator
can create the hierarchies in OFA and populate them by passing the HLENTRY
value into FS.LOAD_HIER as an optional parameter.

The last hierarchy load performed on any given dimension would have that
HILENTRY value reflected in this catalog entry.

BP.CODE.TRANSL

The default method for loading dimension values into Budgeting & Planning is to
prepend a provided prefix character to leaf and node values when they are brought
over from FDM.

In this release a new method is introduced, specifically designed to load ISO _
CURRENCY_CD values. This method loads the values ’as-is’ without prepending a
character prefix, since all currency codes must start with a character.

In addition, code conversion logic translates values of ‘002’ to the FDM functional
currency for the LEDGER_STAT and Maturity Mix Assumption Set loads. In the
LEDGER _ STAT writeback routine, the Express database BASE Currency dimension
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value is converted to the FDM functional currency. The functional currency is
obtained from FS.ENV.CAT, which is populated by FS.SET_META.

Time Dimension Management

In addition to creating the Time dimension, fiscal year, and appropriate time
periods through the OFA interface you also need to run the FS.MAINTAIN_TIME
procedure.

FS.MAINTAIN_TIME is included in the FS. ADDTOSUPER routine when you create
the Budgeting & Planning structures and data.

When Running FS.MAINTAIN_TIME is Required

You must run FS.MAINTAIN_TIME whenever you either add or delete time values
through OFA. Failing to do so will prevent your cash flow calculations from
running properly.

To run this routine follow these steps:
1. Open the Express command window.

2. Attach the Super database and the FSBPTOOL and FSLANG databases as
instructed in "Prerequisites to Running Your Routines" in the "Executing the
Data Movement Routines" section of this chapter.

3. Enter the following command:

Gl FS Mintain_Tine

This routine accomplishes the following:
« Populates the FS.ORIG_MONTH dimension from the Time dimension.

« Stores day weighting information, which is necessary for computing rates,
yields, and interest, and for doing proper rollups.

Establishing Attributes

Attributes relate the values of one dimension to another. For the Budgeting &
Planning application, these attributes are all one-to-many relationships. For
instance, multiple Chart of Account dimension values are mapped to one account
type attribute, such as asset or liability.
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Defining Attributes

The following attributes need to be populated:

Category Attribute

Chart of Account .

COA Account Type

COA Accrual Method

COA Balance Sheet Model
COA Transfer Price Method

Forecast . FCST Interest Rate Scenario
« FCST Maturity Mix Scenario
« FCST Data As Of Date
« FCST Currency Scenario
Report Line Item « RPL Chart of Accounts

Attributes can be assigned either using Express Administrator or through the OFA

interface. If you are unfamiliar with Express command language it is recommended
that you populate your attributes through the OFA interface. Conversely, if you are
familiar with Express command language you can create a script to assign the

attributes.

Defining Attributes Using OFA

You can populate your attributes using the OFA interface by launching OFA,
selecting the Maintain menu option, and the Attribute sub-menu option.
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The following OFA dialog box appears:

Base Dimension:

Lloze

CO ount Type

COA Accrual Method

CO4 Balance Sheet Model

COA& Market R ate

C04 Product =l

Library: Perzonal
Type: One to Many

Grouping Dimensziorn: Account Type

Delete

Bename. ..

Edit...

Elik b

Help

From the Base Dimension list box select the dimension for which you want to
establish an attribute. In the above example the Chart of Accounts dimension has

been selected.

Below the Base Dimension list box is the Attributes scroll box listing attributes
related to the Base Dimension (in this example Chart of Accounts). Select the
attribute you want by highlighting it (in this example the selected attribute is COA

Account Type) and select Edit.
The OFA Edit Attribute dialog box appears:

1 Edit Attribute

Grouping ¥alues:

IAsset g

COA Account Type

Total Assets 501900036

s3et

Total Earning Assets 501900039

Azzet

Total Investments 501300042

Azzet

Securities 501900044

Azzet

US Treasuries 10001

Azzet

Commercial Paper 12001

Azzet

Short-Term Investments 501900045

Azzet

Fed Funds Sold 20001

Azzet

Reverse Repos 22001

Azzet

Total Loans 501900043

Azzet

Revolving Credit Loans 501900061

Azzet

Platinum - Intro Rate 34031

Azzet

Viza Gold 34041

Azzet

Preferred Mastercard 34051

Azzet
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The Grouping Values item is the attribute value that you want to assign to one or
more dimension values in the base dimension of the attribute. In this example, the
Asset account type option is listed as the grouping value. Using the white grid,
highlight the dimension values to which you want to assign this attribute value and
select Set.

Once you have completed defining all dimension values, select Save, followed by
Close.

Assigning Attributes in Express

If you are familiar with Express command language you can either use the
command line or create a script to establish the attributes you want. The following
set of commands sets the first 10 chart of account dimension values to an account
type attribute of ASSET:

limt fs.chrt_of acct to first 10
fs. coa_acct _type=" ASSET

Forecast Management

This section presents the following two forecast-related tasks:
« Adding a new forecast

« Setting the as-of-date for a forecast

Adding a New Forecast

The Budgeting & Planning database, when installed, has one seeded Forecast
dimension value called Base. In the Forecast dimension of the Financial Plans
planning item this seeded forecast appears as the only dimension value.

To create an additional Forecast dimension value, follow these steps:
Launch Oracle Financial Analyzer.
Choose Dimension Value from the Maintain menu.
Select the Forecast dimension.

1.
2.
3
4. Click New and type the name you want to give to the new forecast.
5. Type the Express name as the dimension value.

6

Close the dialog box.
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Setting the As-of-Date for a Forecast

Setting the as-of-date for a forecast is a key task. By advancing the as-of-date you
establish the months of historical or actual data that the data movement routines
load into Budgeting & Planning. The as-of-date determines the last month of
historical data that is loaded.

Note: Set your as-of-date for a forecast before running the data
movement routines, not after.

If you have multiple forecasts you must set the as-of-date for each forecast. You can
set these dates independently. For example, you can advance the as-of-date for one
forecast and leave the as-of-date for another forecast either unchanged or set to a
different date. The data movement routines load the correct months of actual data
for each forecast based on these dates.

To advance an as-of-date, follow these steps:
1. Launch Oracle Financial Analyzer.
2. From the Maintain menu choose Attribute.
The Maintain Attribute dialog box appears.
3. Select Forecast from the Base Dimension list box.
4. Select FCST Data As Of Date from the Attribute list box.
5. Click Edit.
The Edit Attribute list box appears.

6. Expand the Select Grouping Value list box and click the date you want for your
as-of-date.

7. Highlight the date cell of the forecast to which the new date applies.
8. Click Set.
9. Click Save.

This process sets the new as-of-date for a forecast. Repeat this step, when necessary,
to prepare for loading additional months of historical or actual data.
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Maturity Mix Information

This discussion of maturity mix assumes that your maturity-related data has
already been moved from FDM to the Express database. If you plan to manually
create your maturity mix default assumption sets you need to complete that task
before proceeding.

This process assigns a set of default maturity mix assumptions to a specific
combination of chart of accounts, time period, and currency.

To set the maturity mix assignments complete the following steps:
1. Log into Express Administrator and attach to the Super database.

2. Inthe variable section of the database Explorer window locate the variable
FS.MIX_MAP and double-click on it to open the Modify FS.MIX_MAP dialog
box.

12 Modify Fs.mix_map

M ame: D atabase:
FS_MIX_MAP SUPER
Label I Eomat I Data | [rata Driven Format ]
Type: fidth:
Text ﬂ l ﬂ
Selected Dimensions
fe.chrt_of_acct

time
fz.mix_scenario
fz.cumency

Sparze Dimenzions

MNone

I | Temporan Dt

Lloze Help
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3. Select the Data tab.

12 . Modify FS_MIX_MAP

Name: Database:
FS.MIX_MAP BGTF

General I Label I Fomat I Diata Dyiven Format I

PBage Dimension: Selector.
FS Ml SCENARID [BASE MIx =l =

Down Dimension: Acrazs Dimension:

|TIME =l [Fs.CHRT_OF_AccT |

I 1104010111 FS006000409 F5006000082 F14118

Close | Help |

For each intersection of the Time, Chart of Accounts, Mix Scenario, and Currency
dimensions select a maturity assumption set ID (FS.MIX_ASSUM_SET) that you
want to apply to this data.

Only accounts that use a cash flow-based method need to have a maturity mix
assumption set applied.

Note: These steps can also be completed using Express commands
or an OFA worksheet.

New Business Timing

New business timing can vary by chart of account. If the new business timing is
other than mid-month you will need to set your new business timing for each chart
of account. If you do not, the Budgeting & Planning application assumes
mid-month timing.
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Using an OFA Worksheet to Change New Business Timing

To set new business timing for individual chart of account values use an OFA
worksheet to edit the New Timing Percent planning item (financial data item in
OFA).

Using Express Administrator to Change New Business Timing

As an alternative you can use Express Administrator. The Express object name for
the New Timing Percent planning item is FS.NB_TIMING_PCT.

Controlling Which Financial or Mix Elements Appear in the Interface

Financial and mix elements selected to appear in the interface are called "enabled.’
The Boolean variables FS.FE_ENABLED and FS.ME_ENABLED define the financial
or mix elements enabled for each balance sheet model type.

Use the variable FS.FE_ENABLED for financial elements appearing in the main
forecasting window and FS.ME_ENABLED for mix elements associated with your
maturity mix assumptions. A value of YES indicates that a specific financial or mix
element is enabled for the selected balance sheet model type.

Once you have associated your Chart of Accounts products with the seeded balance
sheet model types the application automatically links these products to the
appropriate seeded financial elements. The application has also been designed to
enable some financial and mix elements while disenabling others. The balance sheet
model type governs the default settings.

These two variables are dimensioned by the following:

Variable Dimensions
FS.FE_ENABLED « FSBAL_SHT _MODEL
. FS.FIN_ELEM

FS.ME_ENABLED « FSBAL_SHT_MODEL
«  FS.MIX_ELEMENT

If you want to make changes to these settings you must access these variables
through Express Administrator, not OFA.
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Also, the following prerequisites must be met before making any changes:

« Populate the Balance Sheet Model dimension with balance sheet model types.
(Note that nine Balance Sheet Model dimension values are seeded. User-defined
dimension values can be added using OFA by selecting the Maintain menu
option and then selecting Dimension Values).

« Populate the COA Balance Sheet Model attribute with associations between
every chart of account product and a balance sheet model type

Note: You can view cell parameters in an OFA worksheet but you
cannot change them in OFA. Use Express Administrator to make
changes.

Setting Read-Only and Read/Write Parameters

This section discusses read-only and read/write settings for the application.
Read-only cells appear shaded in the Budgeting & Planning interface and cannot be
edited. Read/write cells are unshaded and can be edited.

Two operations set these parameters. The first uses the as-of-date. The second uses
one of the following two variables:

= FS.FE_WRITEABLE
= FS.ME_WRITEABLE

Using the As-of-Date to Set the Read-Only Parameter

When you set or advance the as-of-date for a forecast (use the FCST Data As of Date
attribute) all cells equal to or earlier than the as-of-date contain actual data. By
default, the application assigns the read-only setting to cells with actual data.

Using FS.FE_WRITEABLE and FS.ME_WRITEABLE to Set Parameters

Use the Boolean variables FS.FE_WRITEABLE and FS.ME_WRITEABLE to set cells
to either read-only or read/write. For the main forecasting window use FS.FE_
WRITEABLE. For the Maturity Mix Assumption interface use FS.ME_WRITEABLE.

A value of YES indicates that a cells is read/write. A value of NO or NA indicates
the opposite.
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These two variables are dimensioned by the following:

Variable Dimensions

FS.FE_WRITEABLE .

FS.ME_WRITEABLE -

FS.BAL_SHT MODEL
FS.FIN_ELEM
FS.CHRT_OF_ACCT
FS.MIX_ELEMENT
FS.ORG_UNIT

The application pre-defines read-only and read/write settings for financial elements
appearing in the main forecasting window, however, it does not pre-define these
settings for the mix elements appearing in the Maturity Mix Assumption interface.

Note: You must set FS.ME_WRITEABLE = YES for the Chart of
Accounts / Organizational Unit / Mix Element combinations
where the entry of Mix Override values will be allowed.

To change these settings use Express Administrator, not OFA, and make sure the
following prerequisites have been met:

« Populate the Balance Sheet Model dimension with balance sheet model types.
(Note that nine Balance Sheet Model dimension values are seeded. User-defined
dimension values can be added using OFA by selecting the Maintain menu
option and then selecting Dimension Values).

« Populate the COA Balance Sheet Model attribute with associations between
every chart of account product and a balance sheet model type

Note: You can view cell parameters in an OFA worksheet but you
cannot change them in OFA. Use Express Administrator to make

changes.

3-40 Oracle Budgeting & Planning Reference Guide



Transfer Pricing Accrual Methods

Transfer Pricing Accrual Methods

For Budgeting & Planning to generate transfer pricing dollar charges and credits,
you need to define an accrual basis. This is accomplished by populating the variable
FS.TP_ACC_METH with one of the following accrual methods:
ACTUAL.ACTUAL

ACTUAL.365

ACTUAL.360

A30.360

A30.ACTUAL

A30.365

INSTRUMENT

If you select the INSTRUMENT accrual method this generates transfer pricing

charges and credits using the same accrual method that has been defined for the
balance sheet product interest accruals in the COA Accrual Method attribute.

The database is seeded with a default transfer pricing accrual basis of
ACTUAL.ACTUAL. To change this method to another, follow these steps:

1. Open the Express command window.

2. Attach the Super database and FSBPTOOL and FSLANG databases as
instructed in "Prerequisites to Running Your Routines" in the "Executing the
Data Movement Routines" section of this chapter.

3. Enter the following command:
FS. TP_ACC METH=<net hod>
where <method> is the accrual basis you select from the list of accrual methods,
enclosed in single quotes.

For example, the following command sets the transfer pricing accrual basis to
ACTUAL.360:

FS. TP_ACC METH=" ACTUAL. 360°
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Distributing Express Database Objects and Data

Database objects are the Express database definitions of the following in the
Budgeting & Planning data model:

« Dimensions

« Dimension values

« Variables (financial data items in OFA)
« Relations (attributes in OFA)

= Relation values

In OFA these database objects are called structure and include the OFA descriptions
and other metadata associated with these objects.

Distributed data is the data values contained in the variables.

Distribution Flow

After preparing the Super Administrator’s personal database you are ready to
distribute the Express database objects, data, and OFA metadata to the shared
database and to your sub-administrators.

The distribution flow starts at the Super Administrator’s personal database, where
the objects and data reside. The objects and data are then distributed from the Super
Administrator’s personal database to the super shared database, then to the
sub-administrator’s shared databases. The sub-administrators, in turn, distribute
Express objects or data to their end users.

Note: In the Web-enabled version, only structure must be
distributed to users of the Budgeting & Planning interface.
However, if any users will only use OFA, then both structure and
data must be distributed using the Budget workstation approach.

Controlling Data Access for End Users

Administrators at both the super and subordinate levels control end user data
access by distributing specific organizational unit and other appropriate dimension
values to end users.
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End users are then only able to access the subsets of financial data pertaining to
their organizational units.

Note: Before you distribute the Express objects and data from
FDM you need to have your OFA tiered system environment in
place. For more information refer to the Oracle Financial Analyzer
User’s Guide.

Distribution Limitations

The Super Administrator and sub-administrators can create any database objects in
their personal databases and distribute these objects to their shared database, and
then to their end users. However, custom objects cannot be distributed to a higher
level administrator or shared database. In other words a sub-administrator cannot
create a database object and distribute it to the super shared database or the super
administrator’s personal database.

Caution: You cannot create database objects at a
sub-administrator or budget workstation and distribute those
objects to a higher level administrator or shared database. Database
objects created for distribution to all users must first be created in
the Super Administrator’s personal database.

After this initial distribution, the following cycle begins:

End users use the Budgeting & Planning application to develop forecasts and
budgets.

End users submit their work to their administrator; sub-administrators in turn
submit data they have collected from their subordinate end-users up the
hierarchy, and so forth until all data has been submitted into the Super
Administrator's shared database. The frequency of submissions depends on
your organization’s policy regarding updating information.

For additional information on submitting data see "Saving to the Shared
Database" and "Distributing Database Objects" in this chapter.

The Super Administrator advances the Budgeting & Planning as-of-date and
re-runs the data movement routines to load actual data from FDM into the
Super Administrator's shared database.
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« The Super Administrator may perform additional work using the Budgeting &
Planning application

« The Super Administrator and sub-administrators re-distribute the new data and
any new structures down the OFA tiered user hierarchy.

Distributing Database Objects

The initial distribution distributes all of the Express objects and metadata down the
OFA user hierarchy. Subsequent distributions are done to distribute new dimension
values or attribute values not previously distributed.

During database object distributions, for most of the Budgeting & Planning
dimensions, you can choose to distribute all dimension values to the subordinate
shared database(s). However, for some dimensions, particularly the Organizational
Unit dimension, you should select only the dimension values that pertain to that
sub-administrator or end user.

For the Web-enabled version, data distributions are not required for end users who
use only the Budgeting & Planning Java interface. You must distribute data to the
Super Administrator’s shared database for any external users who report directly to
the Super Administrator. The Super Administrator also distributes data to any
sub-administrator’s personal database. Like the Super Administrator, the
sub-administrator must also distribute data to their shared database for any
external users who report to them. In addition, sub-administrators must also
distribute data to any sub-administrators and so forth.

If the Super Administrator or sub-administrators have any budget workstations
who will be using only the OFA client/server interface, as opposed to OFA Web
Client interface, data and structure must be distributed to them as well.

Distributing Data

Data distributions involve only data values of OFA Financial Data Items (variables
in Express). Data should be re-distributed as necessary each time the super shared
database is updated. This is done by either running data movement routines or
creating/updating any other data at the top level.

For OFA client/server users (as opposed to OFA Web Client users), data is received
into the subordinate shared or personal databases during the database "refresh"
process. This process can be set to happen automatically when an end user logs into
OFA.
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All distributions are performed using the standard OFA distribution functionality.
For more specific information regarding data distribution and data submission,
refer to the Oracle Financial Analyzer User’s Guide.

Budgeting & Planning Custom Distributions

In addition to the distributions previously discussed, two custom distributions are
needed for Budgeting & Planning-specific objects and data.

The first custom distribution distributes objects in the Budgeting & Planning data
model that exist as Express objects but that are not registered with OFA.

The second custom distribution is a 'shortcut’ for distributing data contained in all
of the Budgeting & Planning planning items that you distribute to and are used at
the sub-administrator level but are not re-submitted to the super shared database.
These variables are referred to as 'one-way data.’

Both of these custom distributions are performed by distributing a "dummy"
dimension using the OFA Distribute Structure function. When the administrator
distributes either of the two dummy dimensions, a set of custom programs that
mimic the OFA distribution functions are triggered. These custom programs copy
certain objects, not easily distributed by the standard OFA distribution method,
from the source database to the target database.

Distributing the Non-OFA Budgeting & Planning Database Objects

From the Manage menu in OFA select Distribution -> Distribute Structure to open
the Distribute Structure interface. On the left side of the interface appears a list of all
the distributable objects in the current database. One of those objects is the
Non-OFA BP Database Objects '"dummy’ dimension.

To initiate the custom distribution, select this dimension and move it to the list box
on the right, using the arrow button, then double-click on the name. The Selector
appears, displaying a single dimension value for distribution. Select this value
again and move it to the list box on the right using the arrow button. Choose OK.
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Distributing this dimension with it’s single dimension value causes the following
Budgeting & Planning objects to be distributed:

. FS.TP_ACC_METH « FS.MIX_DATA
. FSHIST_PDS . FS.IR_ACCESS
» FSFCST_PDS . FS.MD_ACCESS

. FS.Culo

. FS.CUJO.DECIMALL - FS.MD_VAR_SOURCE
. FS.CUJO.DECIMAL2 =« FS.FDI_ENTRY

« FS.CUJO.SPRD_DT . FS.FDI_PROP

« FS.CUJO.SPRD_MTH
« FS.CUJO.DELETE

. FS.FDI_CATALOG
. FS.TIME_MONTH_NUM

. FS.WKSHT_CATALOG

. FSCP_ACCESS . FSTIME_YEAR

. FS.FD_ACCESS « FS.DAYS_MON_YTD

. FSFD_DATA . FSFFIN_DATA YTD

- FS.ME_STATUS . FS.YTD_DAY_F140

Actions Requiring the Distribution of This Dimension Whenever you take the following
actions you must distribute/re-distribute this dimension:

Action Description

Initial database object distribution Distribute this dimension to the Super shared
database and to each sub-administrator and end

user.
Changing the value in any of the _ o
scalar variables listed in this table: ~ Scalar Variable Description
FS.TP_ACC_METH Transfer Pricing Accrual
Method
FS.HIST_PDS Number of Historical
Periods
FS.FCST_PDS Number of Forecast
Periods
Adding users Distribute as the initial distribution
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Action Description
Changing entries in the FDI Distribute as the initial distribution.
Catalog

For additional information on the FDI Catalog, see
Chapter 5, "Administering Planning Item Access
and Programs".

One-Way Custom Data Distribution

From the Manage menu in OFA select Distribution -> Distribute Structure to open
the Distribute Structure interface. On the left side of the interface appears a list of all
the distributable objects in the current database. One of those objects is the One-way
Custom Data Distribution '"dummy’ dimension.

To initiate the custom distribution, select the One-way Custom Data Distribution
object and move it to the list box on the right using the arrow button, then double
click on the name. The Selector appears displaying a single dimension value for
distribution. Select this value again and move it to the list box on right using the
arrow button. Choose OK.

Distributing this object with its single value distributes data for all of the variables
in the Budgeting & Planning application except FS.MIX_OVERRIDE, FS.FIN_
DATA, and FS.CAPITAL_PLANS.

Note: Even though this custom distribution uses OFA’s Distribute
Structure function the program is actually mimicking the OFA
Distribute Data functionality. Therefore, it is important that the
destination objects and dimension values already exist in the target
database.

When the custom distribution is initiated, it exports all the data for each variable in
the custom distribution. Each time the data for a variable is imported into a
subordinate shared database during the refresh step, only the slices matching
existing dimension values in that database are imported.

You can distribute any Budgeting & Planning variables using OFA’s data
distribution functionality. However, by default, only FS.FIN_DATA, FS.MIX_
OVERRIDE and FS.FEE_INCOME appear in the OFA data distribution interface.
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To distribute other variables, follow these steps:

1. Exit the Distribute Structure interface if it is open.
2. Select Maintain -> Financial Data Item.

3. Select the planning item you want to distribute.
4. Choose the Enable Distribution option.

Now the variable appears in the data distribution interface and is available for
distribution.
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Administering Reports

The Budgeting & Planning data model and programs included in this release have
been designed to support the quick and efficient generation of reports normally
required to review budget and forecast data as part of your organization’s planning
process.

Effective with the release of the Web-enabled version of Budgeting & Planning,
users can now access reports that have been defined in Oracle Financial Analyzer
(OFA) directly from the Budgeting & Planning interface. Web users who have
received report access through the OFA distribution functionality can open a list of
available reports from within the main Budgeting & Planning interface, select the
desired report(s) and produce those reports for both viewing and printing.

This release also includes additional, seeded standard reports created specifically
for use with the Web-enabled version of the application.

This chapter is intended for administrators who may be responsible for
administering seeded and user-defined reports for Budgeting & Planning. For
information on how to produce reports from the interface see Chapter 15,
"Generating Reports".

This chapter presents the following topics:

« Reporting Features

« Reporting Elements

« Report Totals and Sub-totals

= Seeded Reports

= Reporting Dimensions, Dimension Values, and Attribute
« Income Statement Report Formulas

« Detailed Reporting Formulas
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Reporting Features

This version of Budgeting & Planning includes the following features:

Budgeting & Planning generates and writes most of the financial elements
required for standard reporting needs directly to the Financial Plans planning
item in the Express database.

Aggregation of data values is routinely performed by the application to
generate and write totals and sub-totals to the database for reporting access at
summary organizational, product, and time levels.

A set of standard reports have been provided, addressing typical business
requirements, for business unit managers and supervisors to use in reviewing
financial results in a forecasting or budgeting exercise.

Reports that were seeded for use with the OFA client/server software have
been expanded to include comparable balance sheet, income statement, and rate
reports that can now be accessed over the Web using Budgeting & Planning.

A pre-defined set of formulas have been developed for use in creating trend
and comparative income statement reports.

Effective in this release, two new dimensions and one new attribute have been
added to the Budgeting & Planning data model to support production of
income statement reports over the Web.

When users launch reports from within the application, the OFA Web Client
application is also launched. OFA Web Client is used to produce the reports by
accessing data from the same session being accessed by Budgeting & Planning.

You can have multiple reports open at the same time. When you open multiple
reports, each is opened in its own browser window. These reports can be
printed directly from the browser.

Reporting Elements

Typical financial statement requirements include both trend reports delineating
budget or forecast values over time and comparative reports that compare quarterly
or annual amounts from one period to another.
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These reports would normally cover the following financial data elements:

Average Balance Sheet

Ending Balance Sheet

Average Rates

Average Transfer Rates

Transfer Pricing Spreads - Dollars

Average Transfer Pricing Spreads - Percentages
Transfer Pricing Spread Based Income Statement

Interest Income/Expense Based Income Statement

The application generates and writes most of the financial elements required for
standard reporting needs directly to the Financial Plans planning item in the
Express database. This approach avoids the need for calculating items such as
average rates or transfer rates through the use of formulas by storing those items in
the database and making them directly available for access by reports.

The data model is seeded with the following financial elements that are populated
with the results of running the interface:

Financial Element Value Description

F100 Ending Balance

F140 Average Balance

F160 Average Net Rate

F170 Average Transfer Rate

F455 Non Interest Income

F457 Non Interest Expense

N451 TP Spread Income

N171 Average Spread

A420 Annualized Interest

A450 Annualized Charge/Credit

Administering Reports  4-3



Report Totals and Sub-totals

Report Totals and Sub-totals

The application includes routines developed to solve or aggregate data in the
Financial Plans planning item along organizational, chart of accounts, time, and any
other user-defined hierarchies. When the Calculate With Partial Solve or Calculate
With Full Solve options are processed in the Java interface, or when the
FS.PARTIALROLLUP program is run from the Express command line, the
aggregation of leaf-level data is performed. This generates aggregated values for
parents and nodes along the hierarchies. This means that sub-total rows on a
product hierarchy for items such as total loans, total investments or total assets are
calculated and written back to the database at the last descendent organizational
unit level.

Consolidations up the organizational hierarchy are also performed and values for
the quarter and year time buckets are calculated and written back to the database as
well.

All of these nodes, or parent data values, are available for access in seeded reports
and reports you create in OFA. For example, if you produce a balance sheet report
with product average balances you no not need to create a formula to sum values
within the product hierarchy.

After solving or aggregating your data, you can select 'Total Assets’ using the
Selector to create the Total Asset value in the report. By selecting quarter or year
values for the Time dimension you can display quarterly or annual totals in your
report. Selecting "Total Company’ on the Organizational hierarchy paging
dimension accesses aggregate values for that parent node.

See Chapter 12, "Using the Selector" for additional information on using this tool to
select data from the database.

Seeded Reports

The Budgeting & Planning application provides a series of seeded starter reports to
help administrators prepare reports that can be distributed to end users.

This section provides the following information on seeded reports:

« Seeded Data and Dimension Value Selections Used in Generating Reports
« Prerequisites to Producing Reports

= Notes on Calculated Rows and Columns in OFA Reports

« Customizing Seeded Reports
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« Basic Report Formats

« List of Seeded Reports

Seeded Data and Dimension Value Selections Used in Generating Reports

The application does not seed values for the Time, Organizational Unit, and Chart
of Accounts dimensions because each organization defines and implements
different values for these dimensions.

The application does seed various attributes for the Chart of Accounts dimension
that reflect processing parameters such as Account Type and Balance Sheet Model.
To bypass the issue of not having seeded values for the Chart of Accounts
dimension, the reports have been designed with seeded selections of Chart of
Accounts dimension values based on their assigned Account Type and Balance
Sheet Model. Once you define the attributes, the reports can successfully select the
appropriate dimension values.

Making selections based on attributes is performed using the Tools components in
the application’s Selector dialog. Other Selector features are used in seeding
dimension value selections for dimensions other than Chart of Accounts.

The following table provides information on seeded dimension value and formula
selections that are used in the seeded standard reports provided with the

application:

Dimension Selected Values

Organizational Unit All organizational unit dimension values
Forecast Base Forecast dimension value

Strategy Momentum (or base strategy) dimension value
Currency Base Currency dimension value
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Dimension

Selected Values

Chart of Accounts

Reports that include all balance sheet line items use seeded
selections based on account type values contained in the
COA Account Type attribute. Accounts with the following
account types are selected:

Asset, Liability, or Equity

Reports on new volume originations use seeded selections
based on balance sheet model values contained in the COA
Balance Sheet Model attribute. Accounts with the following
balance sheet models are selected:

Bullet Fixed, Amortizing Fixed, Amortizing Reprice, or
Rollovers

Detailed income statement reports select all Chart of
Accounts dimension values, and both summary and
detailed income statement reports use some combination of
seeded reporting formulas, dimensions, and dimension
values provided with the application.

See the Reporting Dimensions, Dimension Values and
Attributes and Income Statement Report Formulas sections
of this chapter for more information.

In order to take advantage of these seeded selections and open them in the
application you must complete the tasks outlined in the following section.

Prerequisites to Producing Reports
The following implementation tasks must be performed before you can run, format,

or copy the seeded reports.

« Create at least two years of Time dimension values. You must use the Maintain
Time function in OFA to complete this task. The as-of-date must be defined for
the FCST Data As Of Date attribute, and must reflect a monthly time bucket
that falls in the second year of Time dimension values in order to open and
process the comparative reports.

« Create and/or load your Organizational Unit and Chart of Accounts dimension

values and hierarchies.

« Setthe COA Account Type and COA Balance Sheet Model attributes for all
appropriate Chart of Accounts values. You must use OFA to complete this task.
The COA Account Type attribute must be defined for node-level dimension

4-6 Oracle Budgeting & Planning Reference Guide



Seeded Reports

values as well as leaf-level dimension values. The COA Balance Sheet Model
attribute only needs to be defined for leaf-level dimension values.

« Populate the RPL Chart of Accounts attribute with Chart of Accounts values
representing:

« Total Assets

« Total Liabilities and Capital

= Total Non-interest Income

« Total Non-interest Expense

« Loan Loss Provision Expense

« Load historical, actual data values into the Express database. Solve the database
to perform consolidations for the Time, Organizational Unit, and Chart of
Accounts hierarchy node values.

The seeded reports, by default, suppress rows with zero or NA values, therefore
you must complete this task so that rows are visible when you open the report.
If historical data has not been loaded or solved either the report rows will not
appear or certain rows will seem to be missing from the report.

« To view reports provided for viewing over the Web, you must first distribute
the appropriate reports to the shared database and to External Users using the
OFA distribute structure dialog.

Note: To preview a report format without loading data, turn off
the zero or NA row suppression. This is done in the Report option
dialog box, from the Tools menu.

Notes on Calculated Rows and Columns in OFA Reports

Both seeded and user-defined reports created using OFA client/server software that
make use of inserted rows and/or columns with formula calculations and row or
column label overrides cannot be successfully opened intact using the OFA Web
Client software. The inserted rows and columns, as well as any label overrides, will
not be displayed when users open the reports in Budgeting & Planning or OFA Web
Client.

The Comparative and Income Statement reports that were seeded in the previous
release of Budgeting & Planning employed the OFA client/server feature of
inserting rows and columns. Since the OFA Web Client does not support inserted
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rows and columns, additional reports have been included in this release to provide
comparable information for viewing over the Web. The new Web reports were
created using a different definition approach. These reports are identified in the list
of seeded reports later in this chapter with report names that start with either
WebComp or Web Periodic.

The original reports have been retained and can still be used in the client/server
version of OFA if desired.

Displaying the Year Total Column in the Web-Enabled Version

Additionally, a certain technique employed in the previous release for seeding a
selection for the Year Total time bucket on periodic reports does not successfully
display the column in the reports when viewed over the Web after launching them
from within Budgeting & Planning. In their original form, the reports display the
Year total column when opened using the OFA client/server version, but do not
display it when opened over the Web.

To revise the Time selection open the seeded report in the OFA client/server
version, performing a File -> Save As operation, and adding the YearXX dimension
value to the list of selected values from the list of available Time dimension values
in the Selector.

After making the changes, distribute the modified reports to the shared database
and External Users for viewing from within Budgeting & Planning.

Using the Drill Down Feature for Reports
To use the reporting drill down feature open a seeded report and follow these steps:

1. Open the Selector and choose the dimension you want to use with the drill
down feature.

For most reports, this is the Chart of Accounts dimension.
2. From the Organize By: list box select the Chart of Accounts hierarchy option.

3. Inthe Selected box keep the node(s) or parent values that you want to display
in the report.

4. Close the Selector.
5. From the Report menu select Drill to invoke the drill down feature.

For additional information see Chapter 12, "Using the Selector".
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Customizing Seeded Reports

You can re-format and customize seeded reports if necessary, or duplicate them for
subsequent years. With the seeded report open, perform a File -> Save As operation
to save the report to a new report name and make your modifications in the new
report. This will retain the original reports in their seeded form in case you need to
go back to them later.

You can make changes such as adjusting column widths, adding sub-titles and
footers, or adding additional rows or columns to the reports if desired. For example,
the Income Statement reports provided for viewing in the OFA client/server
version require that additional rows with formulas be inserted so that you can
calculate line items such as net interest income, total spread income, income taxes,
and net income.

For additional instructions on making changes to these reports, refer to the Oracle
Financial Analyzer User’s Guide.

Basic Report Formats
Each report incorporates one of the following formatting types:

Report Format Explanation

12-Month Trend Report  The first twelve, monthly time bucket values and the
with Year Total (BP/OFA corresponding Year Time bucket are returned based on the
Web Client version and  seeded Time dimension selection.

OFA client/server See "Notes on Calculated Rows and Columns in OFA Reports" in

version) this chapter for information on viewing the Year column over
the Web.

Comparative Report Compares the first two Year Time bucket values using a seeded

(OFA client/server dollar variance column and a seeded percent variance column.

version) See "Notes on Calculated Rows and Columns in OFA Reports” in
this chapter for comments on viewing the Year column over the
Web.

Comparative Report Compares the Current Year and Last Year Time bucket values

(BP/OFA Web Client using seeded formulas for all columns. Current Year is

version and client/server determined using the Forecast as-of-date. Year values are

version) returned and adjusted automatically as the Forecast as-of-date is

moved forward across a year-end into a new year.
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List of Seeded Reports

The following tables lists the seeded reports included in this release. The first table
reflects the reports seeded in the earlier version of Budgeting & Planning for use
with OFA client/server software, and includes the variables and financial elements
supporting each report. The Across, Down, and Paging dimensions indicate the
placement of these dimensions in the report itself. The Periodic reports can also be
viewed when launched from within the Web-enabled Budgeting & Planning
application, but some modification is required to successfully view the Year
columns. See "Displaying the Year Total Column in the Web-Enabled Version" in
this chapter for detailed information on displaying Year columns.

Seeded Reports From the Client/Server Version

The following table lists the seeded reports provided for the client/server version of
Budgeting & Planning. Shaded reports have comparable versions in the
Web-enabled release of the application. Refer to "Seeded Reports for the
Web-Enabled Version" in this chapter for a list of those comparable reports.

Variable Object Financial Across

Report Name Name Element Dimension Down Dimension Paging Dimension(s)

Periodic Average FS.FIN_DATA F140 Time Chart of Accounts  Currency,

Balance Sheet Organizational Unit,
Forecast, Financial
Element, Strategy

Periodic Ending FS.FIN_DATA F100 Time Chart of Accounts  Currency,

Balance Sheet Organizational Unit,
Forecast, Financial
Element, Strategy

Periodic Interest FS.FIN_DATA F160 Time Chart of Accounts  Currency,

Rates Organizational Unit,
Forecast, Financial
Element, Strategy

Periodic Transfer FS.FIN_DATA N171 Time Chart of Accounts  Currency,

Pricing Organizational Unit,

Percentage Forecast, Financial

Spreads Element, Strategy

Periodic Margin  FS.FIN_DATA F160, Time Chart of Accounts, Currency,

Analysis F170, Financial Element  Organizational Unit,

N171 Forecast, Strategy
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Report Name

Variable Object
Name

Financial Across
Element

Dimension Down Dimension

Paging Dimension(s)

Comparative FS.FIN_DATA F140 Time Chart of Accounts  Currency,

Average Balance Organizational Unit,

Sheet Forecast, Financial
Element, Strategy

Comparative FS.FIN_DATA F100 Time Chart of Accounts  Currency,

Ending Balance Organizational Unit,

Sheet Forecast, Financial
Element, Strategy

Comparative FS.FIN_DATA F160 Time Chart of Accounts  Currency,

Interest Rates Organizational Unit,
Forecast, Financial
Element, Strategy

Comparative FS.FIN_DATA N171 Time Chart of Accounts  Currency,

Transfer Pricing Organizational Unit,

Percentage Forecast, Financial

Spreads Element, Strategy

Comparative FS.FIN_DATA F160, Time Chart of Accounts, Currency,

Margin Analysis F170, Financial Element  Organizational Unit,

N171 Forecast, Strategy

Originations by  FS.FIN_DATA F340 Time Chart of Accounts  Currency,

Account Organizational Unit,
Forecast, Financial
Element, Strategy

Origination FS.FIN_DATA F375 Time Chart of Accounts  Currency,

Spreads by Organizational Unit,

Account Forecast, Financial
Element, Strategy

Origination FS.FIN_DATA F375 Time Organizational Currency, Chart of

Spreads by Org Unit Accounts, Forecast,

Unit Financial Element,
Strategy

Periodic Income FS.REG_INC_STMT NA Time Chart of Accounts  Currency,

Statement Organizational Unit,
Forecast, Strategy

Periodic Transfer FS.INC_STMT NA Time Chart of Accounts  Currency,

Pricing Spread
Income
Statement

Organizational Unit,
Forecast, Strategy
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Variable Object

Financial Across

Report Name Name Element Dimension Down Dimension Paging Dimension(s)
Comparative FS.REG_INC_STMT NA Time Chart of Accounts  Currency,

Income Organizational Unit,
Statement Forecast, Strategy
Comparative FS.INC_STMT NA Time Chart of Accounts  Currency,

Transfer Pricing
Spread Income
Statement

Organizational Unit,
Forecast, Strategy

Seeded Reports for the Web-Enabled Version

The following table lists the seeded reports included with this release for the
Web-enabled version of Budgeting & Planning. These reports can be produced
either when launched from within Budgeting & Planning or from within the
client/server version of OFA.

Financial Across

Paging

Report Name Formulas Used Element Dimension Down Dimension Dimension(s)
WebComp « FinData Current Year F140 FinData Chart of Accounts  Currency,
Average Balance . Formulas Organizational
Sheet FinData Last Year 4) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp « FinData Current Year F100 FinData Chart of Accounts  Currency,
Ending Balance . Formulas Organizational
Sheet FinData Last Year 4) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp « FinData Current Year F160 FinData Chart of Accounts  Currency,
Interest Rates . Formulas Organizational
FinData Last Year @) Unit, Forecast,

. Current Year Variance

. Current Year Percent
Variance

Strategy
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Report Name

Formulas Used

Financial Across
Element

Dimension Down Dimension

Paging
Dimension(s)

WebComp TP FinData Current Year N171 FinData Chart of Accounts  Currency,
Percentage - Formulas Organizational
Spreads FinData Last Year 4) Unit, Forecast,
Current Year Variance Strategy
Current Year Percent
Variance
WebComp FinData Current Year F160, FinData Chart of Accounts  Currency,
Margin Analysis . F170, Formulas Organizational
FinData Last Year N171 4) Unit, Forecast,
Current Year Variance Strategy
Current Year Percent
Variance
WebComp Comp Income Stmt NA FinData Income Statement  Currency,
Income Current Year Formulas Organizational
Statement Comp Income Stmt (4) ;Jt?;ttéForecast,
Last Year 9y
Comp Income Stmt
Variance
Comp Income Stmt
Percent Variance
(Embedded formulas)
WebComp TP Comp Income Stmt NA FinData Income Statement  Currency,
Spread Income Current Year Formulas Organizational
Statement 4 Unit, Forecast,

Comp Income Stmt
Last Year

Comp Income Stmt
Variance

Comp Income Stmt
Percent Variance

(Embedded formulas)

Strategy
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Financial Across Paging

Report Name Formulas Used Element Dimension Down Dimension Dimension(s)
Web Periodic « Interest Income NA Time FinData Formulas  Currency,
Income Interest Expense 9) Organizational
Statement - P Unit, Forecast,

«  Net Interest Income Strategy

. Loan Loss Provision

«  Non Interest Income

. Non Interest Expense

«  Income Before Taxes

. Income Tax

« NetlIncome

«  (Embedded formulas)
Web Periodic TP« Asset Spread Income  NA Time FinData Formulas ~ Currency,

Spread Income
Statement

Organizational
Unit, Forecast,
Strategy

Liability & Capital ©)
Spread Income

« Total Spread Income
« Loan Loss Provision
« Non Interest Income
. Non Interest Expense

. Net Income Before
Taxes (TP)

« Income Tax (TP)
=« NetIncome (TP)
« (Embedded formulas)

Reporting Dimensions, Dimension Values, and Attribute

This release of Budgeting & Planning includes a new, seeded attribute and seeded
dimensions and dimension values, to support the Web-enabled production of
seeded income statement reports.
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Dimensions and Dimension Values

The application includes the following two dimensions and associated dimension
values:

Report Line Item Dimension

Description Object Name
Dimension Report Line Item FS.REPORT_LINE
Dimension Values  Total Assets COA Value TOTAL_ASSETS_COA

Total Liabilities and Capital COA Value TOTAL_LIAB COA
Total Non Interest Income COA Value TOTAL_NIR_COA

Total Non Interest Expense COA Value TOTAL_NIE _COA

Loan Loss Provision COA Value LOAN_LOSS_PRO_COA

Income Statement Dimension

Description Object Name
Dimension Income Statement FS.INCOME_STMT
Dimension Values Interest Income INTINCOME
Interest Expense INTEXPENSE
Loan Loss Provision LLPROVISION
Net Interest Income NETINTINC
Non Interest Income NONINTREV
Non Interest Expense NONINTEXP
Income Before Taxes INCBTAX
Income Taxes INCTAX
Net Income NETINC
Asset Spread Income ASSETSPRD
Liability & Capital Spread Income LIABCAPSPRD
Total Spread Income TOTSPRDINC
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Description Object Name
Income Before Taxes (TP) INCBTAXTP
Income Taxes (TP) INCTAXTP
Net Income (TP) NETINCTP
Attribute
Attribute Description

RPL Chart of Accounts The RPL Chart of Accounts attribute identifies the appropriate
node-level dimension values from the Chart of Accounts
dimension to reference or access data for the reporting line item
in the income statement reports.

Note: This attribute must be populated in order to produce the
following seeded reports:

= WebComp Income Statement
«  WebComp Transfer Pricing Spread Income Statement
«  Web Periodic Income Statement

=« Web Periodic Transfer Pricing Spread Income Statement

Income Statement Report Formulas

This release of the Budgeting & Planning application includes pre-defined formulas
that are used in the production of comparative and income statement reports as
reflected in the List of Seeded Reports tables earlier in this chapter. These are
formula variables, meaning the formulas created to calculate data needed in the
reports are stored in the database and calculations are performed 'on the fly’ when a
report is opened up with the formula variable selected.

What is unique about income statements, whether based on transfer pricing spread
income or the more traditional interest income minus interest expense view of net
interest margin is that data residing in multiple financial elements are required to
complete an income statement. Additionally, a spread-based income statement
requires the calculation of transfer pricing spread income, where the formula for
that calculation is different for an asset than for a liability.
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The Budgeting & Planning application includes seeded formulas to generate

variables for both views of the income statement.

The following formulas are included as seeded selections in the seeded reports:

Descriptions and Row Labels

Column Label

Object Name

Interest Income

Interest Expense

Loan Loss Provision

Net Interest Income

Non Interest Income

Non Interest Expense

Income Before Taxes

Income Tax

Net Income

Asset Spread Income
Liability & Capital Spread Income
Total Spread Income

Net Income Before Taxes (TP)
Income Tax (TP)

Net Income (TP)

Regular Income Statement
Spread Income Statement
FinData Current Year
FinData Last Year

Current Year Variance

Current Year Percent Variance

INT INC

INT EXP

LLP

NIl

NIR

NIE

IBT

Taxes

Net Inc

Asst Spread
Liab/Cap Spread
Spread Inc

IBT (TP)

Taxes (TP)

Net Inc (TP)
NA

NA

FinData CurYr
FinData LstYr
CurYr Variance

CurYr % Variance

FS.INT_INC
FS.INT_EXP
FS.LOAN_LOSS_PRO
FS.NET_INT_INC
FS.NONINT_INC
FS.NONINT_EXP
FS.NET_INC_BT
FS.INC_TAX
FS.NET_INC
FS.ASST SPD_INC
FS.LIAB_SPD_INC
FS.SPD_INC
FS.SPDNET_INC_BT
FS.SPD_INC_TAX
FS.SPD_NET_INC
FS.REG_INC_STMT
FS.INC_STMT
FS.CY_FIN_DATA
FS.LY_FIN_DATA
FS.CY_VARIANCE
FS.CY_VARPCT
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The following formulas are also seeded in the database. Most of the formulas above
include embedded references to these formulas:

Descriptions and Row Labels Column Label Object Name
Current Year Current Year FS.CURRENT_YEAR
Last Year Last Year FS.LAST_YEAR

The following section lists the detailed formula equations for all of the above
formulas.

Detailed Reporting Formulas

Object Name

Formula

FS.INT_INC
FS.INT_EXP

fs.reg_inc_stmt(fs.chrt_of_acct FS.COA.REP_LINE (fs.report_line TOTAL_ASSETS_COA"))
fs.reg_inc_stmt(fs.chrt_of _acct FS.COA.REP_LINE (fs.report_line 'TOTAL_LIAB_COA"))

FS.LOAN_LOSS PRO fs.reg_inc_stmt(fs.chrt_of acct FS.COA.REP_LINE (fs.report_line ’'LOAN_LOSS PRO_COAY))

FS.NET_INT_INC
FS.NONINT_INC
FS.NONINT_EXP
FS.NET_INC_BT

FS.INC_TAX
FS.NET_INC

FS.ASST_SPD_INC
FS.LIAB_SPD_INC

FS.SPD_INC

fs.int_inc-fs.int_exp

fs.reg_inc_stmt(fs.chrt_of_acct FS.COA.REP_LINE (fs.report_line TOTAL_NIR_COA"))
fs.reg_inc_stmt(fs.chrt_of _acct FS.COA.REP_LINE (fs.report_line ' TOTAL_NIE_COA))
fs.net_int_inc-fs.loan_loss_pro+fs.non_int_inc-fs.non_int_exp

fs.net_inc_bt*0.34

fs.net_inc_bt-fs.inc_tax

fs.inc_stmt(fs.chrt_of acct FS.COA.REP_LINE (fs.report_line TOTAL_ASSETS_COA"))
fs.inc_stmt(fs.chrt_of _acct FS.COA.REP_LINE (fs.report_line TOTAL_LIAB_COAY)

fs.asst_spd_inc+fs.liab_spd_inc

FS.SPDNET_INC_BT fs.spd_inc+fs.non_int_inc-fs.non_int_exp

FS.SPD_INC_TAX
FS.SPD_NET_INC

fs.spdnet_inc_bt*0.34

fs.spdnet_inc_bt-fs.inc_tax
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Formula: FS.REG_INC_STMT
IF FS.COA.ACCT_TYPE EQ "ASSET’ -
THEN-

(FS.FIN_DATA(FS.FIN_ELEMF420’)+(FS.FIN_DATA(FS.FIN_ELEM ’F900’))+ -
(FS.FIN_DATA(FS.FIN_ELEM F910"))+(FS.FIN_DATA(FS.FIN_ELEM F920")) -

ELSE -

IF FS.COA.ACCT_TYPE EQ 'LIABILITY’ -

THEN ((FS.FIN_DATA(FS.FIN_ELEM 'F420")+FS.FIN_DATA(FS.FIN_ELEM °F920"))) -
ELSE -

IF FS.COA.ACCT_TYPE EQ 'DIR.NON.INT.INC’ -

THEN FS.FIN_DATA(FS.FIN_ELEM 'F455’) -

ELSE -

IF FS.COA.ACCT_TYPE EQ 'DIR.NON.INT.EXP’ -

THEN FS.FIN_DATA(FS.FIN_ELEM 'F457’) -

ELSE NA

Note the following:

« Asthe above formula is dependent upon an account being designated as
ASSET, LIABILITY, EQUITY, DIR.NON.INT.INC or DIR.NON.INT.EXP, the
attribute COA Account Type must be defined in the Maintain -> Attribute
interface in OFA before including the variables in a report.

« Ifyou are using the Allocated Non Interest Income and/or Allocated Non
Interest Expense account types, the above formula will need to be modified to
add those account types. Use OFA for this purpose if necessary.
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Formula: FS.INC_STMT
IF FS.COA.ACCT_TYPE EQ "ASSET’ -
THEN-

(FS.FIN_DATA(FS.FIN_ELEM’F420")+(FS.FIN_DATA(FS.FIN_ELEM ’F900"))+ -
(FS.FIN_DATA(FS.FIN_ELEM’F910")+(FS.FIN_DATA(FS.FIN_ELEM’F920%))- -
(FS.FIN_DATA(FS.FIN_ELEM ’F450°))-

ELSE-
IF FS.COA.ACCT_TYPE EQ 'LIABILITY"-
THEN-

(FS.FIN_DATA(FS.FIN_ELEMF450")-(FS.FIN_DATA(FS.FIN_ELEM 'F420")+FS.FIN_DATA(FS.FIN_
ELEM ’F920%)))-

ELSE-

IF FS.COA.ACCT_TYPE EQ EQUITY*-

THEN FS.FIN_DATA(FS.FIN_ELEM ’F450")-
ELSE-

IF FS.COA.ACCT_TYPE EQ 'DIR.NON.INT.INC*-
THEN FS.FIN_DATA(FS.FIN_ELEM ’F455)-
ELSE -

IF FS.COA.ACCT_TYPE EQ 'DIR.NON.INT.EXP"-
THEN FS.FIN_DATA(FS.FIN_ELEM ’F457")-
ELSE NA

Note the following:

= Asthe above formula is dependent upon an account being designated as
ASSET, LIABILITY, EQUITY, DIR.NON.INT.INC or DIR.NON.INT.EXP, the
attribute COA Account Type must be defined in the Maintain -> Attribute
interface in OFA before including the variables in a report.

« If you are using the Allocated Non Interest Income and/or Allocated Non
Interest Expense account types, the above formula will need to be modified to
add those account types. Use OFA for this purpose if necessary.

4-20 Oracle Budgeting & Planning Reference Guide



Income Statement Report Formulas

Formula: FSWCIS_LY

IF FS.INCOME_STMT EQ INTINCOME’ THEN FS.INT_INC (TIME FS.LAST_YEAR) ELSE -
IF FS.INCOME_STMT EQ INTEXPENSE’ THEN FS.INT_EXP (TIME FS.LAST_YEAR) ELSE -
IF FS.INCOME_STMT EQ 'NETINTINC’ THEN FS.NET_INT_INC (TIME FS.LAST_YEAR) -
ELSE IF FS.INCOME_STMT EQ 'LLPROVISION’ THEN FS.LOAN_LOSS_PRO (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NONINTREV’ THEN FS.NONINT_INC (-
TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NONINTEXP’ THEN -
FS.NONINT_EXP (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCBTAX’ THEN -
FS.NET_INC_BT (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCTAX’ THEN -
FS.INC_TAX (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NETINC’ THEN -
FS.NET_INC (TIME FS.LAST_YEAR) ELSE NA

Formula: FS.WCIS_VAR

IF FS.INCOME_STMT EQ INTINCOME’ THEN FS.INT_INC (TIME FS.CURRENT_YEAR) - -
FS.INT_INC (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INTEXPENSE’ THEN -
FS.INT_EXP (TIME FS.CURRENT_YEAR) - FS.INT_EXP (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'NETINTINC’ THEN FS.NET_INT_INC (TIME FS.CURRENT_YEAR) - -
FS.NET_INT_INC (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'LLPROVISION’ -
THEN FS.LOAN_LOSS_PRO (TIME FS.CURRENT_YEAR) - FS.LOAN_LOSS_PRO (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NONINTREV’ THEN FS.NONINT_INC (-
TIME FS.CURRENT_YEAR) - FS.NONINT_INC (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'NONINTEXP’ THEN FS.NONINT_EXP (TIME FS.CURRENT_YEAR) - -
FS.NONINT_EXP (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCBTAX’ THEN -
FS.NET_INC_BT (TIME FS.CURRENT_YEAR) - FS.NET_INC_BT (TIME FS.LAST_YEAR) -
ELSE IF FS.INCOME_STMT EQ INCTAX’ THEN FS.INC_TAX (TIME FS.CURRENT_YEAR) -

- FS.INC_TAX (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NETINC’ THEN -
FS.NET_INC (TIME FS.CURRENT_YEAR) - FS.NET_INC (TIME FS.LAST_YEAR) ELSE NA
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Formula: FS.WCIS_PCTVAR

IF FS.INCOME_STMT EQ INTINCOME’ THEN 100*((FS.INT_INC (TIME -
FS.CURRENT_YEAR) - FS.INT_INC (TIME FS.LAST_YEAR))/ FS.INT_INC (TIME -
FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ INTEXPENSE’ THEN 100*((-

FS.INT_EXP (TIME FS.CURRENT_YEAR) - FS.INT_EXP (TIME FS.LAST_YEAR))/ -
FS.INT_EXP (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ 'NETINTINC’ THEN -
100*((FS.NET_INT_INC (TIME FS.CURRENT_YEAR) - FS.NET_INT_INC (TIME -
FS.LAST_YEAR))/ FS.NET_INT_INC (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT -
EQ 'LLPROVISION’ THEN 100*((FS.LOAN_LOSS_PRO (TIME FS.CURRENT_YEAR) - -
FS.LOAN_LOSS_PRO (TIME FS.LAST_YEAR))/ FS.LOAN_LOSS_PRO (TIME FS.LAST_YEAR-
)) ELSE IF FS.INCOME_STMT EQ 'NONINTREV’ THEN 100*((FS.NONINT_INC (TIME -
FS.CURRENT_YEAR) - FS.NONINT_INC (TIME FS.LAST_YEAR))/ FS.NONINT_INC (TIME -
FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ 'NONINTEXP’ THEN 100*((-
FS.NONINT_EXP (TIME FS.CURRENT_YEAR) - FS.NONINT_EXP (TIME FS.LAST_YEAR))/ -
FS.NONINT_EXP (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ 'INCBTAX’ -
THEN 100*((FS.NET_INC_BT (TIME FS.CURRENT_YEAR) - FS.NET_INC_BT (TIME -
FS.LAST_YEAR))/ FS.NET_INC_BT (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT -
EQ INCTAX’ THEN 100*((FS.INC_TAX (TIME FS.CURRENT_YEAR) - FS.INC_TAX (-

TIME FS.LAST_YEAR))/ FS.INC_TAX (TIME FS.LAST_YEAR)) ELSE IF -

FS.INCOME_STMT EQ 'NETINC’ THEN 100*((FS.NET_INC (TIME FS.CURRENT_YEAR) - -
FS.NET_INC (TIME FS.LAST_YEAR))/ FS.NET_INC (TIME FS.LAST_YEAR)) ELSE NA

Formula: FSWCISTP_CY

IF FS.INCOME_STMT EQ 'ASSETSPRD’ THEN FS.ASST_SPD_INC (TIME -
FS.CURRENT_YEAR) ELSE IF FS.INCOME_STMT EQ 'LIABCAPSPRD’ THEN -
FS.LIAB_SPD_INC (TIME FS.CURRENT_YEAR) ELSE IF FS.INCOME_STMT EQ -
'TOTSPRDINC’ THEN FS.SPD_INC (TIME FS.CURRENT_YEAR) ELSE IF FS.INCOME_STMT -
EQ LLPROVISION’ THEN FS.LOAN_LOSS PRO (TIME FS.CURRENT_YEAR) ELSE IF -
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Formula: FS.WCISTP_CY

FS.INCOME_STMT EQ 'NONINTREV’ THEN FS.NONINT_INC (TIME FS.CURRENT_YEAR) -
ELSE IF FS.INCOME_STMT EQ 'NONINTEXP’ THEN FS.NONINT_EXP (TIME -
FS.CURRENT_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCBTAXTP’ THEN -
FS.SPDNET_INC_BT (TIME FS.CURRENT_YEAR) ELSE IF FS.INCOME_STMT EQ -
INCTAXTP’ THEN FS.SPD_INC_TAX (TIME FS.CURRENT_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'NETINCTP’ THEN FS.SPD_NET_INC (TIME FS.CURRENT_YEAR) -
ELSE NA

Formula: FS.WCISTP_LY

IF FS.INCOME_STMT EQ "ASSETSPRD’ THEN FS.ASST_SPD_INC (TIME FS.LAST_YEAR) -
ELSE IF FS.INCOME_STMT EQ 'LIABCAPSPRD’ THEN FS.LIAB_SPD_INC (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'TOTSPRDINC’ THEN FS.SPD_INC (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'LLPROVISION’ THEN -
FS.LOAN_LOSS PRO (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'NONINTREV’ -
THEN FS.NONINT_INC (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ -
'NONINTEXP’ THEN FS.NONINT_EXP (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT -
EQ INCBTAXTP’ THEN FS.SPDNET_INC_BT (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'INCTAXTP’ THEN FS.SPD_INC_TAX (TIME FS.LAST_YEAR) ELSE -
IF FS.INCOME_STMT EQ 'NETINCTP’ THEN FS.SPD_NET_INC (TIME FS.LAST_YEAR) -
ELSE NA

Formula: FS.WCISTP_VAR

IF FS.INCOME_STMT EQ 'ASSETSPRD’ THEN FS.ASST_SPD_INC (TIME -
FS.CURRENT_YEAR) - FS.ASST_SPD_INC (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'LIABCAPSPRD’ THEN FS.LIAB_SPD_INC (TIME FS.CURRENT_YEAR-
) - FS.LIAB_SPD_INC (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ -

"TOTSPRDINC’ THEN FS.SPD_INC (TIME FS.CURRENT_YEAR) - FS.SPD_INC (TIME -
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Formula: FS.WCISTP_VAR

FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'LLPROVISION’ THEN -
FS.LOAN_LOSS PRO (TIME FS.CURRENT_YEAR) - FS.LOAN_LOSS PRO (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ '"NONINTREV’ THEN FS.NONINT_INC (-
TIME FS.CURRENT_YEAR) - FS.NONINT_INC (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'NONINTEXP’ THEN FS.NONINT_EXP (TIME FS.CURRENT_YEAR) - -
FS.NONINT_EXP (TIME FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCBTAXTP’ -
THEN FS.SPDNET_INC_BT (TIME FS.CURRENT_YEAR) - FS.SPDNET_INC_BT (TIME -
FS.LAST_YEAR) ELSE IF FS.INCOME_STMT EQ 'INCTAXTP’ THEN FS.SPD_INC_TAX (-
TIME FS.CURRENT_YEAR) - FS.SPD_INC_TAX (TIME FS.LAST_YEAR) ELSE IF -
FS.INCOME_STMT EQ 'NETINCTP’ THEN FS.SPD_NET_INC (TIME FS.CURRENT_YEAR) - -
FS.SPD_NET_INC (TIME FS.LAST_YEAR) ELSE NA
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Formula: FS.WCISTP_PCTVAR

IF FS.INCOME_STMT EQ "ASSETSPRD’ THEN 100*((FS.ASST_SPD_INC (TIME -
FS.CURRENT_YEAR) - FS.ASST_SPD_INC (TIME FS.LAST_YEAR))/ FS.ASST_SPD_INC (-
TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ 'LIABCAPSPRD’ THEN 100*((-
FS.LIAB_SPD_INC (TIME FS.CURRENT_YEAR) - FS.LIAB_SPD_INC (TIME -
FS.LAST_YEAR))/ FS.LIAB_SPD_INC (TIME FS.LAST_YEAR)) ELSE IF -

FS.INCOME_STMT EQ "TOTSPRDINC’ THEN 100*((FS.SPD_INC (TIME FS.CURRENT_YEAR-
) - FS.SPD_INC (TIME FS.LAST_YEAR))/ FS.SPD_INC (TIME FS.LAST_YEAR)) ELSE -

IF FS.INCOME_STMT EQ LLPROVISION’ THEN 100*((FS.LOAN_LOSS_PRO (TIME -
FS.CURRENT_YEAR) - FS.LOAN_LOSS_PRO (TIME FS.LAST_YEAR))/ FS.LOAN_LOSS_PRO -
(TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ '"NONINTREV’ THEN 100%((-
FS.NONINT_INC (TIME FS.CURRENT_YEAR) - FS.NONINT_INC (TIME FS.LAST_YEAR))/-
FS.NONINT_INC (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ "NONINTEXP’ -
THEN 100*((FS.NONINT_EXP (TIME FS.CURRENT_YEAR) - FS.NONINT_EXP (TIME -
FS.LAST_YEAR))/ FS.NONINT_EXP (TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT -
EQ INCBTAXTP’ THEN 100*((FS.SPDNET_INC_BT (TIME FS.CURRENT_YEAR) - -
FS.SPDNET_INC_BT (TIME FS.LAST_YEAR))/ FS.SPDNET_INC_BT (TIME FS.LAST_YEAR-
) ELSE IF FS.INCOME_STMT EQ INCTAXTP’ THEN 100*((FS.SPD_INC_TAX (TIME -
FS.CURRENT_YEAR) - FS.SPD_INC_TAX (TIME FS.LAST_YEAR))/ FS.SPD_INC_TAX (-
TIME FS.LAST_YEAR)) ELSE IF FS.INCOME_STMT EQ 'NETINCTP’ THEN 100*((-
FS.SPD_NET_INC (TIME FS.CURRENT_YEAR) - FS.SPD_NET_INC (TIME FS.LAST_YEAR)-
)/ FS.SPD_NET_INC (TIME FS.LAST_YEAR)) ELSE NA

Formula: DSC FS.WCIS_CY

IF FS.INCOME_STMT EQ INTINCOME'-

THEN FS.INT_INC (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'INTEXPENSE-
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Formula: DSC FS.WCIS_CY

THEN FS.INT_EXP (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'NETINTINC-

THEN FS.NET_INT_INC (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'LLPROVISION-
THEN FS.LOAN_LOSS PRO (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'NONINTREV™-

THEN FS.NONINT_INC (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'NONINTEXP’-

THEN FS.NONINT_EXP (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'INCBTAX’-

THEN FS.NET_INC_BT (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'INCTAX’-

THEN FS.INC_TAX (TIME FS.CURRENT_YEAR)-
ELSE IF FS.INCOME_STMT EQ 'NETINC"-

THEN FS.NET_INC (TIME FS.CURRENT_YEAR)-
ELSE NA
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Administering Planning Item Access and

Programs

Administering planning item access and programs means administrators have the
option of enabling end-user access to certain seeded planning items as well as
user-defined planning items and custom programs created during implementation.

With this functionality, end users can now perform a majority of, if not all, the
budget-related tasks solely through the Budgeting & Planning interface.

This chapter explains how to set up end-user access, presenting the following
topics:

Using a Catalog-Driven Interface Approach

Seeded Catalog Entries

Describing the FS.FDI_CATALOG Database Catalog
Setting Up Planning Item and Custom Program Access

Administering Status For Your Custom Programs

Using a Catalog-Driven Interface Approach

The Java interface has been programmatically modified to read a series of entries or
properties contained in a new database catalog called FS.FDI_CATALOG. These
properties define:

Planning item accessibility from within the Budgeting & Planning application,
whether seeded or user-defined

Default interface dimension and dimension value display
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Seeded Catalog Entries

« Host and dependent planning item relationships
« How to launch custom calculations from common interface icons
« How to access and launch custom programs from the Options menu

A catalog-driven approach enables System Administrators to allow user-level
access to different plan components and custom programs by maintaining a set of
entries in the new catalog.

The new catalog, FS.FDI_CATALOG, is dimensioned by the following:

Dimension Description

FS.FDI_ENTRY This dimension stores the name of the planning items (variables)
you want to be accessible through the interface.

You can view this dimension in Oracle Financial Analyzer (OFA)
as BP FDI Access.

FS.FDI_PROP This dimension stores the properties of each planning item
included in the FS.FDI_ENTRY dimension.

You cannot view this dimension in OFA.

The following section describes seeded entries for FS.FDI_CATALOG.

Seeded Catalog Entries

The application seeds access to four different planning items. These are:

Description Express Object Name
Financial Plans FS.FIN_DATA
Mix Override FS.MIX_OVERRIDE

Capital Expenditures FS.CAP_PLAN_DATA
Interest Rates FS.INTEREST_RATE
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Note: Each of these planning items existed in previous releases
with different descriptions. For this release the descriptions have
been modified to make them more generic, making it easier for
users to interpret what the planning item represents.

About the Capital Expenditures Planning Item

Access to the Capital Expenditures planning item is seeded for this release,
however, this planning item currently has limited functionality.

For this release you can use the planning item to collect inputs of expected asset
purchases at the business unit level and set timing assumptions during the planning
horizon. Programs to convert this information into projected income statement and
balance sheet line items (such as depreciation expense, furniture and equipment
balances) are not provided in this release.

If you choose not to create custom programs for this planning item and you do not
want to collect this type of data use OFA to delete the Capital Expenditures
dimension value from the BP FDI Access dimension.

Seeded FS.FDI_PROP Entries

The following table includes entries that have been seeded in the FS.FDI_
CATALOG for this release. Use this table as a reference point for the detailed
descriptions of FS.FDI_PROP and FS.FDI_ENTRY, which are discussed in the
sections that follow.

Caution: Through FS.FDI_CATALOG you can access and modify
all properties for the seeded planning items. Do not modify the values
for the Financial Plans (FS.FIN_DATA) and Maturity Mix Assumption
(FS.MIX_OVERRIDE) entries. Doing so may result in problems with
the interface or may cause the application to generate inaccurate or
incomplete data, invalidating your budget and forecast data.
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Reference Table for FS.FDI_CATALOG
Note that blank cells in this table represent NA values.

FS.FDI_ENTRY
FS.FDI_PROP FS.FIN_DATA FS.MIX_OVERRIDE FS.CAP_PLAN_DATA FS.INTEREST_RATE
DATA_SRC FS.FD_DATA FS.MIX_DATA FS.CAP_PLAN_DATA |FS.INTEREST_RATE
INIT_PRG FS.MD_INIT FS.IR_INIT
DEPENDENT NO YES NO YES
AUTO_DIM FS.FIN_ELEM FS.MIX_ELEMENT
AUTO_DIM_PRG FS.AUTO_FIN_DATA |FS.AUTO_MIX_DATA
ACROSS_DIM TIME FS.MIX_BREAKOUT TIME TIME
DOWN_DIM FS.FIN_ELEM FS.MIX_ELEMENT FS.FIN_ELEM FS.RATE_TERM
SELECT_ACROSS_DIM [FS.ORG_UNIT TIME TIME
SELECT_DOWN_DIM [TIME FS.FIN_ELEM FS.RATE_TERM

CALC

FS.PROCESS.COAS

CALC_PARTIAL

FS.PROCESS.COAS

CALC_FULL FS.PROCESS.COAS
SAVE_PRG FS.FD_SAVE

SUBMIT_PRG FS.FD_SUBMIT FS.SB_CHANGES FS.SB_CHANGES FS.SB_CHANGES
RW_SRC FS.FD_ACCESS FS.MD_ACCESS FS.CP_ACCESS FS.IR_ACCESS
CONJ_DIM FS.CUIO

WRTBACK_PRG

FS.DATA_WRITE

FS.DATA_WRITE

FS.GN_DATA_WRITE

FS.GN_DATA_WRITE

APP_SRC FS.MD_VAR_SOURCE
WRITE_SRC FS.CUJO.DECIMALL |FS.MIX_OVERRIDE  |FS.CAP_PLAN_DATA |FS.INTEREST RATE
CUST_PRG

CUST_PRG_DESC

VALIDATION_PRG

DEPENDENT_FDI

FS.MIX_OVERRIDE
FS.INTEREST_RATE

ADMIN
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Describing the FS.FDI_CATALOG Database Catalog

This section provides detailed information on the dimensions of the FS.FDI_

CATALOG.

Access FS.FDI_CATALOG through Express Administrator.

Note the following when adding access to additional seeded or user-defined
planning items as well as to custom programs:

Multi-Line Rows for FS.FDI_PROP

The data type for every row in FS.FDI_PROP
is multi-line text. Values for some properties,
however, require a single rather than
multi-line entry.

An error message does not appear if you
violate this constraint. Therefore, note
carefully which properties allow multi-line
entries and which require single-line entries.
These requirements are defined in the
Single/Multi column of the table in this
section.

Single-line entries are acceptable for a
multi-line data type.

Ordering of Properties

The order in which the properties appear in
the following table is the order of appearance
in FS.FDI__CATALOG.
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Host and Dependent Planning Items

Host and dependent planning items are
interrelated. A dependent planning item
provides information related to a host
planning item and can only be opened from
the host planning item interface.

If a host and dependant planning item
contain the same dimension, the dimension
values selected for the host planning item
become the same dimension values
displayed in the dependent planning item,
unless modified by the program identified in
the INIT_PRG property of the dependent
planning item.

Modifying Seeded Programs

You can use seeded programs as the
foundation for custom programs. Contact
Customer Support for information on how to
access seeded programs.

Mandatory Entries

Entries for some properties are required. This
information is provided in the following
table and also in the section "Mandatory and
Non-Mandatory Dimension Values Listed",
in this chapter.

Non-Mandatory Entries

For non-mandatory entries you can leave the
‘cell’ at the intersection of the planning item
and property empty. FS.FDI_CATALOG
treats this as NA.
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Describing the FS.FDI_PROP Dimension

The following table describes, in detail, each of the dimension values for the
FS.FDI_PROP dimension.

Single/
Property Object Name |Description Multi Req’'d

DATA_SRC This property specifies the data source object from which the Single |Yes
application’s main forecasting window or dependent interfaces, such
as the Maturity Mix Assumption interface, read and display data.

For FS.FIN_DATA and FS.MIX_OVERRIDE note that, rather than
referencing the planning item itself, the values for this property
represent a formula that controls data collection from multiple
sources rather than a single source.

If data for your planning item comes from a single source, reference
the planning item itself, such as FS.CAP_PLAN_DATA or
FS.INTEREST_RATE.

INIT_PRG Use this property to specify a program that initializes special status |Single |No
needs for dependent planning items. Use this program to further
refine or filter selections made in the Selector.

An example of such a program is the filtering that occurs on
dimension values for the Mix Override interface. The Mix Override
interface displays only leaf values, even though an end user may
have chosen node values as well as leaf values in the Selector. The
FS.MD_INIT program filters out the node values before passing data
to the interface.

This property is intended primarily for use with dependent planning
items. For host planning items this property could actually control
what is available for selection from the Selector rather than filtering
selections before passing the data to the interface.
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Property Object Name

Description

Single/
Multi

Req’'d

DEPENDENT

A dependent planning item holds information related to a host
planning item.

This property specifies whether the planning item is a host or a
dependent. The default setting is NO, meaning that the planning item
is a host. A YES value means the planning item is a dependent.

If an object is a dependent planning item you also need to enter the
object name of the planning item in the DEPENDENT_FDI property
of the host planning item.

A further distinction between a host and dependent planning item is
that a host planning item can be accessed from the Planning Item
Selector when logging in to the application or from the Plan Menu
option in the main forecasting window. A dependent planning item
can only be accessed from the Options menu of its associated host
interface when the host planning item is open.

An example of a dependent planning item is Mix Override (FS.MIX_
OVERRIDE), which has, as its host, Financial Plans (FS.FIN_DATA).

Single

No

AUTO_DIM

Controls which dimensions, if any, should not appear in the Selector.
The values for such dimensions are selected programmatically, rather
than by an end user through the Selector.

The Financial Element dimension of the Financial Plans (FS.FIN_
DATA) planning item is an example of an AUTO_DIM.

Multi

No
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Single/
Property Object Name |Description Multi Req’d

AUTO_DIM_PRG This is the name of the program that selects the appropriate Single |No
dimension values for the dimension designated as AUTO_DIM.

For example, the financial elements displayed in the main forecasting
window are selected by a program that associates relevant financial
elements to the chart of accounts selected. The AUTO_DIM program
for Financial Plans (FS.FIN_DATA) is FS.AUTO_FIN_DATA.

If you designate either a single dimension or multiple dimensions as
automatic, you must also create a program to control the selection of
the values you want displayed in the interface. Design your program
to select the values, for each automatic dimension, in a single
operation, as shown in the following table:

AUTO_DIM | AUTO_DIM_PRG
Property Property

A X
B
C

ACROSS DIM Designates the dimension whose values are displayed across the top |Single |Yes
(columns) of the grid when the interface first opens.

DOWN_DIM Designates the dimension whose values are displayed down the side |Single |Yes
(rows) of the grid when the interface first opens.

SELECT_ACROSS_DIM |Associated with the Selector. This entry designates the dimension that |Single |Yes
appears first when the Selector is launched.

The purpose of this property is to select one of the two
most-commonly used dimensions from the planning item. This
relieves an end user from having to select this dimension whenever
viewing data for the associated planning item.

Note the following:

=« You cannot use a dimension listed in the AUTO_DIM property
for this property

« Required for a host planning item but not a dependent planning
item
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Single/
Property Object Name |Description Multi Req’'d
SELECT_DOWN_DIM | Also associated with the Selector. This entry designates the next Single |Yes

dimension in the list of dimensions available for selection in the
Selector.

The purpose of this property is to select one of the two
most-commonly used dimensions from the planning item. This
relieves an end user from having to select this dimension whenever
viewing data for the associated planning item.

Note the following:

=« You cannot use a dimension listed in the AUTO_DIM property
for this property

« Required for a host planning item but not a dependent planning
item
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Single/
Property Object Name |Description Multi Req’d
CALC This property designates the calculation program you want called Single |No

when an end user selects the Calculate icon or Calculate from Options
in the Menu bar.

The calculations launched from the CALC property depend on:
«  The custom program you write for this property

« The planning item to which you have assigned this calculation
program through FDI_CATALOG, and;

«  Which planning item interface is active (open) when the end user
selects this calculation method

For seeded or user-defined planning items (other than the Financial
Plans planning item) designate the program you want called by
entering the program name at the intersection of the CALC property
and planning item. End users launch this custom program when they
select either the Calculate icon or the Calculate option in the Options
menu selection of the interface for the active planning item.

Note that, except for the planning item name that appears in the
upper right corner of the interface, the fact that the calculations might
behave differently, depending on the planning item selected, is not
apparent to the end user. For more information, refer to the section
"Interface Icons and Menu Items" in this chapter.

For Financial Plans (FS.FIN_DATA), the program FS.PROCESS.COAS
runs calculations with No Solve, Partial Solve, and Full Solve, which
are driven by entries residing in the conjoint dimension FS.CUJO.
This particular property (CALC) runs calculations for the No Solve
option.

You can set a global restriction on the use of this program by any end
user by entering NA for this property.

If you enter NA or omit a calculation program altogether from the
planning item this causes the associated icon and calculation option
in the Options Menu to appear greyed out when you open the
planning item.
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Single/
Property Object Name |Description Multi Req’'d

CALC_PARTIAL This property designates the calculation program you want called Single |No
when an end user selects the Calculate with Partial Solve icon or this
calculation method from Options in the Menu bar.

You can set a global restriction on the use of this program by any end
user by entering NA for this property.

As with the CALC property, entering NA or omitting a program for
this property causes the associated icon and Options menu selection
to appear greyed out.

For Financial Plans (FS.FIN_DATA), the program FS.PROCESS.COAS
runs calculations for Calculate with Partial Solve from this property.

CALC_FULL This property designates the calculation program you want called Single |[No
when an end user selects the Calculate with Full Solve icon or this
calculation method from Options in the Menu bar.

You can set a global restriction on the use of this program by any end
user by entering NA for this property.

As with the CALC and CALC_PARTIAL properties, entering NA or
omitting a program for this property causes the associated icon and
Options menu selection to appear greyed out.

For Financial Plans (FS.FIN_DATA), the program FS.PROCESS.COAS
runs calculations for Calculate with Full Solve from this property.
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Single/
Property Object Name |Description Multi Req’d

SAVE_PRG Use this property to designate a program that determines whether an |Single |No
operation needs to be performed by the end user before saving data
to the database. This program verifies that an end-user’s data entries
and calculated results are ready to be saved.

For example, in the Financial Plans (FS.FIN_DATA) planning item, if
an end user inputs data without running one of three calculation
routines (No Solve, Partial Solve, or Full Solve) the application does
not perform the Save function until the end user either runs a
calculation routine or instructs the application to undo the entries.

If all conditions for saving data are met, the program should return a
value of Yes, which results in the data being submitted to the shared
database through the task processor. If the required conditions are not
met, the program should return a value of No, which causes the
interface to abort the process. The end user needs to take corrective
action before selecting Save, which launches the program again.

For the Financial Plans (FS.FIN_DATA) planning item the save
program is FS.FD_SAVE. The program looks for entries in FS.CUJO
(conjoint dimension). If entries are located, the Save function requires
the end user to either run a calculation routine or undo inputs before
continuing. If FS.CUJO is empty the Save function runs without
interruption.

SUBMIT_PRG The program you input for this property writes data to an EIF file (or [Single |Yes
files), which is the Save function for the application. The data is then
sent to the task processor for uploading to the shared database.

A default program is provided for this property which automatically
identifies the planning item object name, any automatic dimensions,
and dimension values in status, then creates an EIF file(s).

Before the EIF file is created the default program sets the status of
each of the entries in AUTO_DIM as follows:

« All values in status for non-hierarchical dimensions
. All leaves in status for hierarchical dimensions

The default program sets the status for the Time dimension to all
future time periods regardless of current status
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Single/
Property Object Name |Description Multi Req’'d
RW_SRC Use this property to designate formula objects that identify whether |Single |Yes

cells in the grid are read-only or read/write. Formula objects used
here should be dimensioned by the same dimensions as the data
source object identified in the DATA_SRC property.

The following formulas are provided for use with the seeded
planning items in FS.FDI_CATALOG:

Planning ltem Formula Action

FS.FIN_DATA FS.FD_Access Calls program to determine RO,
RW

FS.MIX_OVERRIDE FS.MD_Access  Calls program to determine RO,
RW

FS.CAP_PLAN_DATA FS.CP_Access Returns YES
FS.INTEREST_RATE FS.IR_Access Returns NO

Read/write status for Financial Plans (FS.FIN_DATA) and Maturity
Mix Assumption (FS.MIX_OVERRIDE) is controlled by the database
variables FS.FE_WRITEABLE and FS.ME_WRITEABLE. The formulas
FS.FD_Access and FS.MD_Access call programs that have been
written to read these variables and determine the appropriate status
for cells in the grid.

The seeded formula for FS.CAP_PLAN_DATA returns a default value
of YES, meaning that all cells in the grid are read/write.

The seeded formula for FS.INTEREST_RATE returns a default value
of NO, meaning that all cells in the grid are read-only.

To control access to either user-defined or other seeded planning
items in the database, create new formulas that are dimensioned by
the same dimensions as the data source object listed in the DATA _
SRC property.

To establish a global status for all cells in the grid, the formulas can
either return a value of YES (read/write) or NO (read-only). To
establish read/write status for individual cells in the grid, create a
custom formula or a custom variable that controls read/write access
for the selected combination of dimensions and dimension values in
the planning item.

Use Express Administrator to create these formulas, variables, and
programs.
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Property Object Name

Description

Single/
Multi

Req’d

CONJ_DIM

If you want to track data entered to a planning item through the
interface, it is necessary to create a new conjoint dimension.

For the Financial Plans (FS.FIN_DATA) planning item, the conjoint
dimension used to generate a list of entries is FS.CUJO. When a user
selects Calculate, Calculate with Partial Solve, or Calculate with Full
Solve the program (FS.PROCESS.COAS) reads FS.CUJO to determine
the entries on which to process calculations.

To employ a similar process for tracking entries you want to process
using custom program calculations, create an FS.CUJO-like conjoint
dimension. This dimension should accumulate entries, and is the
dimension that your custom program should read to determine
which entries to process.

In addition to creating a custom conjoint dimension and custom
program calculations, you must also create a program to write data
entries to the conjoint dimension. This program is identified in the
WRTBACK_PRG property.

Single

No

WRTBACK_PRG

This property identifies the program that actually writes data from
the interface back to the database.

Use this property in conjunction with the WRITE_SRC property,
which contains the name of the destination planning item.

For FS.FIN_DATA a specific writeback program is seeded because
data is written to the variable FS.CUJO_DECIMAL1, rather than the
planning item itself.

A default, generic program called FS.GN_DATA_WRITE is provided
for the FS.CAP_PLAN_DATA and FS.INTEREST_RATE planning
items. This program does not reference any other object, like
FS.CUJO_DECIMAL1 because such an object would need to be
user-defined. Therefore this generic program writes data directly to
the planning item being accessed.

Single

Yes

APP_SRC

Formulas entered for this property control display characteristics for
data in the interface. This property applies to both host and
dependent planning items.

For example, in the Maturity Mix interface, default data appears
black while override data appears blue. For this interface the data
display is controlled through the formula FS.MD_VAR_SOURCE.

Single

No

WRITE_SRC

This property names the planning item to which data is written. It is
used in conjunction with the program identified in the WRTBACK _
PRG property. Express objects used here should be dimensioned by
the same dimensions as the data source object identified in the
FS.DATA_SRC property or be able to accept all those dimensions.

Single

Yes
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Property Object Name

Description

Single/
Multi

Req’'d

CUST_PRG

User-defined program object names are entered here. This property
works with the CUST_PRG_DESC property to identify custom
programs set up to be accessed and launched from within the
Budgeting & Planning interface. Custom programs are accessed from
the Options menu, and multiple custom programs can be defined for
a given planning item.

Multi

No

CUST_PRG_DESC

The description of a user-defined program object is entered here.

This description appears as a selection in the Options menu of the
interface. By selecting the description from the Options menu you
launch the program.

Note the following, imperative conditions:

« You must input a description for each custom program. If you
fail to input a description the program is not accessible through
the interface to end users.

« If you create multiple programs your list of descriptions must be
in the exact order as the programs listed in CUST_PRG.

Multi

No

VALIDATION_PRG

Not activated for this release.

Designed to accommodate a program that checks data validity.

NA

NA

DEPENDENT_FDI

For a host planning item in FS.FDI_ENTRY enter the dependent
planning item(s) here.

For example, the seeded dependent planning items for Financial
Plans (FS.FIN_DATA) are FS.MIX_OVERRIDE and FS.INTEREST_
RATE.

Multi

No

ADMIN

Not activated for this release.

NA

NA
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Mandatory and Non-Mandatory Dimension Values Listed
The following table categorizes the FS.FDI_PROP dimension values by whether or

not they are mandatory:

Non-Mandatory

SELECT_ACROSS_DIM
SELECT_DOWN_DIM
SUBMIT_PRG

RW_SRC
WRTBACK_PRG
WRITE_SRC

Mandatory Properties Properties
DATA_SRC INIT_PRG
ACROSS_DIM DEPENDENT
DOWN_DIM AUTO_DIM

AUTO_DIM_PRG
CALC
CALC_PARTIAL
CALC_FULL
SAVE_PRG
CONJ_DIM
APP_SRC
CUST_PRG
CUST_PRG_DESC
DEPENDENT _FDI

For this release VALIDATION_PRG and ADMIN are not active and, therefore, not
included in the preceding table.

Interrelated Properties
Some properties have dependencies. The following table lists these dependencies:

When you enter a
value for...

You must also enter a

value for...

Which is...

DEPENDENT DEPENDENT_FDI The name of the dependent planning
item, entered under the host planning
item’s DEPENDENT_FDI property.

AUTO_DIM AUTO_DIM_PRG The program that links values in the

AUTO_DIM dimension to their
associated values when those associated
values are chosen from the Selector.
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When you enter a  You must also enter a
value for... value for... Which is...

CUST_PRG CUST_PRG_DESC The name of the program, as you want it
to appear, in the Options menu of the
Menu bar. Failing to enter a description
in the CUST_PRG_DESC property
renders the custom program inaccessible
through the interface to end users.

Describing the FS.FDI_ENTRY Dimension

Entries in this dimension name the planning items. This dimension in OFA is BP
FDI Access. Use Express object names for the planning items you create.

The seeded planning items for FS.FDI_ENTRY include:

Description Express Object Name
Financial Plans FS.FIN_DATA
Mix Override FS.MIX_OVERRIDE

Capital Expenditures FS.CAP_PLAN_DATA
Interest Rates FS.INTEREST_RATE

Setting Up Planning Item and Custom Program Access

This section explains the requirements for accessing planning items and custom
programs.

Requirements for Planning Item Access

For user-defined planning items, first create the planning item using OFA. It must
have a minimum of three dimensions.

The steps for adding a planning item and any associated custom programs to the
FS.FDI_CATALOG follow:

1. Open Oracle Financial Analyzer.

2. Add the planning item as a dimension value to the FS.FDI_ENTRY dimension
by selecting Maintain -> Dimension Values from the Menu bar.
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The dimension you want to add the dimension value to should be listed in OFA
with the description BP FDI Access.

Note: The dimension value must be created with the same name as the
Express object name of the planning item you want to add. Descriptions
should match as well.

Open Oracle Express Administrator.

Create any custom formulas or programs that you want to add to FS.FDI_
CATALOG. These formulas or programs control planning item access, display,
and functions.

You can use existing formulas or programs as a guide in creating your custom
objects, if desired. Contact Customer Support for information on how to access
seeded programs.

Populate FS.FDI_CATALOG with the required and optional properties using
Express Administrator.

When adding entries to the catalog use Express object names where
appropriate.

Refer to the section "Mandatory and Non-Mandatory Dimension Values Listed"
in this chapter to know which properties are required and which are optional.

Establishing User Access to Additional Planning Items

Once you have populated FS.FDI_CATALOG with the information that provides
accessibility you need to establish controls for end-user access.

Complete this task in OFA, using the distribution functionality, to distribute the
planning item(s) to the end users to whom you want to grant access.

Manage this process by completing the following steps:

1.
2.

Open Oracle Financial Analyzer

Select Distribution -> Structure to select the new dimension value or values that
you added to the BP FDI Access dimension in the previous section.

From the Distribute Structure dialog box locate and select BP FDI Access.
Double-click on this selection to open the Selector.

Choose the planning item or items you want to distribute.

Administering Planning Item Access and Programs 5-19



Administering Status For Your Custom Programs

5. Choose the user or users from the Users column to whom the planning item
will be distributed.

6. Add the One-Way Data Custom Distribution object in the Distribute Structure
dialog box to the items you have selected for distribution.

This step distributes the FS.FDI_CATALOG property entries for the planning
item being distributed. Therefore, this object must be listed in the Item column
after the BP FDI Access entry.

7. Submit the distribution.

8. Run the Task Processor to process the distribution.

Interface Icons and Menu Items

The descriptions for the Calculation icons and the Calculation selections in the
Options menu always remain the same, whether you open a seeded planning item
or a user-defined planning item. Even if you alter the calculation program to
accommodate a specific planning item-related requirement, the descriptions in
these two areas remain unchanged.

Custom calculation routines, however, that you have cataloged in the FS.CUST _
PRG property and described in the FS.CUST_PRG_DESC property appear as
selections in the Options menu and are dynamic. Only the custom programs you
catalog for a specific planning item appear as Option menu selections when you
access that planning item.

Administering Status For Your Custom Programs

When creating a custom program it is important that you define the combination of
dimension values on which you intend the program to operate. You need to decide
whether you want the program to perform its operation only on the values
displayed in the interface, a combination of those values plus other values selected
by an end user, or include values not represented in the current selections.

You define these combinations of dimension values from the following possibilities:
« Dimension values displayed in the interface (default)

«  Currently visible dimension values plus a subset of other in-status values

= All dimension values in status

« Dimension values not represented in any of these preceding options
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Determining the combinations of dimension values also helps to define status for
your program. The following section describes the actions taken by the application,
regarding status, when an end user launches a custom program.

Saving and Retrieving Status

When an end user selects a custom program from the Options menu, the
application stores the current status of all the dimensions plus the status of any
corresponding hierarchies also selected, in an Express object called a context. Once
stored, the application limits status of all paging dimensions to the individual
values visible on the current page of the interface.

Scenario

For example, an end user makes the following selections from the Financial Plans
planning item:

Dimension Dimension Values Selected

Time 12 monthly periods

Organizational Unit 3 units

Chart of Accounts 2 cash flow accounts

Strategy 1 value
Forecast 1 value
Currency 1 value

In the interface Time occupies the across dimension and Financial Element occupies
the down dimension. Before the end user selects the program there are a total of six
pages currently selected (3 Organizational Units * 2 Chart of Accounts).

Process

When the end user selects your program the application stores the current status of
all dimensions in a dynamically generated context. Since the context is dynamically
generated the name is never the same. Immediately after creating the context the
application stores the name in an Express variable called FS.SLCTN_CONTEXT.

The application then limits all the current paging dimensions (in this example
Organizational Unit, Chart of Accounts, Strategy, Forecast, and Currency) to the
single values displayed in the interface.
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After limiting the paging dimensions the custom program is executed. If the desired
combination of dimension values upon which you want the program to operate
differs from those reflected on the current page, then you need to adjust status
during the program’s execution.

The following table summarizes the possible combinations of dimensions and the
actions you need to take:

If you want your program to operate on... then you need to...

Only the current page of dimension values Do nothing, this is the default setting.

All dimension values in the current page, plusa  Selectively restore the status that the
subset of other pages currently selected application saved in the context.

All dimension values currently selected through  Restore the entire context.
the Selector

Dimension values not currently selected Use Express functions, such as limit, to
adjust the status.

Processing Selected Dimensions If you want your program to process the three
organizational units in this scenario you need to restore the selection on the
Organizational Unit dimension status from the context.
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Once you have restored status, the following diagram illustrates the range of data
that the rest of your custom program will impact:

Chart of Accounts: Auto Loans
Forecast: Base

Strategy: Momentum
Currency: US Dollars

Beverly Hills

Brentwood

Santa Monica
Interface

Interface

Data Displayed in the Grid of the Interface

Processing All Dimensions If you want your program to process all six combinations
of dimension values you can either restore the selection on the Organizational Unit
dimension and the Chart of Accounts dimension or restore the entire context.

Caution: If you decide to restore the entire context note the following:

«  End users can potentially run your program on very large data sets,
depending on their selection

«  End users can mistakenly run the same custom program on multiple
dimension values, such as for Forecast, with unintentional results

Administering Planning Item Access and Programs 5-23



Administering Status For Your Custom Programs

Referencing the Context in Your Program

To reference the context in your program, use the Express ampersand (&)
substitution functionality. The following command shows how to restore the
Organizational Unit dimension to its former status:

context &S SLCIN OONTEXT restore FS CRGUN T

For more information on the context object refer to the Express documentation and
online help.

After the program finishes it restores status to the way it was before the program
was launched.
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Creating Custom Cash Flow Calculations

Creating custom cash flow calculations enables the administrator to define balance
sheet calculations that accurately reflect the behavior of your institution’s products
or investments. However, once you create this custom cash flow calculation you
need to make sure your calculations are incorporated into the budgeting processes
for the Budgeting & Planning application.

If you do not complete the steps in this chapter, the Budgeting & Planning
application can not use your customized cash flows in the budgeting process.

In this chapter a custom cash flow calculation called BULLET.REPRICE is used to
illustrate the steps you need to take to incorporate a custom cash flow into the
Budgeting & Planning application. This example assumes that you already know
how to create a customized cash flow.

For the purposes of this chapter BULLET.REPRICE is the name given to a loan
instrument that has a bullet maturity and also reprices at specified intervals during
the term of the loan. BULLET.REPRICE is considered a cash flow calculation
because the computation of outstanding balance and earnings is based on the
instrument’s maturing and repricing characteristics and also your institution’s
forecasts for new business. In contrast, a non-cash flow calculation has only total
amounts input.

Refer to FS.NON.TERM and FS.NON.RATE.REL as examples of non-cash flow
simplified calculations.

Caution: All programs created using Oracle Express and seeded
programs included with the Budgeting & Planning product have an
FS. prefix. Do not use the prefix 'FS' when you name your custom
programs.
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Setting Up the Cash Flow Calculation

The first thing to do is create your custom cash flow calculation and add it to your
list of cash flow programs in Oracle Express. The following section explains how to
do this.

Creating the Custom Cash Flow Calculation
Follow these steps to create the custom cash flow calculations:

1.
2.

5.
6.

Launch Oracle Express Administrator.
Attach your custom program database.

For additional instructions on using custom databases see "Defining FSBPTOOL
as the Primary Custom Database" in the Oracle Financial Services Installation and
Configuration Guide.

From the menu items select Edit -> Define -> Program. The Define a Program
dialog box appears.

In the Name field, type the name you have chosen for your custom cash flow
then select a return type of NONE from the Return Type selection box.

1#. Define a Program

Mame: [atabaze:
BULLET.REPRICE BGTY =

General I Labels I

Fieturn Type:

|nonE =

Define | Lloze | Help

Click Define then close the dialog box.
Create the BULLET.REPRICE custom cash flow program.

Note that you can use an existing cash flow calculation as the basis for creating your
customized calculation. In this example FS.BULLET.FIXED might be a calculation
program that most closely reflects the characteristics of the program you want to
create.
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Adding the New Custom Cash Flow

Follow these steps to add your custom cash flow to the list of available programs.

1.

2
3.
4

Launch Oracle Financial Analyzer.

From the Maintain menu choose Dimension Value.
Select Balance Sheet Model.

Click New.

In this scenario, the Name field would be populated with the description for the
new model type (Bullet Repricing) and the dimension value field would be
populated with the exact Express name of your program (BULLET.REPRICE).

Note: In this example BULLET.REPRICE is not prefixed by "FS."
This is a custom cash flow calculation, therefore the prefix is not
used. Only predefined calculations use the prefix "FS."

Associating the Custom Cash Flow with Budgeting & Planning

The tasks described in this section include the following:

Associating your newly created cash flow program with the chart of accounts
(FS.CHRT_OF_ACCT) that use this calculation

Designating the new program as a cash flow type calculation so that it is
recognized by the Budgeting & Planning application as such

Designating which financial elements appear in the interface

Designating which elements are read/write and which are read-only

Associating the Cash Flow Program with the Relevant Chart of Accounts

The first task associates the new custom cash flow program with the Chart of
Accounts products that rely on this program so that whenever changes are made to
these products the custom cash flow program runs.

To complete this task, follow these steps:

1.
2.

Launch Oracle Financial Analyzer.

From the Maintain menu choose Attribute.

The Maintain Attribute dialog box appears.
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3. Select Chart of Accounts from the Base dimension list box.
4. Select COA Balance Sheet Model from the Attribute list box.
5. Click Edit.
The Edit Attribute list box appears.
6. Expand the Grouping Values list box and click the custom cash flow program.

7. Highlight the cells opposite the Chart of Accounts products to which you want
to apply your custom cash flow program.

8. Click Set.
9. Click Save.

Designating the Calculation Program as "Cash Flow"

The next task assigns "cash flow" as the calculation type for this program. This step
is necessary so that the Budgeting & Planning application recognizes this new
program as a cash flow calculation.

To complete this task, follow these steps:
1. Launch Express Administrator.
2. Locate and double-click on the variable FS.IS_ CASHFLOW.
3. Select the Data tab.
The Modify FS.IS_CASHFLOW dialog box appears.

4. Type YES in the row opposite your custom cash flow program.
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An example of the Modify FS.IS_ CASHFLOW dialog box follows.

2 Modify F5.15_CASHFLOW

M ame: D atabase:
FE.IS_CASHFLOW EGTY
General I Label I FEormat I Data I [rata Driven Format I

Down Dimenszion: Selector... |

|Fs.BAL_SHT_MODEL =]

FS_BULLET.FIXED YES| &
F5_AMORT.FIXED YES

F5_AMORT.REPRICE YES
F5_NON.TERM NO
F5_NON.RATE.REL NO
F5_ROLLOVERS YES
BULLET.REPRICE

Lloze | Help |

Displaying Relevant Financial Elements in the Interface

This task enables you to designate which financial elements associated with your
custom cash flow appear in the interface when an end user selects this type of
account.

To select the financial elements you want displayed follow these steps:

1. From Express Administrator locate and double-click on the Express object
FS.FE_ENABLED.

The Modify FS.FE_ENABLED dialog box appears.

2. Select the Data tab and type YES for each of the financial elements used in the
calculation that you want to appear in the interface.
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An example of a Modify FS.FE_ENABLED dialog box follows.

2. Modify F5_FE_ENABLED

M ame: D atabase:
FS.FE_ENAELED EGTY

General I Label I Format I I [Drata Driven Format I

Down Dimenszion: Acrozs Dimenzion: Selectar...
|Fs.BaL_SHT_MODEL =]/ [FS.FIN_ELEM =

|
F5.BULLET.FIXED
F5.AMORT.FIXED
F5.AMORT.REPRICE
F5.NON.TERM
F5.NON.RATE.REL
F5.ROLLOVERS
BULLET.REPRICE

Lloze Help

Note: Any value other than YES, such as leaving the row blank or
entering NA, is treated as a NO value.

Designating Relevant Financial Elements as Read/Write

This task designates which financial elements in your custom cash flow can be

changed by an end user. To designate these financial elements as read/write follow
these steps:

1. Locate the FS.FE_ WRITEABLE Express object.
The Modify FS.FE_WRITEABLE dialog box appears.

2. Designate the financial elements available to the end users for input by entering
YES in the appropriate cell.

6-6 Oracle Budgeting & Planning Reference Guide



Setting Up the Cash Flow Calculation

An example of this step follows:

2 Modify F5_FE_WRITEABLE

M ame: D atabase:
FE.FE_WRITEAELE EGTY

General I Label I FEormat I Data I [rata Driven Format I

Down Dimenszion: Acrozs Dimenzion: Selectar...
|Fs.BaL_SHT_MODEL =]/ [FS.FIN_ELEM =

FS_BULLET.FIXED
F5_AMORT.FIXED
F5_AMORT.REPRICE
F5_NON.TERM
F5_NON.RATE.REL
F5_ROLLOVERS
BULLET.REPRICE

Lloze Help

After you have completed the steps in this section, your newly created custom cash
flow calculation should appear and function properly in the Budgeting & Planning
user interface.
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Running the LEDGER_STAT Writeback
Procedure

The LEDGER_STAT writeback data transformation procedure is an Express
program used in conjunction with the LEDGER_STAT load utility in the Oracle
Financial Data Manager (FDM) to move Budgeting & Planning data to the
LEDGER_STAT table. The Express program moves data to a staging table in FDM;
the LEDGER_STAT load utility then moves the data from the staging table to the
LEDGER_STAT table.

Using the writeback procedure you can move both official budget projections and
interim forecasts of performance to the LEDGER_STAT table. Once loaded, you can
subject this data to further processing using other OFSA applications such as
Performance Analyzer and, ultimately, use this processed data for performance
reporting against FDM.

If your budgeting process calls for allocations or other refinements on the
Budgeting & Planning data using Performance Analyzer, you can then load the
resulting adjusted or final budget back into Express. Use the data movement
routines described in Chapter 3, "Administering the Application" to complete this
task.

This chapter explains how to prepare your data for the writeback procedure and
execute the program using Oracle Express Administrator. This chapter presents the
following topics:

« Features of the Writeback Procedure
« Overview of the Load Process
« Key Steps in the LEDGER_STAT Writeback Procedure

= Details of the Writeback Procedure
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Features of the Writeback Procedure
The following points highlight key features of the writeback procedure:

« Transfers budget or forecast data from the Financial Plans planning item in the
Super Administrator’s shared database in Express to an Oracle table (staging
table) in FDM. From there, a separate tool, the LEDGER_STAT Load Utility,
loads data to the LEDGER_STAT table.

« Loads only leaf-level dimension values from Express to the staging table and
then to the LEDGER_STAT table. All nodes and orphans are excluded.
Hierarchies identified when the process is run provide the mapping
information to determine which dimension values in Express represent
leaf-level dimension values.

The procedure also removes any alpha prefixes (retaining the numerical
identifiers) from Express dimension values before loading data to the staging
table.

« Loads only financial elements with an 'F' prefix to the staging table and
LEDGER_STAT.

« Performs leaf-level validation to confirm the existence of destination leaf values
in FDM Leaf Setup tables that match dimension values in Budgeting &
Planning. The procedure excludes values unique to Budgeting & Planning from
both the staging table and the LEDGER_STAT table.

« Provides the option to create a log file to record Budgeting & Planning
dimension values rejected during the writeback procedure. Rejections could be
due to the absence of matching leaf values in the Leaf Setup tables in FDM,
unique constraint violations, or non-unique leaf values.

« If you populate the Chart of Accounts dimension in Budgeting & Planning from
a leaf field other than COMMON_COA _ID the procedure performs a lookup of
the COMMON_COA _ID value assigned to the FDM leaf field in leaf setup. The
procedure then populates the COMMON_COA _ID column in the staging table
with the chart of account value returned from the look up. This process ensures
that the field is appropriately populated when data is loaded to LEDGER_STAT.

« Performs consolidation code-based operations on budget and forecast data. Per
your specifications, the LEDGER_STAT load utility deletes LEDGER_STAT
records with consolidation codes 200 or 300, in advance of loading new records
to the LEDGER_STAT table. You also have the option of copying records with
consolidation code 300 to records with a code of 310 before new records are
inserted into the LEDGER_STAT table.
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« Parameters associated with the call statement used to launch the procedure are
maintained in a catalog that is seeded with the database.

Overview of the Load Process

In the load procedure, Budgeting & Planning data from the Express database is
loaded into a staging table using the Express LEDGER_STAT writeback program.
The staging table is created using script templates, associated with the LEDGER _
STAT load procedure, and provided in FDM.

Express OFDM Database

Financial Plans OFDM
(or user-defined),

LEDGER_STAT
Table
———

S——
Staging Table
e —

LEDGER_STAT
Load (Oracle
Stored
Procedure)

v

LEDGER_STAT
Writeback Program

Runtime parameters, such as the name of the load table, which columns to load,
ADD or REPLACE update functionality, and whether or not to create offset records
can be entered into the Ledger Stat Load Batch table using a Data Verification ID.
One row per table to be loaded is entered in this table, as a way to batch a
multiple-table load in one run of the procedure.

The procedure is implemented as an Oracle PL/SQL stored procedure so it can be
invoked from a SQL ID or from SQL*Plus. Input parameters are read from the
batch/parameter table and validated for correctness, completeness and consistency
before the load begins. Parameter errors are written to a Message column in the
batch/parameter table. Runtime statistics are written to the batch/parameter record
following completion of the load for that record.
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Key Steps in the LEDGER_STAT Writeback Procedure

This section describes the key activities for the writeback procedure. The following
diagram illustrates the sequence:

Step 1

Create the staging table in the Financial
Data Manager database

'

Step 2
Set parameters for FS.WB_CATALOG !

Step 3

Customize Parameters (optional)

Step 4 ¢ ----=-=---- E
Set parameters for FS.WM_CATALOG | i
Step 5
Customize Parameters (optional)
\ 4 .
1
Step 6 :

Run LEDGER_STAT Writeback Reject [€
Utility (optional)

v

Step 7

Execute Express program to move
Budgeting & Planning data to staging
table

'

Step 8
Run LEDGER_STAT Load Utility
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Step 1: Create the Staging Table and View in FDM

This is the first step in the procedure. It creates the table that temporarily holds
Budgeting & Planning data for loading to the LEDGER_STAT table. Create the
staging table using scripts provided in FDM. Enter the staging table name when
you set the parameters for FS.WB_CATALOG, in the next step. Refer to "Creating
the Staging Table and Views" in this chapter for more information.

Step 2: Set Parameters for FSWB_CATALOG

The following table shows the dimensions and dimension values for this catalog. A
typical writeback procedure uses seeded values for many of the FSWB_ENTRY
dimension values. In this example, shaded cells indicate unseeded entries that a
user might typically make or need to make. Note that the shaded cells for BUDGET
and FORECAST and the entry for the LOGFILE property, which is optional, contain
sample values.

FS.WB_CATALOG

FS.WB_ENTRY
USER-DEFINED

FS.WB_PROP BUDGET FORECAST (optional)
CUBE [PLANNING ITEM] |[FS.FIN_DATA FS.FIN_DATA
TABLE BPLGRST BPLGRST
MAPSET STD200 STD300
STARTMONTH JUL99 JUL99
ENDMONTH JUNOO JUNOO
LOGFILE! D:/logs/reject.log D:/logs/reject.log
LOGMAX
FINELEMLIST F100 F100

F140 F140

F420 F420

F450 F450

F455 F455

F457 F457

F10000 F10000

L LOGFILE is an optional entry. This example illustrates a sample path for a log file.
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Mapset values STD200 and STD300 are dimension values from the second catalog,
FS.WM_CATALOG. Refer to "Setting Parameters for FS\WM_CATALOG" in this
chapter for more information on creating mapsets.

Step 3: Customize Parameters

If you want to load data from a user-defined planning item to the staging table you
need to add an additional dimension value to FS.WB_ENTRY. In the example this is
the third column in the FS.WB_CATALOG table. Customizing this catalog may
require adding a mapset entry to the FSWM_ENTRY dimension in the FSWM _
CATALOG catalog, if the existing, seeded mapsets are not sufficient.

Step 4: Set Parameters for FS.WM_CATALOG

Entries in this catalog support entries in FS.WB_CATALOG. The values you enter in
this catalog are referenced as the MAPSET property values in FS.\WB_CATALOG.

The following tables display the dimensions and dimension values for this catalog.
As with FSWB_CATALOG, a typical writeback procedure uses seeded values for
many of these dimensions. Shaded cells indicate values you need to enter. In this
example values in the shaded cells are sample values.

Dimension Value STD200

FS.WM_ENTRY: STD200 FS.WM_MAP
FS.WM_SET DIM coL HIERARCHY
1 A ACCUM_TYPE

2 200 CONSOLIDAT

3 FS.FIN_ELEM FINANC_ID

4 FS.ORG_UNIT ORG_ID HI.AA12345

5 0 GL_ACCT_ID

6 FS.CHRT_OF_ACCT |BP_COA_ID HI.AA67890

7 FS.STRATEGY MOMENTUM

8 FS.FORECAST BASE

9 FS.CURRENCY BASE

10- 12

7-6 Oracle Budgeting & Planning Reference Guide



Key Steps in the LEDGER_STAT Writeback Procedure

Dimension Value STD300

FS.WM_ENTRY: STD300 FS.WM_MAP
FS.WM_SET DIM coL HIERARCHY
1 A ACCUM_TYPE

2 300 CONSOLIDAT

3 FS.FIN_ELEM FINANC_ID

4 FS.ORG_UNIT ORG_ID HI.AA55555

5 0 GL_ACCT_ID

6 FS.CHRT_OF_ACCT |BP_COA_ID HI.AA44444
7 FS.STRATEGY MOMENTUM

8 FS.FORECAST BASE

9 FS.CURRENCY BASE

10-12

Note that in these examples the FS.CHRT_OF_ACCT maps to a hypothetical,
user-defined leaf called BP_COA_ID. When the process is run the COMMON _
COA_ID column will be populated with the COMMON_COA _ID values found in
OFSA_DETAIL_OTHER_COA for the given BP_COA_ID values. It is not necessary
to explicitly mention the COMMON_COA_ID column to trigger this functionality.

Step 5: Customize Parameters

If you customize FS.WB_CATALOG to include user-defined planning items you
need to create a new value in FSWM_ENTRY and include:

« All user-defined dimensions from your planning item
« Required dimensions

See "Loading Data From User-Defined Planning Items", in this chapter, for the list of
required dimensions.
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Step 6: Run LEDGER_STAT Writeback Reject Utility (optional)

This utility determines where problem leaf-level values exist and reports those
values out to the same log file as indicated in FS.WB_CATALOG.

Use the following command if you want to run this utility:

FS. VB K RICT(<db connectstring>, <wb_entry>)

Step 7: Execute the Express Program

Run the Express program to move data from the Express database to the staging
table, using the following command:

FS. LS WR TEBACK(<db connect stri ng>, <wb_ent ry>, <bool ean: | og r ej ect s>)

where:
Entry Description
<db connectstring> <user>/<password>@<databasename>
where <databasename> is the name of FDM
<wb_entry> A valid FS\WB_ENTRY value
<boolean: log rejects> YES = log rejected data

NO = do not log rejected data
The default setting is NO.

Refer to "Executing the Express Program" in this chapter for additional information.

Step 8: Run the LEDGER_STAT Load Utility

Execute the load routine from FDM. Refer to "Executing the LEDGER_STAT Load
Procedure for Budgeting & Planning" in this chapter for information regarding this
routine.

Details of the Writeback Procedure

This section provides the following detailed information on the writeback
procedure:

« Creating the Staging Table and Views
« Setting Parameters for FS\WB_CATALOG
« Setting Parameters for FSWM_CATALOG
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« Executing the Express Program
« Executing the LEDGER_STAT Load Utility

Creating the Staging Table and Views

The staging table temporarily holds Budgeting & Planning data before loading to
the LEDGER_STAT table. Before running the Express writeback program, create the
staging table and views in FDM. The name you assign to the table is the name you
enter in FS.\WB_CATALOG. Without this entry your writeback program will not run
successfully.

Create the staging table and views using scripts in FDM. Refer to the "FDM
Utilities" chapter of the Oracle Financial Services Installation and Configuration Guide
for instructions on customizing and running these scripts.

Setting Parameters for FS.WB_CATALOG

FS.WB_CATALOG is the primary catalog for the writeback procedure, storing
information about the data source, time range, financial elements, and log file.

This section describes the following for FS.\WB_CATALOG:
« Accessing this Catalog

« Populating Values for FSWB_CATALOG

« Designating the Log File

Accessing this Catalog
Access FS.WB_CATALOG through Express Administrator.

Populating Values for FS.WB_CATALOG
This catalog is dimensioned by:

. FS.WB_PROP
. FS.WB_ENTRY

This section describes the dimension values for both dimensions.
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FS.WB_PROP Dimension

Dimension
Value Explanation for WB_PROP Dimension Values Options
CUBE Planning item supplying data. This is either the Seeded -
Financial Plans planning item (FS.FIN_DATA) or a Financial Plans
user-defined planning item. planning item
(FS.FIN_DATA).
User-defined -
optional
TABLE Name of the staging table created to hold Budgeting & User defined -
Planning data before the load utility loads this datato  Enter the name
the LEDGER_STAT table. of the staging
Refer to the Oracle Financial Services Installation and table.
Configuration Guide for information on creating this
table.
MAPSET The identifying name for the specific set of parameters  Seeded
for loading data to the staging table. The parameters Additional

defining each mapset are stored in the FSWM_ g
CATALOG catalog. user-defined
mapsets can be

The application seeds the following two mapsets: created.
STD200 = Consolidation code 200 (for Budget data)
STD300 = Consolidation code 300 (for Forecast data)

STARTMONTH The first month of an inclusive range of months of data User defined -
you want to include in the load procedure. First month of
the time range.
Use the format
MMMYY.

ENDMONTH The last month of an inclusive range of months of data  User defined -
you want to include in the load procedure. Last month of
the time range.
Use the format

MMMYY.
LOGFILE Designate the log file by entering a fully-pathed file User defined -
name. For more information see "Designating the Log  Either a
File" in this chapter. user-defined
If you choose to omit a log file enter NO for the Lor;?:'lc:)n ?IE
appropriate argument when launching the LS_ altogetr?er

WRITEBACK program. See "Executing the Express
Program" in this chapter for additional information.
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Dimension
Value Explanation for WB_PROP Dimension Values Options
LOGMAX The maximum number of rows written to the log file. Seeded - All
- . entries (rows)
If left blank, the program writes all rows to the file. written to log
file.
User defined -
Input the
limiting number
of rows written
to the log file.
FINELEMLIST  The list of financial elements included in the load Seeded
procedure. User defined -
The following financial elements are seeded: Add to or
F100 - End Balance su_btr_act from
this list as

F140 - Average Balance
F420 - Interest

F450 - Charge/Credit

F455 - Non Interest Income

appropriate

F457 - Non Interest Expense
F10000 - Statistical

Only financial elements with the prefix "F" are
acceptable.

Elements with numeric values not matching values in
FDM are rejected and written to the log file.

See "Table Integrity" for more information on valid and
invalid financial elements.

FS.WB_ENTRY Dimension

Dimension
Value Explanation for FS.WB_ENTRY Dimension Values Options:
BUDGET Data loaded using this dimension value is your official Seeded

budget for the year. Mapset STD200 represents the
budget consolidation code. This is a seeded dimension
value.
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Dimension
Value Explanation for FS.WB_ENTRY Dimension Values Options:
FORECAST Data loaded using this dimension value is forecasted Seeded
data. Mapset STD300 represents the consolidation code
for forecasted data. This is a seeded dimension value.
User Defined  You can add as many additional values for this User defined

dimension as necessary.

Designating the Log File

To create a log file, enter a fully-pathed file name in the LOGFILE dimension value
of FS.WB_CATALOG and enter YES in the third argument (boolean variable) of the
FS.LS_WRITEBACK program.

The program reads your file location and writes invalid data to that file. After you
review the rejections written to this file and make adjustments, as necessary, delete
this file or rename it, while leaving the file name (in FS.WB_CATALOG) intact. The
next time you execute the writeback program (with logfile invoked) the program
writes rejections directly to this file.

Failing to Delete Your Log File From the Database If you forget to delete your reject.log
file from the database and execute the writeback program, the program
automatically creates a new file, locating it in the directory you created, with the
following naming convention:

D:/LOGS/WB_REJECTS-DD-MMM-YYYY-HHMM.LOG

where:

D:/LOGS/ Represents your user-defined
directory location for the log file

WB_REJECTS-DD-MMM-YYYY-HHMM.LOG Represents the program-generated
file name, including an identifying
name and datetime stamp

The program does not overwrite any previously created files. It creates a new file by
retaining the name but appending the date and time values to reflect the point in
time when the new file was generated.

Entering YES to Create a Logfile Without a Fully-Pathed Name If you enter YES as the third
argument of the writeback program but fail to enter a fully-pathed name for the log
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file in FS.WB_CATALOG, the program automatically generates a log file for you in
the current working directory.

The default directory and file name is:
WORKING DIRECTORY/WB_REJECTS-DD-MMM-YYYY-HHMM.LOG

If you fail to enter a file location in FS.WB_CATALOG and continue with the default
setting, every time you execute the writeback program it generates a new file by this
same algorithm.

Data Written to the Log File Invalid leaf values are written to the log file. An invalid
leaf value is a value that exists in Budgeting & Planning but does not have a
corresponding value in Leaf Setup in FDM. In addition, any duplicate occurrences
of leaf values, where the original Express dimension values differ only by prefix, is
treated as an invalid leaf value.

Regarding special circumstances for invalid financial elements, refer to "Table
Integrity and Data Rules When Setting Parameters" in this chapter.

Setting Parameters for FS.WM_CATALOG

This catalog supports FS.WB_CATALOG by consolidating information into datasets
that incorporate the following information:

« Defining the data for each mapset used in the FS.WB_CATALOG catalog
« Mapping Express dimensions to staging table columns

« Mapping the Budgeting & Planning Chart of Accounts dimension to the FDM
column used to load the application’s Chart of Accounts

« Entering the appropriate consolidation and accumulation codes
This section describes the following:

« Accessing this Catalog

« Populating Values for FSWM_CATALOG

Accessing this Catalog
Access FSWM_CATALOG through Express Administrator.
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Populating Values for FS.WM_CATALOG
This catalog includes the following dimensions:

Dimension Description
FSWM_SET Use this dimension to modify the number of rows in the catalog. The
default is 12.
FSWM_MAP Use this dimension to:
«  Map Express dimensions that correspond one-to-one with staging
table columns
«  Specify a single value for dimensions that do not have
corresponding columns in FDM
«  Specify a single value for columns from FDM that do not have
corresponding Express dimensions
« Identify hierarchical structures for leaf/node definitions, if
necessary
FSWM_ENTRY  Use this dimension to differentiate datasets in the catalog. Two datasets

(dimension values) are seeded: STD200 and STD300.
You can create additional dimension values as needed.

An Example of FS.WM_CATALOG The following table illustrates the content of FS.WM _
CATALOG. The values for this example are specific to the Financial Plans planning
item, for forecasted data (consolidation code 300).

FS.WM_ENTRY: STD300 FS.WM_MAP

FS.WM_SET DIM coL HIERARCHY
1 A ACCUM _TYPE

2 300 CONSOLIDAT

3 FS.FIN_ELEM FINANC_ID

4 FS.ORG_UNIT ORG_ID HI.AA55555
5 0 GL_ACCT_ID

6 FS.CHRT_OF_ACCT |BP_COA_ID HI.AA44444
7 FS.STRATEGY MOMENTUM
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FS.WM_ENTRY: STD300 FS.WM_MAP

FS.WM_SET DIM CoL HIERARCHY
8 FS.FORECAST BASE

9 FS.CURRENCY BASE

10-12

Defining the Parameters for FS.WM_SET This dimension sets the number of rows for the
catalog. In the example provided, rows 1 through 9 are used. The default number of
rows is 12. Additional rows may be needed if:

= You are mapping dimensions from a user-defined planning item that has more
dimensions than Financial Plans (FS.FIN_DATA) to the staging table, for
loading to LEDGER_STAT or;

= Your staging table has more columns

Use Express Administrator to modify the number of rows.

Defining the Parameters for FS.WM_MAP This dimension provides mapping
information between Budgeting & Planning and the staging table for the following:

= Associating Express dimensions with staging table columns where a one-to-one
correspondence exists

« Entering values for staging table columns where corresponding dimensions do
not exist

= Selecting the source value for dimensions that do not map to staging table
columns

Mapping Express Dimensions to Staging Table Columns

Use the FS.\WM_MAP dimension to set up the mapping associations between
dimensions in the Express database and columns in the staging table.

It is important to note that a strict one-to-one relationship does not always exist
between dimensions and columns. Where this relationship is non-existent you need
to instruct the program how to handle the mapping.

For example, an Express dimension for ACCUM_TYPE does not exist, therefore,
you need to enter the accumulation code in the DIM column of the FSWM_MAP
dimension.
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As another example, if multiple strategies exist in the Express database, you need to
filter the strategies so that you pass only the strategy you want to the staging table.
Selecting a value other than MOMENTUM (which is seeded) for the FS.STRATEGY
dimension or values other than BASE (also seeded) for FS.FORECAST and
FS.CURRENCY would illustrate this example.

Note also that values entered in DIM or COL do not necessarily correspond to
Express dimensions or FDM columns. DIM entries are either a dimension name or
an input value. COL entries are either a column name or a dimension value used for
filtering.

For new FS.WM_ENTRY dimension values or user-defined planning items some if
not all of the seeded mappings may require modification.

The following tables and diagrams provide additional information on these three
mapping scenarios:

Relationship 1 Description and Example

Express dimension A one-to-one relationship exists between an Express dimension and
maps to FDM an FDM column.

column

Examples of this relationship include Financial Element,
Organizational Units, and Chart of Accounts.

In the FSWM_CATALOG example rows 3, 4, and 6 illustrate this relationship, as
shown in the following table:

Row DIM COL
3 FS.FIN_ELEM FINANC_ID
4 FS.ORG_UNIT ORG_ID

6 FS.CHRT_OF_ACCT BP_COA _ID!

BP_COA_ID is a hypothetical, user-defined value
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Relationship 2

Description and Example

Express dimension
does not exist for an
FDM column

A column in the staging table does not have an equivalent dimension
in the Express database.

An example of this would be a user-defined column added to FDM
(and the staging table) but not used in Budgeting & Planning.
Another example would be the column CONSOLIDATION_CD or
ACCUM_TYPE_CD, which are seeded in FDM rather than added.

The LEDGER_STAT table cannot have null values. Therefore, if you
do not specify a value in the Express dimension (DIM column in the
example) the Express LEDGER_STAT writeback procedure inserts a
value of zero.

In the FS.WM_CATALOG example rows 1, 2, and 5 illustrate this relationship, as
shown in the following table:

Row DIM coL
1 A ACCUM_TYPE
2 300 CONSOLIDAT
5 0 GL_ACCT_ID

Relationship 3

Description and Example

Express dimension
values without
equivalent FDM
columns

Dimension values such as Strategy, Forecast, and Currency may not
have equivalent FDM columns in the staging table. In order to select
the data slice you want, you need to filter Budgeting & Planning data
before passing it to the staging table.

In the FS.WM_CATALOG example rows 7, 8, and 9 illustrate this relationship, as
shown in the following table:

Row DIM COL

7 FS.STRATEGY MOMENTUM
8 FS.FORECAST BASE

9 FS.CURRENCY BASE
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Mapping Your Chart of Accounts Dimensions
When you map your Chart of Accounts dimension you must:

« Enter the hierarchy identifier you want to use to distinguish between leaf and
node values — the writeback program writes only leaf values to the LEDGER _
STAT table.

In the FSWM_CATALOG example, the identifier for the Chart of Accounts
dimension is HI.AA67890.

If you populate the Chart of Accounts dimension in Express from a leaf field in
FDM other than COMMON_COA_ID note the following:

« Enter the name given to the leaf field in FDM. In the example, BP_COA _ID is a
hypothetical, user-defined leaf from FDM.

« The values for COMMON_COA_ID are read from the leaf setup table, based on
the values written to the user-defined leaf column. You do not need to specify
COMMON_COA_ID in the map to trigger this code

If you use the COMMON_COA_ID field to populate the Chart of Accounts
dimension in Express, insert COMMON_COA _ID in the COL cell corresponding to
the FS.CHRT_OF_ACCT value in the DIM column. The program logic that performs
a lookup of COMMON_COA_ID values is ignored in this circumstance.

Mapping Hierarchies

As with the Chart of Accounts dimension, for other dimensions having a
hierarchical structure you must enter the appropriate identifier so that the program
can distinguish between leaf and node-level values for that dimension.

In the example, the entry HI.AA12345 defines the leaf and node-level values for the
FS.ORG_UNIT dimension.

Selecting the Aggregation Code

Typically, one of two aggregation codes are used in FDM. Enter one of the following
two values in the DIM column for ACCUM_TYPE:

ACCUM_TYPE

Code Code Definition

A Aggregate

D Detail
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Defining the Parameters for FS.WM_ENTRY STD200 and STD300 are seeded dimension
values that pair with the consolidation code of 200 for budget values and 300 for
forecast values. These dimension values represent the seeded mapset entries in
FS.WB_CATALOG.

Seeded FDM Consolidation

Dimension Value Code Description
STD200 200 Budget values
STD300 300 Forecast values

When you create FS.WM_ENTRY dimension values (mapsets) for user-defined
planning items you can either copy the FS.WM_MAP values STD200 or STD300 or
enter values manually. You have the option of using predefined and user-defined
values in any combination.

Table Integrity and Data Rules When Setting Parameters
This section describes:

« The features of the writeback program that ensure LEDGER_STAT table
integrity

« Rules that maintain data consistency between Budgeting & Planning and FDM

Table Integrity
Table integrity refers to the following:
« Loading data to the LEDGER_STAT table only for leaf and financial element

values that have been defined in FDM and that exist in the FDM Leaf Setup
tables.

Leaf and node-level dimension values and financial elements that exist in
Budgeting & Planning but do not exist in FDM are not loaded to the staging
table by the writeback routine.

« Excluding orphaned dimension values in Budgeting & Planning from being
loaded to the staging table.

Only leaf-level dimension values contained in the hierarchy specified for use in
loading data and existing in FDM Leaf Setup tables can be loaded.

« Avoiding the creation of rows in the staging table for loading into LEDGER _
STAT that contain either all zeroes or all NA values in the Express database.
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Validating Budgeting & Planning Leaf and Financial Element Values In order to successfully
load data for Budgeting & Planning dimension values into FDM, the dimension
values must already exist in FDM as leaves or previously defined Financial Element
ID values. This approach ensures that the LEDGER_STAT table is insulated from the
introduction of data for leaf values that have not been established in FDM.

The writeback program excludes from the load to the staging table, data for
dimension values that do not exist in leaf setup, and writes most of those excluded
values to a log file (if you decide to create one). You also have the ability to run a
utility program, FS.WB_CHK_RJCT, that identifies values that will be rejected, in
advance of running the writeback program. You can use this utility to identify leaf
values that you will need to create in FDM in order to load data for them, prior to
running the program.

Validating Financial Elements

Valid financial elements begin with the single letter prefix of "F," followed by
numerical values matching the numerical values of financial elements in FDM.

The following table describes program behavior if you attempt to load an invalid
financial element:

If the financial element... Then the program...

Begins with "F" but the numerical values Does not load the data, writes the invalid
do not match financial element values in financial element to the log file (if created),
FDM. and proceeds to the next data element.

Begins with an alpha prefix other than "F"  Aborts

Note: If you plan to load a user-defined financial element with an 'F’
prefix, you must first add the financial element to FDM before running the
program.

Because certain types of invalid financial elements cause the writeback program to
abort, financial elements are validated first when the program is executed.

Validating Other Leaf Values

Other Budgeting & Planning dimension values, such as organizational units,
without equivalent values in the FDM leaf setup tables are treated as invalid. The
program writes those dimension values to the log file.
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Excluding Orphans and Nodes

The program excludes data for both orphan and node-level dimension values from
being loaded to the staging table. Orphan and node-level dimension values are not
written to a log file.

To distinguish orphan and node-level dimension values from leaf values the
program uses the hierarchy values you specify when the program is run.

FDM Columns Without Corresponding Express Dimensions When the staging table is
created in FDM using the scripts provided for that purpose, the columns that are
created will include the same columns that exist in the LEDGER_STAT table itself,
with the exception of the LEDGER_STAT table’s Year-To-Date columns (YTD_
01..YTD_12). While the majority of those columns are populated with
corresponding values from the Express database, several columns do not exist in
Express. These columns must still be populated with a value in the LEDGER_STAT
table, as the table and Oracle Financial Services Applications (OFSA) software do
not support columns with null values.

Columns that exist in LEDGER_STAT but not in Express are populated in the
staging table by the writeback program, using defaults that are entered with other
program parameters in FS.WM_CATALOG. For more information on FSWM_
CATALOG see "Setting Parameters for FSWM_CATALOG".

Zero or NA Values in Budgeting & Planning The program excludes from the staging table
any row of data in the application that contains either all zeros or NA.

Data Rules
Data rules refer to:

« Determining the definition of a fiscal year

« Aggregating year-to-date values for a fiscal year

« Specifying date ranges to load

Defining Fiscal Year Values If you use a fiscal rather than calendar year, the start and
end months chosen for the Budgeting & Planning load routine convert

automatically to the appropriate months for your fiscal year when loaded into the
staging table.

For example, data stored in Budgeting & Planning for October 1999 converts to
Month 1 if your fiscal year start month in FDM is 10.
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The fiscal year as stored in FDM governs the fiscal year definition, overriding the
Budgeting & Planning definition if they differ.

Calculating LEDGER_STAT Year-To-Date Values The LEDGER_STAT Load utility is used
to load data from the staging table to the LEDGER_STAT table. The routine
automatically calculates values for the year-to-date columns and populates them in
the LEDGER_STAT table, based on the monthly values loaded from the staging
table and the Aggregation Method specified in Leaf Setup for the Financial Element
dimension in FDM. These values are calculated based on the fiscal year definition in
the Fiscal Year Info table in FDM.

It is possible to have different fiscal year parameters established for FDM than those
established for the Express database. In this circumstance, the calculated
year-to-date values in the LEGDER_STAT table will differ from the aggregated
Quarter and Year time bucket values in the Express database.

Specifying Range of Dates to Load Any range of monthly time values can be loaded
from Budgeting & Planning to the staging table for subsequent loading to the
LEDGER_STAT table. The range is specified by populating the STARTMONTH and
ENDMONTH properties of the FS.WB_PROP dimension of FS.WB_CATALOG. For
more information on FS.WB_CATALOG see "Setting Parameters for FS.WB_
CATALOG".

Note the following regarding date range selection:
= Your date selection can span more than 12 months

« The selected data range can begin in one fiscal or calendar year and end in
another

Regardless of the range of monthly time values specified for loading, even if fiscal
or calendar year settings differ between Express and FDM, the writeback routine
maps the monthly buckets in Express to the appropriate time buckets in the staging
table, based on the FDM fiscal year definition reflected in the OFSA_FISCAL _
YEAR_INFO table.

Loading Data From User-Defined Planning Items

You can load data from a user-defined planning item following the principals
outlined in this chapter. Note, however, that the user-defined planning item must be
dimensioned by at least the following four dimensions:

« Chart of Accounts (FS.CHRT_OF_ACCT)
« Organizational Units (FS.ORG_UNIT)
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« Financial Element (FS.FIN_ELEM)
« Time (TIME)

If any of these dimensions do not exist in your user-defined planning item you will
not be able to load data from your planning item to the staging table.

Example of a Mapped Load Procedure

The diagram that follows illustrates mappings for a completed load procedure and
provides examples for each of the three dimension/column relationships discussed
in the section "Mapping Express Dimensions to Staging Table Columns" in this
chapter. It also includes other aspects of either the writeback procedure or the
LEDGER_STAT load utility in generating values for the LEDGER_STAT table.

In this example the start month is January, 1999 and the end month is December,
1999.

The following sections describe key aspects of the load procedure example.

One-To-One Relationships

Data in the table storing FS.FIN_DATA values have one-to-one relationships with
columns in the staging table and the LEDGER_STAT table.

Filtered Data

Filtered data from Budgeting & Planning is defined for FS.STRATEGY and
FS.FORECAST as MOMENTUM and BASE. Each has a single dimension value
specified for loading.

FDM Columns Without Express Dimensions

Four values in FSWM_CATALOG are FDM columns in the staging table and
LEDGER_STAT table but do not have corresponding dimension values in Express.
The LEDGER_STAT load utility enters default values for these columns unless you
specify an input value.
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Other Embedded Processes
The writeback procedure also generates program-driven values.

For example, the value input to the YEAR_S column in the staging table comes from
the monthly time values you load.

If the COMMON_COA _ID is not the FDM source field for the Chart of Accounts
dimension then the COMMON_COA _ID column is populated by performing a
lookup against FDM. The value returned is the COMMON_COA _ID value mapped
to the individual BP_COA _ID value in the FDM Leaf Setup tables that is the source
for the Chart of Accounts dimension. The program automatically performs this look
up therefore it is not necessary to explicitly mention the COMMON_COA _ID
column to trigger this functionality.

Note that in the following diagram BP_COA _ID is a hypothetical, user-defined leaf
field created in FDM.

The LEDGER_STAT Load utility is designed to calculate and write year-to-date
(YTD) values to the LEDGER_STAT table during the loading.
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Data stored in FS.FIN_DATA

FS.LS_WRITEBACK program

FS.ORG_UNIT
FS.CHRT_OF_ACCT
FS.FIN_ELEM
FS.CURRENCY
TIME JAN99
TIME FEB99
TIME MAR99
TIME APR99
TIME MAY99
TIME JUN99
TIME JUL99
TIME AUG99
TIME SEP99
TIME OCT99
TIME NOV99
TIME DEC99
Filtering FS.FIN_DATA Data
FS.STRATEGY MOMENTUM
FS.FORECAST BASE

Data input from FS.WM_CATALOG

ACCUM_TYPE D

CONSOLIDAT 200

GL_ACCOUNT_ID |0

IDENTITY_CODE

System-generated

Program-driven input

COMMN_COA_ID | Process - Lookup

YEAR_S

Process - Derived

v

Staging Table

ORG_ID

BP_COA_ID

FINANC_ID

ISOCRNCYCD

M1

M2

M3

M4

M5

M6

M7

M8

M9

M10

M11

M12

Data slice from FS.FIN_DATA

Data slice from FS.FIN_DATA

ACCUM_TYPE

CONSOLIDAT

GL_ACCOUNT_ID

IDENTITY_CODE

COMMON_COA_ID

YEAR_S

LEDGER_STAT Load stored procedure

\/

LEDGER_STAT Table

ORG_UNIT_ID

BP_COA_ID

FINANCIAL_ELEM_ID

ISO_CURRENCY_CD

MONTH_01

MONTH_02

MONTH_03

MONTH_04

MONTH_05

MONTH_06

MONTH_07

MONTH_08

MONTH_09

MONTH_10

MONTH_11

MONTH_12

Data slice from FS.FIN_DATA

Data slice from FS.FIN_DATA

ACCUM_TYPE_CD

CONSOLIDATION_CD

GL_ACCT_ID

IDENT_CODE

COMMON_COA_ID

YEAR_S

Iﬁ

Year-to-date values generated by the
stored procedure

y

YTD_01 through YTD_12
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Staging Table and LEDGER_STAT Column Names

Column entries for FSWM_CATALOG use abbreviated forms of the column names
in the LEDGER_STAT table. The following table compares the two:

Column Names for the Column Names for
Staging Table LEDGER_STAT
ACCUM_TYPE ACCUM_TYPE_CD
CONSOLIDAT CONSOLIDATION_CD
FINANC_ID FINANCIAL_ELEM_ID
ORG_ID ORG_UNIT_ID
GL_ACCT_ID GL_ACCOUNT_ID
COMMON_COA_ID COMMON_COA_ID

When mapping between the Express dimensions and staging table columns be sure
to use the abbreviated forms provided.

For user-defined leaves, however, you can create your own staging table column
names. You can find the abbreviations for user-defined leaves in the DBF_NAME
column of the OFSA_TAB_COLUMNS table.

Executing the Express Program
This section describes the following:

« Prerequisites to running the program

« Program script

Prerequisites to Running the Program
Before executing the Express program you must meet the following conditions:

« Attach FSBPTOOL read-only

« Attach the Super Administrator personal database read/write without
uncommitted changes

Use either the graphical interface or the command line in Express Administrator to
complete these tasks.
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It is important the you save your uncommitted changes before attaching the
personal database because the program detaches this database as part of the
process, which causes any uncommitted changes to be lost.

Either save your changes from the File -> Save command in the interface or issue an
Update command from the command line in Express Administrator.

FS.LS_WRITEBACK Syntax

Run the program from the Express Administrator command window, using the
following command:

FS. LS WR TEBACK(<db connect stri ng>, <wb_ent ry>, <bool ean: | og r ej ect s>)

where:
Entry Description
<db connectstring> <username>/<password>@<databasename>
where <databasename> is the name of FDM
<wb_entry> A valid FSWB_ENTRY value
<boolean: log rejects> YES = log rejected data

NO = do not log rejected data
The default setting is NO

The following is an example of an FS.LS WRITEBACK call:
call FS LS WR TEBAXK(’ of sa/ of sa@fsa’, 'BUDET , YES)

Executing the LEDGER_STAT Load Utility

Load data from the staging table to the LEDGER_STAT table using the LEDGER _
STAT load utility. Refer to the "FDM Utilities" chapter in the Oracle Financial Services
Installation and Configuration Guide for detailed instructions on completing the load
process.
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Important Information About the Load Utility
When preparing the load utility note the following:

= When you create the staging table be sure to set the table-creation script to load
all months rather than one month at a time

« The FS.LS WRITEBACK program populates the Is_load_batch table as part of
the procedure. You do not need to add entries to this table manually.

Executing the LEDGER_STAT Load Procedure for Budgeting & Planning
This section describes the final procedure to follow in completing the load process.

Execute a PL/SQL procedure (BP_LEDGER_STAT_WRITEBACK) in OFSA_UTIL.
Note the following arguments when you execute this procedure:

« p_sequence IN NUMBER is the SEQUENCE number identifying the row from
OFSA LS LOAD_BATCH to be loaded

= p_consolidation_cd IN NUMBER is either 200, 300, or 310

Before the procedure will run there must be a row in OFSA_LS LOAD BATCH
with SEQUENCE = p_sequence, and the LOAD_TABLE_NAME table should exist

and contain data.

For p_consolidation_cd...

The program takes the following action...

200 .

For p_consolidation_cd =200, rows in the LOAD _
TABLE_NAME table should have consolidation_cd =
200

For p_consolidation_cd = 200, DELETE from LEDGER_
STAT where consolidation_cd = p_consolidatioin_cd

300 .

For p_consolidation_cd =300, rows in the LOAD _
TABLE_NAME table should have consolidation_cd =
300

For p_consolidation_cd = 300, DELETE from LEDGER_
STAT where consolidation_cd = p_consolidation_cd

310 .

For p_consolidation_cd = 310, rows in the LOAD _
TABLE_NAME table should have consolidation_cd =
300

For p_consolidation_cd = 310, DELETE from LEDGER_
STAT where consolidation_cd = 310, then UPDATE
LEDGER_STAT set consolidation_cd = 310 where
consolidation_cd = 300
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Syntax for OFSA_UTIL.BP_LEDGER_STAT_WRITEBACK
The following is the syntax for this call;

1. Loginto SQLPIlus as the OFSA database owner.

2. Turn on messages:

SQ >set serverout put on

3. Execute the procedure, similar to the following example:

QA >execute ofsa_util.bp_| edger_stat_witeback (1,300)

In this example, the sequence number is "1’ and the consolidation code is *300.’

Arguments

« p_sequence IN NUMBER is the SEQUENCE number identifying the row from
OFSA_LS_LOAD_BATCH to be loaded

« p_consolidation_cd IN NUMBER is either 200, 300, or 310

Validate the Parameters
« p_consolidation_cd =200, 300, or 310 and:

« for p_consolidation_cd = 200, rows in the LOAD_TABLE_NAME table
should have consolidation_cd = 200;

« for p_consolidation_cd =300 or 310, rows in the LOAD_TABLE_NAME
table should have consolidation_cd = 300;

If an error occurs at this point, quit the procedure, otherwise continue
Delete LEDGER_STAT Rows

«  For p_consolidation_cd = 200 or 300, DELETE from LEDGER_STAT where
consolidation_cd = p_consolidatioin_cd

« For p_consolidation_cd = 310, DELETE from LEDGER_STAT where
consolidation_cd = 310, then UPDATE LEDGER_STAT set consolidation_cd = 310
where consolidation_cd = 300
Call OFSA_UTIL.LEDGER_STAT_LOAD

Execute this call.
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Setting up the Express Server

This chapter explains how to set up and run the Express server for the Budgeting &
Planning application.

Before an end user can log into the application the System Administrator, DBA, or
Super Administrator must set up the connection to and launch the Express server.
Noncompletion of either task rejects all log in attempts by end users.

Note: Refer to Oracle Financial Services Installation and
Configuration Guide for instructions on starting the Web Listener

Starting the Oracle Express Service

This section is intended for individuals such as System Administrators, DBAS, or
the Super Administrator. These individuals are responsible for setting up and
running the Express server.

Starting the service is a prerequisite that enables the Web Listener to connect to
Express databases.

Using Instance Manager

Begin the process by accessing the Express server. The following steps provide an
example in an NT environment.

1. Access the Instance Manager from this path:
Start/Programs/Express Server 6.3.0/Express Instance Manager

The Oracle Express Instance Manager interface appears.
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8-2

2. Expand the following nodes in this sequence — Network -> Express Servers — to
display the Express server to which you want to connect.

If the name of the server does not appear from the service menu, select the
Discover Nodes option. Enter the name of the server in the text box and click
OK.

Note that your organization may be using multiple Express server instances. Be
sure you know which instance is dedicated to the Budgeting & Planning
environment.

3. Double-click on the appropriate Express server name. The Authenticate dialog
box appears.

File ce
g Metwark
é—ﬁﬂ Express Servers

- |
T ~

Lzer 10 |

Passward :|

Diamain : |

Service ; l sm-ofsa-bp

oK Qancel] Help J

In this example, the server name is sm-ofsa-bp.
4. Type your User ID and Password. These are required entries.

5. Type a Domain entry if required for your organization’s overall system
environment.
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6. Click OK.

The dialog box closes, replaced by a hierarchical tree in the unshaded area of
the Instance Manager.

Note that an error message appears if you typed incorrect entries. Retry your
entries. If the error message persists, contact your System Administrator or
DBA.

Proceed to the next section to launch the Express server. This is also done from the
Instance Manager.

Running the Express Server
This task starts the Express server. To complete this task follow these steps:

1. Click Instance in the hierarchical tree. The Service State dialog box appears.

" Shutdown Normal
" Shutdown Ahort

Startup Parameters ;

~ Information

Oracle Express Server 6.3
Build : 71062
QS Family : WWin3z2
Flatform : Microsoft Windowes MNT
Copyright (C) 1996 - 1999 by Oracle Carp. All rights reserved.

Oracle Express Agent 6.3.0.0
Build : 71062
Host 05 Windows NT

2. Click the Service Start radio button.
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3. Click Apply. The light changes from red to yellow, indicating that the transition
has begun. When the light changes to green the server is running. Proceed to
the next step.

4. Click File -> Exit.

The steps in these two sections connect the Budgeting & Planning environment to
Express server and place the server in a run mode. Without both of these steps
completed end users cannot log in.
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Part Il

Using Budgeting & Planning

Part Il provides information for end users on how to use the application to enter
budgeting data and produce reports.

Audience

This section of the reference guide is written for individuals within your
organization who have direct responsibility for contributing data to the budgeting
process, including the following:

«  Super Administrator
« Sub-Administrators

« Business Unit Managers

Content
This section includes the following chapters:

« Chapter 9, "Logging In"

« Chapter 10, "Features of the Main Forecasting Window"
« Chapter 11, "Functions Available Through the Interface"
« Chapter 12, "Using the Selector"

« Chapter 13, "Using Input and Calculation Tools"

« Chapter 14, "Using the Maturity Mix End-User Interface"
« Chapter 15, "Generating Reports"
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Logging In

This chapter describes how to log in to the Web-enabled version of Budgeting &
Planning.

Prerequisites to logging in to the application include:

« Internet Explorer version 5.0 (or later) or Netscape version 4.72 (or later)
installed on your computer

« Jlnitiator 1.1.7.29 (Java plug-in) installed

« Universal Resource Locator (URL) used by your organization to access the
application. The URL should be provided to you prior to launching the
application the first time.

One of the prerequisites is a specific Java plug-in (JInitiator 1.1.7.29) that may not be
installed on your computer. If not, this chapter explains how to download and
install the plug-in. Once installed, you do not need to perform this task again.

This chapter presents the following topics:

« Launching the Application the First Time

« Downloading and Installing JInitiator for Internet Explorer
« Downloading and Installing Jinitiator for Netscape

« Logging In to the Application

« If Your Login Fails

= Troubleshooting
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Launching the Application the First Time

The Web environment for Budgeting & Planning requires a Java plug-in called
JInitiator 1.1.7.29. If not installed on your computer, the application provides
prompts to help you download and install this version on your computer.

Note: Before you enter the Budgeting & Planning URL the first
time, close all applications running on your computer.

Entering the URL to Launch Budgeting & Planning

Before logging in to the application you need to open your Web browser and enter
the application URL in the address field. The URL has a format similar to the
following:

http://bpserver/obpweb/obp.html

If you enter an incorrect URL the following types of messages appear, depending on
which browser you use:

Browser Message
Internet Explorer Page not found
Netscape The requested URL is not found

Verify that you entered the correct URL. If you did, then contact your DBA or
System Administrator for help.

Viewing the Pre-Login Page
After entering the application URL in the address field, a pre-login page appears,
which provides important information regarding Jinitiator.

Jinitiator is Installed

If your computer has Jinitiator version 1.1.7.29 installed, the text "Loading Java
Applet..." appears on the pre-login page, followed by the Connect to Express Server
dialog box. The login procedure begins at this point. See "Logging In to the
Application,"” for the steps to follow.

Jinitiator is Not Installed

If your computer does not have Jlnitiator 1.1.7.29 installed and you use Internet
Explorer as your browser, the application automatically begins the download and
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installation process from the pre-login page. Refer to "Downloading and Installing
JInitiator for Internet Explorer,” and follow the steps in that section.

If you use Netscape as your browser a puzzle piece appears on the pre-login page
with the text "Click here to get the plug-in." Refer to "Downloading and Installing
JInitiator for Netscape," and follow the steps in that section.

Server Does Not Respond

You cannot open your browser to begin the login process or download and install
JInitiator if the server is not running. A nonresponsive server generates error status
messages from both browsers.

If you are using Netscape, the message indicates that there is no response from the
server.

Metscape

There was no responze. The server could be down
of iz ot responding.

If you are unable to connect again later, contact
the server's administratar.

Using previously cached copy instead

If you are using Internet Explorer the message contains an introductory title
indicating that the page cannot be displayed.

@ The page cannot be displayed

The page you are looking for might have been removed or had its
name changed.

In the event that either of these messages appear, contact your System
Administrator or DBA to verify that the server is not running. If it is, other issues
may be preventing you from logging in, which will require additional help.
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Downloading and Installing Jinitiator for Internet Explorer

This section explains how to download and install Jinitiator 1.1.7.29 on your
computer using Internet Explorer.

1.

With your Internet Explorer browser open type the Budgeting & Planning URL
in the address field.

The pre-login page appears. Note the progress indicator on your status bar at
the bottom of your screen. When finished the Security Warning dialog box
appears.

Security Warning E

Do you want ta install and run "Oracle JInitistor signed on
51742000 3:52 P and distibuted by:

Oracle Corporatiorn

Publisher authenticity verified by YeriSign Commercial
Software Publizhers C&

Caution: Oracle Corporation asserts that thiz content iz
zafe. “ou should only installview this content if pou trust
Oracle Corporation to make that assertion.

[~ Always trust content from Oracle Corporation

More Info

Click Yes to initiate the download process.

Click Yes in the InstallShield Self-extracting EXE message box.

InstallShield Self-extracting EXE

Thiz will install Oracle Jinitiator 1.1.7.29. Do pou wish to continue?

This step launches the InstallShield wizard, which guides you through the
installation. Click Next in response to each prompt to accept the default
settings. The wizard then runs the installation.

Click Finish in the Setup Complete dialog box.

On the pre-login page the text "Loading Java Applet..." appears, followed by the
product screen and Connect to Express Server dialog box.
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You can now log in to Budgeting & Planning. See "Logging In to the
Application,” in this chapter for the steps to follow to complete your log in.

Downloading and Installing Jinitiator for Netscape

The section explains how to download and install JInitiator 1.1.7.29 on your
computer using Netscape.

Prerequisites
Before you enter the Budgeting & Planning URL be sure that you have:

« Enabled Java and Javascript
« Disabled SmartUpdate
« Removed SmartDownload (if present) from your computer

If you are unsure whether or not these elements are set correctly or whether
SmartDownload has been removed contact your DBA, System Administrator, or
Super Administrator for help.

Downloading Jlnitiator
This section describes how to download Jlnitiator to your computer:

1. With your Netscape browser open type the Budgeting & Planning URL in the
address field.

The pre-login page appears. Note the puzzle piece and text "Click here to get
the plug-in."

Click here to get the plugin

2. Click the puzzle piece to initiate the download.
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The Plug-in Not Loaded dialog box appears.

Plug-in Not Loaded [ %]

Information on thiz page requires a plug-in for:
application/s-jinit-applet;version=1.1.7.29

Mavigator can retrieve the plug-in for you fram:
fobpweb/obpijinit. html

The Smartlpdate feature makes it eazy to install new plug-ins. To
take advantage of Smartllpdate, you must enable Java, JavaScript
and Autolngtall in the Advanced panel of the Preferences, then
click the plug-in icon on the page.

‘what would you like to do?

et the Fiug-in | Cancel

3. Click Get the Plug-in.

The Jinitiator Download and Installation Instructions page appears. This page
contains the link that launches the download process.

4. Click the "Download Oracle JInitiator Installer” link.

The Save As dialog box appears with jinit11729.exe highlighted in the File
Name field. Download this file to your computer. This file contains the program
file that guides you through the installation process.

You have discretion in deciding where to place this file. The C:/Temp directory
may be the logical location.

Note: Remember where you place jinit11729.exe because you will
need to locate this file later to complete the installation task.

5. Click Save. The Saving Location progress indicator provides a graphic display
of the system’s progress in downloading the jinit11729.exe file.

6. Close the JInitiator Download and Installation Instructions page.

This enables you to access the pre-login page, which you will do in the next
section.
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Installing Jinitiator
This section describes how to complete the installation of JInitiator 1.1.7.29.

1.
2.

Locate jinit11729.exe and double-click the file.
Click Yes in the InstallShield Self-extracting EXE dialog box.

InstallShield Self-extracting EXE

Thiz will install Oracle Jinitiator 1.1.7.29. Do pou wish to continue?

This step launches the InstallShield wizard, which guides you through the
installation. Click Next in response to each prompt to accept the default
settings. The wizard then runs the installation.

Click Finish in the Setup Complete dialog box.
The application returns you to the location where you launched jinit11729.exe.

Click the puzzle icon in the pre-login page. Note that the text has changed to
"Click here after installing the plug-in."

"Loading Java Applet..." replaces the puzzle piece and text, followed by the
product screen and Connect to Express Server dialog box. See "Logging In to
the Application,” for information on beginning your log in.

Note: ’'After installing JInitiator you can delete the jinit11729.exe
file from your computer.

Logging In to the Application

Follow these steps:

1.

Open your Web browser and type the Budgeting & Planning URL in the
address field.

The pre-login page appears with the text "Loading Java Applet." This indicates
that JInitiator 1.1.7.29 has been installed and that you can log in to the
application without having to first download and install the plug-in.

If a puzzle piece appears on the pre-login page you must first download
JInitiator before continuing. Refer to "Launching the Application the First
Time," in this chapter, for the information you need.
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2. Type your username and password in the Connect to Express Server dialog box
and click OK.

The Planning Item Selector dialog box appears:

If... First... Then... And...
You have multiple Open the User Name list Select the Click
Oracle Financial box and select the user planning item you Continue.

Analyzer user names name you want to log in as... want to open...
assigned to you...

You have one user Select the Click
name assignment... planning item you Continue.
want to open...

The selected planning item interface and the Selector appear. Make your data
selections to begin your session.

Caution: During your session do not close your Web browser.
Doing so closes both your browser and the application, resulting in
loss of data.

If Your Login Fails
Common reasons for failing to log in:
= JInitiator 1.1.7.29 not installed
= Not able to connect to Express server

. Incorrect username or password

Jinitiator Not Installed

If you enter the Budgeting & Planning URL and your computer remains idle, look
for the puzzle icon on the pre-login page with text indicating that you need to get
the plug-in. Refer to the instructions specific to your browser for downloading and
installing Jinitiator 1.1.7.29.

If, after installing JInitiator, you still cannot log in, other problems are causing your
login to fail, which will require help from your DBA or System Administrator. Refer
to "Troubleshooting," in this chapter for additional information.
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Not Able to Connect to Express Server

The Express server needs to be running in order to log in to the application. If it is
not running your login will fail and you will receive an error message pertaining to
the status of the Express server and Web Listener.

I gu are not logged into express server

CQBP Error 30091: Login Failed! Please make sure that Express Server and Web Listener are
running.

You should contact your DBA or System Administrator to verify the status of the
the Express server. If it is not running, you will have to wait until it is restarted
before logging in.

Incorrect User Name or Password

You have entered your user name or password incorrectly if the Username and
Password Required dialog box appears.

The following steps describe what to do:

1. Enter your username and password again and click OK. You should perform
this step to verify that you did not enter either one incorrectly.

If either your username or password are invalid, the same dialog box reappears.

You must terminate the login procedure and exit the application. To do so,
proceed to step 2.

2. Click Cancel.

The "You are not logged into Express server’ message appears.
3. Click OK.

The Connect to Express Server dialog box reappears.
4. Click Cancel to close the login procedure.

5. Close the Budgeting & Planning interface (File -> Exit).
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The Exit Application dialog box appears.

I E xit Application

please close your weh hrowser immediately after exiting
BPF. Your lagin infarmation remains in your weh browser
memary until you close the browser.

@ Are you sure you want to exit the Application? IfYES,
s

6. Click Yes to exit the application.

7. Close your browser to completely terminate the session, then contact your DBA
or System Administrator for help.

Your Session Timed Out

The system automatically disconnects you if inactivity during your session reaches
the pre-set time limit established by your DBA or System Administrator.

If you receive either one of the following two messages, you have remained inactive
beyond the specified time parameter and your connection has been terminated.

WebAgent Timed Out Error Message:

I S elector Error E
QBP Error 30092: The WehAgent session is no longer available. It may have been -

terminated because itwas idle too long. Please shut down the internet hrowser and restart |
again. Any data since your [ast save will he lost. Contact your administrator to lengthen the
WegAgent Timeout Parameter, if necessary. -

I‘Waming: Applet Window
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Error Message:

Errar [4354]: Parsing errar. Level: Non-fatal Class: Express
=IDOCTYPE HTML PUBLIC "-HIETFADTD HTMLYEN"=

<HTML=

=HEAD=
=TITLE=(Oracle Express YWeh Agent=iTITLE=
=/HEAD=

=BODY bocolor="#FFFFFF"=

=P=

=img sre="foew-installlsampleiwahanner.gif* alt="0racle Express
Web Agent'==ip=

=5TROMG=AN errar occurred in the Oracle Express Web
Agent=iSTROMNG==/p=

=5TROMNG=EWA-00006: The session is no langer available. It may
have been terminated because it was idle toa long.

==

=ISTROMG= </BODY=

=HTML=

Click OK to clear each message, then exit the application. You cannot save any data
entries or calculations once the system disconnects you.

Note: You cannot save your entries or calculations when your
session times out, even if you accept the messages which appear to
indicate that the application is saving your work.

To continue using the application, start a new session by exiting Budgeting &
Planning, closing your browser, and re-launching the application.

Troubleshooting

This section explains how to provide diagnostic information to your DBA or System
Administrator.

If you continue having problems logging in to the application after downloading
and installing Jinitiator the approaches provided in this section may provide helpful
information.
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Diagnosing Jinitiator-Related Problems

Login problems may result from JInitiator-related issues other than installation of
the correct version. If your computer sits idle after entering the URL, look for either
the puzzle icon or the message "Loading Java Applet..."

If the puzzle icon appears, JInitiator has not been loaded or not loaded correctly.
Click the icon and follow the instructions to download and install the plug-in again.
You can also refer to the section in this chapter that explains how to download and
install JInitiator for the browser you are using.

If the text "Loading Java Applet..." appears, JInitiator has been installed. If your
computer remains idle while this text appears other issues may be causing your
login to fail.

Verifying the Installation of Jinitiator 1.1.7.29
You can verify the installation of JInitiator by following these steps:

1. Click Start and display the list of Programs on your computer.
2. Look for JInitiator Control Panel 1.1.7.29.

If you cannot locate this item and have completed the download and
installation steps, other problems may be preventing you from logging in,
which will require help from your DBA or System Administrator.

Diagnosing Other Problems

If you have installed JInitiator 1.1.7.29 and the application still does not start, you
can provide other information that may help your DBA or System Administrator
locate the problem.

1. Click Start and display the list of Programs on your computer.

2. Click JInitiator Control Panel 1.1.7.29.
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The Oracle JInitiator Properties dialog box appears.

Ega Oracle Jinitiator Properties [ [ %]
fBasic rnd\ranced rProxies |

[v] Enable Jinitiator

[C] Show Java Console

Network access | Applet Host - |
Java Run Time Parameters |—mx64m -Deache.size=50000000 |
Reset

3. Check Show Java Console.
4. Click Apply to enable the console, then close the dialog box.

5. Launch the application.

A Java Console appears on your screen providing information about the
Budgeting & Planning application. Conveying this information to your DBA or
System Administrator may help locate your problem.

To disable the Java console follow the preceding steps, and uncheck the Show Java
Console box.
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Features of the Main Forecasting Window

This chapter provides detailed information on the components of the main
forecasting window of the Financial Plans planning item. This chapter also
describes how to select dimension values for display in the interface and explains
how financial elements are filtered, based on the Chart of Accounts values you
select.

Note that some application interfaces, such as supporting interfaces like Interest
Rates, may vary from the main forecasting window, however, the procedures for
displaying data in the interface or paging through dimensions remain the same.

This chapter presents the following topics:

« Components of the Main Forecasting Window
= Selecting and Displaying Dimension Values

« Paging Through Dimension Values

« Displaying Financial Elements
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Components of the Main Forecasting Window

This section explains the components of the main forecasting window.

™ 5 a =
Iﬁ Sidh  dddh  ddw il % % ?
Strategy | Maormentur | Organizational Unit
e— Forecast | Bage Forecast
Chatt of Accounts J. Mortgage Fived 15 YR 30201
e TR e —e

» End Balance 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000) |
» Ending NetRate 0.0000] 0.0000/ 0.0000/ 0.0000] 0.0000 0.0000 0.0000 0.0000
» Ending Transfer Rate 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Average Halance 0.0000 0.0000 0.0000 0.0000 0.0000 0.0o0o0 0.0000 0.0000
» Avarage Net Rate 0.0000/ 0.0000/ 0.0000/ 0.0000/ 0.0000 0.0000 0.0000 0.0000
» Average Transfer Rate 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
+ Tatal Runoft Positive 0.0000 0.0000 0.0000/ 0.0000 0.0000 0.0000 0.0000 0.0000
» Total Runof Net Rate 0.0000 0.0000] 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Total Runof Transfer Rate 0.0000 0.0000 0.0000 0.0000] 0.0000 0.0000 0.0000 0.0000
» New Add Balance 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Mew Add Met Rate 0.0000 0.0000/ 0.0000/ 0.0000 0.0000 0.oooo 0.0000 0.0000

e— + New Add Transfer Rate 0.0000, 0.0000] 0.0000] 0.0000/ 0.0000 0.0000 0.0000 0.0000
» New Add Spread 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 10,0000/ 0.0000
» Interest 0.0000 0.0000 0.0000] 0.0000 0.0000 0.0000 0.0000 0.0000
» Charge/Credit 0.0000 0.0000 0.0000 0.0000 0.0oo0 0.oooo 0.0o0o0 0.0000
» Fee Income on Int, Bearing Acct 0.0000 0.0000/ 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Fee Income % 0.0000] 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Cur Pos Beginning Balance 0.0000 0.0000 0.0000 0.0000 o0.0oo0 0.0ooo 0.0000 0.00007
» Cur Pos Beginning Net Rate 0.0000 0.0000) 0.0000 _0.0000 0.0000 0.0oo0 0.0000 0.0000
» Cur Pos Beginning Transfer Rate 0.0000/ 0.0000/ 0.0000/ 0.0000/ 0.0000 0.0000 0.0000 0.0000
» Cur Pos End Balance 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Cur Pos Ending Met Rate 0.0000 0.0000 0.0000 0.0000 o.0ooo 0.0ooo 0.0000 0.0000
» Cur Pos Ending Transfer Rate 0.0000] 0.0000/ 0.0000/ 0.0000] 0.0000 0.0000 0.0000 0.0000
» Cur Pos Average Bal 0.0000 0.0000 0.0000, 0.0000] 0.0000 0.0000 0.0000 0.0000
¥ Cur Pos Average Net Rate 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
» Cur Pos Average Transfer Rate 0.0000] 0.0000) 0.0000) 0.0000) 0.0000 0.0oo0 0.0000 0.0000
+ Cor Pns Total Runoff Met Rate 7 0000n 00000 00000 00000 0n0an 00000 00000 ﬂﬂﬂlﬂ’ﬂ o

ancial Element |

The following table names and describes the window components:

1 Window Title Application name with the active planning item in
parentheses. The main forecasting window of the Financial
Plans planning item appears in this example.

2 Menu Bar Provides access to multiple, related functions for each item
on the bar.
3 Tool Bar Provides short cuts for performing the specific functions

represented by the icons.

4 Planning Item Dimensions Paging dimensions and dimension values.

5 Down dimension values Values for the Down dimension appear as rows in the grid.

6 Down dimension tile The dimension name for values occupying the rows in the
grid.
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7 Display grid

Data display area.

8 Across dimension values  Values for the Across dimension appear as columns in the

grid.

9  Across dimension tile The dimension name for values occupying the columns in

the grid.

10 Planning Item name

The planning item serving as the source for the dimensions
and dimension values and data appearing in the display
grid.

The following sections provide detailed information on the Menu and Tool bar

selections.

The Menu Bar

This section details the functions that you can perform from the Menu bar.

File Menu

Menu Item Description

Login Log in to the Budgeting & Planning application using this
selection. The login function can also be accessed from the Tool
bar.

Selector The Selector is the query tool used to retrieve subsets of data from
the database for the active planning item.

Save This menu item enables you to save data you have input and cash
flow calculation processes that you have run. By selecting this
item you also trigger the submit function, which submits your
saved data to the database.

Close Close a dependent planning item (such as Maturity Mix Override
or Interest Rate) using this menu item.

Exit Close the application using this menu item.
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Plan Menu

Menu Item Description

Financial Plans Open the Financial Plans planning item using this selection, if this
planning item is not already open in the main forecasting
window.

Optional Planning Open other planning items to which you have access from this

Items option.

Edit Menu

Menu Item Description

Copy/Paste Use these selections to copy and paste data in the display grid.

Options Menu
The Options Menu becomes active after you populate the main forecasting window

with data.

Menu Item Description

Spread Assumptions This is a dialog box that defines how to allocate node-level
data to leaves underneath that node.

Calculate This selection takes the values that have been input and
calculates results for the related financial elements (such as
earnings).

Calculate with Partial Solve  This selection executes the calculate routine and aggregates
data but only for hierarchy points affected by changes you
have input.

Calculate with Full Solve This selection executes the calculate routine and then
aggregates all points on all hierarchies (solving the entire
database) regardless of whether or not other nodes in the
hierarchy have been impacted by your changes.
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Menu Item

Description

Maturity Mix Override

This selection opens the Maturity Mix Assumptions
interface for end-user input of maturity mix and pricing
spread assumptions for new business.

Note that this planning item may not be available to all
users.

Interest Rate

This selection opens the Interest Rate interface to view
interest rate assumptions.

Note that this planning item may not be available to all
users.

Tools Menu

Menu Item

Description

Target Input

Choose this option to open the Target Input Tools dialog box.

Source to Target

Choose this option to open the Source to Target Input Tools dialog
box.

Show/Hide Reports

Choose this option to open and close the Reports list.

Help Menu

Menu Items Description

Contents Online documentation

Index Index of topics in the online documentation

Search for Help On

Not available

Oracle Financial Services
Library

Library of online documentation for the OFSA product suite

Using Help

Information on how to use online help.

About...

Information about this version of Budgeting & Planning.
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The Tool Bar

This section details the functions that you can perform from the Tool bar.

Icon

Label

Log in Dialog

Opens the Connect to Express Server dialog
box. This dialog box also serves as the log in
for the Budgeting & Planning application.

Xy

Close Variable

Closes a dependent variable (planning item).
This icon is disabled and greyed-out if a host
variable is open. When you close the
dependent variable the host variable remains
intact.

=

Selector

Opens the Selector query tool, which you use
to retrieve subsets of data for the active
planning item.

Save the Changes

Opens the Save Changes dialog box with the
option to either save or not save your
changes.

Show/Hide Reports

Opens the Reports list to view the list of
reports from which to make your selection. If
the Reports list is open, clicking this icon
closes it.

- Calculate Opens the Cash Flow Calculation dialog box
do with the option to either launch or cancel the
oo ob calculation process.
o Calculate with Partial  Opens the Cash Flow Calculation - Partial
,»':': i?x Solve Solve dialog box with the option to either
oo oo launch or cancel the partial solve calculation

process.
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Icon Label
= Calculate with Full Opens the Cash Flow Calculation - Full Solve
H i Solve dialog box with the option to either launch
oo mi or cancel the full solve calculation process.

Spread Assumptions  Opens the Spread Options dialog box, which
enables you to select spread options for
Time, Rate/Spread and Other dimensions.

Target Input Tools Opens the Target Input tools interface to
change existing data, based on the
calculation method selected.

A Source to Target Input Opens the Source to Target Input tools
Tools interface to either copy existing source data
@ to a target destination or perform
calculations on the source data to change it
as it is being sent to the target destination.
?

Help Provides access to online help for cash flow
calculations and Express.

Selecting and Displaying Dimension Values

Choose dimension values for the main forecasting window using the Selector. See
Chapter 12, "Using the Selector" for detailed information on how to use this tool.

Data is passed to the main forecasting window after you make your dimension
value selections and close the Selector.

Data appearing in the grid is governed by the following two factors:
« The active dimension values in the interface

« The dimension tiles controlling the column and row display
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Displaying Active Dimension Values

Only data for active dimension values can appear in the display grid of the main
forecasting window. Active dimension values are those that appear in the fields to
the right of the dimensions.

Change the active dimension value by clicking the arrow that opens the dimension
list box and then click a new value. This new selection appears in place of the
previous active value and changes the values in the display grid.

Controlling the Across and Down Display of Values

The Across and Down dimension tiles govern the data displayed in the display
grid. Refer to the illustration in the "Components of the Main Forecasting Window"
section for the location of these tiles.

Use your mouse to change the dimension values appearing in the columns and
rows.

To change values, begin by clicking the tile for the new dimension using the left
button of your mouse. With the button depressed, move that tile to position it over
the dimension being replaced and release the button. The two dimension tiles
switch position and data appearing in either the rows or columns of the grid
(depending on which tile you decided to replace) now reflects the dimension values
of the new tile.

You can also use this procedure to switch the positions of the Across and Down
dimensions in the interface.

Appearing below is the main forecasting window as it would appear with
Organizational Unit as the Across dimension and Chart of Account as the Down
dimension.

= Oracle Budgeting & Planning (Financial Plans) [_[7]x]

File

Plan Edit Options Tools Help

i [ & & & sn B @ 2
Strategy ‘Mumemum | Time |Vear2EII]EI v‘ Financial Plans
Forecast ‘ Basze Forecast | Currency Base Currency Organizational Unit
Financial Element J

» Retail 7710084

PEYAN » Retail - Morthern 7710087

» BR 961 Industry Drive 5013961

» Mortgage Fixed 15 YR 30201 0.0000 3350.4773 8453.5848 0.0ot
| Mortgage Loans 501900059 | | 0.0000, 135038.9828 412972.6900 000t
» Mortgage 1 YR ARM 30321 0.0000 B476E.8504) 262808.7682| 0.0ot
|+ Mortgage Fixed 20 YR 30202 I 0.0000 26517272 14848.0787 000t
» Mortgage Fixed 30 ¥R 30203 | 0.0000] 41884.3730 912931778 0.0ot
» Mortgage 31 ARM 30322 | 0.0000 1801.3302 40158071 0.000
| Mortgage 51 ARM 30323 0.0000 0.0000 25822 BSESY 0.0ot
» Mortgage 5125 Balloon 30324 0.0000 5751248 5729.9161) 000t
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Paging Through Dimension Values

You can change the data appearing either the rows or the columns of the grid by
selecting a new dimension value from the list box appearing to the right of each
dimension. Every time you choose a new value the data in either the rows or
columns changes. This action is called paging through the dimension values. The
current page of the interface displays only the active dimension values.

Displaying Financial Elements

Financial elements appearing in the interface are linked to the Chart of Accounts
values you choose using the Selector. Only the financial elements specified for a
particular Chart of Accounts value can appear in the interface. However, additional
filtering activities can further limit the financial elements displayed.

Filtering Financial Elements

The first way is through a variable called FS.FE_ENABLED, which designates
which financial elements appear in the interface and which do not. This is set at the
system administration level.

The second way is through the filtering capabilities built into the functionality of
the interface. This filtering can occur when you select a node-level value for the
paging dimension or when the Chart of Accounts dimension occupies either the
Across or Down dimension in the interface.

Filtering For Node-Level Chart of Accounts

If you select a node-level Chart of Accounts value, only the financial elements
common to all of the children of that node appear in the interface. When you
change the paging dimension from a node-level value to a leaf-level value then the
financial elements displayed are those unique to the leaf-level Chart of Accounts
value.

Filtering For All Node- and Leaf-Level Chart of Accounts

When the Chart of Accounts dimension is one of the paging dimensions, the
Budgeting & Planning application displays all of the financial elements that are: 1)
Linked to that Chart of Accounts value; and 2) Have been designated to appear
through the variable FS.FE_ENABLED. Each time you select a new value from the
Chart of Accounts dimension the application displays the set of financial elements
appropriate to that value.
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However, if the Chart of Accounts dimension is either the Across or Down
dimension, and the Financial Elements dimension occupies the opposite position,
the application displays only those financial elements that are enabled for all of the

currently selected Chart of Accounts values.
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Functions Available Through the Interface

This chapter explains common functions available on the Menu and Tool bars of the
main forecasting window.

The chapter presents the following topics:

« Allocating Spread Assumptions

= Running Calculation Routines on Data
« Using the Copy and Paste Functionality
« Saving Data Input and Calculations

= Submitting Data to the Database

« Accessing the Interest Rate Interface

«  Error Messages Text Box

Allocating Spread Assumptions

Access Spread Assumptions from the Options menu on the Menu bar or the Spread
Assumptions icon on the Tool bar.

If a value is input at a node level (the summarization of two or more dimension
values) the application needs to allocate that input value down to the lowest level.
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The Spread Options dialog box enables you to determine the allocation
methodology to use.

Spread Options
Time Time Period
" Spread Evenly Fehruary 1999 G
March 1999
® DayWeighted April 1999
May 1999 o
COther Dimensions Rate/Spread Infarmation
" Spread Evenly " Spread Evenly
@ |se a Time Periods Distribution ® Prorate
Cancel

The following table describes how the spread options in the interface perform the
allocation calculations.

Note that the last options selected in this dialog box are used for all calculations
during a session. If you want to use a different spread assumption method be sure
to open this dialog box and reset the values before running your allocation.

If you want to apply different spread options for different inputs the calculation
process must be run for each unique set of spread options.

Spread

Options

Selection Description

Time « Spread Evenly: This spreads the parent data value evenly over the child

time periods

« Day Weighted: This option performs day-weighting calculations on the
data value before returning the results to your worksheet
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Spread
Options
Selection

Description

Other
Dimensions

These options determine how dimension values other than the Time
dimension have amounts allocated to them. The two options are:

«  Spread Evenly: This apportions the amounts input at a node level
evenly over all subsidiary leaf levels.

« Use a Time Periods Distribution: This uses the time period specified in
the Time Period list box to apportion the amount based upon the % of
the total that each leaf value contributes for that time period.

The following grid shows how a node-level input of 10,000 is apportioned
using these two methodologies:

Time
Base Spread Periods
Month Evenly Distribution

West Side Division Jan 2000 Feb 2000 Feb 2000

Elm St. Branch
Consumer Loans 100 2500 1000
Construction Loans 200 2500 2000

Green St. Branch
Consumer Loans 300 2500 3000
Construction Loans 400 2500 4000

1000 10000 10000

Rate/Spread
Information

These options determine how node level rate information is allocated to
subsidiary leaves. These same two options exist for both rates and balances.
Note, however, that a different logic is employed for rates than for balances
when using a time periods distribution.

Time Period

Use the Time Period selection box to choose the time dimension value you
want to use. The selections from which to choose include all the Time
dimension values you established when you set up your budget. Your
selections are not limited to the Time dimension values chosen using the
Selector.
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Running Calculation Routines on Data

Access these calculation routines from the Options menu on the Menu bar or the
calculation-specific icon on the Tool bar.

This section describes how to use the following options:
« Calculate
= Calculate with Partial Solve

« Calculate with Full Solve

Considerations When Running a Calculation Routine
Note the following:

= Cash flow values are not calculated automatically, as you input data. To view
your results you must select one of these options and run the routine. All inputs
entered since the last time you launched a calculation routine are then
processed.

= You cannot open the Selector, exit the application, or submit your changes to the
shared database without first running one of these routines to calculate your
inputs.

Calculate

Using this selection you can launch the calculation process for each Chart of
Accounts / Organizational Unit combination for which data has been input. It does
not process data for any nodes above this combination.

Calculate with Partial Solve

The Calculate with Partial Solve option executes the calculate routine as described
above and aggregates data for all hierarchy points (nodes) impacted above it.
Where possible, it uses pre-aggregated node amounts for other hierarchy points.

The example in the following table illustrates how this process works. This example
uses the Organizational Unit hierarchy and the Commercial Loan account.
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The user inputs a new average balance (2000) and average rate (12%) for the EIm
Street branch.

COMMERCIAL LOANS Average Balance Average Rate
Total Bank **6500 **9.92%
Division 1 **2500 **11.4%
ElIm Street Branch *2000 *12%
Green Street Branch 500 9%
Division 2 4000 9%
Pine Street Branch 3000 8%
Palm Street Branch 3500 7%

* value input by the user
** new values calculated by the partial solve routine

Executing the Calculate with Partial Solve routine sums up the average balance for
all node points impacted by the change. In this example, the impacted node points
are Division 1 and the Total Bank.

The routine also weights the average rate by the corresponding average balance to
calculate the combined average rate. See the discussion of the physical data model
to understand how rates are associated with the corresponding balance.

Notice that, for Division 2, the sum of this division’s child nodes does not equal the
division balance nor is the average rate accurate, indicating that these values have
been input but not re-solved. The Calculate with Partial Solve uses the Division 2
balance in rolling up to the total bank. In this example, therefore, the average
balance at the total bank level is the sum of Division 1 ($2,500) and Division 2
($4,000).

This example shows that a partial solve is appropriate only if you are confident that
all the other hierarchy points have been satisfactorily solved.

To solve for all hierarchy points select the Calculate with Full Solve option.

Calculate with Full Solve

The Calculate with Full Solve option executes the calculate routine as described in
the other methods, and calculates all hierarchy points in the database over which
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you have control. It rolls up values whether or not they have been impacted by any
input values.

In the following table notice that the values for the Division 2 node have now been
updated, following the processing of the Calculation with Full Solve option.

Commercial Loans Average Balance Average Rate
Total Bank **9000 **8.56%
Division 1 **2500 **11.4%
ElIm Street Branch *2000 *12%
Green Street Branch 500 9%
Division 2 **6500 **7.46%
Pine Street Branch 3000 8%
Palm Street Branch 3500 7%

*value input by the user
** new values calculated by the solve routine

Note: Performance is significantly increased if you solve only
those values affected. You should consider using the Calculate with
Full Solve option only as a final check to make sure your data rolls

up properly.

Using the Copy and Paste Functionality

Access these functions from the Edit option on the Menu bar.

Use copy and paste to:

« Copy data from Budgeting & Planning to a spreadsheet application
« Paste data from a spreadsheet application to Budgeting & Planning

Note that the standard keyboard shortcuts (CTRL-C and CTRL-V) to copy and paste
data are not enabled for this release.
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Copying Cells From the Application Into a Spreadsheet

When you copy cells from Budgeting & Planning into a spreadsheet the column and
row labels and active paging dimension values associated with the highlighted area
are also pasted into the spreadsheet.

The following example shows a block of cells selected to be pasted into a
spreadsheet application. The highlighted section includes a subset of the Time and
Financial Elements dimensions.

Strateay ” Maomenturn | Organizational Unit H BR 036 Hillcrest 5014036 ‘
Forecast ”Elase Forecast | CUrrency Base Currency
Chart of Accounts ”Hume Improvernent Loans 38131 |
»Jan 00 » Feb 00 » Mar 00 » Apr 00 » hay 00 | ¥.Jun 00 »Jul 00 |+ Aug 00

» End Balance | 2840721 292.5821 346674 |
¥ Ending Net Rate 80245 8.0038 7.898
' Ending Transfer Rate 55279 5.5328 5.55¢
» Average Balance 2721608 288.7971 3 342374
|+ Awerage Met Rate 5.0473 8.0144 7.90¢
» Average Transfer Rate 55222 5.5305 5.55¢
| » Total Runaff Positive 56277 5.0644 5.98¢
» Total Runoff Met Rate 81163 8.0907 B.087
¥ Total Runoff Transfer Rate | 545378 5.5413 5 5.52¢
¥ New Add Balance 30.0000 14.4743 : 4 15.384
+ Mew Add Net Rate 75337 7.6337 7.63%

¥ New Add Transfer Rate 5 R337 56337 5.633
| ¥ Mew Add Spread 2.0000 2.0000 2.000
¥ Interest 1.8550 1.8338 2.297
F ChargeiCredit 1.2730 1.2655 1.3933 1.3836 1.4782 1.4730 1.5660 1.611

In the following spreadsheet you can see that:

« The column and row labels associated with the selected values, rather than the
entire selection of labels, have been pasted into the spreadsheet; and

« The paging dimensions and active values for those dimensions are pasted into
the spreadsheet

Strategy : Momentum
Organizational Unit : BR 036 Hillcrest 5014036
Forecast : Base Forecast
Currency : Base Currency
Chart of Accounts : Home Improvement Loans 38191

Mar00 Apr00 May00 Jun00  Jul00
End Balance 301.2313 3100233 318.9399 328.0442  337.2786
Ending Net Rate 7.9839 7.965 7.9469 79297 7.9135
Ending Transfer Rate 5.5376 55421 55465 55506 5.5548
Average Balance 297.1874 306.0045 314.7755 323.8845 332.9597
Average Net Rate 7994 79747 79562 79386 7.9219
Average Transfer Rate 5.5353 554 55444 55486  5.5528
Total Runoff Positive 6.0986  6.0424 6.129  6.1262 59944
Total Runoff Net Rate 8.0928 B8.0917 8.0927 8.0921 8.0875
Total Runoff Transfer Rate 5.5402 554120 55404 55411 5.528
New Add Balance 147479 148344 15.0656 15.2106  15.2288
New Add Net Rate 7.6337 76337 76337 76337 76337
New Add Transfer Rate 5.6337 56337 56337 56337 56337
New Add Spread 2 2 2 2 2
Interest 20122 20002 24212 21075 2.2341
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Pasting Cells From a Spreadsheet Into the Application

Note the following when pasting data from a spreadsheet application into a
Budgeting & Planning interface.

Paste Numeric Values Only

You can paste numeric values into the grid of the interface, but not text labels. If you
have used the copy function to extract data out of the grid and want to paste that
data back, select only the numeric values.

Paste Data In Read/Write Cells

The application allows you to paste data into cells designated as read/write but not
read-only. Values in read-only cells remain unchanged, even if your paste range
overlays them.

Select A Single Cell to Anchor the Paste Area

When pasting data into the grid use your mouse to highlight the cell representing
the upper left corner of the range of cells you want to paste. Then select the Paste
option from the Edit menu.

Note: If the range of cells you want to paste is larger than range
allowed by the grid the application returns an error message.

Error Message When the Range is Too Large Suppose you want to paste two
years of new business projections for a particular Chart of Accounts /
Organizational Unit combination into the grid. When you selected your Time
dimension values using the Selector you chose 12 months rather than 24 months.
The result of your paste operation will be an error message because your paste
range includes 24 months of data but the grid can only accommodatel2 months.

Rectify this situation in one of two ways. Either open the Selector and chose the
additional 12 months, or reduce the amount of data you want to paste to 12 months.

Avoid Pasting Data into the Maturity Mix Override Grid

The application has been designed to accept only manual entries in the grid of the
Maturity Mix Override variable. You cannot use the Paste function with this
interface.
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Storing Pasted Data

When you paste data into the grid, the application writes this data to the same
temporary storage that holds data you enter manually. When you launch a
calculation process, the application moves this data out of the temporary storage
and writes it to the Financial Plans planning item.

Saving Data Input and Calculations

If you have entered data and not run a calculation and saved your inputs you will
be prompted to calculate and save before you can perform any of the following
operations:

«  Opening the Selector
= Switching to another planning item
« Exiting the application

The intent of these prompts is to preserve the integrity of your inputs and make
sure that the cash flow financial elements affected by your inputs have been
updated.

The following sections provide explanations on the dialog boxes you may
encounter.

Perform Calculations Dialog Box

This dialog box prompts you to decide what you want to do with the data you have
entered.

I Perform Calculation

i You have entered at least one new value since the lasttime
iy wau performed a calculation. You must either perfarm a
calculation ar undo any changes since the last calculation
prior to submitting to the shared database.

Click Yes to perform a calculation with no solve.
Click Mo to undo all data entries since last calculation.

Mo )l Cancel )l
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If you click... The application...
Yes Processes your data and generates results using the No Solve calculation
option.

See "Running Calculation Routines on Data," in this chapter, for detailed
information on each of the available calculation choices.

No Removes all entered data from the interface from the time that you last
ran a calculation routine during your session to this point in time.

If you have not run a calculation routine during your session the
application reverses all of your entries.

Cancel Returns you to the interface without deleting any data or running a
calculation routine.

If you decide to run a Partial or Full Solve calculation routine, rather
than a No Solve routine, you can click Cancel then run the routine you
want.

Save Changes Dialog Box

This prompt asks you whether or not to submit your changes to the shared
database.

I 5 ave Changes

@ Do youwant to submit your changes?
ik

If you click... The application...

Yes Submits your data to the Task Processor, where it is queued with other
tasks and entered to the shared database.
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If you click...

The application...

No

Cancels the submission process.

During a session you may encounter this dialog box multiple times. You
can defer the submission of your data to the end of your session by
clicking No when you see this dialog box during the session and then
click Yes when you save your data to complete your session. This
submits all of your work at one time.

Note: If you decide not to submit your changes and exit the application any
input or generated data from calculation routines, since your last save, is
deleted and lost.

Exit Application Dialog Box

When you decide to exit the application (File -> Exit) the Exit Application dialog

box appears.

I E xit Application

please close your weh hrowser immediately after exiting
BPF. Your lagin infarmation remains in your weh browser
memary until you close the browser.

@ Are you sure you want to exit the Application? IfYES,
2

If you click...

The application...

Yes

Terminates your session.

Be sure to close your Web browser immediately after exiting the
application.

Returns you to the interface.

Submitting Data to the Database

End users using the Web-enabled version of Budgeting & Planning do not attach to
a personal database. When you complete your work and click Yes in the Save
Changes dialog box you submit your inputs and calculations directly to a Task
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Processor, which queues all data submissions, and enters them in order to the
shared database.

Caution: Once you submit your data and log out of the
application you cannot see your changes in the interface in
subsequent sessions until the Task Processor updates the shared
database.

After the Task Processor updates the shared database you can view your changes in
the interface. The schedule for updating the shared database is set by the Super
Administrator.

Accessing the Interest Rate Interface

Access the Interest Rate interface from the Options menu of the Menu bar of the
Financial Plans planning item.

This interface provides a reference for the interest rate assumptions being used by
your organization. You can only view this information. All cells are designated
read-only.

Page through the dimension values and switch dimension tile positions the same
way you perform these tasks in the main forecasting window.

& Oracle Budgeting & Planning (Interest Rates) [_[7]x]
File Plan Edit o Tools Helg
T o o » - v‘
[ B = ?
Interest Rate Seanario | Base Rate scen | rterest Rates
Interest Rate Type Transfer Pricing Yield Curve -
_rJan 00 _rFeb oo ¥+ Mar 00 » Apr 00 | rMay0g FJun 00 ‘Nu\ on .rAug on

¥ Term to Maturity - 1 Month 50090 5.0080 50090 5.0090 50090 5.0080 50090/ 5.0080
| » Term to Maturity - 2 Manth 1] 50390/ 5.0390 50390/ 5.030 5.0390) 5.0330 50390/ 5.030
» Term to Maturity - 3 Manth 50280 5.02680 50280 5.0260 510280 5.0260 50280/ 5.02680
|+ Terrm to Maturity - 4 Manth 5.0380 5.0280 5.0380 5.0280 SUESDf 5.0280 5.0380 5.0280
| » Term ta Maturity - 5 Month | 50470 5.0470 50470 5.0470 50470 5.0470 50470 5.0470
» Term to Maturity - 6 Month | 50470 5.0470 50470/ 5.0470 5.0470) 5.0470 5.0470) 5.0470
|+ Term to Maturity - 8 Month 51080 5.1080 51080 5.1080 51080, 5.1080 51080) 51080
' Term to Maturiy- 12 Morith ] 51890 51330 51390 5.1990 JERET 5.1990 51890 51080
¥ Term to Maturity - 24 Month 54310 55310 646310 55310 55310 55310 54310 55310
| » Term to Maturity - 36 Month 1] 56110/ 5.6110 56110/ 5.6110 56110 5.6110 56110/ 5.6110
» Term to Maturity - 48 Month 56610 5.6610, 56610 5.6610 SEBID 5.6610 56610/ 5.6610,
|+ Term to Maturity - 60 Month 57620 5.7620 57620 5.7620 57E2Df 5.7620 57620 5.7620
| » Term to Maturity - 84 Month | 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
»Term to Maturity- 120 Month | 52180, 6380 82180 £.3180 82180 82180 82180 6.2180
|+ Term to Maturity - 180 Month 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000; 0.0000
»Term to Maturity- 360 Month | | 82230 52230 52330 5.1230 52330 £.2230 82230 62230
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Error Messages Text Box

When an error occurs in the application, an error text box similar to the one shown
below appears:

[ESERROR [x]

Could not execute Express Server command.

ERROR: (INTERP1) FS.SAVE_CONTEXT is not a command.
In file HAPI_IN. 144151:

fs.save_context

n -

|»

The message contained in the text box describes the error you have encountered. If
you cannot resolve the error and need to contact Oracle Support, the Budgeting and

Planning application enables you to copy the text of this error message to an e-mail
or text file.
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Using the Selector

The Selector retrieves data from the Express database and passes this data to the
application’s main forecasting window. The Selector’s design includes a structured
interface to simplify data selection and a group of tools, built into the interface, that
enable end users to retrieve data using filtering criteria and analytical processes.

The Super Administrator assigns database access privileges to lower-tiered end
users. These privileges define the subset of data an end user can access through this
interface.

This chapter presents the following topics:
« Accessing the Selector Interface
« Components of the Selector Interface

« Using the Selector Tools

Accessing the Selector Interface

The Selector interface automatically appears when you log in to Oracle Budgeting &
Planning.

If you need to re-access the Selector during a session, follow this step:

From the main forecasting window select File -> Selector.
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Components of the Selector Interface

This section describes the components of the Selector interface.

E‘%Seleclol x|
Select values for:

0 Organizational Unit = = Bl E) (1 Bl = | 8t

Qrganize by:

MNone -

®© 6

Available {14 iterms of 14) Selected (1 item)
Qracle Bancorp - Qracle Bancarp
Commercial Lending L
Retail Banking >
Elm Street.
Arizona Avenue 4 __g
Redondo Blvd.

Highland Street
Treasury

b a

Support Units A

L% = |aa]

QK Cancel Help —e

1 Select Values For: Lists dimensions available for selection, including any
user-defined dimensions.

2 Organize By: Provides the option to show dimension values in the
Available box by hierarchical structure.

3 Available box Shows the dimension values available for selection.

4  Expand All/Contract Expand and collapse dimension values in the Available box
All arrows (operational when you choose the hierarchy option in the
Organize By: list box).

5 Find Value feature Provides a search engine to find entries in the Available box.

6  Operational buttons Enables you to either finalize your selections or cancel the
selection process.

Choose OK to finalize your selections and pass values to the
main forecasting window.

Choose cancel to exit the Selector without retaining any of
your selections.
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7 Help Accesses on-line help.
8 Selected box Shows the dimension values selected.
9  Selection arrows Moves selected values between the Available box and the

Selected box.

10 Selector toolbar Provides options for detailed and analytical data selection.

The following sections describe the use of each component.

Select Values For: List Box

Use the Select Values For: list box to choose the dimension from which you select
values for the main forecasting window. The following dimensions appear in this
list:

« Organizational Unit
« Time

« Chart of Accounts

« Strategy

« Forecast

« Currency

« N-dimension (custom, user-defined dimension)

Selecting the Dimensions from the Select Values For: List Box
To select dimensions follow these steps:

1. Click the arrow at the right of the dimension name to open the list box.
2. Click the desired dimension.

The values in the Available box change as you select different dimensions. The
Available box shows only the dimension values associated with the chosen
dimension.

The Financial Element Dimension is Not Listed The Financial Element dimension does
not appear in the list because Financial Element values are tied to the Chart of
Accounts values you select. You cannot select Financial Element values
independently.
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The Super Administrator defines the associations between Chart of Account
products and Financial Elements at implementation.

Organize By: List Box

Open the Organize By: list box to choose the option that displays dimension values
hierarchically in the Available box. You cannot use this option with dimensions that
have no hierarchical structure.

The Super Administrator creates the hierarchical options that you see in this list.

Available Box and Selected Box

The values that appear in the main forecasting window come from the Selected box.
You select these values by choosing them in the Available box and then moving
them to the Selected box. When you close the Selector the values chosen for each
dimensions are passed to the main forecasting window.

Displaying Dimension Values in the Available Box

Select values for the Available box by first choosing a dimension from the Select
Values For: list box. Both node and leaf-level values appear in the Available box.
The selected dimension governs the displayed values in the Available box. As you
select different dimensions the values in the Available box change.

The number of node and leaf values available for selection appear at the top of the
box.

Displaying the Selected Values
The Selected box holds the chosen dimension values.

Default Dimension Values In the Selected Box The application automatically puts the
first value of each dimension in the Selected box. This can be either a node or a leaf
value.

Hierarchical Structures Not Displayed The Selected box does not show dimension
values hierarchically.
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Selection Arrows for Moving Values Between the Available and Selected Boxes

Move values between the Available and Selected boxes using either the Selection
arrows or a combination of the Selection arrows and mouse. The method you use
depends on the number of values you want to move at a time.

Note: When you move values from the Available box to the
Selected box those values appear in the Selected box and remain in
the Available box.

When you move values from the Selected box to the Available box
those values disappear from the Selected box.

The following sections describe the steps for moving single and multiple values.

Moving Single Dimension Values
For single values use one of the two methods described in this section.

Method 1
To move a single value between boxes using the mouse, follow this step:

Double-click the value. It moves from one box to the other.

Method 2

To move a single value between boxes using the mouse and a Select arrow, follow
these steps:

1. Click the dimension value you want to move.

2. Click either the > or < arrow, depending on which way you want to move the
value.

Moving Multiple Dimension Values

For multiple dimension values use one of the methods discussed in the following
sections. The method you choose depends on whether the values are contiguous or
non-contiguous and whether you want to move individually-selected values or all
of the values, as a whole.

Moving Multiple Contiguous Values

For multiple, contiguous values use one of the two methods described in this
section.
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Method 1

1. Click the first dimension value you want to move, depress the left button on
your mouse and drag the cursor to the last value you want to move.
All of the selected values become highlighted.

2. Click either the > arrow or the < arrow, depending on which way you want to
move the values.

Method 2

1. Click the first dimension value you want to move.

2. Depress and hold the Shift key.

3. Click the last value you want to move.
The first and last values and all values between these two become highlighted.

4. Click either the > arrow or the < arrow, depending on which way you want to

move the values.

Moving Multiple Non-Contiguous Values

Use this method to move multiple, non-contiguous values between boxes.

1.
2.

Click the first value you want to move.

Depress and hold down the Control [Ctrl] key and click additional values with
your mouse. As you select these additional values they become highlighted.

Release the Control key and click either the > arrow or the < arrow, depending
on which way you want to move the values.

Moving All Values Between Boxes

To move all dimension values from one box to the other click either the >> arrow
(Add All) or << arrow (Remove All), depending on which way you want to move
the values.

Expanding and Contracting Hierarchies

Use the + and - buttons to expand or contract the hierarchical structure of
dimension values in the Available box. These buttons become functional when the
dimension has a hierarchical structure and you select the hierarchical option from
the Organize By: list box.
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These buttons expand and contract the entire structure. To expand or contract
individual node segments independent of the structure as a whole click the + or -
buttons appearing beside the node values themselves, in the Available box.

The application does not display dimension values hierarchically in the Selected
box.

Find Value (Search)

Use this feature to search for alphabetical and numerical values in the Available
box.

Example You want to find an organizational unit that contains the word "bank" in
the title but cannot remember the complete unit title. By typing "bank" in the entry
field the search engine finds all text values that include the word the desired word.
Results could include organizational units such as Bank Center, Bank Plaza or Retail
Banking. The engine searches for every instance of the dimension value that you
entered, including occurrences where the text appears within a word, such as
"banking."

The Find Value feature works the same way for numbers.

Launching a Search
To invoke a search, follow these steps:

1. Click the Find Value icon. The Find dialog box appears.
2. Type your search target in the entry field.

You can type either text, numbers or a combination, depending on how your
organization has named the dimension values you want to find.

3. Click either Find Next or Find Previous to start the search. If successful the
match appears, highlighted, in the Available box.

If the search engine cannot find a match a message appears in the lower left
corner of the dialog box.

4. Click either Find Next or Find Previous buttons to locate the next match. If only
one value matches your search that value remains in the Available box.
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Retrieving Previous Searches

The interface stores past search entries during a session. Retrieve these by clicking
the arrow at the right of the entry field and then clicking the search entry that you
want to use again.

Operational Buttons and Help

Use the operational buttons to either complete or cancel your selections. Click OK to
pass your selected values to the main forecasting window. Click Cancel to exit the
Selector without passing any values to the window.

Click Help to invoke the Help menu for the Selector.

Selector Tool Bar

The Selector tool bar provides additional techniques and methodologies for
selecting data. These tools enable you to perform complex, analytical database
queries.

For an explanation on how to use these tools, see "Using the Selector Tools" in this
chapter.

Passing Dimension Values to the Main Forecasting Window

After selecting values for each of the dimensions in the Select Values For: list box
pass these values to the main forecasting window by following this step:

Click OK in the Selector interface.

The Selector closes and the main forecasting window appears, displaying the
selected dimension values.

Using the Selector Tools

The tools on the Selector tool bar provide complex, analytical approaches to
selecting dimension values.

Tool Options

The Selector tools include those in the following list. They appear from left to right
on the tool bar.
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In the interface the names also appear when you point your cursor at an icon.
« Choose Values by Family

« Choose Values by Attribute

« Choose Matching Values

« Choose Values Meeting Value Conditions

« Choose Values Meeting Measure Conditions

« Choose Top/Bottom Values

« Sort

Unavailable Tools You cannot use grayed-out tools. A grayed-out tool indicates one of
the following two conditions:

= The tool is not applicable to the selected dimension

« The tool requires a hierachical display in the Available box

Common Functions in the Tool Interfaces

This section describes the common functionality found in the dialog box of each
tool. This functionality includes the;

«  Value selection list box

« Operational buttons

Value Selection List Box

Use the choices in this list box to perform the selection functions described in the
following table.

Selection  Description

Select Use Select when you want to select new values for a dimension.
This choice replaces any values already in the Selected box.
If no values have been selected for a dimension Select appears by default.

Add Use Add when you want to add more values to a group of values already in
the Selected box.

Add appears by default because the application places the first dimension
value for each dimension in the Selected box when you open the Selector.
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Selection  Description

Keep Use Keep to select the values you want to stay in the Selected box.

When you invoke this option all values not meeting the selection criteria are
removed from the Selected box.

Suggested use: When you want to keep a small number of dimension values.

Remove Use Remove to select the values you want to remove from the Selected box.

When you invoke this option all values meeting the selection criteria are
removed from the Selected box. The values not meeting the criteria remain.

Suggested use: When you want to remove a small number of dimension
values.

Operational Buttons
This section describes the operational buttons at the bottom of each dialog box.

Button Description
OK Puts the chosen dimension values in the Selected box.
Cancel Cancels the data selection process without retaining any dimension values,

closes the tool interface, and returns you to the main Selector interface.

Preview  Enables you to preview the selected dimension values before putting them in
the Selected box.

Help Opens on-line help.

Resizing a Tool Dialog Box

You can resize each of the tool dialog boxes using your mouse. To resize a box,
follow these steps:

1. Place your cursor over the side you want to resize.

2. When it becomes a line with dual arrows depress the left button on your mouse
and drag the side to either enlarge or contract the box.

3. When you reach the desired size, release the left button. The dialog box retains
the new size.
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How to Use the Selector Tools
Use the Selector tools to perform the following three types of activities:
« Selecting data by hierarchical structure, common attributes or matching values
« Selecting data using conditions and measures
« Sorting data in the Selector before closing the interface
Each tool performs one of these activities. The following sections describe what

each tool does and illustrates their functionality with examples.

About the Examples The examples used in these sections illustrate the basic
functionality of each tool. Because you can use multiple tools to select values for a
dimension and you have multiple selection parameters (such as select, add, keep
and remove) available, documenting all the possible permutations for each tool is
beyond the scope of this guide.

To understand and use the full range of features offered by these tools spend time
experimenting with them, using values from your own database so that the results
are meaningful for you.

Note, also, that the values used in these examples are not seeded values.

Selecting Data By Structure, Attributes or Matching Values
The tools described in this section include:

« Choosing values by family

« Choosing values by attribute

« Choosing matching values

Choosing Values by Family This tool enables you to select values according to their

relationships with other values in the dimension. Family references define the
relationships.

Family Relationship

Value Description
Entire Family Value This includes all the levels of the hierarchy from the top-most
value down.
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Family Relationship
Value

Description

Parent and Child Values

Sibling Values
Descendant and
Ancestor Values

Last Descendant Values

Self Value

Each dimension value in a hierarchy (except the top-most value)
has a parent value, which is the value directly above it in the
structure. The dimension values directly below a parent are
called its children.

The parent value is also known as a node.

Each parent value can have any number of children. Dimension
values that have the same parent are called siblings.

Each child value can also have children of its own, and so on.
Multiple levels of dimension values that roll up to a common
value are called descendants of that value, and the value itself is
known as the ancestor of the descendent values.

In structures with multiple levels of dimension values these are
the lowest dimension values. These are commonly referred to as
leaf values.

This is the value itself, whether at a node or leaf level.

Example 1

Goal Select all organizational units (leaf values only, not nodes) for Oracle

Bancorp.

Steps

1. Open the Selector interface if not already open.

2. From the Select Values For: list box choose Organizational Unit.

3. From the Organize By: list box choose the organizational unit hierarchy option.

This activates the Choose Values by Family icon and shows the dimension
values in the Available box in a hierarchical structure.
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Click the Choose Values By Family icon. The Choose Organizational Unit By
Family dialog box appears.

Ega[:hoose ‘F5.0RG_UNIT" By Family

|Se|ect

the family of |Oracle Bancarp J
relationship is

Ancestors

e |

Farent

Sihlings

Self

Children
Descendants
Last Descendants

QK Cancel)l Preview)l Help)l

Choose Select from the Value Selection list box, replacing the default setting of
Add.

From the relationship box select Last Descendants.

Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.

E‘%Pleview [ %]
Selected (6 items)
Elm Street.
Highland Street
Arizona Avenue
Redondo Blvd.
Deposit Processing

Loan Processing

Close Help

You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

Click OK to accept the dimension values and move them to the Selected box.
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Example 2
Goal Select all branches from the Retail Banking hierarchy.

Steps

1. Open the Selector interface if not already open.

2. From the Select Values For: list box choose Organizational Unit.

3. From the Organize By: list box choose the organizational unit hierarchy option.

This activates the Choose Values by Family icon and shows the dimension
values in the Available box in a hierarchical structure.

4. Click the Choose Values By Family icon. The Choose Organizational Unit By
Family dialog box appears.

5. Choose Select from the Value Selection list box, replacing the default setting of
Add.

6. Click the drill button (box with three periods) at the right of The Family Of list
box. The Select an Organizational Unit dialog box appears.

7. Choose Retail Banking from the list and click OK. Retail Banking replaces
Oracle Bancorp in The Family Of list box.

_ Ega[:hoose ‘F5.0RG_UMNIT" By Family

E‘%Selecl a Organizational Unit [ %]

Select -

Qrganizational Unit:

the family of | Oracle Bancarp

|»

=I0racle Bancarp

Commercial Lending Wherg th.e Entire Famnily
Bank Card Services BIEETERSILD 5
. . Ancestors
-F-.t!tiﬂ” Banking Parent
Elm Street. Siblings
Arizona Avenue Self
Rfadondo Blvd. I Children
Highland Street Descendants
Treasury Last Descendants
=1Support Units -
| =) &
Cancel Preview Help
Ok | Cancel)l Help J
e ——

8. Select Children from the relationship box.
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9. Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.

You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

10. Click OK in the Choose Values by Family dialog box to accept the dimension
values and move them to the Selected box.

Selecting Family Values for Other Dimensions

Follow the steps previously outlined to select values for other dimensions with
hierarchical structures.

Choosing Values by Attribute

This tool enables you to select values based on attributes.

The Super Administrator sets up and pre-defines attributes (relationships) during
implementation. You cannot create your own attributes.

This icon is enabled for all dimensions that have attributes. A hierarchical structure
is not necessary to activate the icon.

Example

Goal From the Chart of Accounts dimension select loans that use the
Amort.Reprice Balance Sheet Model attribute.

Steps

1. Open the Selector interface if not already open.

2. From the Select Values For: list box choose Chart of Accounts.

3. Click the Choose Values By Attribute icon. The Choose Chart of Accounts By
Attribute dialog box appears.

4. Choose Select from the Value Selection list box, replacing the default setting of
Add.
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5. Open the Where list box and choose Balance Sheet Model.

Ega Choose 'FS.CHRT_OF_ACCT" By Attribute

Select v|

where | Account Type -
Accrual Method

Balance Sheet Model —
Interest Rate Type
_Transfer Fricing Method

Direct Mon Int. Income
Alloc. Mon Int. Income
Direct Mon Int. Expense
Alloc. Non Int. Expense
Income Taxes
Statistical Count

QK | Cancel)l Preview)l Help)l

A dynamic association exists between the selection you make in the Where list
box and the attributes appearing in the box below this list. The attribute values
change as you make different selections from the Where list box.

6. Choose Amort.Reprice from the attribute values.

Ega Choose 'FS.CHRT_OF_ACCT" By Attribute

|Se|ect v|

All Chart of Accounts Yalues

where |Elalance Sheet Wodel v|

g 5| Bullet Fixed
Amaort. Fixed

.~ maott. Reprice
MNon Term
Mon Rate Related
Rollovers
Bank Card Model
PERSOMALLEMNDING

QK | Cancel)l Preview)l Help)l

7. Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.
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You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

Click OK in the Choose Values by Attribute dialog box to accept the dimension
values and move them to the Selected box.

Choosing Matching Values This tool enables you to select matching values using either
text or numerical filters.

Example

Goal Select all values, including node and leaf values, from the Chart of Accounts
dimension, that begin with the word "commercial.”

Steps

1.
2.
3.

Open the Selector interface if not already open.
From the Select Values For: list box select Chart of Accounts.

Click the Choose Matching Values icon. The Choose Matching Chart of
Accounts dialog box appears.

Choose Select from the Value Selection list box, replacing the default setting of
Add.

Open the list box showing the word contain and click start with.

Ega[:hoose Matching 'FS.CHRT_OF_ACCT"®

Select v|

contain
JUEIR start with
end with
nateh exactly

™ match case

QK Cancel)l Preview)l Help)l
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6. Type the word commercial in the text field.

7. Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.

You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

8. Click OK in the Choose Matching Chart of Accounts dialog box to accept the
dimension values and move them to the Selected box.

Selecting Data Using Conditions and Measures

These three tools enable you to select values that filter the data based on a value or
measure criteria.

These three tools include:
« Choosing values meeting value conditions
« Choosing values meeting measure conditions

« Choosing values at the top or bottom of a range

Choosing Values Meeting Value Conditions

The qualifying value conditions for this tool include:
= Greater than

« Greater than or equal to

« Equalto

« Notequal to

« Lessthan or equal to

=« Lessthan

« Between
= Outside
Example

Goal Select Chart of Accounts dimension leaf values from the Retail Banking unit
where the financial element New Add Spread is greater than or equal to 2% for the
month of September, 1998.
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This example also uses the Choosing Values by Family tool to arrive at the final
result.

Note: Normally the application automatically associates financial
element dimension values with the Chart of Accounts values you
select. When using this tool, however, you must select a specific
financial element value.

Steps
1. Open the Selector interface if not already open.
2. From the Select Values For: list box choose Chart of Accounts.

3. Click the Choose Values Meeting Value Conditions icon. The Choose Chart of
Accounts Meeting Value Condition dialog box appears.

4. Choose Select from the Value Selection list box, replacing the default setting of
Add.

5. Leave the Financial Data planning item selection unchanged.

6. Open the next list box containing the default value "greater than" and click the
selection "greater than or equal to."

7. Type 2 in the value text field. The interface recognizes the value as a percent.

8. Click the Dimension Values button to select the additional dimension values
(Time, Organizational Unit, and Financial Element). The Select Qualifying
Dimension Values dialog box appears.

Selecting the Time Dimension Value

a. From the Currently Selected Values box click the Time.

b. From the Choose A Value for Time box, click September 1998.
Selecting the Organizational Unit Dimension Value

a. From the Currently Selected Values box, click Organizational Unit.

b. From the Choose A Value for Organizational Unit box, click Retail Banking.
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The dimension you choose from the Currently Selected Values box appears
as the title of the box from which you choose your dimension values.

Egjl:hoose F5.CHRT_OF_ACCT" Meeting ¥alue Condition

Eg% Select Qualifying Dimension ¥alues [ %}

Currently selected values:

Time: September 19398 =
tional Unit:  Retail Banking where |Financial Data cube
Financial Element.  Beginning Balance
Strategy: Momenturm is | greater than or egqual to -
Forecast: Base Forecast i the value |2
Choose avalue for Organizational Unit: far

January 1988

|*

Oracle Bancor) -
R Organizational Unit:  Oracle Bancorp

Cammercial Lending

Financial Elernent:  Beginning Balance

Fetail Banking

Eim Street Strategy. Momentum
m Street.

Faorecast: Base Forecast -
Arizona Avenue |
Redondo Blvd. Dimension Yalues...
Highland Street
Treasury WiExclude zero values
Support Units =
%+ = ﬂ oK Cancel Preview Help

= | CanCEIJI = )I _

In this example, the title changes from Choose A Value for Time to Choose
A Value for Organizational Unit.

Selecting the Financial Element Dimension Value

a. From the Currently Selected Values box click Financial Element.

b. Click the Find Value icon and type new add spr ead in the text field of the
Find dialog box.

c. Click Find Next. The application locates the financial element and returns it
to the Choose a Value for Financial Element box.

d. Close the Find dialog box, then click OK in the Select Qualifying Dimension
Values dialog box.

Verifying the Strategy, Forecast and Currency Dimension Values

View the dimension values for the Strategy, Forecast, and Currency dimensions
to verify that these are the desired values for your task.

If these are the desired values, you do not need to take any action. If not, select
the appropriate values following the steps previously outlined for selecting the
other dimension values.
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Previewing the Subset of Data

Preview the subset of data. Note that the results include both node and leaf
Chart of Accounts values.

Ega Preview [ %]

Selected {16 iterns)
Total Assets

Loans

Commercial Lending
Commercial Loans Fixed
Commercial Loans Adjustable
Leasing

Other Commercial Loans
Mortgages

Fixed Rate Mortgages
Adjustable Rate Maortgages
Consumer Loans

Direct Auto Financing
Cther Installment Lending
Total Liabilities and Equity
Deposits

Term Deposits

Close Help

Close the Preview box when finished.

In this example you want to target Chart of Accounts leaf values. To filter out
node values, complete the steps in the section "Filtering Out Node Values from
the Chart of Accounts Data Set" which follows.

Filtering Out Node Values from the Chart of Accounts Data Set

1. Click OK to close the Choose Chart of Accounts Meeting Value Condition
dialog box. The results from the Preview box appear in the Selected box of
the Selector.

2. Open the Organize By: list box and choose the hierarchy option for Chart of
Accounts.

3. Click the Choose Values By Family icon to open the Choose Chart of
Accounts by Family dialog box.

4. Choose Keep from the Value Selection list box.
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5. Verify that the value in the family list box is the top-most value of the
hierarchical structure you are working with. If not, open the list box and
select the appropriate value.

6. From the relationship box click Last Descendants.

7. Click Preview to open the Preview box and view your new subset of Chart
of Accounts values.

Ega Preview [ %]

Selected (8 items)
Commercial Loans Fixed

Commercial Loans Adjustable
Leasing

Other Commercial Loans
Fixed Rate Mortgages
Adjustable Rate Maortgages
Direct Auto Financing

Cther Installment Lending

Close Help

These are the target Chart of Accounts leaf values for this example.
Close the Preview box when finished.
Passing Values to the Selected Box

Click OK in the Choose Values by Family dialog box to accept the Chart of
Accounts dimension values and move them to the Selected box. These are the
Chart of Accounts values that appear in the main forecasting window.

Other Value Options Using this Tool

You can also use this tool to select values within a range, such as New Add
Spreads between 1% and 2%. For this selection, open the list box defining the
value qualifier and replace the default value of "greater than" with "between."
The dialog box automatically adjusts, displaying two text fields. These fields
enable you to set the top and bottom range values.

Choosing Values Meeting Measure Conditions

Use this tool to compare a dimension value present in two variables of similar
structure and data.

The measure conditions for this tool include a combination of relative measures and
a numerical qualifier.
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The relative measures include:
«» Lessthan

« Greater than

= Within

« Not within

Users define the numerical measure using values such as 1, 2, or 3, (with the option
of defining the measure as a percent value) and the following two additional
measure conditions:

« Plus
«  Minus
Possible Scenario

Your organization completes budget forecasts for the upcoming year and wants to
be able to compare budget projections against actual performance as the year
progresses.

To do this your organization creates a new variable, called Budget, which mirrors
the structure of the Financial Data planning item. Upon completion of the
forecasting exercise the Super Administrator copies the budget projections from the
Financial Data planning item to the Budget variable.

After actuals are loaded into the Financial Data planning item, use the tool to select
values for a dimension by comparing the actual data in the Financial Data planning
item against budget data in the Budget variable.

For example, you can find all the organizational units from the Financial Data
planning item where the average balance for business lines of credit exceeded
budget projections stored in the Budget variable by 10% for the first quarter of the
year. Use the tool to select the relevant dimension values for each of the other
dimensions and the criteria. For Time, choose the appropriate quarter, for Financial
Element, choose Average Balance, for Chart of Accounts, choose business line of
credit. Continue selecting one dimension value for each of the remaining
dimensions.

An Example is Not Provided for this Tool

Providing an example for this tool requires two variables of similar structure. The
application seeds only one variable that can be used to illustrate how this tool
works. This variable is the Financial Data planning item. Therefore a specific
example using the tool itself has not been provided.
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Choosing Values at the Top or Bottom of a Range
This tool enables you to select data at either the top or bottom of a range, using a
numerical qualifier.

Example

Goal Select the three organizational units (leaf values) with the largest ending
balances for mortgage loans for the month of June, 1999. Then use these units as the
basis for comparing forecasted ending balances for the same organizational units
from January through December, 2000.

This example uses two Selector tools, Choose Values by Family and Choose Values
at the Top or Bottom of a Range. The order of use is reversed from previous
examples to illustrate how you can use different approaches in selecting a data set.

Steps The steps for this example are divided into the following four operational
processes:

« Selecting the organizational unit leaf values

= Selecting the three organizational units meeting the value criteria

« Selecting the remaining dimension values for the main forecasting window

« Modifying the data display in the main forecasting window to compare the
ending balances for June against forecasted balances

Selecting the Organizational Unit Leaf Values

1. Open the Selector interface if not already open.

2. From the Select Values For: list box choose Organizational Unit (default value).
3. From the Organized By: list box choose the hierarchy option.

4. Click the Add All arrow to move all organizational units to the Selected box.

5

Click the Choose Values by Family icon to open the Choose Organizational Unit
by Family dialog box.

6. Choose Keep from the Value Selection list box, replacing the default setting of
Add.

7. \Verify that the value in the family list box is the top-most value of the
hierarchical structure you are working with. If not, open the list box and select
the appropriate value.

8. Choose Last Descendants from the relation box.
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10.

Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.

You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

Click OK in the Choose Values By Family dialog box to accept the
Organizational Unit dimension values and move them to the Selected box.

Selecting the Three Organizational Units Meeting the Value Criteria

1.

Click the Choose Top/Bottom Values icon to open the Choose Top/Bottom
Organizational Unit dialog box.

Choose Keep from the Value Selection list box, replacing the default setting of
Add.

Leave the Financial Data planning item selection unchanged
In the field for the top value type 3. Leave the percent box unchecked.

Click the Dimension Values button to select the additional dimension values
from the Select Qualifying Dimension Values dialog box. These values further
define the selection criteria for the Chart of Account values.

The following table shows the dimensions and dimension values selected for
this example:

Dimension Dimension Values

Time June, 1999

Chart of Accounts Mortgages

Financial Elements End Balance

Strategy, Forecast, and Currency Default values (unless you want to select other
values for these dimensions)
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The interface of the Selector would appear as follows:

Ega[:hoose Top/Bottom 'FS_ORG_UMNIT®

Ega Select Qualifying Dimension Yalues [ %]

Currently selected values:

Time: June 1999

Chartof Accounts: Mortgages wihiere IFinanciaI Data cube ]B
Financial Element.  End Balance

Strategy: Momentum is in the tap [3 ]Dpercent
Forecast: Basze Forecast u and the bottorm [D ] [percent

Choose a value for Financial Element:
Beginning Balance a

Chart of Accounts: Mortgages

Eleginning Gross Rate Financial Element: Beginning Balance

Eleg?nn?ng Met Rate Strategy: Momenturn

Beginning Transfer Rate Forecast Base Forecast
Currency: Base Cur.

Ending Gross Rate

Ending Transfer Rate
Ayerane Bal u M Exclude missing values M Exclude zero values

4= @)

( QK ] [Cancel) (Preview) ( Help )
x ) v

6. Click OK in the Select Qualifying Dimension Values box to close it. The selected
dimension values appear in the interface of the tool.

7. Click Preview to open the Preview box and view your selected dimension
values. Close the Preview box when finished.

You can revise your selections at this point if you want to make any changes
before passing values to the Selected box.

8. Click OK in the Choose Top/Bottom Organizational Unit dialog box to accept
the three dimension values and move them to the Selected box.
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Selecting the Remaining Dimension Values for the Main Forecasting Window

1. From the Selector interface choose the following dimension values:

Dimension

Dimension Values

Time

June, 1999
January, 2000 through December, 2000

Chart of Accounts

Mortgages

Strategy, Forecast, and Currency

Default values (unless you want to select other
values for these dimensions)

Refer to "Selection Arrows for Moving Values Between the Available and
Selected Boxes" in this chapter for information on moving values between these

two boxes.

2. Click OK to close the Selector and move the data set to the main forecasting

window.

Modifying the Data Display in the Main Forecasting Window

When you close the Selector the following data set passes to the main forecasting

window:

Dimension

Dimension Values

Organizational Unit

The three units selected in the previous steps

Time

June, 1999 (in the first column)

January, 2000 through December, 2000 (in
succeeding columns)

Chart of Accounts

Mortgages

Financial Elements

End Balance

Strategy, Forecast, and Currency

Default values

The application displays the data in the main forecasting window in the default
setting, meaning that financial elements appear as rows and units of time appear as

columns.

For this example, exchange the Financial Element tile with the Organizational Unit
tile to display the three organizational units as rows and select End Balance as the

active financial element.
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To finalize the data display in the main forecasting window, follow these steps:

1. Place your cursor on the Organizational Unit tile and, using the left button on
your mouse, drag it to the Financial Element tile in the lower left corner of the
window.

When the Organizational Unit tile covers the Financial Element tile release the
button. The financial elements are replaced by the three organizational units.

2. Open the list box for the Financial Element dimension and choose End Balance.

The main forecasting window now displays the ending mortgage balances for the
three units for June, 1999 in the first column and forecasted ending balances for
January through December, 2000 in the succeeding columns.

5 Oracle Budgeting and Planning - Forecasting [super]

File Options

{ & B &l fu g ogu 7
Chart of Accounts Morgages ’ Financial Elerment End Balance -

Strategy Momenturm Faorecast Base Forecast

»Jun 98 »Jan 00 »Feb 00 » har 00 »Apr 00 - hilay 00 »Jun 00

+ Redondo Blvd.

40848.9857 513223140 51389.9324 520661157 52133.7340 52201.3524 53486.10(

+ Arizona Avenue

474590533 479008264 47963.9369 485950413 486581518 48721.2622 49920.36(

+ Elm Street.

38584.2224 383471074 39398.9482 38417.3554 39869.1961 40021.0368 41006.011

Other Selection Options Using this Tool

You can select two ranges of values if you want, a top range and a bottom range,
however, if you want to select one and exclude the other be sure that a zero appears
in the field for the excluded range.

If you leave a field blank an error message appears reminding you to enter a value.
This includes entering a zero.

Sorting Data in the Selected Box
The Sort icon enables you to sort data in the Selected box.

This icon becomes active when you move values to the Selected box.

Two examples are provided for this tool. The first example sorts Chart of Accounts
values. The second example sorts Time values.
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Example 1

Goal Sort by value the Chart of Accounts values selected in the example for the
Choosing Values Meeting Value Conditions tool.

Steps The steps for this example begin after the selections for the Chart of
Accounts leaf values selected for the previous example have been chosen.

E‘%Seleclm [ %]
Select values for:

AQOOOS )

Qrganize hy:

Available (47 items of 47) Selected (8 items)
= Total Assets = Commercial Loans Fixed
Cash Commercial Loans Adjustable
Short Term investment n > Leasing
Securities Porfolio ﬁl Other Commercial Loans
=ILoans Fixed Rate Mortgages
=l Commercial Lending ¢ Adjustable Rate Maortgages
Commercial Loans Fixed Direct Auto Financing
Commercial Loans Adjustable il Cther Installment Lending
Leasing A
& =) @

QK | Cancel)l Help)l

1. From the Selector interface click the Sort icon. The Sort dialog box appears.

2. Inthe "by" list box leave the selection "data value" unchanged (default value).
Additional options for this list box include Name, Hierarchy, and Level.
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3. From the "in order" list box leave the selection "high to low" unchanged. The

alternate option is "low to high."

E‘%Soll

Sort 'Chart of Accounts'

by |data value

i arder [high to low

using |Financia| Data cube

Qrganizational Unit:
Financial Element:

September 1998

Retail Banking
Mew Add Spread

Strateqy: Maormentum
Faorecast: Base Forecast
Currency: Base Cur.
Dimension Yalues...
[ Sortwithin hierarchy
QK | Cancel )l Freview Help )l

4. Click Preview to view the Chart of Accounts values resorted by New Add
Spread values, from high to low. Close the Preview box when finished.

Ega Preview

Selected (8 items)
Leasing

Direct Auto Financing

Cther Installment Lending
Adjustable Rate Maortgages
Commercial Loans Adjustable
Commercial Loans Fixed
Other Commercial Loans

Fixed Rate Mortgages

Close Help

5. Click OK in the Sort dialog box to accept the reordered Chart of Accounts
values and move them to the Selected box.
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Example 2

Goal Sort previously selected monthly Time values in chronological order.

For this example, assume that a business unit manager selects the last six months of
the forecasting budget year and passes these values to the main forecasting
window, along with other dimension values. After making this selection it becomes
necessary to include the first six months of the year as well.

The application’s design does not automatically rearrange Time values in
chronological order. In this example the first six months of the year appear after the
last six months when the second selection of time values is passed to the main
forecasting window.

The steps in the following section explain how to use the Sort tool to display these
Time values chronologically.

Steps The steps for this example begin after the selections for the Time values for
both the first and second half of the year have been selected and are not in
chronological order.

Open the Selector interface if not already open.
From the Select Values For: list box choose Time.
From the Organized By: list box choose the hierarchy option.

1.

2.

3

4. Click the Sort icon to open the Sort dialog box.

5. Open the "by" list box (default value is "data value") and select "hierarchy."
6

From the "in order" list box make the appropriate selection from the following
two options:

« Top to bottom
« Bottom to top

Note: The Sort tool does not provide a chronological option for
ordering Time values. It uses the ordering in the hierarchical
display for the sorting criteria. Therefore, by choosing "top to
bottom" you sort the Time values from the top of the hierarchical
structure (earliest month) to the bottom (last month).
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7. Click Preview to open the Preview box and view the reordered values. Close the
Preview box when finished.

8. Click OK in the Sort dialog box to accept the new ordering of the Time values
and pass this order to the main forecasting window.

Selecting Leaf Values for the Maturity Mix Assumption Interface

If you use any of these tools to select data for the Maturity Mix Assumption
interface you must include leaf values for all dimensions.

See the section entitled "Importance of Selecting Leaf Values" in Chapter 14, "Using
the Maturity Mix End-User Interface" for information on the reason for selecting

leaf values.
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Using Input and Calculation Tools

Budgeting & Planning provides a set of tools to assist users in creating initial
forecast or budget projections, adjusting existing projection values, and adjusting
source values while copying data from one location in the Financial Plans planning
item to another.

These tools enable you to generate projections for all data types including balance
sheet and non-interest income and expense line items, as well as triggering cash
flow processes and solve calculations derived from the generated values.

Business unit managers, budget administrators, sub-administrators and other
individuals responsible for creating budget plans will find these tools useful to
generate preliminary or revised results in an automated fashion.

These tools can be used for both individual business unit and account combinations
as well as combinations crossing multiple business units and accounts. After your
projections have been entered you can process them using cash flow and
aggregation (solve) calculations, either as individual values are generated or after
creating a series of projections using the tools.

Only from the Financial Plans planning item can be used with the Tools interfaces.
Values from planning items you create or other seeded Budgeting & Planning
planning items cannot be accessed in this release.

This chapter explains how to use the input and calculation tools to accomplish these
tasks, presenting the following topics:

« Features of the Input and Calculation Tools
« Inputting and Calculating Values

« Input and Calculation Methods Detailed
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Features of the Input and Calculation Tools

Features of the Input and Calculation Tools functionality include the following:

Two new interfaces provide the ability to define the generation of input values
to be used in subsequent calculations defined for the Financial Plans planning
item. The generated values are initially written to a temporary storage area, and
then are deleted as they are run through the calculation process.

The Target Input Tools Interface is used to generate target input values using
typical formulas available to support generating projections over time or
adjusting existing values up or down.

The Source to Target Input Tools Interface is used to generate input values by
copying existing values from another location, with an ability to adjust those
'source values’ up or down during the copy process

Source values can come from any location in the Financial Plans planning item
and can be written to any other location in the planning item. Source values can
be either historical or forecasted.

Inputs are generated for any future time period or periods for financial

elements that are designated as read/write in the interface. The target financial
element is specified at the time the process is launched. Users select a financial
element from a list of available financial elements. These financial elements are
based on the balance sheet model assigned to the individual accounts selected.

Values can be generated for individual leaf values, individual node values, or
all leaf values currently selected for target or destination values. Projected node
values are ‘pushed down’ to leaf level on a prorated or spread even basis when
calculations are processed.

Using the Tools interfaces, you also have the option of invoking a calculation
process after completing each data input task or completing multiple tasks and
invoking the calculation process once, which generates results for all data in a
single operation.

You can choose from three solve calculation options to roll up the results: No
Solve, Partial Solve, and Full Solve. These options roll up results exactly the
same way as the three solve options in the main forecasting window.

Input and calculation results are only submitted to the shared database after
closing the tools dialogs and either clicking the Save icon or selecting File ->
Save from the File menu option.
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Tools Interfaces

The following two interfaces support generating inputs and launching calculations:
« Target Input Tools
= Source to Target Input Tools

Note that for both interfaces, neither historical values nor future values (cells)
designated as read-only can be changed.

Target Input Tools Interface
This section describes the Target Input Tools interface.

1 I Target Input Tools

Select Method

|Rep|acetargetvalues with inputvalue v|

Enter Value Select Calculation Options

" Run Calculations

& -0 Salve e

!

‘  Partial Solve
= Full Solve
Select Target
Flanning ltem Financial Flans
Time |Allleafvaluesin status b

4

Organizational Linit |ER 471 Andrews Avenue 5010471

° Chart of Accounts |US Treasuries 10001 ¥
Strategy | Marmentum
Farecast |Ease Farecast
Currency |Base currency s

R P B S P

4

Financial Element | End Balance

e (Generate Inputsl

Cloge )l o
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1 Target Input Tools Interface title.

2  Select Method Lists input generation methods.

3  Enter Value Defines the modifying value.

4 Select Target List boxes holding currently selected dimension values; used
to select the combinations of dimension values you want to
change.

5 Generate Inputs button Initiates the input generation or input generation and
calculation process.

6 Close button Closes the interface.
7  Select Calculation Checking the Run Calculations box enables the listed solve
Options options.

The solve options allow you to choose whether or not to
aggregate values and, if so, to what extent. These selections
and the selections in the Options menu and Tool bar of the
main forecasting window are the same.
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Source to Target Input Tools Interface
This section describes the Source to Target Input Tools interface.

o—
o
°_

0—' Source to Target Input Tools
Select Method
|Copy source values v|
1
Enter Walue Enter Lag Walue Select Calculation Options
- :
Wi e Run Caleulations e
o Solve
‘ ‘ i Partial Salve
C Eull Salve
Select Target Select Source
Flanning ltem Financial Flans Financial Plans
Time |AII leafvalue.. v| |AII leafvalues in status v|
Organizational U..| B8R 471 Andr... =| || |BR 471 andrews avenue 5010471 v
Chart of Accounts |US Treasuri., v| |US Treaguries 10001 v| e
Strategy |M0mentum v| |ru10mentum v|
Forecast |Elase Forecast | |Elase Forecast |
Currency |Elase Curren... v| |Elase Currency v|
Financial EIement|End Balance v| |End Balance v|
I(Generate Inputs [ll Close a

Source to Target Input
Tools

Interface title.

Select Method

Lists copy methods.

Enter Lag Value

Defines a range of months for source Time values lagging
back from the target Time value.

Enter Value

Defines the modifying value.
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5  Select Target List boxes holding currently selected dimension values; used
to select the combinations of dimension values you want to
change.

6  Generate Inputs button Initiates the copy or copy and calculate process.

7  Close button Closes the interface.

8  Select Source List boxes holding currently selected dimension values; used
to select the combinations of source dimension values that
you want to copy from.

If you use the Time Lag feature, source Time values do not
need to be currently selected with the Selector.

9  Select Calculation Checking the Run Calculations box enables the listed solve
Options options.

The solve options allow you to choose whether or not to
aggregate values and, if so, to what extent. These selections
and the selections in the Options menu and Tool bar of the
main forecasting window are the same.

Opening the Interfaces
Open the interfaces using either of these two methods.

Menu Bar
From the Menu bar:

1. From the main forecasting window select Menu -> Tools.

2. Select the appropriate input and calculation tool.

Tool Bar
From the Tool bar click the icon for the interface you want.
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Inputting and Calculating Values

This section describes the sequential procedures you follow to generate input values
and calculate results for each Tools interface.

Note the following:

You can generate target values only for currently selected values in the Tools
interfaces

Once you have opened a Tools interface you cannot reopen the Selector to add
new values. You must close the Tools interface and then open the Selector. You
may be prompted to save your changes and calculate.

You can perform multiple tasks within each of the Tools interfaces. It is not
necessary to close an interface in between tasks.
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Process for the Target Input Interface
The following diagram shows the work flow for this interface.

Select Method

'

Enter Value

'

Select Target Dimension
Values

'

Select Calculation Options

i

Generate Results

'

Submit to the Shared
Database
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Select Method Choose the input or calculation method from the following list:
« Replace target values with input value

»  Keep current values

« Adjust current values by a percentage

« Adjust current values by an amount

« Grow by a percent

« Grow by an amount

« Percentage growth from prior year

« Target an ending value

« Annualize year-to-date amount

Refer to "Input and Calculation Methods Detailed" in this chapter for explanations

and examples of each method.

Enter Value This option is dynamic. Selecting a method such as Adjust Current
Values by a Percentage, which requires an input value, also enables the Enter Value
field.

Enter percent values as whole numbers. For 25% type 25, not .25. The application
converts the whole number to a percent.

Select Target Dimension Values Use the dimension list boxes to select values you want
to change when you click Generate Inputs.

The selection All Leaf Values in Status includes all leaf values, for the designated
dimension, that are currently selected. Node values remain unchanged when you
generate inputs using this selection without running the Partial or Full Solve.

You must run calculations with Partial Solve or Full Solve to roll up the results of
the leaf-level calculations to the appropriate node levels when using the All Leaf
Values in Status selection.

In performing an operation, you must choose either a single leaf, a single node, or
all leaf values currently selected.

If you want to use the interface to change values for leaves other than those
currently selected, you need to first close the Tools interface then reopen the Selector
and make your new choices. You may be prompted to save your changes and
calculate when you open the Selector.
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Select Calculation Options Check the Run Calculations box to enable the three
options. Use these options to process calculations based on generated inputs and
(optionally) to run solve routines. Select one of the three, based on the following
descriptions:

Option Result

No Solve Runs calculations without aggregating any node values.

Partial Solve Runs calculations and aggregates values for nodes impacted by
changes in leaf values.

Full Solve Runs calculations and aggregates values for all node values
whether or not they are impacted by the changes.

To launch the calculation routine, check the option you want to invoke and click
Generate Inputs.

Timing Your Cash Flow Processes

You have two basic options relative to processing calculations when you generate
inputs.

You can either:

« Generate inputs from the interface and write them to temporary storage for
processing later or;

« Invoke one of the calculation options at the time that you generate inputs.

To choose the first option click Generate Inputs while leaving the Run Calculations
box unchecked.

Note that if you select this option you cannot submit the generated values to the
shared database until you run a calculation process. After you run the calculation
process the application deletes these values from temporary storage and writes the
results to the Financial Plans planning item.

Constraints
The application requires you to select and run one of the calculation options before:
= Submitting your data to the shared database

« Re-opening the Selector
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« Choosing another planning item
« Exiting the application

If you try to perform any of these operations without first running a calculation
process the Perform Calculation dialog box prompts you to either run a calculation
process, undo your entries since your last calculation, or cancel your intended
operation. See "Perform Calculation Prompt" in this chapter for additional
information.

Running Calculations from the Tools Interface and the Main Forecasting Window

You can select the same calculation processes from either the Menu bar or Tool bar
of the main forecasting window. This can be helpful if you want to complete some
tasks using a Tools interface and then use the main forecasting window for other
tasks before processing calculations. This enables you to run your calculations one
time, for all entries.

The calculation processes are accessible from the main forecasting window only if
you first close the Tools interface.

Whether processing a calculation option from the Tools interface or from the main
forecasting window, all values temporarily stored are processed.

Generate Inputs Click the Generate Inputs button to generate the target value inputs
and run the calculation option selected in the Select Calculation Options box.

Note: Target inputs can only be generated for dimension values
designated read/write. Target inputs cannot be generated for future
values designated read-only or for time periods containing
historical data.

Submit to the Shared Database Submit your input and calculation results to the shared
database by:

1. Generating your inputs

2. Running the selected calculation option
3. Closing the Tools interface; and then

4. Saving your results.

You must close the Tools interface before you can submit your inputs and
calculations.

Using Input and Calculation Tools 13-11



Inputting and Calculating Values

Process for the Source to Target Input Interface
The following diagram shows the work flow for this interface:

Select Method

'

Enter Value Enter Lag Value

'

Select Source Dimension
Values

'

Select Target Dimension
Values

¢

Select Calculation Options

¢

Generate Results

l

Submit to the Shared
Database

13-12 Oracle Budgeting & Planning Reference Guide



Inputting and Calculating Values

Select Method Choose the input or calculation method from the following list:

» Copy source values

« Adjust source values by an amount

« Adjust source values by a percentage

Refer to "Input and Calculation Methods Detailed" in this chapter for explanations
and examples of each method.

Enter Value This option is dynamic. Selecting a method such as Adjust Current
Values by a Percentage, which requires an input value, also enables the Enter Value
field.

Enter percent values as whole numbers. For 25% type 25, not .25. The application
converts the whole number to a percent.

Enter Lag Value Enter an integer to define the range of months to lag from the target
time value to select the source time value.

Using the Time Lag feature disables the Time dimension in the Select Source
Dimension Values column.

Note: Time periods selected as the source or lag values do not
need to be currently selected.

See "Using the Time Lag Feature” in this section for more information.

Select Source and Target Dimension Values Use the dimension list boxes to select source
and target dimension values.

The selection All Leaf Values in Status includes all leaf values, for the designated
dimension, that are currently selected. Source values remain unchanged when you
generate inputs with this tool.

In performing an operation, you must choose either a single leaf, a single node, or
all leaf values currently selected.

If you want to use the interface to change values for leaves other than those
currently selected, you need to first close the Tools interface then reopen the Selector
and make your new choices. You may be prompted to save your changes and
calculate when you open the Selector.
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Select Calculation Options Check the Run Calculations box to enable the three
options. Use these options to process calculations based on generated inputs and
(optionally) to run solve routines. Select one of the three, based on the following
descriptions:

Option Result

No Solve Runs calculations without aggregating any node values.

Partial Solve Runs calculations and aggregates values for nodes impacted by
changes in leaf values.

Full Solve Runs calculations and aggregates values for all node values
whether or not they are impacted by the changes.

To launch the calculation routine, check the option you want to invoke and click
Generate Inputs.

Timing Your Cash Flow Processes

You have two basic options relative to processing calculations when you generate
inputs.

You can either:

« Generate inputs from the interface and write them to temporary storage for
processing later or;

« Invoke one of the calculation options at the time that you generate inputs.

To choose the first option click Generate Inputs while leaving the Run Calculations
box unchecked.

Note that if you select this option you cannot submit the generated values to the
shared database until you run a calculation process. After you run the calculation
process the application deletes these values from temporary storage and writes the
results to the Financial Plans planning item.

Constraints
The application requires you to select and run one of the calculation options before:
= Submitting your data to the shared database

« Re-opening the Selector
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« Choosing another planning item
« Exiting the application

If you try to perform any of these operations without first running a calculation
process the Perform Calculation dialog box prompts you to either run a calculation
process, undo your entries since your last calculation, or cancel your intended
operation. See "Perform Calculation Prompt" in this chapter for additional
information.

Running Calculations from the Tools Interface and the Main Forecasting Window

You can select the same calculation processes from either the Menu bar or Tool bar
of the main forecasting window. This can be helpful if you want to complete some
tasks using a Tools interface and then use the main forecasting window for other
tasks before processing calculations. This enables you to run your calculations one
time, for all entries.

The calculation processes are accessible from the main forecasting window only if
you first close the Tools interface.

Whether processing a calculation option from the Tools interface or from the main
forecasting window, all values temporarily stored are processed.

Generate Inputs Click the Generate Inputs button to generate the target value inputs
and run the calculation option selected in the Select Calculation Options box.

Note: Target inputs can only be generated for dimension values
designated read/write. Target inputs cannot be generated for future
values designated read-only or for time periods containing
historical data.

Submit to the Shared Database Submit your input and calculation results to the shared
database by:

1. Generating your inputs

2. Running the selected calculation option
3. Closing the Tools interface; and then

4. Saving your results.

You must close the Tools interface before you can submit your inputs and
calculations.
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Using the Time Lag Feature

This feature enables you to define your source data values (s) as a lagged or prior
time relationship to the target time period.

The following characteristics define this feature:

« Define the lag value using an integer rather than a date. The value for each
target monthly time period is the value copied or calculated from the earlier
time period which you specify using the monthly lag value.

« The target or destination Time dimension value is chosen from values currently
selected. This can include All Leaf Values in Status.

« Source Time dimension values do not need to be currently selected.

= Source values can be copied only to target destinations that are designated as
read/write.

This is an efficient way to use existing data from multiple combinations of
dimension values to create budget inputs. The feature can be used with any
methodology included in the Source to Target Input Tools interface.

Example The following scenario illustrates the use of this feature.

Scenario  Your organization wants to re-forecast its budget for the last six months
of the year using values from the first six months as the starting point,
then increasing those values by 5%.

The Time dimension values chosen through the Selector are July
through December. This represents the target destination.

The integer entered in the time lag feature field is 6. This instructs the
application to count back 6 months from the earliest month currently
selected, which, for this example, is July.

To simplify the illustration only one row is used in the following tables.
This represents the intersection of one chart of account and one
organizational unit.

The intent of this feature, however, is to perform calculations (or copy
data) across multiple combinations of chart of accounts, organizational
units, and other dimension values in a single operation.
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The following table shows the forecast values as they might currently exist. The
shaded months are the target (forecast) months. These are the months to be
adjusted.

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

Current Actual 1000 2000 3000 2500 O 1150 1275 500 2600 2375 3380 4200
and Forecast
Values

The first six months are the source values. These values are adjusted by 5% to arrive
at the new values for the second six months.

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

Current Actual 1000 2000 3000 2500 O 1150 1275 500 2600 2375 3380 4200

and Forecast

Values
(1000 (2000 (3000 (2500 (O* (1150 No calculations are performed against
*5%) *5%) *5%) *5%) 5%) *5%) source values for these months
+1000 +2000 +3000 +2500 +0 +1150

Calculations =1050 =2100 =3150 =2625 =0 =1207

The new forecast values are written to the target destination, overwriting the
pervious forecast values.

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec
Old Values 1000 2000 3000 2500 O 1150 1275 500 2600 2375 3380 4200

New Forecast 1000 2000 3000 2500 O 1150 1050 2100 3150 2625 O 1207
Values (shaded)

Perform Calculation Prompt
You cannot perform the following tasks without first running a calculation process:

= Submitting your data to the shared database
= Re-opening the Selector
= Choosing another planning item

« Exiting the application
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If you try to perform any of these tasks the Perform Calculation dialog box prompts
you to either run a calculation, undo your entries, or cancel the operation.

I Perform Calculation

i You have entered at least one new value since the lasttime
¢ wau performed a calculation. You must either perfarm a
calculation ar undo any changes since the last calculation
prior to submitting to the shared database.

Click Yes to perform a calculation with no solve.
Click Mo to undo all data entries since last calculation.

Mo )l Cancel )l

If you click... the application...
Yes Runs calculations using the No Solve calculation option.
No Reverses your data entries and any target inputs created using the

Generate Inputs function.
The extent of the reversal depends on your previous task:

« Ifyou entered data or generated target inputs using the Generate
Inputs function without selecting and running a calculation option,
then the application reverses all entries from the time you began
your session.

« Ifyou entered data or generated target inputs, then ran a
calculation option the application reverses your data entries and
target inputs from that point forward.

Cancel Returns you to the main forecasting window and also retains your
entries and results from the Generate Inputs function.

If you try to exit the application without first running one of the three calculation
options the Exit Application dialog box follows your selection in the Perform
Calculation dialog box. This second dialog box asks you to confirm your decision to
exit the application. It also provides an important reminder to close your browser
after exiting.
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Click Yes to exit or No to return to the main forecasting window.

I E xit Application

It Are you sure you want to exit the Application? ITYES,
dy] please close your weh hrowser immediately after exiting
BPF. Your lagin infarmation remains in your weh browser
memary until you close the browser.

Input and Calculation Methods Detailed

This section provides detailed descriptions of each predefined input and calculation
method. These methods are categorized according to the Tools interface in which
they appear and then are listed alphabetically.

Target Input Tools Interface

This section lists the input and calculation methods for this interface in alphabetical
order.

Using Input and Calculation Tools 13-19



Input and Calculation Methods Detailed

Adjust Current Values By a Percent

Description Increase or decrease current values on a percentage basis by the value you input in the

Example 1

Formula

Enter Value field.

The application converts your input value to a percent. A positive value increases the
new target value relative to the existing value. A negative value achieves the opposite
result.

Add to or increase the values for March, April, and May by 10%.

March April May
Old Values 100 110 120
New Values 110 121 132
March 110 = (100 * 1.1)
April 121 =(110*1.1)
May 132=(120*1.1)

If the existing value is zero, zero is written to the Express database (0 * [Input
Percentage] = 0).

[Current Period New] = [Current Period OId] * (1 + ([Input Amount] / 100))
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Adjust Current Values By an Amount

Description Increase or decrease existing values by the value you input in the Enter Value field. A
positive value increases the new target value relative to the existing value. A negative
value achieves the opposite result.

Example 1

Example 2

Formula

Add to or increase the existing values for March, April, and May by 25.

March April May
Old Values 100 110 120
New Values 125 135 145
March 125 = (100 + 25)

April
May

135 = (110 + 25)
145 = (120 + 25)

Add to or increase existing values where some cells are either 0 or NA.

March April May
Old Values 100 0 0 (NA)
New Values 150 50 50

March
April
May

150 = (100 + 50)
50 = (0 + 50)
50 = (NA + 50)

Cells with 0 or NA as current values are replaced with the input value.

[Current Period New] = ([Current Period OId] + [Input Amount])
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Annualize Year-to-Date Amount

Description Annualizes year-to-date values for future time periods remaining in the current year,

Example 1

as designated by the Forecast as-of-date.

Example 1 illustrates this calculation method for all financial elements except Ending
Balance (F100) and Average Balance (F140). In this example actual values are available
for four months (January through April) of the current year. You want to input values
for the remaining eight forecast months using the year-to-date value as the basis for
the calculation.

Actual Values:

Jan Feb Mar Apr YTD
Actual Values |100 125 150 200 575

Monthly Forecasted Values Based on the Actual YTD Values:

May Jun Jul Aug Sep Oct Nov Dec

Forecast |146.75 |146.75 |146.75 |146.75 |146.75 |146.75 |146.75 |146.75
Values

Process:

The sum of the values for the actual months is 575. The total number of days over this
period is 120:

January |February | March April YTD
Values 100 125 150 200 575
Days in Months |31 28 31 30 120

The number of monthly forecast periods is eight.
The calculation to determine the eight forecasted monthly values is:
(((575) / (120) * 365) - (575) / 8 = 146.7448

with the value 146.7448 written to database and reflected in the interface (146.75 in the
table).
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Formula

Example 2

Formula

[Each current year forecast period] = (((Sum of monthly actual period values) / (Total
number of days in monthly actual periods) * Total number of days in year) - Sum of
monthly actual period values) / Number of monthly forecast periods

Example 2 illustrates this calculation method for Ending Balance (F100)

In this example actual ending balances are available for four months (January through
April) of the current year. You want to input values for the remaining eight forecast
months based on the calculation method used for ending balances.

Actual Values:
Jan Feb Mar Apr

Actual 100 125 150 200
Values

Monthly Forecasted Values Based on the Actual YTD Values:

May Jun Jul Aug Sep Oct Nov Dec

Forecast | 200 200 200 200 200 200 200 200
Values

Process:

The value used for the forecast period is the last historical value (as-of-date). In this
example, the last historical ending balance value is 200, therefore that becomes the
ending balance for the forecasted periods.

No formula is associated with annualizing ending balances.
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Example 3

Formula

Example 3 illustrates this calculation method for Average Balance (F140).

In this example, actual average balances are available for four months (January
through April) of the current year. You want to input values for the remaining eight
forecast months by annualizing the actual values.

Actual Values:

Jan Feb Mar Apr
Actual Values 100 125 150 200

Monthly Forecasted Values:

May Jun Jul Aug Sep Oct Nov Dec

Forecast |143.75 |143.75 |143.75 |143.75 |143.75 |143.75 |143.75 |143.75
Values

Process:

The value used for the forecast periods is the actual year-to-date, day-weighted
average balance. The number of days in each month are multiplied against the average
balance for each month. Each calculated value is then summed and divided by the
total number of days in the historical period:

January | February | March | April Sum
Values 100 125 150 200
Days in Months |31 28 31 30 120

Calculated Value |3100 3500 4650 6000 17250

The number of monthly forecast periods is eight.
The calculation to determine the eight forecasted monthly values is:
((100%31) + (125*28) + (150*31) + (200*30)) / 120 = 143.7500
with the value 143.7500 (143.75 in the example) written to each forecast month.

[Each current year forecast period] = (Sum of average balance * days in month for each
actual period) / Sum of days in month for each actual period
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Grow By a Percent

Description Increments the value from the prior period on a percentage basis by the value you

Example

Formula

input in the Enter Value field.

The application converts your input value to a percent. A positive input value
increases balances and a negative input value decreases balances.

Increment by 10% for the months of March, April, and May starting with a beginning
balance of 1000 in February. For this example input 10 in the Enter Value field. The
application automatically converts the integer to percent and applies the appropriate
formula to increment the value correctly.

February March April May
1000 1100 1210 1331
March 1100 = (1000 * 1.1)
April 1210 = (1100 * 1.1)
May 1331 =(1210*1.1)

If the value in the starting time period (in this example, February) is zero, this method
fails and the following message appear:

This calculation does not return any values

[Current Period] = ([Prior Period] * (1 + ([Input Amount] / 100)))
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Grow By an Amount

Description Increments the value from the prior period by the value you input in the Enter Value
field. A positive input value increases balances and a negative input value decreases

Example 1

Formula

balances.

Increment by 100 for the months of March, April, and May starting with a beginning
balance of 1000 for February.

February March April May
1000 1100 1200 1300
March 1100 = (1000 + 100)
April 1200 = (1100 + 100)
May 1300 = (1200 + 100)

If the value in the starting time period (in this example, February) is zero, the March
value becomes the input value (200) and succeeding months are incremental from that
starting point.

February March April May
0 200 400 600
March 200 = (0 + 200)
April 400 = (200 + 200)

May 600 = (400 + 200)

[Current Period] = ([Prior Period] + [Input Amount])
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Description

Example

Formula

Description

Example

Formula

Keep Current Values

Use this selection to run the cash flow engine using existing values in the database and
a selected financial element for the calculation driver. You must select a calculation
option when using this method.

If you make changes in your rate forecast you can use this option to rerun the cash
flow engine, selecting a financial element such as Ending Balance for the calculation
driver.

Not Applicable

Percentage Growth from Prior Year
Calculates target values by multiplying the value in the same month of the prior year
by one plus the value you input in the Enter Value field.
Use this method to incorporate seasonal fluctuations into your budget planning.

The application converts your input value to a percent. A positive input value
increases balances and a negative input value decreases balances.

You do not need to select prior year values when you use this method. The application
automatically selects the appropriate Time dimension values from the preceding year.

Forecast 10% growth from the prior year. For this example input 10 in the Enter Value
field. The application automatically converts the integer to a percent and applies the
appropriate formula to increment the value correctly.

March April May
Prior Year 1000 2000 1100
Current Year | 1100 2200 1210
March 1100 = (1000 * 1.1)
April 2200 = (2000 * 1.1)
May 1100 = (1100 * 1.1)

[Current Period] = [Same Period Prior Year] * (1 + ([Input Amount] / 100))
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Description
Example

Formula

Description

Replace Target Values with Input Value

Copies the value you input in the Enter Value field to selected target destinations.

Replace the current values with 1000. In this example input 1000 in the Enter Value
field.

March April May
Old Values | 100 110 0
New Values | 1000 1000 1000

The input value overwrites current values, including values of zero or NA.

[Current Period] = [Input Value]

Target an Ending Value

Generates interim values between the start month and end month currently selected as
the target time dimension value, with the goal of achieving a target value by the end
month. Use the Enter Value field to input the target ending value.

The values increase incrementally between the start and end month.

Note: Calculations begin using the value from the month prior to the first future Time
dimension value currently selected.

This method overwrites current data for the time periods selected up to and including
the targeted end month.

13-28 Oracle Budgeting & Planning Reference Guide



Input and Calculation Methods Detailed

Example 1

Example 2

Formula

The target is 1500 for May, beginning with 1000 in February. In this example, March
April, and May are selected. The formula uses the value in February to calculate the
March value.

February March April May
1000 1167 1333 1500
March 1167 = ((1500-1000) 7 3) + 1000
April 1333 = ((1500-1000) / 3) + 1167
May 1500 = ((1500-1000) / 3) + 1333

The target is 3000 for May and the value in February is 0 or NA. February is not
selected.

February March April May
0 1000 2000 3000
March 1000 = ((3000-0) 7/ 3) + 0

April 2000 = ((3000-0) 7 3) + 1000

May 3000 = ((3000-0) 7 3) + 2000

[Current Period] = (([Value Given] - [Beginning Value]) / [# of Future Time Periods to
the Target Time dimension value) + [Prior Period Value]

where:

Beginning Value = The value in the monthly time period immediately preceding the
first future monthly time period selected
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Source to Target Input Tools Interface

This section lists the input and calculation methods for this interface in alphabetical
order.

Adjust Source Values By a Percentage

Description Increase or decrease the source value on a percentage basis by the value you input in
the Enter Value field and write the results to the target destination.
The application converts your input value to a percent.

A positive value increases the target value over the source value. A negative value
achieves the opposite result.

Example 1 Increase the source values by 10% for March, April, and May.

March April May
Source Values 100 110 120
Target Values 110 121 132
March 110 = (100 * 1.1)
April 121 =(110*1.1)
May 132 =(120*1.1)

Formula Target Amount = (Source Amount * (1 + (Input Amount / 100)))
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Description

Example

Formula

Description

Example
Formula

Adjust Source Values By an Amount
Increase or decrease the source value by the value you input in the Enter Value field
and write the results to the target destination.

A positive value increases the target value over the source value. A negative value
achieves the opposite result.

Calculate a target value by adding 25 to the source values.

March April May
Source Values 100 110 120
Target Values 125 135 145
March 125 = (100 + 25)
April 135 = (110 + 25)
May 145 = (120 + 25)

Target Amount = (Source Amount + Input Value)

Copy Source Values

Copies values from source to target destination without calculations.
The target value = the source value

Not applicable

Not applicable
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Using the Maturity Mix End-User Interface

This chapter describes how end users such as administrators and business unit
managers (end users) use this interface to enter new maturity mix assumptions or
revise existing assumptions for new business forecasts.

In order to estimate future cash flows for forecasted new business volumes, Oracle
Budgeting & Planning requires that assumptions be provided for maturity mix
profiles, pricing spreads, repricing parameters and expected principal prepayment
activity. Administrators can define and create these assumptions in Budgeting &
Planning, to provide business unit managers with a starting point of reference from
which to work. These assumptions are called default maturity mix assumptions.
Alternatively, administrators may choose not to define a set of default maturity mix
assumptions, opting instead to have business unit managers provide their own
assumptions.

The Maturity Mix Assumption interface enables business unit managers to enter
their own assumptions if default assumptions have not been defined or override
default assumptions with their own assumptions, that more accurately reflect the
managers business reality.

The values input in this interface are saved to the Mix Override planning item in the
database.

This chapter presents the following topics:

= The Structure of the Maturity Mix Assumption Interface
« Using the Maturity Mix Assumption Interface

« Inputting Values in the Interface

« Saving Your Override and New Assumption Inputs

« Using the Options Menu
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The Structure of the Maturity Mix Assumption Interface

This section describes the components of the interface and provides detailed
explanations of the dimensions comprising the Mix Override planning item.

Components of the Interface
This section describes the components of the interface.

0 &
ORI LI R R
Time Movemnber, 1398 Chart of Accounts Commercial Loans Adjustable
Crganizational Unit Redondo Blvd Maturity Mix Scenario Basze Mix Scenario Mix Breakout
Strateoy Momentum
LT T2 ] T TS TG T » M8 _a
i i
[+ Mix Percent 50,0000 50.0000 0.0000 0.0000¢ 0.0000 0.0000 0.0000 0.0000
» Term 12 24 1} 1} i} 0] 1} 1}
¥ Bpread 27500 2.8400 0.0000 0.0000; 0.0000 0.0000 0.0000 0.0000
» Repricing Freg. 1 1 1] 1] 1] 1] 1] 1]
» Prepayment Method 0 0 0 0 0 0 0 0
| » Prepayment Value 0.0000 0.0000 0.0000 0.0000] 0.0000 0.0000 0.0000 0.0000
r Tease Discount 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
4 »
Mix Element
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Dimensions and active
(displayed) dimension values in
the current page of the interface

This area displays five of the seven dimensions
and associated dimension values active for the
current page of the interface. The rows and
columns display the other two dimensions.

Mix elements for the active Chart
of Account product

Each Chart of Account product has specific mix
elements associated with it. The mix elements
appearing in this area are governed by the active
Chart of Account dimension value.

Dimension name of the row
dimension values

This tile names the dimension whose values
appear as rows in the interface.

Display and input grid for
maturity mix data

Default maturity mix assumption values appear in
this grid. Use this area to change default values or
add your own assumption values.

Mix breakout dimension values

The dimension values of the Mix Breakout
dimension are MIX.1, MIX.2 and so forth. Each
dimension value occupies a column in the grid.

You do not need to use all of the Mix Breakout
values when revising existing assumptions or
adding new ones. Creating assumptions that
accurately reflect the maturity behavior of a
product determines the number of Mix Breakouts
necessary.

Dimension name of the column
dimension values

This tile names the dimension whose values
appear as columns in the interface.

Name of the destination variable
for new assumption and override
data

The seven dimensions of the Maturity Mix
Assumption interface are dimensions of the Mix
Override planning item.

This planning item holds your saved inputs,
inclucing both new assumption values and
overrides to default assumption values. After
entering data the application writes your inputs to
the Mix Override planning item.

Dimensions of the Mix Override Variable

This section discusses the dimensions and dimension values of the Mix Override
variable. You need to understand these dimensions before you enter assumption
data in the grid.
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These dimensions include:
« Mix Element

«  Mix Breakout

« Time

« Chart of Accounts

« Organizational Unit

« Maturity Mix Scenario

« Strategy

Mix Element Dimension
This section contains the following:

« Description of each mix element value

« The association of mix elements and Chart of Account products

= The required mix element values for every mix breakout

Mix Element Dimension Values Listed and Defined Fifteen dimension values comprise the

Mix Element dimension. The following table provides descriptions and value
constraints for each mix element value.
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The shaded rows in this table denote mix element values required for all mix
breakouts. You cannot add values to any other mix elements for a particular mix
breakout if you do not have values in either Mix Percent or Term.

Mix Element
Dimension Values

Description

Value Constraints

spread that you want to
associate with the term to
maturity for the product.

Mix Percent Use this mix element to set the The total percentage value across
quantity of a product having the | all mix breakouts must equal
specific maturity characteristics | 100%.
fora mlx_breakout. This The interface automatically
GLIEITI 5 SqEEsses 2 converts integers to percent
percentage of the anticipated lues.* 9 P
dollar volume of new business. | V&4
You must enter a value for mix Ur_1der 2 e BOE, W)

: Mix Breakout, the value can be
percent for each mix breakout houah mix el i
that you use. Both zero even though mix elemen
o . values exist in the mix breakout.
administrators and business
unit managers can enter mix The value is null for unused mix
percent values. breakouts.**

Term This mix element is the term to | Enter an integer value greater

maturity for the product for this | than zero.
AL QUEELE The value is null for unused mix
For example, if you enter 24 in breakouts.**
this cell it indicates that the term
of the product for a mix
breakout is 24 months.
Express term values in months,
not years. Enter the term of a
30-year loan as 360.
You must enter a value for term
for each mix breakout that you
use. Both administrators and
business unit managers can
enter term values.
Spread This is the transfer pricing This value is expressed as a

percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**
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Mix Element
Dimension Values

Description

Value Constraints

Repricing
Frequency

This mix element represents the
number of months between
repricing events.

A loan that reprices annually
has a value of 12.

Enter an integer value greater
than zero.

The value is null for unused mix
breakouts.**

Amortization Term

Use this mix element only for
loans with amortization terms
extending beyond the term to
maturity.

The amortization term is
expressed in months. For
example, enter 180 for a 15-year
amortization term.

Enter an integer value greater
than the value in the Term mix
element.

If the amortization term is equal
to the term to maturity do not
enter a value for this mix element.

The value is null for unused mix
breakouts.**

Residual Value

This mix element represents the

This value is expressed as a

methods. If you enter a
prepayment method value you
must use one of the following:

1 = CPR (Constant Prepayment
Rate)

2 = PSA (Public Securities
Assoc.)

3 = Monthly prepayment speed

Percent residual value for a lease, percentage. The value is less than
expressed as a percentage of the | 100% and greater than 0%.
original lease amount. The interface automatically

converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Prepayment The application is seeded with Enter integer values of 1, 2, or 3.

Method the following prepayment

The value is null for unused mix
breakouts.**
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Mix Element
Dimension Values

Description

Value Constraints

Prepayment Value

The estimated percentage, based
on dollar volume, of
instruments that will prepay.

If the prepayment method is
either 1 or 3, the value is
expressed as a percentage.

If the prepayment method is 2,
the value is expressed as a PSA
factor, such as 100, 200, 700 and so
forth.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Rate Increase Period

This mix element stores the
maximum percentage the
interest rate can increase in each
repricing period.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Rate Decrease
Period

This mix element stores the
maximum percentage the
interest rate can decrease in each
repricing period.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Rate Increase Life

This mix element stores the
maximum percentage the
interest rate can increase over
the life of the product.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**
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Mix Element
Dimension Values

Description

Value Constraints

Rate Decrease Life

This mix element stores the
maximum percentage the
interest rate can decrease over
the life of the product.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Rate Cap Life

The maximum interest rate for
the life of the product.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Rate Floor Life

The minimum interest rate for
the life of the product.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

Tease Discount

This value is the percent by
which the note rate is decreased
to arrive at the discounted rate.

For example, a loan with a note
rate of 7.25% and a discounted

rate of 5.25% has a value of 2%

in this cell.

This rate is in effect until the
end of the first repricing period.

This value is expressed as a
percentage.

The interface automatically
converts integers to percent
values.*

The value is null for unused mix
breakouts.**

*To input a percentage value, such as 50%, input 50. To input a value of 50.5% input 50.5
**Eor unused cells the actual database value is NA (or null). The interface presents an NA

value as a black zero.

For additional information on inputting values see "Input Constraints and Data
Logic to Follow When Entering Values" in this chapter.
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Displayed Mix Elements Match the Chart of Account Product Selected The mix elements in
the rows of the grid are linked to the active Chart of Account product in the
interface. Only mix elements relevant to the active Chart of Account product
appear.

The Super Administrator links the mix elements and Chart of Account products
during implementation.

Note: If you notice that a mix element is missing for a Chart of
Account value, contact the application administrator.

The following table illustrates how Chart of Account values could be linked to Mix
Element values.

The relevant mix element values appearing in
If your product is a... the interface might include...

Fixed-rate mortgage with a 30 year term .  Mix Percent*

and a 30 year amortization "
« Term

« Spread

«  Prepayment Method

«  Prepayment Value

Fixed-rate mortgage witha5yearterm .  Mix Percent*

and a 30 year amortization "
« Term

«  Amortization Term

« Spread

«  Prepayment Method

«  Prepayment Value

Using the Maturity Mix End-User Interface 14-9



The Structure of the Maturity Mix Assumption Interface

The relevant mix element values appearing in
If your product is a... the interface might include...

Adjustable-rate mortgage witha7year «  Mix Percent*
term, 30 year amortization and a teaser

*
rate . Term

«  Amortization Term

« Repricing Frequency
« Spread

«  Prepayment Method
«  Prepayment Value

« Rate Increase Period
« Rate Decrease Period
« Rate Increase Life

« Rate Decrease Period
« Rate Cap Life

«  Rate Floor Life

«  Tease Discount

*Mix Percent and Term are required for all used mix breakouts

Required Mix Elements You must enter values for Mix Percent and Term for all mix
breakouts. If you try to input any mix element value other than these two for a new
mix breakout the interface rejects your input. A message appears prompting you to
complete values for these required mix elements before continuing.

The exception to this constraint is nullifying the values of a specific mix breakout.
For a detailed explanation see "Nullifying a Mix Breakout" in this chapter.

Mix Breakout Dimension

Mix Breakout holds the individual breakouts used to forecast maturity assumptions
for future cash flows. The mix breakout dimension values are called MIX.1, MIX.2,
MIX.3 and so forth and occupy the columns of the grid.

Restraints on Creating New Mix Breakouts Only the Super Administrator can modify the

number of mix breakouts available in the interface. The application is seeded with
10 mix breakouts.
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Time Dimension

Time dimension values set the time period you want to review. Select months, not
quarters or years. The Maturity Mix Assumption interface recognizes months only.

The Default Ordering of Time Dimension Values in the Selector The default
ordering of dimension values is by the hierarchical structure you have created, such
as the following example:

Year 1

Quarter 1
Month 1
Month 2
Month 3

Quarter 2
Month 1
Month 2
Month 3

If you select None from the Organize By list box the months appear in chronological
order for each year in your forecast, followed by a listing of all the quarters, then the
years. All node and leaf values for this dimension appear in the Available box of the
Selector.

Chart of Account Dimension

Your organization creates node and leaf values for this dimension at the time of
implementation. A leaf value for this dimension is the lowest level at which your
organization decides to process data.

Recommended Method for Selecting Chart of Account Leaf Values To ensure that
you choose leaf values, display your Chart of Accounts by hierarchical structure in
the Available box of the Selector.

See Chapter 12, "Using the Selector" for an explanation on displaying this
dimension hierachically. Using the Choose Values by Family tool may also be
helpful.
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Organizational Unit Dimension

As with Chart of Account values, your organization creates node and leaf values for
organizational units at the time of implementation. These values represent the
lowest level at which your organization decides to process organizational unit data.

Recommended Method for Selecting Organizational Unit Leaf Values To ensure that you
choose leaf values, display your organizational units by hierarchical structure in the
Available box of the Selector.

See Chapter 12, "Using the Selector" for an explanation on displaying this
dimension hierachically. Using the Choose Values by Family tool may also be
helpful.

Restraints on Accessing Organizational Units Administrators and business unit
managers can only access organizational units for which access has been assigned.
The Super Administrator makes the initial assignments. Sub-administrators can
make lower-tiered assignments within their areas of assigned responsibility as
defined by the Super Administrator. Business unit managers cannot assign access
privileges to other business unit managers.

Maturity Mix Scenario Dimension
A forecast has only one maturity mix scenario.

If you have selected only one Forecast dimension value in the Selector, you do not
have to choose a Maturity Mix Scenario dimension value. The choice you make for
Forecast governs the Maturity Mix Scenario value that appears in the interface.

If, however, you select multiple Forecast dimension values in the Selector and each
forecast has a unique maturity mix scenario then multiple Maturity Mix Scenario
values appear as choices for this dimension in the Maturity Mix Assumption
interface.

Since Forecast is not a dimension of the Mix Override planning item you cannot tell,
from the interface, which scenario goes with which forecast. If you are forecasting
multiple maturity mix scenarios you need to remember which scenarios are
associated with which forecasts.

Strategy Dimension

Momentum is the default value for this dimension. If your organization has created
additional values for this dimension they can be selected as well.
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If your organization has created a hierarchical structure for this dimension be sure
to select leaf values.

Currency Dimension

Base Currency is the default value for this dimension. If your organization has
created additional values for this dimension they can be selected as well.

If your organization has created a hierarchical structure for this dimension be sure
to select leaf values.

Using the Maturity Mix Assumption Interface
This section contains the following:
« Selecting data and accessing the interface
« Recognizing the difference between Read-only and Read/Write cells
« Recognizing the difference between default values and override values

« Changing the physical appearance of the display and input grid

Selecting Data and Accessing the Interface

When you log in to Budgeting & Planning the Selector automatically appears. You
must use the Selector to retrieve the data you want to review. See Chapter 12,
"Using the Selector" for detailed information on using this tool.

After selecting your data open the Maturity Mix Assumption interface by following
this step:

From the Options menu select Maturity Mix Assumptions.

When the interface opens any data appearing in the grid is default assumption data
input by either the Super Administrator or a sub-administrator.

How the Interface Differentiates Data in the Grid
The interface differentiates the following:

« Read-only from Read/Write cells

« Default values from override values
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Distinguishing Read-Only From Read/Write Cells

The interface differentiates read-only from read/write cells by shading. Read-only
cells are shaded. You cannot change the values in these cells. Read/write cells are
not shaded and the values can be changed.

Cells become read-only in the following two ways.

Historical Data is Read-Only Historical or actual data is read-only. The application
shows historical data as shaded. The application separates historical data from
forecasted data using the Forecast’s as-of-date. Data prior to the as-of-date cannot
be changed. Data following the as-of-date is projected and can be changed.

For example, if you select June through December for your Time values and the
as-of-date is August 31st, data in the cells from June through August is shaded and
data from September through December is unshaded.

The Super Administrator establishes and advances the as-of-date.
Forecasted Data Designated as Read-Only by Administrators Administrators can

designate some cells as read-only and others as read/write. Cells set to read-only
appear shaded in the interface, even though the values represent forecasted data.

For example, your organization decides not to allow revisions to the transfer pricing
spread for certain products. When you select these products the row for the Spread
mix element appears shaded.

Distinguishing Between Default and Override Values

The interface differentiates default and null values from your input by color. A
black font indicates default and null values. A blue font indicates your changes.
This helps you distinguish your input from default assumptions.

Changing the Data Display in the Interface
You can change the data display in the interface two ways:

« Adjusting the width of columns and the height of rows

« Maximizing the interface

Adjusting Column and Row Sizes
This section tells you how to change column widths and row height.
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Changing Column Widths and Row Height Adjust column widths by following these
steps:

1. Place your cursor over a line that separates two columns. The shape of the
cursor changes to a line with two arrows.

2. While holding down the left button of your mouse, move the dual-arrowed line
either to the right or left. As you move, the width of the column changes.

3. When the column width is the size you want, release the mouse button.
4. All of the columns in the interface adjust to the selected width.

Follow the same steps to adjust row height.

Note: These adjustments apply globally. You cannot adjust the
width of one column independent of other columns nor can you
adjust individual row height.

Adjusted Column and Row Settings Remain In Place During a Session Adjusted column
and row settings remain in place during your session in the application and carry
over to the main forecasting window. If you decide, later in your session, to adjust
either columns or rows again the new settings replace the previous ones.

Upon exiting the application your customized column and row settings revert to the
default width and height.

Maximizing the Interface

Maximize your interface so that the entire description of each dimension value
appears. A partially enlarged window truncates the dimension value descriptions,
making it difficult to correctly identify them.

Click the Maximize icon in the upper right corner of the window to enlarge the
interface.

Note: In this interface, the position of the dimension tiles cannot
be changed.

Inputting Values in the Interface

Administrators can either create default maturity mix assumptions for products and
organizational units or leave default assumptions blank. The Maturity Mix

Using the Maturity Mix End-User Interface 14-15



Inputting Values in the Interface

Assumption interface gives business unit managers the ability to adjust (override)
an administrator’s default maturity mix assumptions or input their own
assumptions when none have been defined.

The Maturity Mix Assumption interface enables business unit managers to change
maturity assumptions for new business. This functionality recognizes the fact that
customer behavior and product maturity assumptions can vary between
organizational units.

This section provides the following information on inputting data to the interface:
« Importance of selecting leaf values

= Anapproach to viewing data in the interface

« Navigating the grid and inputting values

« Inputting override and new assumption data

« Input constraints and data logic to follow when entering values

Importance of Selecting Leaf Values

The interface enables input for leaf values but not node values. As you make your
selections remember to select leaf values in order to view and input changes to the
interface.

For dimensions with hierarchical structures you can either organize your dimension
values using that structure or use the Choose Values by Family tool and select Last
Descendants. See Chapter 12, "Using the Selector"” for more information on using
this tool.

You can include node values in the Selector, however, the interface filters these out.
For example, if you select the node Quarter 1, 1999 and the leaf values January;,
February, and March only the individual months appear as values in the Time
dimension.

Leaf Value Error Message

If you fail to designate leaf values for a particular dimension an error message
appears when you select Maturity Mix Assumption from the Options menu. The
message prompts you to select leaf values before continuing.
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Navigating the Grid and Inputting Values
Explanations on navigating between cells in the grid and inputting values follow:
Moving Between Cells

Use the arrow keys to move between contiguous cells in the grid and your mouse to
move between non-contiguous cells.

Inputting Values

After typing your value, press either the Enter key or the Tab key to enter the value
to the grid.

Inputting Override and New Forecast Assumption Data
This section discusses:

1. Inputting override data in mix breakouts with existing data
2. Inputting new values in unused mix breakouts

3. Revising data previously input

Inputting Override Data in Mix Breakouts With Existing Data

To change or add values to mix breakouts with existing values input your values
directly in the cells you want to change. This process is the same whether you are
overriding default assumption data or changing override data previously input.

Inputting New Values In Unused Mix Breakouts

When you open the Maturity Mix Assumption interface you may find that not all of
the available mix breakouts have been used for a product, or, alternatively, no
default assumptions have been defined at all.

Leaving mix breakouts unused (without default assumption data) reflects the Super
Administrator’s or a sub-administrator’s decision that either not all mix breakouts
are necessary or they are relying on business unit managers to forecast maturity
assumptions.
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Revising Previously Input Values
You can change previously input values using the following methods:

« Entering revisions in the grid
« Using the Revert to Default Assumption Values feature
« Using the Copy Across feature

Entering Revisions in the Grid You can enter your revisions directly in the grid,
wherever the cells are Read/Write.

Using the Revert to Default Assumption Values Feature This method actually deletes
your override values from the interface and brings back any default assumption
values. This feature changes only the values on the current page of the interface. See
"Reverting to the Default Assumption Values" in this chapter for more information
on how to use this feature.

Using the Copy Across Feature This method takes the values from the current page
of the interface and copies them across the Time and Organizational Unit
dimensions. This process overwrites your previous inputs. It can also overwrite
default assumptions. See "Copying Values to Cells Across the Time and
Organizational Unit Dimensions" in this chapter for more information on how to
use this feature.

Input Constraints and Data Logic to Follow When Entering Values

Input constraints and data logic must followed, whether you are inputting new
values or overriding default assumptions. Some constraints apply specifically to
inputting values in unused mix breakouts while others apply to both new values
and default values.

Input Constraints for Unused Mix Breakouts
This section explains the following:

« Adding data to contiguous mix breakouts
« Inputting Mix Percent and Term values first
« Totalling the Mix Percent values to 100%

« Nullifying a mix breakout
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Add Data to Contiguous Mix Breakouts You must add values to contiguous mix
breakouts.

For example, you cannot add data to mix breakout 2 (MIX.2) and mix breakout 4
(MIX.4) without having values in mix breakout 3 (MI1X.3).

If you try to enter values in a non-contiguous mix breakout an error message
appears in the status bar in the lower right corner of the window. This message tells
you to use the first available mix breakout.

Input Mix Percent and Term First For unused mix breakouts Mix Percent and Term
values must be input first.

If you try to input a value in any cells other than these two an error message
appears in the lower right corner of the window. This message tells you to first
enter a value for Term. The cell for Term becomes shaded in red. When you input a
value in the Term cell the shading disappears and the Term value remains.

A similar error message appears if, after entering a Term value, you try to enter a
value other than Mix Percent. In this case the error message tells you to first enter a
value for Mix Percent. The Mix Percent cell is shaded in red.

When you input a value in the Mix Percent cell the shading disappears and the Mix
Percent value remains.

Note: If either Term or Mix Element are read-only you cannot
input values to unused mix breakouts.

The Cumulative Mix Percent For All Mix Breakouts Must Equal 100% The total of all Mix
Percent values must equal 100%, otherwise you cannot exit the Maturity Mix
Assumption interface.

The interface does not round percentages. You must set each Mix Percent value so
that the total equals exactly 100%. For example, if you have one mix breakout and
want to add two more, yet keep all three equal, you must enter percentage values
such as the following: 33.3%, 33.3%, and 33.4%.

If the totalled Mix Percent values do not equal 100% and you try to close the
interface an error message appears. Revise your Mix Percent values so that they
total 100%, then exit.
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Nullifying a Mix Breakout Nullify a mix breakout by changing the Mix Percent value to
zero. This excludes the values in the mix breakout from your forecasted cash flows.

Note: To nullify a mix breakout, change the Mix Percent value to
zero. Do not change any other values in the Mix Breakout.

You can use this feature in the following two scenarios:

= Nullifying either default or override assumptions

= Nullifying a mix breakout when a Term value is accidently input
Nullifying Either Default or Override Assumptions

This feature gives you the option of nullifying mix breakout values rather than
changing them. Use this feature with the Copy Across feature when you want to
nullify individual mix breakouts within your forecasted maturity mix. See "Copying
Values to Cells Across the Time and Organizational Unit Dimensions" in this
chapter for information on how the Copy Across feature can be used in conjunction
with this option.

Nullifying a Mix Breakout When a Term Value is Accidently Input

You cannot enter a zero for Term mix element once a value has been input. If you
inadvertently enter a Term value you must enter a zero in the Mix Percent element
to nullify the mix breakout. The application does not let you exit the interface with a
value in Term but not Mix Percent.

Another feature allows you to nullify an inadvertent Term value however this
feature has implications for all of the values on the current page of the interface, not
just the Term value that you want to change back to zero. See "Reverting to the
Default Assumption Values" in this chapter for an explanation of this feature.
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Input Constraints and Data Logic for All Mix Breakouts
The following input constraints and data logic apply when:

« Overriding default values in existing mix breakouts

« Entering new data to unused mix breakouts

Input Constraints and Data

Logic Explanation
Decimal values and integers Decimal values cannot be input to cells that require
integers.

Integers can be input to cells requiring percentage values.
The application automatically converts the integer to a
percentage value.

Prepayment Method and If you enter a value for Prepayment Method you must
Prepayment Values enter a value for Prepayment Value also.

A Prepayment Value cannot exist without a Prepayment
Method entered.

Term and Amortizing Term Input a value for Amortizing Term only when the
amortizing term is greater than the instrument term.

Do not enter a value for Amortizing Term if the
instrument term and the amortizing term have the same
duration.

All term values are expressed in months. For a loan with a
15-year amortization enter 180 in the cell.

Term and Repricing Frequency The Repricing Frequency must be greater than zero and
less than the term of the loan.

Express the Repricing Frequency as the number of months
between repricing events.

Using the Options Menu

The options available from this menu selection include:
« Reverting to the default assumption values

« Copying input values to multiple cells across the Time and Organizational Unit
dimensions

This section describes each option.
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Reverting to the Default Assumption Values

This option enables a business unit manager to delete all entered values and revert
to either the default maturity mix assumptions input by the administrator or reset
all values to zero (null) if no default values previously existed.

This Option Applies Only to the Current Page This option applies only to data for the
current page of the interface. When you invoke this option changes occur only to
the active dimension values, causing them to revert to either default assumptions or
to zero if no default values existed prior to your input. If you selected multiple
organizational units, time dimension values and Chart of Account products for this
session, only the active dimension values revert. Dimension values for all other
organizational unit, time and product combinations remain unchanged.

This is a global operation for the current page. You cannot keep some override
values and delete others.

Copying Values to Cells Across the Time and Organizational Unit Dimensions

The copy feature enables you to copy default and override values to multiple cells
in mix breakouts. You can copy values across the Time dimension, the
Organizational Unit dimension, or both.

Note: The Copy Across feature affects only the values you choose
using the Selector. No other values in the Mix Override planning
item change.

Copying Across the Time Dimension

This feature enables you to copy your override values from the current page to all
future time values for the active organizational unit and Chart of Account product.
This function does not affect Time dimension values earlier than the active Time
dimension value.

Default assumption values for future time values are not affected unless you have
overridden them in the current page.
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Example: The following table displays the parameters of a session for this example:

Dimension

Dimension Values

Organizational Unit

Time

Chart of Accounts

Forecast
Strategy

Currency

. Elm Street Branch
« Highland Street

January through December (12 individual months selected)

. Commercial Loans - Fixed
«  Commercial Loans - Adjustable
. Line of Credit

Base
Momentum

Base

The following dimension values are active:

Dimension
Organizational Unit
Time

Chart of Accounts
Forecast

Strategy

Currency

Dimension Value

Highland Street

June

Commercial Loans - Adjustable
Base

Momentum

Base

In this example a business unit manager enters changes in the month of June and
invokes the Copy Across Time function. The values input for this month are copied
to the mix breakouts for adjustable commercial loans at the Highland Street branch
from July through December.

Unaffected Values Values between January and May for adjustable commercial loans
at the Highland Street branch do not change.

Also, this function does not change values for adjustable commercial loans at the

Elm Street branch.
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Invoking the Copy Across Time Feature Follow these steps to invoke this feature:
1. From the Options menu select Copy Across -> Time.

The Copy Across Time message box appears, informing you that this operation
copies all override values to future time periods.

2. Click OK to invoke this operation.

Copying Across the Organizational Unit Dimension

This feature enables you to copy override values from the current page to all
organizational units chosen for this session, not just the active organizational unit.

Invoking the Copy Across Organizational Unit Feature Follow these steps to invoke this
feature:
1. From the Options menu select Copy Across -> Organizational Unit.

The Copy Across Organizational Units message box appears, informing you
that this operation copies all override values from the current page to all
organizational units chosen for this session.

2. Click OK to invoke this operation.

Copying Across the Time and Organizational Unit Dimensions

This feature combines the copying functionality of both Copy Across Time and
Copy Across Organizational Unit. Override values are copied from the current page
to all organizational units chosen for this session and all future time periods.

Invoking the Copy Across Time and Organizational Unit Feature Follow these steps to
invoke this feature:
1. From the Options menu select Copy Across -> Time and Organizational Unit.

The Copy Across Time and Organizational Units message box appears,
informing you that this operation copies all override values from the current
page to all future time periods and all organizational units chosen for this
session.

2. Click OK to invoke this operation.

Changing Your Input After Using the Copy Across Feature
Use either of the following two methods to change data copied to multiple cells.
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Using the Copy Across Option This method overwrites existing data with new data
using the Copy Across feature. You can either change all of the data previously
copied or make revisions to selected mix elements.

To use this method, follow these steps:

1.
2.
3.

Re-select the active dimension values previously used.
Input your revisions in the grid.
Invoke the same Copy Across feature that you used before.

The revised Mix Element values are copied to the Time, Organizational Unit
and Chart of Account combinations previously selected. Unchanged mix
elements in the current page remain unchanged in other dimension
combinations.

Note: Itisimportant to use the same Copy Across feature for your
revisions as you used for the initial process. This ensures that your
revised data overwrites data for the same Time, Organizational
Unit, and Chart of Account combinations as before.

Remember that Time dimension values are copied from the active time period to all
future time periods chosen for this session.

Using the Revert to Default Values Option Use this method to change your revisions
back to the default assumption values.

To use this method, follow these steps:

1.
2.

Re-select the active dimension values previously used.

From the Options menu choose Revert to Default Values. All values for the
current page revert to default assumption values.

Invoke the same Copy Across feature that you used before.

The Copy Across feature deletes all of your override values and reinstates
default assumption values to the interface. Where your initial changes actually
added new data rather than overriding default assumptions the values in the
cells revert to null.
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Saving Your Override and New Assumption Inputs

After inputting your maturity mix assumptions or overriding default assumptions
follow these steps to save your inputs:

1. From the File menu select Close.

If you have input your data correctly the Maturity Mix Assumption interface
closes and the main forecast window appears.

If you have not input your data correctly an error message appears explaining
why you cannot close the interface. Correct the errors described in the message
and then start again at step 1.

2. From the File menu select Save.

Your inputs are saved to the Mix Override variable.

Note: The interface retains your last selection parameters from the
current session and carries those parameters to your next session.
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Generating Reports

The Budgeting & Planning data model and programs included in this release have
been designed to support the quick and efficient generation of reports normally
required to review budget and forecast data as part of your organization’s planning
process.

Effective with the release of the Web-enabled version of Budgeting & Planning,
users can now access reports that have been defined in Oracle Financial Analyzer
(OFA) directly from the Budgeting & Planning interface. Web users who have
received report access through the OFA distribution functionality can open a list of
available reports from within the main Budgeting & Planning interface, select the
desired report(s) and produce those reports for both viewing and printing.

This release also includes additional, seeded standard reports created specifically
for use with the Web-enabled version of the application.

This chapter presents the following topics:
« Reporting Features

« Producing Reports

« Reporting Elements

« Report Totals and Sub-Totals

« Basic Report Formats
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Reporting Features

This version of Budgeting & Planning includes the following features:

Budgeting & Planning generates and writes most of the financial elements
required for standard reporting needs directly to the Financial Plans planning
item in the Express database.

Aggregation of data values is routinely performed by the application to
generate and write totals and sub-totals to the database for reporting access at
summary organizational, product, and time levels.

A set of standard reports have been provided, addressing typical business
requirements, for business unit managers and supervisors to use in reviewing
financial results in a forecasting or budgeting exercise.

Reports that were seeded for use with the OFA client/server software have
been expanded to include comparable balance sheet, income statement, and rate
reports that can now be accessed over the Web using Budgeting & Planning.

A new report icon and menu selection have been added to the interface to
enable users to open a list of available reports and review and print budget and
forecast projections directly from the Budgeting & Planning application.

When an end user clicks Generate Report the selected report is produced in a
browser window that is separate from the browser window used by Budgeting
& Planning.

You can have multiple reports open at the same time. When you open multiple
reports, each is opened in its own browser window. These reports can be
printed directly from the browser.

Producing Reports

Reports that have been defined and distributed to end users for access using the
Web-enabled version of Budgeting & Planning can be produced directly from the
Budgeting & Planning interface.
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The Reports Interface

Each report appears in its own browser window as shown in the following example
of the Year 2000 Periodic Average Balance Sheet report.

3 fear 2000 Periodic Average Balance Sheet
e EahE @
Currency Organizational Unit Forecast Financial Element Strategy
J| Basze Cumency | J| BR 036 Hillcrest 5014026 v| J| Base Forecast | J| HAorerage Balance | J| homentum
Aowrerage Balance Sheet
Jan 00 Feb 00 har 00 Fpr 00 Wy 00 Jun 00 Jul 0o Fug 00
 Total Assets 501900036 2,380.02 2,407.74) 257420 265137 2,726.06 2,805.23 288102 2,063.29|
¥ Total Eaming Assets 501900030 1 227138 237388 2,446 53 251088 250276 2 f66.11] 2,739.00 2,816.55
T Total Loans 501900043 237138 237338 2,446 53 2,519.38| 250376 2,666.11| 2,730.00| 2,816.55
~  Revoluing Credit Loans 501900061 | 164002 172383 177698 123002| 189306 183611 1.889.15| 2042.20|
Platinum - Intro Rate 34031 i 1037 40| 108294 1.117.29] 1,150 | 1.134.00] 121738 1.250.70| 120406 |
“sa Gold 34041 1 36502 362,34 304.10 405 86 4753 4z0.38| 44116 45202
Prefemed Mastercard 34051 24650 257 65| 265 .58 27351 281.44 23037 20730 05,22 |—
T Installment Loans 501900060 [ 21 48| 540,35 489,55 8g0 25| 700.70| 7001 740 24 77435 |
Farm Loans 37131 i 108.77| 11408 1740 121.13] 124.61| 128.34| 13181 120 g4
Student Loans 37631 1 40| £0.37) 71.51 7364 75.78| 7701 20.05| 82,18
Consumer - hsc, 3TA06 2212 20.40| an.zr 31.18| 3207 32.08| 28T 34.76|
Home Improvement Loans 38181 | 260.78| 23058 30000 32870 34822 a2 387 46| a07.06|
Line of Credit 33401 i 150.50] 15725 16200 16693 17177| 17681 18145 126 20|
~ Total Noneaming fssets 501000041 | 113.56] 122.87| 137.68 131.48 136.30] 13011 142,92 146.73
~  Cash, Due From & Float 501800073 0.0 0.5z 064 0.65| 0.8 07| 0.7z 0.74|
foorued Interest Receivable 04011 | 050| 0.2 04| 0.8 068 070| 071 074 =
[ | O

Opening and Closing Specific Reports

This section explains how to open reports for viewing and printing and how to
close the report when you complete your work.

To produce a report you first need to open the list of reports available to you.
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Opening the Reports List
Open the Reports list using either of these two methods:

From the Menu Bar From the Tools menu option select Show Reports. The list of
available reports appears in a new pane of the interface.

From the Tool Bar Click the Reports icon. The icon label appears as Open Reports.
The list of reports appears.

Closing the Reports List

Using either the Tools menu option or the Reports icon, reverse the process to close
the Reports list. The Tools menu option and the icon labels change to Hide Reports
when a report is open.

Opening an Individual Report

When you select a report your browser opens it in a new browser window that
exists independently of the main window of the interface. Opening additional
reports opens additional browser windows, one for each report you select.

Follow these steps to open a specific report:
1. From the Reports list click the report you want to open.
2. Click Generate Report.

A new browser window opens and the application begins transferring data for
your report. Before displaying the first report of a session a Java Security dialog
box appears.
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As indicated in the message box, additional privileges need to be granted in
order to generate the report.

Bl Java Security [-[O]x]
g JawvaScript or a Java applet from 'Oracle Corporation ' is requesting
& additional privileges.

Granting the following iz high risk:

Contacting and connecting with other computers over a networle

T 1

Dretails
I™ Remember this decision

_Iqep!i_tv \re_rifie_d_b\_r VgriSign Class 3 CA- Commercial Content’Softmare Publisher
Certificate I Grant | Deny | Help |

3. Click Grant to proceed with the production of the report.

The tile section and column headings for the report appear first, followed by the
report itself.

While the application fetches data the following message appears on the status bar
at the bottom of your screen: Transferring data from <name of server providing
Budgeting & Planning data>.

Note: The first report may take some time to display. Subsequent
reports open faster than the original report.

Opening Multiple Reports You can select and generate as many reports as you want.
Each report appears in a separate browser window.

This functionality enables you to open and close a report independently of other
reports.

Each report description appears on the status bar at the bottom of your screen and
can be accessed by clicking the title representing that report.

Updating Report Content You can update the content for an open report by clicking
the Reload icon on the Tool bar.
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OFA Web Client Functionality When you generate a report from the Budgeting &
Planning application an OFA Web Client session is launched. This application
actually produces the report. The OFA Web Client session accesses data from the
same Express session that you are using for Budgeting & Planning.

Report-related features available in the standard OFA Web Client interface are also
available through the Budgeting & Planning interface. Refer to online help in the
Reporting interface or to the Oracle Financial Analyzer Reference Guide for
information on how to use report-related functionality from the interface.

Closing an Individual Report

To close an individual report select File -> Close from the browser window
containing the report. This closes both the report and its browser window. Follow
the same procedure to close additional reports you may have opened.

Timing Out of a Session
If you cannot open a report or use any of the reporting features you may have timed
out of your session.

You can test this by trying to exit the application. If a Selector Error message
appears, indicating that your WebAgent session is no longer available you must exit
both the application and Web browser, then log in again. See "Your Session Timed
Out" in Chapter 9, "Logging In".

Printing Reports

When printing a report from the browser, be sure to print by clicking on the print
button in the OFA Web Client document tool bar. Use the following instructions
from the OFA Web Client online help as a guide:

You can print the data in a report and specify settings that determine how you want
your printed page to look.

1. Inthe Document toolbar, click Print. The Print dialog box for your Web
browser appears.

2. You can change the print defaults for the browser. For example, you can specify
new values for your printer or the number of copies.

3. Click OK to continue. The Print dialog box for OFA appears.
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In the Print box, specify the pages that you want to print. You can choose one of
the following options:

Current Page of Data Prints the current page of data as indicated by the page
labels.

All xx pages of Data  Prints all pages of data in the report, beginning at the
first logical page, regardless of the current page
settings.

Tip: If the number of pages is very large, then you might want to use the
Selector tools to choose values that will result in fewer pages of data.

In the Order box, specify the order in which to print the pages. You can choose
one of the following options:

Across then down Prints as many rows and columns as will fit on a
physical page, then moves across the columns (until all
are printed) and then down the rows (until all are
printed).

Down then across Prints all rows of data, then all columns of data.
To indicate how you want the printed pages to look, choose Page Setup. This

opens the Page Setup dialog box where you can perform the following
operations:

Specify: «  Optional header text for the printed pages. You can
enter up to 100 characters.

« Optional footer components for the printed pages.

= Whether page, row, and column labels will be
repeated on each printed page.

=  Whether title, subtitle, and footnotes will appear on
the printed pages.

« Margin settings for the printed pages.
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7. Choose Print Preview to review the pages before printing.

This opens the Print Preview dialog box, which displays the components
specified in the Page Setup dialog box. You can set margins, header, footer, and
so on.

8. Click OK to print the report.

Reporting Elements

Typical financial statement requirements include both trend reports delineating
budget or forecast values over time and comparative reports that compare quarterly
or annual amounts from one period to another.

These reports would normally cover the following financial data elements:
« Average Balance Sheet

« Ending Balance Sheet

« Average Rates

« Average Transfer Rates

« Transfer Pricing Spreads - Dollars

« Average Transfer Pricing Spreads - Percentages

« Transfer Pricing Spread Based Income Statement

« Interest Income/Expense Based Income Statement

The application generates and writes most of the financial elements required for
standard reporting needs directly to the Financial Plans planning item in the
Express database. This approach avoids the need for calculating items such as
average rates or transfer rates through the use of formulas by storing those items in
the database and making them directly available for access by reports.

The data model is seeded with the following financial elements that are populated
with the results of running the interface:

Financial Element Description
F100 Ending Balance
F140 Average Balance
F160 Average Net Rate
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Financial Element Description

F170 Average Transfer Rate

F455 Non Interest Income

F457 Non Interest Expense

N451 TP Spread Income

N171 Average Spread

A420 Annualized Interest

A450 Annualized Charge/Credit

Report Totals and Sub-Totals

The application includes routines developed to solve or aggregate data in the
Financial Plans planning item along organizational, chart of accounts, time, and any
other user-defined hierarchies. When Calculate With Partial Solve or Calculate With
Full Solve are processed in the Java interface the aggregation of leaf-level data is
performed, which generates aggregated values for parents and nodes along the
hierarchies. This means that sub-total rows on a product hierarchy for items such as
total loans, total investments or total assets are calculated and written back to the
database at the last descendent organizational unit level.

Consolidations up the organizational hierarchy are also performed and values for
the quarter and year time buckets are calculated and written back to the database as
well.

All of these nodes, or parent data values, are available for access in seeded reports
and reports you create in OFA. For example, if you produce a balance sheet report
with product average balances you no not need to create a formula to sum values
within the product hierarchy.

After solving or aggregating your data, you can select "Total Assets’ using the
Selector to create the Total Asset value in the report. By selecting quarter or year
values for the Time dimension you can display quarterly or annual totals in your
report. Selecting "Total Company’ on the Organizational hierarchy paging
dimension accesses aggregate values for that parent node.

See Chapter 12, "Using the Selector” for additional information on using this tool to
select data from the database.

Generating Reports  15-9



Basic Report Formats

Basic Report Formats

Each report incorporates one of the following formatting types:

Report Format Explanation

12-Month Trend Report  The first twelve, monthly time bucket values and the

with Year Total (BP/OFA corresponding Year Time bucket are returned based on the
Web Client version and  seeded Time dimension selection.

OFA client/server

version)

Comparative Report Compares the first two Year Time bucket values using a seeded
(OFA client/server dollar variance column and a seeded percent variance column.
version)

Comparative Report Compares the Current Year and Last Year Time bucket values
(BP/OFA Web Client using seeded formulas for all columns. Current Year is

version and client/server determined using the Forecast as-of-date. Year values are
version) returned and adjusted automatically as the Forecast as-of-date is

moved forward across a year-end into a new year.

List of Seeded Reports

The following tables list the seeded reports included in this release. The first table
reflects the reports seeded in the earlier version of Budgeting & Planning for use
with OFA client/server software, and includes the variables and financial elements
supporting each report. The Across, Down, and Paging dimensions indicate the
placement of these dimensions in the report itself. The Periodic reports can also be
viewed when launched from within the Web-enabled Budgeting & Planning
application.

Seeded Reports From the Client/Server Version

The following table lists the seeded reports provided for the client/server version of
Budgeting & Planning. Shaded reports have comparable versions in the
Web-enabled release of the application. Refer to "Seeded Reports for the
Web-Enabled Version" in this chapter for a list of those comparable reports.

Variable Object Financial Across
Report Name Name Element Dimension Down Dimension Paging Dimension(s)
Periodic Average FS.FIN_DATA F140 Time Chart of Accounts  Currency,

Balance Sheet

Organizational Unit,
Forecast, Financial
Element, Strategy

15-10 Oracle Budgeting & Planning Reference Guide



Basic Report Formats

Report Name

Variable Object
Name

Financial Across
Element

Dimension Down Dimension

Paging Dimension(s)

Periodic Ending FS.FIN_DATA F100 Time Chart of Accounts  Currency,
Balance Sheet Organizational Unit,
Forecast, Financial
Element, Strategy
Periodic Interest FS.FIN_DATA F160 Time Chart of Accounts  Currency,
Rates Organizational Unit,
Forecast, Financial
Element, Strategy
Periodic Transfer FS.FIN_DATA N171 Time Chart of Accounts  Currency,
Pricing Organizational Unit,
Percentage Forecast, Financial
Spreads Element, Strategy
Periodic Margin  FS.FIN_DATA F160, Time Chart of Accounts, Currency,
Analysis F170, Financial Element  Organizational Unit,
N171 Forecast, Strategy
Comparative FS.FIN_DATA F140 Time Chart of Accounts  Currency,
Average Balance Organizational Unit,
Sheet Forecast, Financial
Element, Strategy
Comparative FS.FIN_DATA F100 Time Chart of Accounts  Currency,
Ending Balance Organizational Unit,
Sheet Forecast, Financial
Element, Strategy
Comparative FS.FIN_DATA F160 Time Chart of Accounts  Currency,
Interest Rates Organizational Unit,
Forecast, Financial
Element, Strategy
Comparative FS.FIN_DATA N171 Time Chart of Accounts  Currency,
Transfer Pricing Organizational Unit,
Percentage Forecast, Financial
Spreads Element, Strategy
Comparative FS.FIN_DATA F160, Time Chart of Accounts, Currency,
Margin Analysis F170, Financial Element  Organizational Unit,
N171 Forecast, Strategy
Originations by  FS.FIN_DATA F340 Time Chart of Accounts  Currency,

Account

Organizational Unit,
Forecast, Financial
Element, Strategy

Generating Reports  15-11



Basic Report Formats

Variable Object Financial Across

Report Name Name Element Dimension Down Dimension Paging Dimension(s)

Origination FS.FIN_DATA F375 Time Chart of Accounts  Currency,

Spreads by Organizational Unit,

Account Forecast, Financial
Element, Strategy

Origination FS.FIN_DATA F375 Time Organizational Currency, Chart of

Spreads by Org Unit Accounts, Forecast,

Unit Financial Element,
Strategy

Periodic Income FS.REG INC_STMT NA Time Chart of Accounts  Currency,

Statement Organizational Unit,
Forecast, Strategy

Periodic Transfer FS.INC_STMT NA Time Chart of Accounts  Currency,

Pricing Spread Organizational Unit,

Income Forecast, Strategy

Statement

Comparative FS.REG_INC_STMT NA Time Chart of Accounts  Currency,

Income Organizational Unit,

Statement Forecast, Strategy

Comparative FS.INC_STMT NA Time Chart of Accounts  Currency,

Transfer Pricing Organizational Unit,

Spread Income Forecast, Strategy

Statement
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Seeded Reports for the Web-Enabled Version

The following table lists the seeded reports included with this release for the
Web-enabled version of Budgeting & Planning. These reports can be produced
either when launched from within Budgeting & Planning or from within the
client/server version of OFA.

Financial Across Paging
Report Name Formulas Used Element Dimension Down Dimension Dimension(s)
WebComp « FinData Current Year F140 FinData Chart of Accounts  Currency,
Average Balance . Formulas Organizational
Sheet «  FinData Last Year 4) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp « FinData Current Year F100 FinData Chart of Accounts  Currency,
Ending Balance . Formulas Organizational
Sheet «  FinData Last Year 4) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp « FinData Current Year F160 FinData Chart of Accounts  Currency,
Interest Rates . Formulas Organizational
« FinData Last Year @) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp TP «  FinData Current Year N171 FinData Chart of Accounts  Currency,
Percentage . Formulas Organizational
Spreads »  FinData Last Year 4) Unit, Forecast,
«  Current Year Variance Strategy
«  Current Year Percent
Variance
WebComp . FinData Current Year F160, FinData Chart of Accounts  Currency,
Margin Analysis . F170, Formulas Organizational
-  FinData Last Year N171 4) Unit, Forecast,
«  Current Year Variance Strategy

. Current Year Percent
Variance
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Financial Across Paging
Report Name Formulas Used Element Dimension Down Dimension Dimension(s)
WebComp «  Comp Income Stmt NA FinData Income Statement  Currency,
Income Current Year Formulas Organizational
Statement . Comp Income Stmt 4) ;Jt?;ttéForecast,
Last Year 9y
«  Comp Income Stmt
Variance
»  Comp Income Stmt
Percent Variance
«  (Embedded formulas)
WebComp TP »  Comp Income Stmt NA FinData Income Statement  Currency,
Spread Income Current Year Formulas Organizational
Statement 4 Unit, Forecast,
»  Comp Income Stmt Strate
Last Year oy
»  Comp Income Stmt
Variance
«  Comp Income Stmt
Percent Variance
« (Embedded formulas)
Web Periodic « Interest Income NA Time FinData Formulas  Currency,
Income Interest Expense 9) Organizational
Statement - P Unit, Forecast,

Net Interest Income
Loan Loss Provision
Non Interest Income
Non Interest Expense
Income Before Taxes
Income Tax

Net Income
(Embedded formulas)

Strategy
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Report Name

Formulas Used

Financial
Element

Across

Paging

Dimension Down Dimension Dimension(s)

Web Periodic TP
Spread Income
Statement

=« Asset Spread Income

« Liability & Capital
Spread Income

«  Total Spread Income
« Loan Loss Provision
. Non Interest Income
«  Non Interest Expense

. Net Income Before
Taxes (TP)

«  Income Tax (TP)
« NetIncome (TP)
«  (Embedded formulas)

NA

Time

FinData Formulas Currency,

©)

Organizational
Unit, Forecast,
Strategy
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Appendixes

Part 11l includes detailed reference information about the application.

Audience
This section is written for the following:

«  Super Administrator
. DBA

« System Administrator

Content
This section includes the following chapters:

« Appendix A, "Financial Elements"

=« Appendix B, "Cash Flow Calculations"

= Appendix C, "Express and OFA Object Descriptions"

= Appendix D, "Details of the Maturity Mix Data Model"

« Appendix E, "Express Programs, Objects and Processes"






A

Financial Elements

This appendix lists the seeded financial elements for Oracle Budgeting and Planing
in the following two tables:

« Sorted by the Financial Element Identifier

« Sorted by the Financial Element Description

Sorted by the Financial Element Identifier

FS.FIN_ELEM

FE.DESC

F60

Beginning Balance

F70

Beginning Gross Rate

F80

Beginning Net Rate

F90

Beginning Transfer Rate

F100

End Balance

F110

Ending Gross Rate

F120

Ending Net Rate

F130

Ending Transfer Rate

F140

Average Balance

F141

Average Account Balance

F142

Average Total Balance

F143

Average Percentage Active

F144

Average Volume Total
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Sorted by the Financial Element Identifier

FS.FIN_ELEM

FE.DESC

F150

Average Gross Rate

F160

Average Net Rate

F170

Average Transfer Rate

F172

Average Rem Term Transfer Rate

F180

Prepay Runoff Positive

F181

Timing of Prepay Runoff Positive

F182

Prepay Runoff Negative

F183

Timing of Prepay Runoff Negative

F190

Payment Runoff Positive

F191

Timing of Payment Runoff Positive

F192

Payment Runoff Negative

F193

Timing of Payment Runoff Negative

F195

Maturity Runoff Positive

F196

Timing of Maturity Runoff Positive

F197

Maturity Runoff Negative

F198

Timing of Maturity Runoff Negative

F210

Total Runoff Positive

F211

Timing of Total Runoff Positive

F212

Total Runoff Negative

F213

Timing of Total Runoff Negative

F220

Total Runoff Gross Rate

F230

Total Runoff Net Rate

F235

Prepay Runoff Net Rate

F240

Total Runoff Transfer Rate

F245

Prepay Runoff Transfer Rate

F250

Repricing Balance

F255

Repricing Balance At End

F260

Before Repricing Gross Rate
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

F270 After Repricing Gross Rate
F280 Before Repricing Net Rate
F290 After Repricing Net Rate
F300 Before Reprice Transfer Rate
F310 After Reprice Transfer Rate
F320 Fully Indexed Gross Rate
F330 Fully Indexed Net Rate
F340 New Add Balance

F341 Rollover Percentage

F342 Net New Business

F350 New Add Gross Rate

F360 New Add Net Rate

F370 New Add Transfer Rate
F375 New Add Spread

F380 Roll Add Balance

F390 Roll Add Gross Rate

F400 Roll Add Net Rate

F410 Roll Add Transfer Rate
F420 Interest

F425 Interest Amount Gross
F430 Interest Cash Flow

F435 Interest Cash Flow Gross
F437 Interest Cash Flow T-Rate
F440 Interest Accrued

F445 Interest Accrued Gross
F450 Charge/Credit

F452 Charge/Credit Rem Term
F455 Non Interest Income
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

F457 Non Interest Expense

F460 Accrued Interest Ending Balance
F470 Accrued Interest Average Balance
F480 Interest Credited

F490 Discount Rate

F500 WARM

F510 Annual Prepayment Rate
F515 Balance Before PrePay

F520 Deferred End Balance

F530 Deferred Average Balance
F540 Deferred Runoff

F550 Period Cap Balance

F560 Period Cap Effect Rate

F570 Period Cap Effect Amount
F580 Life Cap Balance

F590 Life Cap Effect Rate

F600 Life Cap Effect Amount

F610 Tease Balance

F620 Tease Effect Rate

F630 Tease Effect Amount

F640 Neg Am Balance

F650 Neg Am Interest

F660 Gap Runoff

F661 Gap Principal Runoff

F662 Gap Repricing Runoff

F663 Gap Deferred Runoff

F670 Gap Runoff Term

F671 Gap Interest Cash Flow Gross
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

F672 Gap Interest Cash Flow Net
F673 Gap Interest Cash Flow Transfer
F674 Gap Accrued Interest Gross
F675 Gap Accrued Interest Net

F676 Gap Accrued Interest Transfer
F677 Gap Interest Credited

F680 Gap Runoff Gross Rate

F690 Gap Runoff Net Rate

F700 Gap Runoff Transfer Rate

F710 Market Value

F720 Duration

F730 Convexity

F740 New Gross Balance

F750 New Net Balance

F760 Cur Pos Reprice Balance

F765 Adj Cur Pos Reprice Balance
F768 Cur Pos Before Reprice Rate
F770 Cur Pos After Reprice Rate

F775 Adj Cur Pos Reprice Rate

F778 Cur Pos Before Reprice T-Rate
F780 Cur Pos After Reprice T-Rate
F785 Adj Cur Pos Reprice Transfer Rate
F790 Cur Pos Runoff Balance

F795 Adj Cur Pos Runoff Balance
F800 Cur Pos Runoff Rate

F805 Adj Cur Pos Runoff Rate

F810 Cur Pos Runoff Transfer Rate
F815 Adj Cur Pos Runoff Transfer Rate
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

F820 Total Maturity/Repricing

F830 Total Mat/Repricing Rate

F840 Total Mat/Repricing Transfer Rate
F900 Fee Income on Int. Bearing Acct.
F905 Fee Income Percent

F910 Tax Exempt Adjustment

F920 Other Interest Income Adjustment
F930 Federal Taxes

F935 Local Taxes

F940 Dividends

F1101 Ending Balance per Account

F1102 Ending Number of Accounts

F1103 Percent of Active Ending Accounts
F1104 Number of Active Accounts

F1105 Ending Balance Unearned Discount
F1106 Ending Gross Balance

F1141 Average Account Balance (FE1141)
F1142 Average Number of Accounts
F1143 Average Percent Active Accounts
F1144 Average Number of Active Accounts
F1341 Rollover Percent New Business
F1342 Net New Business (FE1342)

F1343 New Balance Per Account

F1344 Number of New Accounts

F1345 Percent of Active New Accounts
F1346 Number of Active New Accounts
F1794 Average Maturing Account Balance
F1796 Number of Maturing Accounts
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

F1823 Maturing Balance per Account

F1824 Number of Maturing Active Accounts

F1825 Percent of Active Maturing Accounts

F1826 Number of Maturing Active Accounts_26

F2001 Static Gross Par Balance

F2002 Static Net Par Balance

F2003 Static Deferred Balance

F2004 Static Accrued Interest Balance

F2005 Static Net Rate

F2006 Static Transfer Rate

F2007 Static Remaining Term

F2008 Static Market Value

F2009 Static Duration

F10000 Statistical

C60 Current Position Beginning Balance

C80 Current Position Beginning Net Rate

C90 Current Position Beginning Transfer Rate

C100 Current Position End Balance

C120 Current Position Ending Net Rate

C130 Current Position Ending Transfer Rate

C140 Current Position Average Bal

C160 Current Position Average Net Rate

C170 Current Position Average Transfer Rate

C180 Current Position Prepay Runoff Positive

Cci181 Current Position Timing of Prepay Runoff Positive

C182 Current Position Prepay Runoff Negative

C183 Current Position Timing of Prepay Runoff
Negative
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

C190 Current Position Payment Runoff Positive

C191 Current Position Timing of Payment Runoff
Positive

C192 Current Position Payment Runoff Negative

C193 Current Position Timing of Payment Runoff
Negative

C195 Current Position Maturity Runoff Positive

C196 Current Position Timing of Maturity Runoff
Positive

C197 Current Position Maturity Runoff Negative

C198 Current Position Timing of Maturity Runoff
Negative

C210 Current Position Total Runoff Positive

c211 Current Position Timing of Total Runoff Positive

C212 Current Position Total Runoff Negative

C213 Current Position Timing of Total Runoff Negative

C230 Current Position Total Runoff Net Rate

C240 Current Position Total Runoff Transfer Rate

C250 Current Position Repricing Balance

C255 Current Position Repricing Balance At End

C280 Current Position Before Repricing Net Rate

C290 Current Position After Repricing Net Rate

C300 Current Position Before Reprice Transfer Rate

C310 Current Position After Reprice Transfer Rate

C330 Current Position Fully Indexed Net Rate

C430 Current Position Interest Cash Flow

C437 Current Position Interest Cash Flow T-Rate

C440 Current Position Interest Accrued

C450 Current Position Charge/Credit

A-8 Oracle Budgeting & Planning Reference Guide



Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

C500 Current Position WARM

C510 Current Position Annual Prepayment Rate
C515 Current Position Balance Before PrePay
C520 Current Position Deferred End Balance
C530 Current Position Deferred Average Balance
C540 Current Position Deferred Runoff

C790 Current Position Runoff Balance

N100 New Business Ending Balance

N120 New Business Ending Net Rate

N130 New Business Ending Transfer Rate

N140 New Business Average Balance

N160 New Business Average Net Rate

N170 New Business Average Transfer Rate

N171 TP Percent Spread

N180 New Business Prepay Runoff

N210 New Business Total Runoff

N230 New Business Total Runoff Net Rate

N235 New Business Prepay Runoff Net Rate
N240 New Business Total Runoff Transfer Rate
N245 New Business Prepay Runoff Transfer Rate
N250 New Business Repricing Balance

N255 New Business Repricing Balance At End
N280 New Business Before Repricing Net Rate
N290 New Business After Repricing Net Rate
N300 New Business Before Reprice Transfer Rate
N310 New Business After Reprice Transfer Rate
N395 Roll Add Spread

N420 New Business Interest
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

N450 New Business Charge/Credit
N451 TP Spread Income

N790 New Business Runoff Balance
N1395 Net New Spread

w1 Temporary Weighting #1
W2 Temporary Weighting #2
W3 Temporary Weighting #3
W4 Temporary Weighting #4
W5 Temporary Weighting #5
W6 Temporary Weighting #6
W7 Temporary Weighting #7
W8 Temporary Weighting #8
W9 Temporary Weighting #9
W10 Temporary Weighting #10
W11 Temporary Weighting #11
W12 Temporary Weighting #12
W13 Temporary Weighting #13
W14 Temporary Weighting #14
W15 Temporary Weighting #15
W16 Temporary Weighting #16
W17 Temporary Weighting #17
W18 Temporary Weighting #18
W19 Temporary Weighting #19
W20 Temporary Weighting #20
w21 Temporary Weighting #21
W22 Temporary Weighting #22
W23 Temporary Weighting #23
W24 Temporary Weighting #24
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

W25 Temporary Weighting #25
W26 Temporary Weighting #26
W27 Temporary Weighting #27
W28 Temporary Weighting #28
W29 Temporary Weighting #29
W30 Temporary Weighting #30
W3l Temporary Weighting #31
W32 Temporary Weighting #32
W33 Temporary Weighting #33
W34 Temporary Weighting #34
W35 Temporary Weighting #35
W36 Temporary Weighting #36
W37 Temporary Weighting #37
W38 Temporary Weighting #38
W39 Temporary Weighting #39
W40 Temporary Weighting #40
w41l Temporary Weighting #41
W42 Temporary Weighting #42
W43 Temporary Weighting #43
W44 Temporary Weighting #44
W45 Temporary Weighting #45
W46 Temporary Weighting #46
w47 Temporary Weighting #47
W48 Temporary Weighting #48
W49 Temporary Weighting #49
W50 Temporary Weighting #50
W51 Temporary Weighting #51
W52 Temporary Weighting #52
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Sorted by the Financial Element Identifier

FS.FIN_ELEM

FE.DESC

W53

Temporary Weighting #53

W54

Temporary Weighting #54

W55

Temporary Weighting #55

W56

Temporary Weighting #56

W57

Temporary Weighting #57

W58

Temporary Weighting #58

W59

Temporary Weighting #59

W60

Temporary Weighting #60

W61

Temporary Weighting #61

W62

Temporary Weighting #62

W63

Temporary Weighting #63

W64

Temporary Weighting #64

W65

Temporary Weighting #65

W66

Temporary Weighting #66

W67

Temporary Weighting #67

W68

Temporary Weighting #68

W69

Temporary Weighting #69

W70

Temporary Weighting #70

W71

Temporary Weighting #71

W72

Temporary Weighting #72

W73

Temporary Weighting #73

W74

Temporary Weighting #74

W75

Temporary Weighting #75

W76

Temporary Weighting #76

W77

Temporary Weighting #77

W78

Temporary Weighting #78

W79

Temporary Weighting #79

W80

Temporary Weighting #80
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Sorted by the Financial Element Identifier

FS.FIN_ELEM FE.DESC

W Temporary Weighting #81
W82 Temporary Weighting #82
W83 Temporary Weighting #83
W84 Temporary Weighting #84
W85 Temporary Weighting #85
W86 Temporary Weighting #86
W87 Temporary Weighting #87
W88 Temporary Weighting #88
W89 Temporary Weighting #89
W90 Temporary Weighting #90
W91l Temporary Weighting #91
W92 Temporary Weighting #92
W93 Temporary Weighting #93
W94 Temporary Weighting #94
W95 Temporary Weighting #95
W96 Temporary Weighting #96
W97 Temporary Weighting #97
W98 Temporary Weighting #98
W99 Temporary Weighting #99
W100 Temporary Weighting #100
A420 Annualized Interest
A450 Annualized Charge/Credit
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Sorted by the Financial Element Description

Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Accrued Interest Average Balance F470
Accrued Interest Ending Balance F460
Adj Cur Pos Reprice Balance F765
Adj Cur Pos Reprice Rate F775
Adj Cur Pos Reprice Transfer Rate F785
Adj Cur Pos Runoff Balance F795
Adj Cur Pos Runoff Rate F805
Adj Cur Pos Runoff Transfer Rate F815
After Reprice Transfer Rate F310
After Repricing Gross Rate F270
After Repricing Net Rate F290
Annual Prepayment Rate F510
Annualized Charge/Credit A450
Annualized Interest A420
Average Account Balance F141
Average Account Balance (FE1141) F1141
Average Bal F140
Average Gross Rate F150
Average Maturing Account Balance F1794
Average Net Rate F160
Average Number of Accounts F1142
Average Number of Active Accounts F1144
Average Percent Active Accounts F1143
Average Percentage Active F143
Average Rem Term Transfer Rate F172
Average Total Balance F142

A-14 Oracle Budgeting & Planning Reference Guide



Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Average Transfer Rate F170
Average Volume Total F144
Balance Before PrePay F515
Before Reprice Transfer Rate F300
Before Repricing Gross Rate F260
Before Repricing Net Rate F280
Beginning Balance F60
Beginning Gross Rate F70
Beginning Net Rate F80
Beginning Transfer Rate F90
Charge/Credit F450
Charge/Credit Rem Term F452
Convexity F730
Cur Pos After Reprice Rate F770
Cur Pos After Reprice T-Rate F780
Cur Pos Before Reprice Rate F768
Cur Pos Before Reprice T-Rate F778
Cur Pos Reprice Balance F760
Cur Pos Runoff Balance F790
Cur Pos Runoff Rate F800
Cur Pos Runoff Transfer Rate F810
Current Position After Reprice Transfer Rate C310
Current Position After Repricing Net Rate C290
Current Position Annual Prepayment Rate C510
Current Position Average Bal C140
Current Position Average Net Rate C160
Current Position Average Transfer Rate C170
Current Position Balance Before PrePay C515
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Current Position Before Reprice Transfer Rate C300
Current Position Before Repricing Net Rate C280
Current Position Beginning Balance C60
Current Position Beginning Net Rate C80
Current Position Beginning Transfer Rate C90
Current Position Charge/Credit C450
Current Position Deferred Average Balance C530
Current Position Deferred End Balance C520
Current Position Deferred Runoff C540
Current Position End Balance C100
Current Position Ending Net Rate C120
Current Position Ending Transfer Rate C130
Current Position Fully Indexed Net Rate C330
Current Position Interest Accrued C440
Current Position Interest Cash Flow C430
Current Position Interest Cash Flow T-Rate C437
Current Position Maturity Runoff Negative C197
Current Position Maturity Runoff Positive C195
Current Position Payment Runoff Negative C192
Current Position Payment Runoff Positive C190
Current Position Prepay Runoff Negative C182
Current Position Prepay Runoff Positive C180
Current Position Repricing Balance C250
Current Position Repricing Balance At End C255
Current Position Runoff Balance C790
Current Position Timing of Maturity Runoff C198
Negative

Current Position Timing of Maturity Runoff C196
Positive
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Sorted by the F

inancial Element Description

FE.DESC FS.FIN_ELEM
Current Position Timing of Payment Runoff C193
Negative

Current Position Timing of Payment Runoff C191
Positive

Currer_lt Position Timing of Prepay Runoff C183
Negative

Current Position Timing of Prepay Runoff Positive C181
Current Position Timing of Total Runoff Negative  C213
Current Position Timing of Total Runoff Positive Cc211
Current Position Total Runoff Negative C212
Current Position Total Runoff Net Rate C230
Current Position Total Runoff Positive C210
Current Position Total Runoff Transfer Rate C240
Current Position WARM C500
Deferred Average Balance F530
Deferred End Balance F520
Deferred Runoff F540
Discount Rate F490
Dividends F940
Duration F720
End Balance F100
Ending Balance per Account F1101
Ending Balance Unearned Discount F1105
Ending Gross Balance F1106
Ending Gross Rate F110
Ending Net Rate F120
Ending Number of Accounts F1102
Ending Transfer Rate F130
Federal Taxes F930
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Fee Income on Int. Bearing Acct. F900
Fee Income Percent F905
Fully Indexed Gross Rate F320
Fully Indexed Net Rate F330
Gap Accrued Interest Gross F674
Gap Accrued Interest Net F675
Gap Accrued Interest Transfer F676
Gap Deferred Runoff F663
Gap Interest Cash Flow Gross F671
Gap Interest Cash Flow Net F672
Gap Interest Cash Flow Transfer F673
Gap Interest Credited F677
Gap Principal Runoff F661
Gap Repricing Runoff F662
Gap Runoff F660
Gap Runoff Gross Rate F680
Gap Runoff Net Rate F690
Gap Runoff Term F670
Gap Runoff Transfer Rate F700
Interest F420
Interest Accrued F440
Interest Accrued Gross F445
Interest Amount Gross F425
Interest Cash Flow F430
Interest Cash Flow Gross F435
Interest Cash Flow T-Rate F437
Interest Credited F480
Life Cap Balance F580
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Life Cap Effect Amount F600
Life Cap Effect Rate F590
Local Taxes F935
Market Value F710
Maturing Balance per Account F1823
Maturity Runoff Negative F197
Maturity Runoff Positive F195
Neg Am Balance F640
Neg Am Interest F650
Net New Business F342
Net New Business (FE1342) F1342
Net New Spread N1395
New Add Balance F340
New Add Gross Rate F350
New Add Net Rate F360
New Add Spread F375
New Add Transfer Rate F370
New Balance Per Account F1343
New Business After Reprice Transfer Rate N310
New Business After Repricing Net Rate N290
New Business Average Balance N140
New Business Average Net Rate N160
New Business Average Transfer Rate N170
New Business Before Reprice Transfer Rate N300
New Business Before Repricing Net Rate N280
New Business Charge/Credit N450
New Business Ending Balance N100
New Business Ending Net Rate N120
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
New Business Ending Transfer Rate N130
New Business Interest N420
New Business Prepay Runoff N180
New Business Prepay Runoff Net Rate N235
New Business Prepay Runoff Transfer Rate N245
New Business Repricing Balance N250
New Business Repricing Balance At End N255
New Business Runoff Balance N790
New Business Total Runoff N210
New Business Total Runoff Net Rate N230
New Business Total Runoff Transfer Rate N240
New Gross Balance F740
New Net Balance F750
Non Interest Expense F457
Non Interest Income F455
Number of Active Accounts F1104
Number of Active New Accounts F1346
Number of Maturing Accounts F1796
Number of Maturing Active Accounts F1824
Number of Maturing Active Accounts_26 F1826
Number of New Accounts F1344
Other Interest Income Adjustment F920
Payment Runoff Negative F192
Payment Runoff Positive F190
Percent of Active Ending Accounts F1103
Percent of Active Maturing Accounts F1825
Percent of Active New Accounts F1345
Period Cap Balance F550

A-20 Oracle Budgeting & Planning Reference Guide



Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Period Cap Effect Amount F570
Period Cap Effect Rate F560
Prepay Runoff Negative F182
Prepay Runoff Net Rate F235
Prepay Runoff Positive F180
Prepay Runoff Transfer Rate F245
Repricing Balance F250
Repricing Balance At End F255
Roll Add Balance F380
Roll Add Gross Rate F390
Roll Add Net Rate F400
Roll Add Spread N395
Roll Add Transfer Rate F410
Rollover Percent New Business F1341
Rollover Percentage F341
Static Accrued Interest Balance F2004
Static Deferred Balance F2003
Static Duration F2009
Static Gross Par Balance F2001
Static Market Value F2008
Static Net Par Balance F2002
Static Net Rate F2005
Static Remaining Term F2007
Static Transfer Rate F2006
Statistical F10000
Tax Exempt Adjustment F910
Tease Balance F610
Tease Effect Amount F630
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Tease Effect Rate F620
Temporary Weighting #01 w1
Temporary Weighting #02 W2
Temporary Weighting #03 W3
Temporary Weighting #04 W4
Temporary Weighting #05 W5
Temporary Weighting #06 W6
Temporary Weighting #07 W7
Temporary Weighting #08 W8
Temporary Weighting #09 W9
Temporary Weighting #10 W10
Temporary Weighting #100 W100
Temporary Weighting #11 W11
Temporary Weighting #12 W12
Temporary Weighting #13 W13
Temporary Weighting #14 W14
Temporary Weighting #15 W15
Temporary Weighting #16 W16
Temporary Weighting #17 W17
Temporary Weighting #18 W18
Temporary Weighting #19 W19
Temporary Weighting #20 W20
Temporary Weighting #21 W21
Temporary Weighting #22 W22
Temporary Weighting #23 W23
Temporary Weighting #24 W24
Temporary Weighting #25 W25
Temporary Weighting #26 W26

A-22 Oracle Budgeting & Planning Reference Guide



Sorted by the F

inancial Element Description

FE.DESC FS.FIN_ELEM
Temporary Weighting #27 W27
Temporary Weighting #28 W28
Temporary Weighting #29 W29
Temporary Weighting #30 W30
Temporary Weighting #31 W3l
Temporary Weighting #32 W32
Temporary Weighting #33 W33
Temporary Weighting #34 W34
Temporary Weighting #35 W35
Temporary Weighting #36 W36
Temporary Weighting #37 W37
Temporary Weighting #38 W38
Temporary Weighting #39 W39
Temporary Weighting #40 W40
Temporary Weighting #41 w4l
Temporary Weighting #42 W42
Temporary Weighting #43 W43
Temporary Weighting #44 W44
Temporary Weighting #45 W45
Temporary Weighting #46 W46
Temporary Weighting #47 w47
Temporary Weighting #48 W48
Temporary Weighting #49 W49
Temporary Weighting #50 W50
Temporary Weighting #51 W51
Temporary Weighting #52 W52
Temporary Weighting #53 W53
Temporary Weighting #54 W54
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Temporary Weighting #55 W55
Temporary Weighting #56 W56
Temporary Weighting #57 W57
Temporary Weighting #58 W58
Temporary Weighting #59 W59
Temporary Weighting #60 W60
Temporary Weighting #61 W61
Temporary Weighting #62 W62
Temporary Weighting #63 W63
Temporary Weighting #64 W64
Temporary Weighting #65 W65
Temporary Weighting #66 W66
Temporary Weighting #67 W67
Temporary Weighting #68 W68
Temporary Weighting #69 W69
Temporary Weighting #70 W70
Temporary Weighting #71 W71
Temporary Weighting #72 W72
Temporary Weighting #73 W73
Temporary Weighting #74 W74
Temporary Weighting #75 W75
Temporary Weighting #76 W76
Temporary Weighting #77 W77
Temporary Weighting #78 W78
Temporary Weighting #79 W79
Temporary Weighting #80 W80
Temporary Weighting #381 wal
Temporary Weighting #82 W82
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Temporary Weighting #83 W83
Temporary Weighting #84 W84
Temporary Weighting #85 W85
Temporary Weighting #86 W86
Temporary Weighting #87 w87
Temporary Weighting #88 W88
Temporary Weighting #89 W89
Temporary Weighting #90 W90
Temporary Weighting #91 Wol
Temporary Weighting #92 W92
Temporary Weighting #93 W93
Temporary Weighting #94 W94
Temporary Weighting #95 W95
Temporary Weighting #96 W96
Temporary Weighting #97 W97
Temporary Weighting #98 W98
Temporary Weighting #99 W99
Timing of Maturity Runoff Negative F198
Timing of Maturity Runoff Positive F196
Timing of Payment Runoff Negative F193
Timing of Payment Runoff Positive F191
Timing of Prepay Runoff Negative F183
Timing of Prepay Runoff Positive F181
Timing of Total Runoff Negative F213
Timing of Total Runoff Positive F211
Total Mat/Repricing Rate F830
Total Mat/Repricing Transfer Rate F840
Total Maturity/Repricing F820
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Sorted by the Financial Element Description

FE.DESC FS.FIN_ELEM
Total Runoff Gross Rate F220
Total Runoff Negative F212
Total Runoff Net Rate F230
Total Runoff Positive F210
Total Runoff Transfer Rate F240
TP Percent Spread N171
TP Spread Income N451
WARM F500
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B

Cash Flow Calculations

The Budgeting & Planning application is designed primarily to meet the cash flow
modeling needs of financial institutions. The primary source of a financial
institution’s profitability is its financial instruments. Therefore, the ability to forecast
run off and repricing becomes paramount in determining profitability.

Modeling financial instruments is typically referred to as cash flow forecasting, as
opposed to the forecasting of total portfolio balances. Cash flow forecasts model the
maturities and repricing characteristics of both existing business as well as
anticipated new business.

The cash flow engine for the Budgeting & Planning application is designed to meet
the following objectives:

« Maintain a thin client approach, which means that data-intensive calculations
are performed within the Express stored procedure language

« Enable end users to customize the cash flow routines that have been provided
to accommodate unique requirements

« Design the application’s architecture in such a way that the user interface is
separated from the engines that calculate pro forma financial results

Cash flow forecasting within the Budgeting & Planning application consists of the
following two components:

« Cash flow routines that use the Express stored procedure language

« A user interface that simplifies your interaction with these routines

Cash Flow Calculations B-1



Basic Cash Flow Calculations

Basic Cash Flow Calculations

This section provides detailed explanations of the basic cash flow calculations used
in the Budgeting & Planning application. The following cash flow types are
documented:

« Fixed Bullet Maturity

« Fixed-rate Amortizing

« Amortizing Repricing (adjustable-rate amortizing)
= Non-interest Income

« Non-interest Expense

« Non-term

= Non-rate Related

= Rollovers

« Statistical Data

This appendix also provides a detailed explanation of how current position run-off
is calculated using the actual maturity date of the instrument, rather than a
mid-period average, to determine the cash flow. This is a change from previous
versions of the Budgeting & Planning application and is discussed in the next
section.

Changes in Calculating Runoff

Previous releases of the Budgeting & Planning application assumed a mid-period
timing event for both maturing and newly booked loans. This caused the results of
the cash flow calculations to be inconsistent with cash flow calculations from Risk
Manager, which uses the actual date on which the financial instrument either paid
off or was booked. With this release of the Budgeting & Planning application,
results are computed in such a way as to more closely correspond to Risk Manager
runoff calculations.
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Basic Cash Flow Calculations

Cash Flow Calculations Used in Previous Releases

In prior releases the calculation of interest, average balance, and average rate used
the following formulas:

Interest = Beginning Balance * Beginning Rate / Annualization Factor+
New Business * New Business Rate *.5 / Annualization
Factor- Current Position Maturities * Current Position
Maturing Rate* .5 / Annualization Factor - New Business
Maturities* New Business Maturing Rate * .5/Annualization
Factor

Average Balance = (Beginning Balance + Ending Balance) / 2

Average Rate = (Interest * Annualization factor) / Average Balance

These formulas were based on the following factors:

Annualization Based on the accrual method used. For example, the number
Factor of days in month/number of days in year represented an
actual/actual accrual method .

0.5 Time weighting factor used to reflect maturities and new
business bookings in the middle of the month.

Transfer pricing charges and credits and average transfer rates were also
determined using the approach outlined above. The only difference was
substituting transfer rates for interest rates, where appropriate.

However, the cash flow engines used by Risk Manager compute interest, charges
and credits, and average balance for the current position maturities, using the day
of the month on which the instrument matures rather than employing a mid-period
maturity for all instruments, regardless of the actual date the instrument is paid off.
Therefore, unless an instrument matured on the 15th of the month, there was an
inherent inconsistency in the cash flow results between the method used in the
Budgeting & Planning application and the method used in Risk Manager.
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Basic Cash Flow Calculations

Cash Flow Calculations Used for this Release

In this release of the Budgeting & Planning application, all of the current position
projected results generated by Risk Manager are pulled over and loaded into
Budgeting & Planning. The actual maturity, payment, and repricing timing factors
for all of the instruments for your organization are included in the interest, charges
and credits, and ending and average balance amounts pulled into Budgeting &
Planning.

The current position results generated by Risk Manager are then combined with the
new business assumptions entered into the Budgeting & Planning application to
determine the total results.

Storing New Business Runoff Data

All of the projected principal balance runoff and repricing activity for new business
volumes, along with associated rate and transfer rate information, is stored in the
Incremental Runoff variable. Cash flow calculations write the projected values to
this variable with data storage corresponding to the month originated and mix_
breakout level. The calculations then perform relevant balance summations and
calculate balance-weighted average rates and transfer rates using the information
stored in the Incremental Runoff variable. They then write these values to the
appropriate financial elements in the Financial Data (FS.FIN_DATA) variable. The
use of this approach allows new business calculations performed by the cash flow
engine to be limited to only those time periods where new business balances have
been input or derived. This avoids the need to re-calculate projections for new
business values previously processed.

References in this guide to any of the financial elements listed below generally
imply that the balance, rate, or transfer rate information is being written to or
accessed from the Incremental Runoff variable:

= New Business Runoff

= New Business Runoff Rate

= New Business Runoff Transfer Rate

« New Business Repricing Balance

« New Business Rate Before Repricing

« New Business Rate After Repricing

« New Business Transfer Rate Before Repricing

« New Business Transfer Rate After Repricing
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New Business Volumes
For new business volumes, the calculation of interest, average balance, average rate,
charges and credits and average transfer rate is computed as follows:

NB Interest = ((NB Beginning Balance * NB Beginning Rate) - (NB Runoff * NB
Runoff Rate * Timing Factor) + (New Business * New Business Rate * Timing
Factor))

NB AvgBal = ((NB Beginning Balance - (NB Runoff * Timing Factor) + (New
Business * Timing Factor))

NB AvgRt = NB Interest * Annualization Factor / NB AvgBal

NB Chg/Cr = ((NB Beginning Balance * NB Beginning Transfer Rate - (NB Runoff
* NB Runoff Transfer Rate * Timing Factor) + (New Business * New Business
Transfer Rate * Timing Factor))

NB AvgTrt = NB Chg/Cr * Annualization Factor / NB AvgBal

The total account results for interest, average balance, average rate, charges and
credits and average transfer rate are calculated as follows:

Interest = CP Interest + NB Interest

AvgBal = CP AvgBal + NB AvgBal

AvgRt = Interest * Annualization Factor / AvgBal

Chg/Credit = CP Chg/Cr + NB Chg/Cr

AvgTrt = Chg/Credit * Annualization Factor / AvgBal

where:

CP Interest = Current Position interest from Risk Manager

CP AvgBal = Current Position average balance from Risk Manager

CP Chg/Cr = Current Position charge/credit from Risk Manager

Note that NB AvgBal, NB AvgRt and NB AvgTrt are not currently displayed in the
interface or written to the database.

These calculations break down individual accounts into the following three *virtual’
instruments:
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Virtual’ Instrument Business Approach

Current Position Results  Pro forma financial results, generated by Risk Manager, for the
current position maturity and repricing activity, are used.

New Business A new business timing factor is input by your organization. This
section presents examples of how the calculations arrive at
results. For the purposes of these examples, it is assumed that
new business is booked, on average, at the middle of the month.

New Business Maturities A new business timing factor is input by your organization. As
with the booking of new business, these examples assume a
maturity at the middle of the month.

Rate and transfer rate information generated by Risk Manager is also loaded into
Budgeting & Planning and is available for display purposes, to show how the
current position results are generated. These are also used in certain types of
calculations.

Changes in the Cash Flow Output

In previous versions of the Budgeting & Planning application, the cash flow output
generated by Risk Manager was assigned to financial elements created specifically
for Budgeting & Planning. In addition, you had to choose the Budgeting Cash
Flows option under Processing Types in the Risk Manager Process ID.

With this release, rather than using financial elements unique to Budgeting &
Planning, the cash flow outputs are written to financial elements that are changed
slightly to conform to the naming conventions imposed by Oracle Express. For the
Risk Manager cash flow output the appropriate financial elements now have the
character "C" added to the beginning of each financial element. The relationship to
the OFSA financial element is, in virtually all cases, one-to-one. With this change the
Budgeting Cash Flows option is no longer necessary. When you process your cash
flows you should now select the option called Scenario based option.

Bullet Maturity (FS.BULLET,FIXED)

A bullet maturity is a financial instrument where the principal balance matures at a
specific point in the future. A Certificate of Deposit is an example of a bullet
maturity instrument.

This section presents, in detail, the methodologies used to calculate cash flows for
this type of instrument.
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Cash flow calculations include the maturities of current position (those instruments
currently on the books), new business and the forecasted maturity of new business
(runoff). The timing of the new business maturities is stored in the Maturity Mix
variable. See the section entitled "Maturity Mix Data Model for New Business" in
Chapter 2, "The Data Model" for more information on this variable.

Bullet Maturity Cash Flow Example
In this example Certificates of Deposit are used to model cash flow calculations.

This provides detailed formulas and examples to calculate the following results,
which are required for bullet maturity instruments:

«  Current position results

« Ending balance

« Average balance

« Interest and transfer charges and credits
= New business beginning balance

= New business runoff

= New business interest

Parameters and Assumptions Used in this Example
The following parameters and assumptions are provided for this example:

« The financial institution is offering Certificates of Deposit with one, two and
three-month maturities.

= New business is forecasted at $800 in each time period, which, for this example
is a month.

= New business is booked equally through the course of a month, therefore the
time period weighting factor used is 50%.

« The spread below the transfer rate is forecasted at 2%.
« The annualization method is: Number of days in the month/365.

«  Customer activity, based on prior experience, indicates that, for the first month
customer preference is spread equally across all maturities. However, in the
second and third months of the forecast period, customers select only one and
two month maturities.
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This customer preference is displayed in the following table:

Term January February March
1 Month 33% 50% 50%

2 Month 34% 50% 50%

3 Month 33%

Current Position Results Generated by Risk Manager for this Example

The following tables show this account’s current position and the results of Risk
Manager processing against that data. All of the information in the tables is
produced by Risk Manager and brought into Express using the data movement
routines described in the section entitled "Data Movement Routines" in Chapter 3,
"Administering the Application".

This table displays the current position maturities for this example:

Balance Rate Transfer Rate  Ending Balance
Beginning Balance 1000 6.50% 7.78%
Maturities in January 700 6.00% 7.50% 300
Maturities in February 200 7.00% 8.50% 100
Maturities in March 100 9.00% 8.25% 0
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This table displays the results from the processing of current position data:

Beginning Ending Average

Average Charge/ Beginning Ending Average Transfer Transfer Transfer
Month Balance Interest Credit Rate Rate Rate Rate Rate Rate
January 481 2.873 3.295 6.50% 7.67% 7.04% 7.78% 8.42% 8.07%
February 248 1.570 1.598 7.67% 9.00% 8.25% 8.42% 8.25% 8.40%
March 51 0.390 0.358 9.00% 0.00% 9.00% 8.25% 0.00% 8.25%

Ending Balance Computations for the Entire Account

Calculating the ending balance for the entire account is shown in the formula below.

Ending Balance = Prior Period EndBal + New Business - CP Runoff - NB Runoff.
where:

CP Runoff = The projected current position runoff balance from Risk Manager
data transfer.

New Business = Input value

New Business Runoff = Sum of (New Business Runoff from the Incremental
Runoff variable)

The calculation of the new business ending balance component of total ending
balance is as follows:

NB EndBal = Accumulated New Business - Accumulated New Business Runoff
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This table displays the ending balances for this example:

Month New Business + New -New Business = New Business + Current = Total
Beginning Business Runoff Ending Balance Position Ending Ending
Balance Balance Balance
January 0 800 0 800 300 1100
February 800 800 264 =(800*.33) 1336 =((800 + 100 1436
(800 - 264))
March 1336 800 672 =(800*34) 1464 =((800 + 0 1464
+ (800 * .50) (1336 - 672))

Average Balance Computations

The formula below shows how average balances are calculated.

Average Balance = CP AvgBal + NB AvgBal
where:

CP AvgBal = The projected current position average balance from RM data
transfer

NB AvgBal = (New Business Beginning Balance + (New Business - New Business
Runoff) * New Business Timing Factor)

New Business Beginning Balance = Prior period ending balance.

New Business Runoff = Sum of New Business Runoff from the Incremental Runoff
variable

New Business Timing Factor = User input value indicating when new business is
typically booked during the course of a month.

New Business: Input assumption.

Note that NB AvgBal is not currently displayed in the interface nor written to the
database.
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The average balance calculations for this example are shown in the following table:

New Current

Business  New Business New Position  Total

Beginning Runoff Business  Total New Business Average Average
Month Balance Average Average Average Balance Balance Balance
January 0 0 400=800*5 400=800*.5 481 881
February 800 132=264*(0.5) 400=800*5 1068=2800-132+400 248 1316
March 1336 336=672*(0.5) 400=800*5 1400=1336-336+400 51 1451

Computing Interest and Transfer Charges and Credits

After the current position, ending and average balances have been calculated the
next step is to compute interest and transfer credits and charges for the account.

To calculate interest on new business, you first need to select the appropriate
transfer rate to assign to this balance. This calculation requires information from
the rate forecast yield curve and the maturity mix variable.

In this example, the transfer rate data, which resides in the Interest Rate variable, is
assigned to the product in the following manner:

Transfer Rates for: January February March
1 month 6.00% 6.50% 7.25%
3 months 7.00% 7.50% 8.25%

In this example, the two month term is missing. The transfer rate is assigned to new
business based on the interest rate data and maturity mix information that is
available. In this example the instrument has a two month term, however, a two
month term does not exist on the transfer rate curve, therefore the two month
transfer rate is interpolated, using the straight line method.
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The formula below is used to determine the interpolated transfer rate:

Interpolated rate = ((Rate at later term - Rate at earliest term) / (later term - earlier
term)) + rate at earliest term.

In this example, the transfer rate for January is:
((7.00% - 6.00%) / (3 - 1)) +6.00 = 1.00% / 2 + 6.00% = 6.50%

The transfer rates for all terms is:

Transfer Rates  January February March
1 month 6.00% 6.50% 7.25%
2 months 6.50% 7.00% 7.75%
3 Months 7.00% 7.50% 8.25%

From this information the transfer rate on new business for each month can be
derived. This is done by weighting the rate on the interest rate curve by the
maturity mix percentage in the Maturity Mix variable.

In this example the following results are calculated:
January = (6.00 * .33) + (6.50 * .34) + (7.00 * .33) = 6.50%
February = (6.50 * .50) + (7.00 * .50) = 6.75%

The interest rate on new business, for assets and liabilities or capital, is computed as
follows:

For accounts with the attribute of asset:

Interest Rate on New Business = Transfer rate on New Business + Spread on New
Business
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For accounts with the attribute of liability or capital:

Interest Rate on New Business = Transfer rate on New Business - Spread on New
Business

Assuming a spread to the transfer rate of -2.00% for all terms, the new business
interest rates in this example are displayed in the following table:

Transfer Rates For:  January February March
1 Month 4.00% 4.50% 5.25%
2 Months 4.50% 5.00% 5.75%
3 Months 5.00% 5.50% 6.25%

These calculations enable you to compute interest, transfer rate credits, and margins
for this account.

Interest is calculated according to the following formula:

Total Interest for the time period = Current Position Interest + New Business
Interest

where,

Current Position Interest = Interest on Current Position from Risk Manager

New Business Interest = ((New Business Beginning Balance * New Business
Beginning Rate/100 - (New Business Runoff * New Business Runoff Rate/100 *
Timing Factor) + (New Business * New Business Rate/100 * Timing Factor)) *
Annualization Factor

New Business Beginning Balance = Prior Period New Business Ending Balance
New Business Beginning Rate = Prior Period New Business Ending Rate

New Business Ending Rate = ((New Business Beginning Balance * New Business
Beginning Rate) - (New Business Runoff * New Business Runoff Rate) + (New
Business * New Business Rate)) / New Business Ending Balance

In the above formula, the New Business Runoff rate should be the point on the yield

curve for the time period that corresponds to the term of the maturity. For example,
the portion that is maturing one month from when that portion was put on the
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books should receive the rate corresponding to the one month term in the month of
origination.

For this example, the interest calculations are as follows:

New Business

Beginning + New Business  -NewBusiness + Current Position

Balance Interest Runoff Interest Total Interest
January 0.000 1.529 0.000 2.873 4401
February 1.227 1.458 0.405 1.570 3.850
March 2439 1.868 1.284 0.390 3413

The following tables show the interest calculations for the following:
« New business beginning balance
= New business runoff

=« New business interest

New Business Beginning Balance

New Business

Beginning New Business Annualization Timing New Business Beginning
Balance Beginning Rate  Factor Factor Balance Interest
January 0 0% 8.49% 50% $ 0.000
February 800 4.00% 7.67% 50% $ 1227
March 1336 4.30%=(536*4%)+ 8.49% 50% $ 2439
(800*4.5%)/1336
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New Business Runoff

New Business New Business Annualization 1-Timing New Business Runoff
Runoff Balance Runoff Rate Factor Factor Interest
January 0 0 8.49% =31/365 50% 0
February 264 4.00% 7.67% 50% $ .405
March 672 = 272+400 4.50% = 8.49% 50% $1.284
(272*.045)+(400*.045)
/672

New Business Interest

Annualization New Business
New Business New Business Rate Factor Timing Factor Interest
January 800 4.00% 8.49% 50% $ 1529
February 800 4.50% 7.67% 50% $ 1458
March 800 5.00% 8.49% 50% $ 1.868

Fixed-Rate Amortizing (FS.AMORT.FIXED)

A fixed-rate amortizing instrument matures new business according to the principal
portion of a level payment amount. An auto loan is an example of this type of
instrument.

The unique challenge for this kind of instrument is the derivation of the transfer
rate to be assigned to new business. If the rate on new business is computed as:

New Business rate = The transfer rate + spread
and,

The transfer rate is computed based on the level payment, which in turn requires
the new business rate to derive it (Payment = f(balance, rate, term)) then circular
logic exists.

Cash Flow Calculations B-15



Basic Cash Flow Calculations

The transfer pricing calculations in the Budgeting & Planning application use an
iterative methodology that performs the calculations for the transfer rate twice to
arrive at an equilibrium transfer rate.

The Budgeting & Planning application supports the following transfer rate
methodologies:

« Zero Coupon
« Duration Based

« Weighted Average Term

Fixed-Rate Amortizing with Balloon

An amortizing-balloon instrument behaves the same as a regular fixed-rate
amortizing instrument, except that instrument amortization is calculated using an
amortization term that is longer than the contractual term to maturity. The balance
remaining at maturity represents a ’balloon payment’ due in lump sum at the
maturity date of the instrument. You can use this functionality by entering an
Amortization Term in the Maturity Mix variable.

The initial transfer rate for this instrument uses the same iterative methodology as
the fixed-rate amortizing instrument. The transfer rate for the remaining balance
and interest cash flow at the balloon term is the corresponding transfer rate for that
term on the transfer pricing yield curve.

Fixed-Rate Amortizing with Residual Value

With a residual value instrument, a specified portion of the principal balance
amortizes over the term of the loan and the remaining, or residual, portion matures
at the end of the loan. This instrument requires that your end user input a %
residual value in the Maturity Mix variable. Once this value is input, the instrument
behaves like a standard, fixed-rate amortizing instrument for the non-residual
portion of the principal and a bullet maturity for the residual portion of the
principal. A lease is an example of a residual instrument.

Amortizing-Repricing

An amortizing-repricing instrument is similar to a fixed-rate amortizing instrument
except that, at contractually specified intervals during the instrument’s life, the
remaining outstanding balance (the non-matured portion) reprices, based on the
current market rate.
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At repricing, the rate is calculated as follows:
Transfer rate at repricing period + spread at loan origination

The initial transfer rate uses the same iterative process used to calculate the transfer
rate for fixed-rate amortizing instruments.

For amortizing repricing accounts the following calculations are used:

New Business Interest = (((New Business Beginning Balance * New Business
Beginning Rate/100) + ((New Business * New Business Rate/100) * Timing Factor) -
((New Business Runoff * New Business Runoff Rate/100) * Timing Factor) + ((New
Business Repricing Balance * ((New Business Rate After Repricing - New Business
Rate Before Repricing)/100)) * Timing Factor) * Annualization Factor

New Business Charge/Credit = (((New Business Beginning Balance * New
Business Beginning Transfer Rate/100) + ((New Business * New Business Transfer
Rate/100) * Timing Factor) - ((New Business Runoff * New Business Runoff Transfer
Rate/100) * Timing Factor) + ((New Business Repricing Balance * (New Business
Transfer Rate After Repricing - New Business Transfer Rate Before Repricing)/100))
* Timing Factor) * Annualization Factor

New Business Ending Rate = ((New Business Beginning Balance * New Business
Beginning Rate) + (New Business * New Business Rate) - (New Business Runoff *
New Business Runoff Rate) + (New Business Repricing Balance * (New Business
Rate After Repricing - New Business Rate Before Repricing))) / (Prior Period New
Business Ending Balance + New Business - New Business Runoff)

New Business Ending Transfer Rate = ((New Business Beginning Balance * New
Business Beginning Transfer Rate) + (New Business * New Business Transfer Rate) -
(New Business Runoff * New Business Runoff Transfer Rate) + (New Business
Repricing Balance * (New Business Transfer Rate After Repricing - New Business
Transfer Rate Before Repricing))) / (Prior Period New Business Ending Balance +
New Business - New Business Runoff)

Caps and Floors

Instruments with interest rate caps and/or floors are repricing instruments whose
rate changes cannot exceed a specified, contractual range. An instrument can have
two types of caps and/or floors.
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Non-Term

Periodic Caps and Floors

The rate cannot change more than a specified range at any repricing point. For
example, the rate change can not exceed 2%, either upwards or downwards, for any
repricing event.

You can use this functionality by entering values for the following two
characteristics in the Maturity Mix variable:

= RATE.INCREASE.PERIOD
« RATE.DECREASE.PERIOD

Lifetime Caps and Floors

A lifetime cap or floor is the absolute upper and lower limit, beyond which an
interest rate cannot go during the life of the instrument. It can be expressed as either
a maximum lifetime change from the initial rate or as an absolute ceiling or floor.
You can use this functionality by entering values for the following characteristics in
the Maturity Mix variable:

= RATE.INCREASE.LIFE
- RATE.DECREASE.LIFE
= RATE.CAPLIFE

« RATE.FLOOR.LIFE

Teaser Rates

An instrument with a teaser rate is a repricing instrument whose introductory rate
is below market rates. An adjustable rate mortgage (ARM) often has a teaser rates
attached.

This instrument behaves like a repricing instrument with the exception that the
initial rate on new business is reduced by a TEASER.DISCOUNT percentage input
into the Maturity Mix variable. Subsequent repricing of the instrument occurs at
market rates when the instrument is scheduled to be repriced, subject to the
application of any caps and/or floors, as described the section entitled “Caps and
Floors,” in this appendix.

A non-term instrument has neither a stated maturity nor a predictable cash flow.
Passbook savings accounts and credit cards are examples of non-term instruments
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because a customer can withdraw funds from the passbook account or pay off a
credit card balance at any time, without contractual limitations on this activity.

Cash flow modeling for such instruments is irrelevant because the cash flows are
unpredictable. For these types of instruments no differentiation is made between
current account balances and new business. The entire portfolio receives the same
interest rate.

These characteristics make rate computation easy. The calculation is as follows:

Rate = Transfer Rate +/- Spread
where,

the spread is added for accounts with an attribute of asset, and subtracted for
accounts with an attribute of liability.

Interest = Average Rate/100 * Average Balance * Annualization Factor

Transfer Charge or Credit = Average Balance * Average Transfer Rate/100 *
Annualization Factor

If ending balance is input, the average balance is derived from the Beginning and
Ending Balance and the timing factor, calculated as follows:

Average Balance = (Prior Period Ending Balance * (1-Timing Factor)) + (Ending
Balance * Timing factor)

If average balance is input, the ending balance is calculated as follows:

Ending Balance = (Average Balance - Prior Period Ending Balance * (1-Timing
Factor))/Timing Factor

A timing factor of 0.5 achieves the average balance calculation.

Rollover Behavior

You can model the cash flow characteristics of a fixed-rate, bullet instrument at a
further level of detail by distinguishing between new business from new customers
and new business from existing customers who are rolling their matured balances
into the same product. This approach is common when modeling Certificates of
Deposit.

The computations that reflect rollover behavior are identical to a bullet maturity
instrument, with the exception that new business input is broken into several
components.
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This is shown in the following calculation:

Total New Business = New Customer Business + Rollovers
where,
Rollovers = Total Maturing Balance * Rollover Percent New Business

The end user inputs Net New Business, the Rollover Percent New Business, the
Net New Spread and the Roll Add Spread

The additional calculations associated with rollovers are:

Total New Business = Net New Business + Rolled Amount

Total New Add Spread = ((Net New Business * Net New Spread) + (Rolled
Amount * Roll Add Spread)) /7 (Net New Business + Rolled Amount)

where

Rolled Amount = (CP Runoff + New Business Runoff) * Rollover Percent New
Business

Net New Business = Input Amount

Net New Spread = Input Amount

Rollover Percent New Business = Input Amount
Roll Add Spread = Input Amount

Non-Rate Related Balances

Non-rate related assets and liabilities are the non-financial instrument balances on
your balance sheet. While cash flow modeling does not necessarily pertain to these
balance sheet items they still need to have transfer pricing charges and credits
generated. The transfer rate assigned to this type of balance is not a yield curve
driven amount but a single rate for any time period (for example, the 3-month
weighted average of the 3-month transfer rate).
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The transfer pricing charge or credit is calculated as follows:

Transfer Charge or Credit = Average Balance * Average Transfer Rate *
Annualization Factor

Ending and Average Balance calculations are the same as defined for non-term
instruments.

Other Calculations

Loan Fees

The following non-rate related calculations are addressed in this section:
« Loan Fees

« Non-interest Expense

= Non-interest Income

= Number of Accounts

«  Statistical Data

« Tax equivalency

Accounting practices on certain financial instruments (most commonly mortgage
loans) require that loan fees paid by the customer are recognized in the same way as
interest on the loan. In other words, while the customer pays cash 'points’ when the
loan is originated, the financial institution must recognize these points over the life
of the loan.

To have the cash flow calculations include the generation of a fee income amount,
input an annualized fee income percentage in financial element F905 (Fee Income
Percent) in the the main forecasting interface.

In order for the financial element to appear in the interface and accept input of
values, FS.FE_ENABLED and FS.FE_WRITEABLE should be set to YES. This is for
financial element F905, for the Balance Sheet models where use of this option is
desired.

Loan fees are calculated as a percentage of the outstanding balance of the loan. The
formula for calculating these fees, called recognized loan fees, is as follows:
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Recognized Loan Fees = Average Balance * Loan Fee %/100 * Annualization
Factor

Note: Recognized loan fees is an OFSA financial element.

It is important to note that the Income Statement report and the Interest Rate report
must include the recognized loan fees amount as part of interest income.

Non-Interest Expense

This Balance Sheet Model program object is in the database to support the entry of
non-interest expense data in the main forecasting interface.

This object can be customized, if desired, to include formula-driven calculations for
individual non-interest expense account balances.

Non-Interest Income

This Balance Sheet Model program object is in the database to support the entry of
non-interest income data in the main forecasting interface.

This object can be customized, if desired, to include formula-driven calculations for
individual non-interest income account balances.

Number of Accounts

Calculating the number of accounts is a method of identifying the components of an
instrument in a meaningful way by separating the number of customer accounts
from the average balance per customer account. This provides a way of logically
dividing the performance of these types of accounts into separate components and
can provide an additional, detailed source of variance data when comparing budget
projections to actual performance.

Two types of calculations based on the Number of Accounts have been provided in
this release.

The calculation of New Business in Fixed Bullet, Fixed-rate Amortizing and
Amortizing Repricing accounts can be driven by the input of values for the number
of new accounts and new balance per account.
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The calculation used is:

New Business = New Balance per Account * Number of New Accounts

The calculation of average balances for non-term and non-rate related accounts can
be driven by the input of values for Average Account Balance, Average Number of
Accounts and Average Percent Active Accounts. If tracking of the total average
number of accounts is all that is desired, input values for Average Account Balance
and Average Number of Accounts.

Total Average Balance will be calculated as:

Average Balance = Average Account Balance * Average Number of Accounts

If you are tracking both a total number of accounts as well as a measure of active
accounts, input values for Average Account Balance, Average Number of Accounts
and Average Percent Active Accounts.

The ensuing calculations are:

Average Number of Active Accounts = Average Number of Accounts * Average
Percent Active Accounts

Average Balance = Average Number of Active Accounts * Average Account Balance

To use any of this functionality, you must enable (turn on) the financial elements
referenced above and designate the appropriate financial elements as writeable and
as a driver for the calculation for each balance sheet model desired. To enable
calculation of New Business in this manner, turn on the following financial
elements:

FS.FIN_ELEM F1343 New Balance Per Account
FS.FIN_ELEM F1344 Number of New Accounts

Set the values for FS.FE_ENABLED, FS.FE_WRITEABLE and FS.IS_DRIVER to YES
for any or all of the Bullet.Fixed, Amort.Fixed and/or Amort.Reprice balance sheet
models.
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To enable calculation of average balances for non-term and non-rate related
accounts when you are tracking only total accounts, you must enable the following
financial elements:

FS.FIN_ELEM F1141 Average Account Balance
FS.FIN_ELEM F1142 Average Number of Accounts

Set the values for FS.FE_ENABLED, FS.FE_WRITEABLE, and FS.IS_DRIVER to YES
for one or both of the non-term and/or non-rate related balance sheet models. To
activate tracking of number of active accounts as well, turn on the following
financial elements:

FS.FIN_ELEM F1143 Average Percent Active Accounts
FS.FIN_ELEM F1144 Average Number of Active Accounts

Set the values for FS.FE_ENABLED, FS.FE_WRITEABLE and FS.IS_DRIVER to YES
for F1143. However, only set the value for FS.FE_ENABLED to YES for F1144.
FS.FE_ WRITEABLE and FS.IS_DRIVER should remain set to NA for this financial
element.

Statistical Data

This Balance Sheet Model program object is in the database to support the entry of
statistical data in the main forecasting interface.

This object can be customized, if desired, to include formula-driven calculations for
individual statistical account balances.

Tax Equivalency

Certain financial instruments are advantageous to financial institutions because all
or part of their interest is tax exempt. As a result, coupon rates paid on these
instruments are generally lower than their taxable counterparts. Common practice
is to adjust these tax exempt instruments to a fully taxable equivalent status in order
to facilitate the comparison of tax exempt instruments to taxable instruments. To
have the cash flow calculations include generation of a tax equivalent adjustment
amount, input an adjustment factor percentage into FS.TAX_EQUIV_PCT for the
appropriate product.
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Other Calculations

The computation of the taxable equivalent adjustment is as follows:

Taxable Equivalent Adjustment = Total Interest * Tax Equivalent Adjustment
Factor/100

Note that the income statement report and the interest rate report must include the
tax equivalent adjustment financial element as part of interest income.

Tax equivalent adjustments are not a standalone calculation but rather, are
embedded within the calculation of another cash flow instrument. Tax equivalent
adjustments are an additional financial element computed within the context of the
standard cash flow calculation.

Cash Flow Calculations B-25



Other Calculations
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Express and OFA Object Descriptions

This appendix contains lists to help you understand the relationships of data
elements between Express, Oracle Financial Analyzer (OFA) and Budgeting &

Planning.

The following table describes the information provided in the sections of this

appendix:

Section Description

Dimensions Matches an OFA dimension, as it appears in the OFA
interface, with the corresponding Express object. This
section also lists the corresponding OFA dimension
prefix.

Attributes The Express relations and OFA attributes for the

(Relations) Budgeting & Planning application have the same

names. This section supplies descriptions for each of
these objects.

Financial Data Iltems
(Variables and Formulas)

Matches a financial data item in OFA with the
corresponding Express variable or formula.

Budgeting & Planning
Express Database
Objects

Lists objects found solely in the Budgeting & Planning
application. These objects are not registered with
OFA.
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Dimensions

Dimensions

This table matches a dimension, as it is named in OFA, with the Express dimension
name.

OFA

Dimension
OFA Description Express Object Name Prefix
Account Type FS.ACCOUNT_TYPE ATP
Accrual Method FS.ACCRUAL_METH ACM
Activity FS.ACTIVITY ACT
Activity Chart of Accounts FS.ACTIVITY_COA ACA
Balance Sheet Model FS.BAL_SHT_MODEL BSM
Capital Assets FS.CAPITAL_ASSET CPA
Chart of Accounts FS.CHRT_OF ACCT COA
Currency FS.CURRENCY CUR
Currency Scenario FS.CURRENCY_SCEN CYS
Employee FS.EMPLOYEE EMP
Employee Info FS.EMPLOYEE_INFO EIN
Employee Info Chart of Accounts FS.EMP_INFO_COA ECA
Financial Element FS.FIN_ELEM FE
Financial Element Type FS.BP_FE _TYPE FET
Forecast FS.FORECAST FCST
Forecast Calculation Status FS.CALC_STATUS CLS
Forecast Status FS.FCST_STATUS SST
From Currency FS.FROM_CURRENCY FCUR
Income Statement FS.INCOME_STMT INC
Incremental Runoff Financial Elements FS.INCR_ELEM IEL
Interest Rate Scenario FS.RATE_SCENARIO RTS
Interest Rate Type FS.INT_RATE_TYPE IRT

C-2 Oracle Budgeting & Planning Reference Guide



Dimensions

OFA

Dimension
OFA Description Express Object Name Prefix
Maturity Mix Scenario FS.MIX_SCENARIO MSC
Mix Assumption Set FS.MIX_ASSUM_SET MAI
Mix Breakout FS.MIX_BREAKOUT MBO
Mix Element FS.MIX_ELEMENT MEL
Model Calculation Type FS.MDL_CALC_TYPE CLT
Model Definition Type FS.MDL_DEFN_TYPE MDT
Non-OFA BP Database Objects FS.BP_NON_OFA NOO
One-way Data Custom Distribution FS.FDI_CUST _DIST FDIDST
Organization Type FS.ORG_TYPE ORT
Organizational Unit FS.ORG_UNIT ORG
Origination Month FS.ORIG_MONTH ORD
Product FS.PRODUCT PRD
Rate Term FS.RATE_TERM RTM
Report Line Item FS.REPORT_LINE RPL
Strategy FS.STRATEGY STR
Time TIME TIME
To Currency FS.TO_CURRENCY TCUR
Transfer Pricing Method FS.TP_METHOD TPM
Transfer Rate FS.TRAN_RATE TRT
Worksheet Dimensions FS.WKSHT._DIMS WSD
Worksheet User FS.WKSHT._USER WSU
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Attributes (Relations)

Attributes (Relations)

Budgeting & Planning OFA attributes and their underlying Express relations have
the same names. This table lists and describes these objects.

Express Name Description
FS.BSM.CALC_TYPE BSM Calculation Type
FS.BSM.DEFN_TYPE BSM Definition Type
FS.COA.ACCT_TYPE COA Account Type
FS.COA.ACRL_METH COA Accrual Method

FS.COA.ACT_COA COA Activity Chart of Accounts
FS.COA.BS_MODEL COA Balance Sheet Model
FS.COA.EMP_COA COA Employee Info Chart of Accounts

FS.COA.MARKET_RT COA Market Rate
FS.COA.PRODUCT COA Product
FS.COA.TP_METHOD COA Transfer Price Method
FS.CPA.CHRT_ACCT CPA Chart of Accounts
FS.CPA.END_MONTH CPA End Month
FS.CPA.STR_MONTH CPA Start Month
FS.CPA.STR_W_MTH CPA Start Weighting Month

FS.EMP.ORG_UNIT EMP Organizational Unit
FS.FCST.AS_OF DT FCST Data As Of Date
FS.FCST.CLC_STAT FCST Calculation Status
FS.FCST.CURR_SCN FCST Currency Scenario
FS.FCST.MIX_SCN FCST Maturity Mix Scenario
FS.FCST.RATE_SCN FCST Interest Rate Scenario
FS.FCST.STATUS FCST Forecast Status
FS.FE.BP_FE_TYPE FE BP Financial Element Type
FS.IEL.FIN_ELEM IEL Financial Element
FS.ORG.ORG_TYPE ORG Organizational Unit Type

C-4 Oracle Budgeting & Planning Reference Guide



Planning Items (Variables)

Express Name

Description

FS.RPL.CHRT_ACCT

RPL Chart of Accounts

Planning Items (Variables)

This tables matches the OFA financial data item with its corresponding Express

variable or formula.

OFA Name

Express Name

Activity Costs

FS.ACTIVITY_COST

Activity Factors

FS.ACT_FACTOR

Activity Units

FS.ACT_UNITS

Average Rates (formula)

FS.AVG_RATES

Average Spread (formula)

FS.AVG_SPREAD

Average Transfer Rate (formula)

FS.AVG_T_RATE

Capital Expenditures

FS.CAP_PLAN_DATA

COA Access

FS.COA_ACCESS

COA Transfer Rate Type

FS.COA.TRAN_RATE

Currency Access

FS.CUR_ACCESS

Days in Month

FS.DAYS_MONTH

Days in Year

FS.DAYS_YEAR

Employee Information

FS.EMPLOYEE_DATA

Exchange Percentages

FS.EXCHANGE_PCT

Forecast Access

FS.FCST_ACCESS

Fin Plan Access (formula)

FS.FD_ACCESS

FE Access

FS.FE_ACCESS

Is Financial Element Divisible

FS.FE_DIVISIBLE

FE Enabled

FS.FE_LENABLED
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Planning Items (Variables)

OFA Name Express Name
FE Status FS.FE_STATUS
FE Writable FS.FE_WRITABLE

Financial Plans

FS.FIN_DATA

Incremental Runoff

FS.INCR_RUNOFF

Interest Rates

FS.INTEREST_RATE

Is Cashflow Model (Boolean)

FS.IS_CASHFLOW

Is FE a Driver for Model (Boolean) FS.IS_DRIVER
Maturity Mix Default FS.MIX_DEFAULT
Maturity Mix Map FS.MIX_MAP

Maturity Mix Override

FS.MIX_OVERRIDE

Mix Element Enabled

FS.ME_ENABLED

Mix Element Writeable

FS.ME_WRITEABLE

New Timing Percent

FS.NB_TIMING_PCT

Org Access

FS.ORG_ACCESS

Regular Income Statement (formula)

FS.REG_INC_STMT

Spread Income Statement (formula)

FS.INC_STMT

Strategy Access

FS.STR_ACCESS

Tax Equivalence Percentage

FS.TAX_EQUIV_PCT

Time Weighting

FS.TIME_WEIGHT

Weighting Financial Element

FS.WEIGHTING_FE

Weighted Average Periods

FS.WGT_AVG_PER

Weighted Average Term

FS.WGT_AVG_TERM

Worksheet Catalog

FS.WKSHT_CATALOG
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Budgeting & Planning Express Database Objects

Budgeting & Planning Express Database Objects

The tables in this section list Express objects that are used in the Budgeting &
Planning application but not used in OFA. The following types of Express objects
are included:

« Scalar variables
« Working variables and dimensions
« Catalogs

« Catalog dimensions

SCALAR Variables

These variables are distributed using the custom distribution routines for non-OFA
objects. They are defined with no dimensions and can be maintained in Express
Administrator.

Express Name Description
FS.FCST_PDS Number of Forecast Months
FS.HIST_PDS Number of Historical Months

FS.TP_ACC_METH Transfer Pricing Accrual Method

Working Variables and Dimensions

These variables and dimensions are distributed using the custom distribution
routines for non-OFA objects. Since they are based on an Express conjoint
dimension, these variables cannot be defined as FDIs in OFA.

Express Name Description

FS.CUJO Conjoint working dimension
FS.CUJO.DECIMAL1 Working variable
FS.CUJO.DECIMAL2 Working variable
FS.CUJO.DELETE Working variable
FS.CUJO.SPRD_DT Working spread date
FS.CUJO.SPRD_MTH Working spread month
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Budgeting & Planning Express Database Objects

Catalogs

These catalogs appear in the Super Administrator’s personal database. FS.ENV.CAT
is distributed during the one-way custom data distribution. FS.ARG.CAT and
FS.DM.CATALOG are not.

Express Name

Description

FS.ARG.CAT

Temporary catalog variable for data loading

FS.DM.CATALOG

Dimension Catalog

FS.ENV.CAT

Environment Catalog

Catalog Dimensions

These catalog dimensions appear only in the Super Administrator’s personal
database and are not distributed.

Express Name

Description

FS.ARG.PROP

Properties dimension for FS.ARG.CAT catalog

FS.DM.ENTRY

Lists Budgeting & Planning dimensions that correspond to
OFSA leaf columns

FS.DM.PROP

Properties dimension for FS.DM.CATALOG

FS.ENV.PROP

Properties dimension for FS.ENV.CAT catalog
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Details of the Maturity Mix Data Model

This appendix provides detailed information on the following key variables that
make up the maturity mix data model:

« FS.MIX_DEFAULT
«  FS.MIX_MAP
« FS.MIX_OVERRIDE

FS.MIX_DEFAULT Variable

The FS.MIX_DEFAULT variable stores the decimal variable default values for each
maturity mix characteristic

This variable is dimensioned by the following values:

Dimension Description
FSMIX_ELEMENT Maturity mix characteristics

FS.MIX_BREAKOUT  Column that identifies the unique characteristics for each
maturity term

FS.MIX_ASSUM_SET  Unique assumption set identifier

In Expressthe FS.MIX_DEFAULT variable is defined as follows:

DEFI NE FS. M X_DEFALLT VAR ABLE DEQ MAL <SPARSE <FS. M X ELEMENT FS M X_
BREAKQUT> FS. M X ASSUM SET. | D>
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FS.MIX_DEFAULT Variable

FS.MIX_ELEMENT Dimension

The following table outlines the standard seeded dimension values for the FS.MIX_

ELEMENT dimension:

Required/
Dimension Value (Express) | Optional Description
TERM Required | Thelength, in months, of the term to maturity
for one corresponding breakout.
MIX.PERCENT Required | The mix percentage for this term number
SPREAD Optional The spread for thisindividual term number
REPFREQ Optional The repricing frequency, in months
AMORT.TERM Optiona Amortization term length for balloon
maturities, in months
RES.VAL.PERCENT Optiona Residual value percentage
PREPAY.METHOD Optiona The following prepayment methods are
available:
« OorNA for none
« 1forCPR
« 2for PSA factor
«  3foramonthly prepayment spread
PREPAY.VALUE Optional The value for the particular prepayment
method
RATE.DECREASE.PERIOD | Optional The maximum percentage the rate can
decrease each repricing period
RATE.INCREASE.PERIOD | Optional The maximum percentage the rate can
increase each repricing period
RATE.DECREASE.LIFE Optional The maximum percentage the rate can
decrease over the life of the product
RATE.INCREASE.LIFE Optional The maximum percentage the rate can
increase over the life of the product
RATE.CAPLIFE Optional The maximum rate for the life of the product
RATE.FLOOR.LIFE Optional The minimum rate for the life of the product
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FS.MIX_DEFAULT Variable

Required/

Dimension Value (Express) | Optional Description

TEASE.DISCOUNT Optional Tease discount percentage

FS.MIX_BREAKOQUT Dimension

This dimension is seeded with 10 dimension values. If you need more you must add

them.

The following three charts depict how this information is stored.

Across: Time
Down: FS.CHRT_OF ACCT
Page: FS.MIX_SCENARIO
Default FS.MIX_MAP

Jan99 Feb99 Mar99 Apra9 May99
Auto A000001 AO000001 AO000001 A000002 A000002
Loans
Across: FSMIX_ELEMENT
Down: FSMIX_BREAKOUT
Page: FSMIX_ASSUM_SET (only first two values shown)
A000001 FS.MIX_DEFAULT

MIX.1 MIX.2 MIX.3

Mix % 10 20 70
Term 6 12 18
Spread 3.00 2.00 1.00
Repricing Frequency | NA NA NA

Details of the Maturity Mix Data Model

D-3



FS.MIX_DEFAULT Variable

A000002 FS.MIX_DEFAULT

MIX.1 MIX.2 MIX.3
Mix % 20 30 50
Term 6 12 18
Spread 3.40 2.30 1.50
Repricing Frequency | NA NA NA

If the end user decides to change the mix percentages for the second and third terms, this
"override" datais stored in the FSMIX_OVERRIDE variable, as shown in the following
table.

Across: FS.MIX_ELEMENT, FS.MIX_OVERIDE

Down: FS.MIX_BREAKOUT

Page:  TIME, FS.CHRT_OF ACCT, FS.ORG_UNIT, FS.MIX_
SCENARIO, FS.STRATEGY

Jan99
Auto Loans
Branch A
Default Momentum FS.MIX_OVERRIDE

MiX.1 MIX.2 MIX.3
Mix % 0 40 60
Term NA NA NA
Spread NA NA NA
Repricing Frequency | NA NA NA
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FS.MIX_MAP Variable

Note: Only default data that is changed is stored in the FS.MIX_
OVERRIDE variable.

When creating your assumption sets refer to the following guidelines:

= The total mix percentage(s) for a given product is equal to 100%; individual mix
percentages can be equal to zero.

« Mix percentages, amortizing terms, repricing frequency, and residual value
percentages can never be negative (however, spreads can be negative).

« Terms should be greater than zero or null. If the term is null the rest of the line
must be null as well.

« For balloon instruments the amortizing term is greater than the loan term.

« For repricing instruments, the repricing frequency is less than the loan term and
greater than zero.

« Forinstruments requiring a residual value percentage, that percentage is greater
than zero and less than one hundred.

FS.MIX_MAP Variable

The FS.MIX_MAP variable stores the unique assumption set identifier that pointsto the
corresponding default maturity assumption set for each product.

This variable is dimensioned by the following values:

Dimension Description

TIME Application time
FS.CHRT_OF_ACCT Chart of Accounts dimensions
FS.MIX_SCENARIO Maturity scenario dimension

In Express the FS.MIX_MAP variable is defined as follows:

DEFI NE FS. M X_MAP VAR ABLE | D <TI ME SPARSE <FS GHRT_CF ACCT FS M X_
SCENAR O>>
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FS.MIX_OVERRIDE Variable

There can be as many as one default assumption set for each time period or as few as one
assumption set for al time periods.

FS.MIX_OVERRIDE Variable

The FS.MIX_OVERRIDE variable is a large, sparse decimal variable that stores any
modifications to the default maturity mix.

This variable is dimensioned by the following values:

Dimension Description

TIME Application time

FS.MIX_ELEMENT Maturity mix characteristics

FS.MIX_BREAKOUT Column number or term number that identifies the unique
characteristics for each different maturity term

FS.CHRT_OF_ACCT Chart of Accounts dimension

FS.ORG_UNIT Organizational unit dimension

FS.MIX_SCENARIO Maturity scenario dimension

FS.STRATEGY Strategy dimension

N.DIM User-defined dimension

In Express the FS.MIX_OVERRIDE variable is defined as follows:

DEFI NE FS. M X_OVERR DE VAR ABLE DEQ MAL <SPARSE <TI ME FS. M X ELEMENT FS M X_
BREAKQUT FS. OHRT_CF_ACCT> FS. GRG UN T SPARSE <FS M X_SCENAR O FS. STRATEGY
N DI M>

The nature of the FS.STRATEGY, FS.MIX_SCENARIO and the N.DIM (user defined)
dimensions is such that each of those dimensionsis likely to have few values. They are
therefore grouped together and form a composite that is slow varying.
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Express Programs, Objects and Processes

This appendix details specific information pertaining to Express programs, objects,
and processes. The order is alphabetical.

Express Programs, Objects and Processes E-1



FS.ACCUMTPDEN

Purpose

Cash flow calculation that derives the transfer rate on amortizing accounts. It
is called multiple times from an amortizing cash flow calculation to
accumulate values used as a denominator in the calculation. It assumes only
one chart of account is currently in status.

Arguments

Transfer pricing method
The spot rate

The spot transfer rate
The initial rate

The principal balance
The runoff amount

The payment

The prepay amount
The time period

The transfer rate

Return

A decimal value that represents a numerator value to be used later in the
derivation of the transfer rate.

Called
From

FS.AMORT.FIXED
FS.AMORT.REPRICE

Exposed to
user

Yes

Category

Cash flow engine
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FS.ACCUMTPNUM

Purpose Used for the derivation of the transfer rate on amortizing accounts. It is
called multiple times from an amortizing cash flow calculation to
accumulate values to be used as a numerator for the calculation. It
assumes only one chart of account is in status.

Arguments Transfer pricing method
The spot rate

The spot transfer rate
The initial rate

The principal balance
The runoff amount

The payment

The prepay amount
The time period

The transfer rate

Returns A decimal value

Called From FS.AMORT.FIXED
FS.AMORT.REPRICE

Exposed to user | Yes

Category Cash flow engine
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FS.ADDTOSUPER

Purpose Creates Budgeting & Planning database objects and seeded data in the
OFA Super Administrator’s personal database during installation and set
up.

Arguments None

Returns NA

Called From Command line

Exposed to user | No

Category Set up

FS.ALLCOMPILE

Purpose Compiles programs in the FSBPTOOLS database during the Budgeting &
Planning application installation and set up.

Arguments None

Returns NA

Called From FS.ADDTOSUPER

Exposed to user | No

Category Set up
FS.ALLCOMP2

Purpose Called by FS.ALLCOMPILE

Arguments None

Returns NA

Called From FS.ALLCOMPILE

Exposed to user | No

Category Set up
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FS.AMORT.FIXED

Purpose Computes the run off, earnings and transfer pricing charges/credits for a
fixed rate, amortizing instrument. It stores the calculated results in
FS.INCR_DATA.

Arguments Independent variable. The value that has been input by the user (New,
Ending, or Average) expressed as the financial element value
'F100°,'F140°,'F340°.

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user

Yes

Category

Cash flow engine

FS.AMORT.REPRICE

Purpose Calculates the run off and repricing for an amortizing repricing product.
Stores the calculated amounts in the Incr_Data variable.

Arguments Independent variable. The value that has been input by the user (New,
Ending, or Average) expressed as the financial element value
'F100’,’F140°,’F340'.

Returns NA

Called From FS.CASHFLOW

Exposed to user | Yes

Category

Cash flow engine
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FS.ANNUALIZE

Purpose Annualizes an amount for a specific time period based upon the accrual
method and accrual days. Used for the computation of annualized yields.
For whole rates, it looks for the accrual method associated with the COA
value (in FS.COA.ACC_METH). For transfer rates, it looks for the
transfer rate accrual method.

Arguments Chart of accounts dimension value (FS.CHRT_OF_ACCT)
Time period
Rate Type
1 =Whole rate
2 = Transfer rate

Returns Decimal representing the annualized amount

Called From FS.CASHFLOW

Exposed to user

Yes

Category

Cash flow engine

FS.BP_METADATA

Purpose Populates dimensions and OFSA-related catalogs during installation and
set up.

Arguments None

Returns NA

Called From FS.ADDTOSUPER

Exposed to user | Yes

Category Set up
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FS.BP_SOLVE

Purpose

A program that executes at the completion of FS.PROCESS.COAS and
that allows a Systems Administrator to define calculations that can be
performed every time a partial or full solve is performed.

Arguments None
Returns NA
Called From FS.PROCESS.COAS

Exposed to user

Yes

Category

Cash flow engine

FS.BULLET.FIXED

Purpose Cash Flow Calculation used for fixed rate instruments with bullet
maturities

Arguments Independent variable. The value that has been input by the user (New,
Ending, or Average) expressed as the financial element value
'F100’,’F140°,’F340'.

Returns NA

Called From FS.CASHFLOW

Exposed to user | Yes

Category Cash flow engine
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FS.CALC.ENABLED

Purpose Populates a temporary variable (FS.FE_STATUS) that indicates which
financial elements should be displayed in the user interface based on the
currently displayed chart of accounts.

Arguments None

Returns NA

Called From User interface

Exposed to user

No

Category

Cash flow engine

FS.CALC.WRITE

Purpose Calculates the read/write status of individual cells of data in the user
interface, based on the values for the TIME, FS.FORECAST, and
FS.CHRT_OF_ACCT dimensions that are active for each cell.

Arguments None

Returns NA

Called From FS.FD_ACCESS

Exposed to user

No

Category

Cash flow engine
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FS.CASHFLOW

Purpose Controller for all cash flow calculations, computes ending balances,
transfer charges and credits, and interest

Arguments The independent variable (new, ending, or average). Solves the other two
based upon the value provided

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user | Yes

Category

Cash flow engine

FS.CHCK_FOR_NODES

Purpose For all dimensions of FS.FIN_DATA (with the exception of FIN_ELEM,
TIME, and FS.FORECAST), determines if any values currently in status
are node values

Arguments None

Returns True if there are nodes and false if there are none

Called From FS.PROCESS.COAS

Exposed to user

Yes

Category

Push down assumptions
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FS.COMP_INTEREST

Purpose Given a balance and yield, computes the periodic interest
Arguments Yield

Balance

Time period

Chart of account dimension value (FS.CHRT_OF_ACCT)
Returns Periodic interest
Called From Command line

Exposed to user

Yes

Category

Cash flow engine

FS.COMP_YIELD

Purpose Computes an annualized yield given the periodic interest and average
balance
Arguments Interest
Balance
Time period
Chart of account dimension value (FS.CHRT_OF_ACCT)
Returns Decimal value for the yield
Called From FS.CASHFLOW
Exposed to user | Yes

Category

Cash flow engine
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FS.DATA.WRITE

Purpose Called from the user interface to update values in the database whenever

a value has been changed by the user interface. It also creates a record in
FS.CUJO indicating to the application that there is data to be processed.

Arguments None
Returns NA
Called From User interface

Exposed to user | No

Category User interface

FS.DEANNUALIZE

Purpose Deannualizes an amount for a specific time period based on the accrual

method and accrual days. Used for the computation of interest. For
whole rates, it looks for the accrual method associated with the
FS.CHRT_OF_ACCT value (FS.COA.ACCURAL_METH). For transfer
rates, it uses the value in FS.TP_ACC_METH.

Arguments Chart of account dimension value (FS.CHRT_OF_ACCT)

Time period
Rate type
Whole rate
Transfer rate

Returns

A deannualized rate

Called From

= FS.AMORT.REPRICE
« FS.AMORT.FIXED
« FS.BULLET.FIXED

Exposed to user

Yes

Category

Cash flow engine
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FS.FDI_DIST

Purpose Performs custom data distribution for "one-way" FDIs.
Arguments None

Returns NA

Called From OFA distribution process

Exposed to user

No

Category Custom distribution
FS.FDI_REFR
Purpose Performs refresh in subordinate database for "one-way" FDI custom data
distribution.
Arguments None
Returns NA
Called From OFA distribution process

Exposed to user

No

Category

Custom distribution
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FS.FIND_ANY_NODE

Purpose For all dimension values except TIME, FS.FIN_ELEM and
FS.FORECAST, it checks if any are node level values. If the input
parameter is set to 'Yes’ it changes the status to the children of the node
level value.

Arguments Yes/No: Yes puts any leaves under a node level in status.

Returns Yes: A node level was found
No: No node levels were found

Called From FS.PROCESS.COAS

Exposed to user | No

Category

Push down assumptions

FS.FIND_CHILDREN

Purpose Determines if the dimension value currently in status for a dimension is a
node or a leaf. Also puts the children in status if it is determined to be a
node.

Arguments The Dimension Name as Text (for example, FS.ORG_UNIT)

Returns The number of children in status ( returns a 0 if the value being fed in is
already a leaf)

Called From FS.PROCESS.COAS

Exposed to user

No

Category

Push down assumptions
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FS.FIND_DIM__

SETS

Purpose Called from FS.PROCESS.COAS to get all of the distinct combinations in
FS.CUJO that contain the same FS.ORG_UNIT, FS.CHRT_OF_ACCT,
FS.FORECAST, and other dimension values exclusive of FS.FIN_ELEM
and TIME. This is called with a loop, looping over all dimension values

Arguments None

Returns NA

Called From FS.PROCESS.COAS

Exposed to user | No

Category Cash flow engine
FS.GETAMTTERM
Purpose This routine returns the amortization term based upon the following
logic.
1.  Looks to the Mix Override planning item for a value input by the
user
2. Looks to the MIX_DEFAULT table for the default term. Uses the
value from FS.GETTERM
Arguments The origination month (FS.ORIG_MONTH)
Returns The amortization term
Called From FS.AMORT.FIXED
FS.AMORT.REPRICE
Exposed to user | Yes
Category Cash flow engine
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FS.GETCPM

Purpose This routine returns a monthly prepayment amount.
Input values: 1=CPR ,2=PSA, 3=CPR

Arguments The prepayment method, the percentage used in the calculation, and the
origination month(FS.ORIG_MONTH)

Returns The Constant Monthly prepayment percentage

Called From FS.AMORT.FIXED

FS.AMORT.REPRICE

Exposed to user

Yes

Category

Cash flow engine

FS.GETINITREPSPD

Purpose This routine is designed to look for a teaser rate on the initial rate set for
a repricing account (stored in the FS.MIX_ELEMENT
"TEASE.DISCOUNT). If it does not find a teaser rate value, it uses the
financial element for new business spread (FE 375).

Arguments The origination month(FS.ORIG_MONTH)

Returns The initial repricing spread at origination (inclusive of teaser rates).

Called From FS.AMORT.REPRICE

Exposed to user

Yes

Category

Cash flow engine
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FS.GETMONTHSTR

Purpose Receives an integer value and returns the three letter representation for
the month.

Arguments An integer value of 1 to 12 representing the actual month in the year
(calendar year and not fiscal year based)

Returns The three character representation for the month.

Called From FS.MAINTAIN_TIME

Exposed to user | No

Category Set up

FS.GETNEWBRKOUT

Purpose This routine returns the balance weighted by a maturity mix
percentage based upon the following logic. First it looks to the
Mix Override planning item and second to the Mix Default
planning item. Finding no value in either, returns an NA value

Arguments The origination month (FS.ORIG_MONTH)

Returns The new business amount

Called From FS.BULLET.FIXED

FS.AMORT.FIXED
FS.AMORT.REPRICE

Exposed to user

Yes

Category

Cash flow engine
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FS.GETPPYAMOUNT

Purpose This routine returns a prepayment amount based upon the following
logic. First it looks to the Mix Override planning item and second to the
Mix Default planning item. Finding no value in either, it returns a value
of 0, which means no prepayments are calculated.

Arguments The origination month (FS.ORIG_MONTH)

Returns The monthly prepayment percent.

Called From FS.AMORT.REPRICE

FS.AMORT.FIXED

Exposed to user

Yes

Category

Cash flow engine

FS.GETPPYMETHOD

Purpose

Returns the prepayment method used for a calculation based on the
following logic. It first looks to the FS.MIX_OVERRIDE variable and, if it
does not find any values, looks to the FS.MIX_DEFAULT variable.
Finding no value in either, it returns a value of 0, indicating no
prepayment is calculated.

Arguments

The origination month (FS.ORIG_MONTH)

Returns

The prepayment method to use in the calculation
1=CPR
2=PSA
3=CPM

Called From

FS.AMORT.REPRICE
FS.AMORT.FIXED

Exposed to user

Yes

Category

Cash flow engine
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FS.GETREPRATE

Purpose This routine computes the new rate on repricing business. It checks for
the maximum rate change(+-) that can take place between repricing time
periods, over the lifetime, and also checks for absolute caps and floors. It
may also check for overrides.

Arguments The origination month(fs.orig_month)

Returns The Repricing rate

Called From FS.AMORT.REPRICE

Exposed to user

Yes

Category

Cash flow engine

FS.GETREPTERM

Purpose This routine returns a repricing term based upon the following logic.
First it looks to the Mix Override planning item and second to the Mix
Default planning item. Finding no value in either, it executes the
fs.getterm function to use the value in the term mix element.

Arguments The origination month (FS.ORIG_MONTH)

Returns The Repricing term

Called From FS.AMORT.REPRICE

Exposed to user

Yes

Category

Cash flow engine
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FS.GETRESVALPCT

Purpose This routine retrieves a residual value percentage based on the following
process. First it looks to the Mix Override planning item and second to
the Mix Default planning item for a user override. Finding no value in
either, it returns a value of 0, indicating there is no residual value.

Arguments The origination month (FS.ORIG_MONTH)

Returns The residual value percentage

Called From FS.AMORT.FIXED

Exposed to user

Yes

Category

Cash flow engine

FS.GETSPOTTRAN

Purpose The purpose of this routine is to assign a transfer rate based upon the
term to maturity fed into the routine for a given time period, which is
also fed into the routine.

Arguments The term to maturity expressed as an integer value, the time period

Returns The spot transfer rate

Called From FS.BULLET.FIXED

FS.AMORT.REPRICE
FS.AMORT.FIXED
FS.ROLLOVERS

Exposed to user

Yes

Category

Cash flow engine
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FS.GETTERM

Purpose

This routine returns a term based upon the following logic. First looks to
the Mix Override table for a value input by the user and second looks to
the Mix Default planning item for the term. Finding no value, it returns a
value of 1, meaning the default term.

Arguments The origination month (FS.ORIG_MONTH)
Returns The term to maturity
Called From FS.BULLET.FIXED

FS.AMORT.REPRICE
FS.AMORT.FIXED

Exposed to user

Yes

Category Cash flow engine
FS.GET_DYS_IN_MN

Purpose Given an integer value for the month and a value for the year (expressed

as YYYY), returns the number of days in the month

Arguments The year in(YYYY) the month as an integer (calendar year based)
Returns The number of days in the month

Called From FS.MAINTAIN_TIME

Exposed to user | No

Category Set up
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FS.GET_DYS_

IN_YR

Purpose Given a year, returns the number of days in the year, adjusted for leap
years.

Arguments The Year (YYYY)

Returns The number of days in the year

Called From FS.MAINTAIN_TIME

Exposed to user | No

Category Set up

FS.INITORACLE

Purpose Initializes connection to FDM
Arguments _dbid text 'user/password@dbname’
Returns NA
Called From FS.LD CAT LVS

FS.LOAD

FS.POP_DESC

FS.SET_META2
FS.LOAD_DATA

Exposed to user

No

Category

Set up
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FS.ISDRIVER

Purpose

Returns whether or not a financial element is a driver based upon the
values in the relation FS.COA.BS_MODEL. A driver indicates that this
financial element can be used as an input into a calculation and used to
derive other financial elements.

Arguments None. However, assumes the chart of account(FS.CHRT_OF_ACCT) is in
status and only one FS.CHRT_OF_ACCT value is in status

Returns Boolean value YES = Is a driver value, NO = Is not a driver calculation

Called From FS.PROCESS.COAS

Exposed to user

Yes

Category Cash flow engine
FS.ISNODE
Purpose Determines if a value is a node or not for a single dimension value.
Assumes the node value to test is already in status.
Arguments The dimension type
Returns Yes: If it is a node
No: If it is not a node
Called From Not applicable

Exposed to user

No

Category

Cash flow engine
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FS.LD_BP

Purpose Loads data from BP_Financial_Data
Arguments « _Cubetext
« _tblopt text
. _thltext
« _where text
« _sumtext
Returns NA
Called From FS.LOAD_DATA

Exposed to user

No

Category

Data movement routines

FS.LD_CAT_IDS

Purpose Brings Catalog of IDs from FDM
Arguments _sidn text

Returns NA

Called From FS.LOAD

Exposed to user | No

Category

Data movement routines
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FS.LD_CAT_LVS

Purpose Brings Catalog of Leaves from FDM
Arguments _dbid text
Returns NA

Called From FS.LOAD

Exposed to user | No

Category Data movement routines
FS.LD_DEST

Purpose Helps load FDM data (general)

Arguments _cube text

Returns NA

Called From NA

Exposed to user | No

Category Data movement routines
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FS.LD_INT

Purpose Loads interest rates

Arguments _cube text
_rh_sys_id text
_rf_sys_id text
_rf_scen text
_fs_scen_text
_pfx text
Defaults to F

Returns NA
Called From FS.LOAD_DATA

Exposed to user | No

Category Data movement routines

FS.LD_INT_RFDEST

Purpose Loads data from Rates_Forecast
Arguments _cube text
Returns NA

Called From FS.SQLFETCH?2

Exposed to user | No

Category NA
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FS.LD_INT_RH

Purpose Loads data from Rates_History

Arguments _cube text
_rh_sys_id text
_rf_sys_id text
_rf_scen text
_fs_scen text
_pfx text
_mult text

Returns NA

Called From FS.LD_INT

Exposed to user | No

Category NA

FS.LD_INT_RHDEST

Purpose Moves interest rate data to FS.INTEREST_RATES
Arguments _cube text
Returns NA

Called From FS.SQLFETCH

Exposed to user | No

Category NA
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FS.LD LS

Purpose Loads data from LEDGER_STAT
Arguments _cube text
_tblopt text
_thl text
_where text
_sum text
Returns NA
Called From FS.LOAD_DATA
Exposed to user | No
Category NA

FS.LD_LS_DEST

Purpose Helps load LEDGER_STAT during fetch
Arguments _cube text

Returns NA

Called From NA

Exposed to user | No

Category NA
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FS.LD_RB

Purpose Reads RESULT_BUCKET table
Arguments _cube text
_tblopt text
_thl text
Returns NA
Called From NA
Exposed to user | No
Category NA
FS.LD_RM
Purpose Loads data from RES_DTL_XXXXXX table
Arguments _cube text
_tblopt text
_thl text
_where text
_sum text
Returns NA
Called From FS.LOAD_DATA
Exposed to user | No
Category NA
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FS.LD_RM_DEST

Purpose Helps load FDM data (RES_DTL_XXXXXX)
Arguments _cube text

Returns NA

Called From NA

Exposed to user | No

Category NA

FS.LEAF_DESC

Purpose Loads leaf description
Arguments _sidn text

Returns NA

Called From FS.LOAD

Exposed to user | No

Category NA

FS.LEAPYEAR

Purpose

Determines if a year is a leap year

Arguments A year time dimension value
Returns Yes if itis a leap year, no if it is not.
Called From FS.MAINTAIN_TIME

Exposed to user | No

Category Set up
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FS.LIMIT_TO_CUJO

Purpose Limits all dimension values to only those in FS.CUJO
Arguments None

Returns NA

Called From FS.PROCESS.COAS

Exposed to user | No

Category Cash flow engine
FS.LOAD
Purpose Manages loading of hierarchies
Arguments _sidn text
_dbid text

Returns NA

Called From FS.RUN_LD

Exposed to user | No

Category NA

E-30 Oracle Budgeting & Planning Reference Guide




FS.LOAD_DATA

Purpose Loads data from various FDM tables
Arguments _dbid text
_cube text
_tblopt text
_thl text
_where text
Returns NA
Called From NA
Exposed to user | No
Category NA
FS.LOAD_HIER
Purpose Loads leaves and nodes from FDM
Arguments a_dbid text " 'user/password@dbname’

a_dim_name text " no wider than 6
a_sidn text " OFSA sys_id_num
a_orphans text " null or 'ORPHANS’ - stray leaves
_hier text "hierarchy dimvalue
to load into (for example, FMSHDIM.ORG=HI.AA19943)

Returns NA

Called From NA

Exposed to user | No

Category NA
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FS.MAINTAIN_TIME

Purpose Sets FS.ORIG_DATE equal to the values of time, populates the FS.DAYS_
MON, FS.DAYS_YEAR and FS.TIME_WEIGHT variables

Arguments None
Returns NA
Called From Directly by the administrator

Exposed to user | No

Category Set up

FS.MAK_CURSOR

Purpose Creates program to declare and open a SQL cursor

Arguments _stmt text
_cursor text
_pgmcurs text
_pgmtpl text

Returns NA

Called From FS.LD_BP
FS.LD_INT_RH
FS.LD_INT_RHDEST
FS.LD LS

Exposed to user | No

Category NA
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FS.MAK_FETCH

Purpose Creates program to fetch a SQL cursor
Arguments _stmttext" 1
_desttext " 2
_cursor text" 3
_pgmcurstext " 4
_pgmtpl text" 5
Returns NA
Called From FS.LD_BP
FS.LD_INT_RH
FS.LD_INT_RHDEST
FS.LD LS
FS.LD_RM
Exposed to user | No
Category NA
FS.MONTRK
Purpose Diagnostic tool
Arguments _verb text " INIT UPDATE or OFF
_objectl text
_object2 text
Returns NA
Called From NA
Exposed to user | No
Category NA
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FS.MSG.GET

Purpose Gets descriptions and error messages
Arguments _cd integer
Returns NA

Called From NA

Exposed to user | No

Category NA
FS.MSG.PUT

Purpose Puts descriptions and error messages
Arguments None

Returns NA

Called From NA

Exposed to user | No

Category NA

FS.NODE_DESC

Purpose Loads node descriptions
Arguments _sidn text
Returns NA

Called From FS.LOAD

Exposed to user | No

Category Data movement routines
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FS.NON.INT.EXP

Purpose Performs user-defined calculations for non-interest expense accounts
Arguments None

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user

Yes

Category

Cash flow engine

FS.NON.INT.INC

Purpose Performs user-defined calculations for non-interest income accounts
Arguments None

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user | Yes

Category

Cash flow engine

FS.NON.RATE.REL

Purpose Calculates balance and transfer charge/credit information for non-rate
related balance sheet accounts

Arguments The driver (average or ending balance)

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user

Yes

Category

Cash flow engine
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FS.NON.TERM

Purpose Calculates information for non-term, interest bearing financial
instruments, such as DDA and credit card accounts.

Arguments The financial element driver.

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user

Yes

Category Cash flow engine
FS.NON_OFA_DIST
Purpose Performs custom structure distribution for non-OFA enabled Budgeting
& Planning objects
Arguments None
Returns NA
Called From OFA distribution process

Exposed to user

No

Category Custom distribution
FS.NON_OFA_REFR
Purpose Performs refresh in subordinate database for non-OFA enabled
Budgeting & Planning objects in custom structure distribution
Arguments None
Returns NA
Called From OFA distribution process

Exposed to user

No

Category

Custom distribution
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FS.PARTIALROLLUP

Purpose Rolls up data values across all hierarchy points

Arguments Rolls up only the values impacted by a change made by the user in the
user interface
Solves for all hierarchy points, regardless of status.

Returns NA

Called From FS.PROCESS.COAS

Command line

Exposed to user

Yes

Category Cash flow engine
FS.PAYMENT
Purpose Calculates a constant payment given a balance, rate, and term
Arguments Principal balance
Rate
Term
Returns The monthly payment
Called From NA
Exposed to user | Yes

Category

Cash flow engine
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FS.PGMTXT

Purpose Returns program shell for SQL cursor and fetch
Arguments _pgm text

Returns NA

Called From FS.MAK_CURSOR

FS.MAK_FETCH

Exposed to user

No

Category Data movement routines
FS.POP_DESC
Purpose Refreshes leaf/node descriptions
Arguments _dbid text
_dim text
_notfound text " if a desc is not found,
‘LEAVE_ALONE’ or 'DIMVAL’
_suffix  text "appended to description
Returns NA
Called From FS.LOAD _DATA
Exposed to user | No
Category Data movement routines
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FS.POP_LABELS

Purpose Fills blank descriptions with dimension values
Arguments _suffix text

Returns NA

Called From FS.ADDTOSUPER

Exposed to user | No

Category Data movement routines
FS.POP_LEAF

Purpose Adds nodes to the LEAF and populates the hierarchy relation
Arguments _sidn text

Returns NA

Called From FS.LOAD

Exposed to user | No

Category Data movement routines

FS.PROCESS.COAS

Purpose Calculates the cash flow for values changed during a session
Arguments None

Returns NA

Called From User interface

Exposed to user

No

Category

Cash flow engine

Express Programs, Objects and Processes E-39




FS.PUSHDOWN

Purpose Allocates values from node levels to a leaf level, based on either a
straight line allocation or the percentage distribution based on another
time period. This program does not push down values for the time
dimension.

Arguments 1 = equally apportioned
2 = weighted on another time period

Returns NA

Called From FS.PROCESS.COAS

Exposed to user | No

Category

Cash flow engine

FS.PUSH_DN_TIME

Purpose Allocates values from a node time level to leaf levels, either equally or
weighted by the number of days in the time period.

Arguments 1 = equally apportioned
2 = weighted based on the number of days in the time period

Returns NA

Called From FS.PROCESS.COAS

Exposed to user

No

Category

Cash flow engine
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FS.RATESOLVER

Purpose This routine calculates either the rate, transfer rate, or spread based upon
the other two.

For assets the equation is Rate = Transfer Rate+Spread.
For liabilities the equations is Rate = Transfer Rate-Spread.

Arguments The Method

«  Compute the rate

«  Compute the Spread
The Transfer Rate

The Spread

Returns Either the rate or the spread based on the input value
Called From FS.AMORT.FIXED

FS.AMORT.REPRICE

FS.BULLET.FIXED

FS.ROLLOVERS

FS.NON.TERM

Exposed to user | Yes

Category Cash flow calculations

FS.ROLLOVERS

Purpose Cash Flow calculation used for fixed rate instruments with rollover
characteristics

Arguments Independent variable. The value that has been input by the user (New,
Ending, or Average) expressed as the financial element value
'F100°,'F140°,'F340°.

Returns NA

Called From FS.CASHFLOW

Exposed to user | Yes

Category Cash flow engine
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FS.ROLLUPAVGS

Purpose Computes day weighted average balances (FS.FIN_ELEM F140) for node
level time dimension values

Arguments None

Returns NA

Called From FS.PARTIALROLLUP

Exposed to user | No

Category Cash flow calculations
FS.RUN_LD

Purpose Loads leaves and nodes from FDM
Arguments a_dim_name text " no wider than 6

a_sidn text " OFSA sys_id_num
a_dbid  text "user/password@dbname’
a_orphans text " null or 'ORPHANS’ - stray leaves

Returns NA

Called From FS.LOAD_HIER

Exposed to user | No

Category Data movement routines
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FS.RUN_THE_MODEL
Purpose Determines which type of calculation to apply to the values being
changed. Also determines if the calculation is a cash flow or non-cash
flow type and executes the FS.CASHFLOW program for the former and
directly execute the latter.
Arguments The driver: The financial element that has been input by the user.
Returns NA
Called From FS.PROCESS.COAS
Exposed to user | No
Category Cash flow calculations
FS.SET_META
Purpose Sets key metadata during installation and set up
Arguments « The connection string for the OFSA database
=« The as-of-date to be set for the BASE forecasts
Returns NA
Called From NA
Exposed to user | Yes (to the DBA during set up)
Category Set up
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FS.SET_META?2

Purpose Reads metadata from OFSA FDM
Arguments _dbid text

_asof text
Returns NA

Called From FS.SET_META

Exposed to user | Yes (to the DBA during set up)

Category Set up
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FS.SOLVEBALANCES

Purpose This program calculates the following cash flow accounts, based on the
financial element (FS.FIN_ELEM) driver value input.
For Cash Flow Calculations:
«  F1343: # of new accounts
F340= F1343*F1344
« F1344: New Account Balance
F340=F1343*F1344
« F100: Ending Balance
F340=F100-F100(prior Period)+C790 + N210
«  F140: Average Balance
F100=(F140-C140)/fs.new_timing-F100(prior period)+C100
F340=F100-C100-N100(prior period)+N210
N100=F320+N100(prior period)-N210
For Non Cash Flow Calcs
. F340: Net New
F100=F340-F100(prior period)
«  F100: Ending Balance
F140=F100(prior period)*(1-fs.new_timing)+F100*fs.new_timing
«  F140: Average Balance
F100=(F140-F100(prior period)*(1-fs.new_timing))/Fs.new_timing
«  F1141: Average Account Balance
F140=F1141*F1142
F100=(F140-F100(prior period)*(1-fs.new_timing))/Fs.new_timing
«  F1142: Average Number of Accounts
F140=F1141*F1142
F100=(F140-F100(prior period)*(1-fs.new_timing))/Fs.new_timing
«  F1143: Average Percent Active Accounts
F1144=F1143/100*F1142
F140=F1141*F1144
F100=(F140-F100(prior period)*(1-fs.new_timing))/Fs.new_timing
Arguments The financial elements (FS.FIN_ELEM) input by the user.
Returns NA
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Called From FS.AMORT.FIXED
FS.AMORT.REPRICE
FS.BULLET.FIXED
FS.NON.TERM
FS.NON.RATE.REL

Exposed to user | Yes

Category Cash flow calculations
FS.SQLCDESC

Purpose Called by FS.POP_DESC
Arguments _dimval text

_leafnode text

_desctbl  text

_leafnumid text " Doubles as SYS_ID_NUM for NODE_DESC

Returns NA

Called From FS.POP_DESC

Exposed to user | No

Category NA
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FS.STATISTICAL

Purpose Performs user-defined calculations for statistical accounts
Arguments None

Returns NA

Called From FS.RUN_THE_MODEL

Exposed to user | Yes

Category Cash flow engine
FS.TRACKRPT

Purpose Diagnostic tool
Arguments None

Returns NA

Called From FS.MONTRK
Exposed to user | No

Category NA
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FS.WGHTAVGTPRATE

Purpose Computes a weighted average transfer rate for non-term and non-rate
related accounts. Uses the value in FSWGT_AVG_PER to determine the
number of prior periods to use in the calculation and the value in
FS.WGT_AVG_TERM to determine which point on the yield curve to
use.

Arguments The time period

Returns The weighted average transfer rate

Called From FS.NON.RATE.REL
FS.NON.TERM

Exposed to user | Yes

Category Cash flow calculations

E-48 Oracle Budgeting & Planning Reference Guide




FS.WRI_DBG

Purpose Diagnostic tool

Arguments _msg text

_new_app text

Returns NA

Called From FS.LD BP
FS.LD_INT
FS.LD_INT_RH
FS.LD_LS
FS.LD_RM
FS.POP_DESC
FS.SET_META2
FS.SQLFETCH2
FS.LOAD_DATA
FS.SQLFETCH

Exposed to user | No

Category NA

FS.XP_PREFIX

Purpose Determines the system-defined shortlabel and longlabel prefix. It is used
for finding the parent relation information of a dimension.

Arguments The Dimension Name as Text (for example, ORG, COA)

Returns The prefix to be applied to the hierarchy relation information(eg.p1,c4)

Called From Process Accounts

Exposed to user | No

Category NA
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LC.STARTUP.PRG

Purpose Attaches FSLANG as an OFA custom database whenever FSBPTOOL is
attached as the primary OFA custom database.

Arguments None

Returns NA

Called From OFA start up process

Exposed to user

No

Category OFA integration
OFAENV.STARTUP

Purpose Start the OFA environment without the front-end

Arguments _lang text "eg, ENU

Returns NA

Called From FS.ADDTOSUPER
FS.ALLCOMPILE
FS.RUN_LD
FS.LOAD_DATA

Exposed to user | No

Category NA
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fixed-format, 3-18
flexible-format, 3-19
WHERE clause, 3-19
pre-existing values, 3-16
RES_DTL_XXXXXX tables, 3-13
sample call
formatting, 3-18
hierarchies, 3-10
interest and exchange rate forecasts, 3-23
LEDGER_STAT, 3-15
maturity mix assumptions, 3-25
RES_DTL_XXXXXX, 3-15
SQL statement, analyzing, 3-22
transforming time, 3-15
WHERE clause, 3-19
data movement routines listed, 3-6
data, submitting, 11-11
DATA SRC dimension, 5-7
database objects
Budgeting and Planning, C-7
distributing, 3-42
DEPENDENT dimension, 5-8
DEPENDENT_FDI dimension, 5-16
dimension values, using the Selector, 10-7
dimensions
correlation between OFA and Express, C-2
in maturity mix assumptions, 14-3
in the Mix Override variable (maturity mix
assumptions), 14-3
distributing
custom distributions for Budgeting and
Planning, 3-45
custom distributions, one-way, 3-47
data, 3-42,3-44
database objects, 3-42, 3-44
end-user access, 3-42
limitations, 3-43
non-OFA database objects, 3-45
documentation
conventions,  Xxxiii
DOWN_DIM dimension, 5-9

E

error message
text box, 11-13
Exit application dialog box, 11-11
external users, 3-1to 3-3
saving data, 3-2
using personal databases, 3-2
external users, creating, 3-1to 3-3

F

financial data variable. See FS.FIN_DATA
financial elements
creating the access settings, 3-38

fixed-rate amortizing, cash flow calculations, B-15

floors

lifetime, financial instrument, B-18

periodic, financial instrument, B-18
forecast dimension

FS.FIN_DATA, 2-6

seeded attributes, 2-11
forecasted data

read-only cells, in maturity mix

assumptions, 14-14

forecasts

adding a new forecast, 3-34

as-of-date, setting, 3-35
FS.AMORT.FIXED, cash flow calculations, B-15
FS.BULLET.FIXED, cash flow calculations, B-6
FS.CHRT_OF_ACCT

FS.FIN_DATA, 2-5
FS.CURRENCY

FS.FIN_DATA, 2-6
FS.FDI_CATALOG

access requirements

planning item, 5-18

capital expenditures, 5-3

custom programs, end-user access, 5-20

dependent planning items, 5-6

dimensions, 5-2

FS.FDI_ENTRY dimension

seeded planning items, 5-18
FS.FDI_ENTRY entries listed, 5-3

Index-3



FS.FDI_PROP dimension
ACROSS_DIM, 5-9
ADMIN, 5-16
APP_SRC, 5-15
AUTO_DIM, 5-8
AUTO_DIM_PRG, 5-9
CALC, 5-11
CALC_FULL, 5-12
CALC_PARTIAL, 5-12
CONJ_DIM, 5-15
CUST_PRG, 5-16
CUST_PRG_DESC, 5-16
DATA_SRC, 5-7
DEPENDENT, 5-8
DEPENDENT_FDI, 5-16
DOWN_DIM, 5-9
INIT_PRG, 5-7
RW_SRC, 5-14
SAVE_PRG, 5-13
SELECT_ACROSS_DIM, 5-9
SELECT_DOWN_DIM, 5-10
SUBMIT_PRG, 5-13
VALIDATION_PRG, 5-16
WRITE_SRC, 5-15
WRTBACK_PROGRAM, 5-15
FS.FDI_PROP entries listed, 5-3
host planning items, 5-6
interrelated properties, listed, 5-17
mandatory dimension values, listed, 5-17
mandatory entries, 5-6
modifying seeded programs, 5-6
multi and single row entries, 5-5
non-mandatory dimension values, listed, 5-17
non-mandatory entries, 5-6
ordering of properties, 5-5
planning item access seeded, 5-2
seeded access, planning items, 5-2
seeded entries, 5-3
status, 5-20to 5-24
context, referencing, 5-24
dimension combinations, listed, 5-22
process, 5-21
processing all dimension, 5-23
processing selected dimension, 5-22
saving and retrieving, 5-21

Index-4

user access, managing, 5-19
FS.FDI_PROP dimension, 5-7 to 5-16
FS.FIN_DATA

attributes, 2-7

chart of accounts dimension, 2-5

currency dimension, 2-6

dimensions, 2-4

financial element dimension, 2-6

forecast dimension, 2-6

organizational unit dimension, 2-5

strategy dimension, 2-6

time dimension, 2-6

user-defined dimension, 2-7
FS.FIN_ELEM

FS.FIN_DATA, 2-6
FS.FORECAST

FS.FIN_DATA, 2-6
FS.INTEREST _RATE

attributes, 2-21

dimensions, 2-20

physical data model, 2-19
FS.INTEREST_RATE variable (described),
FS.LOAD_DATA

data movement routines

LEDGER_STAT table, 3-11
RES_DTL_XXXXXX tables, 3-13
FS.LOAD_HIER
data movement routines, 3-7
sample call, 3-10
FS.MIX_BREAKOUT dimension

maturity mix data model, D-3
FS.MIX_DEFAULT

maturity mix data model, 2-24
FS.MIX_DEFAULT variable

FS.MIX_ELEMENT dimension, D-2

maturity mix data model, D-1
FS.MIX_ELEMENT dimension

maturity mix data model, D-2
FS.MIX_MAP

maturity mix data model, 2-26
FS.MIX_MAP variable

maturity mix data model, D-5
FS.MIX_OVERRIDE

maturity mix data model, 2-26

2-19



FS.MIX_OVERRIDE variable, maturity mix data
model, D-6
FS.ORG_UNIT
FS.FIN_DATA, 2-5
FS.RUN_LOAD. See FS.LOAD_DATA
FS.STRATEGY
FS.FIN_DATA, 2-6
FS.WEIGHTING_FE
seeded values, 2-17

H

hierarchies
data movement routine, 3-7
refreshing, 3-10
historical data
read-only cells, in maturity mix
assumptions, 14-14

INIT_PRG dimension, 5-7
input tools
calculations, running, 13-17
features, 13-2
interface
source to target input, 13-5
target input, 13-1
opening interfaces, 13-6
saving data, 13-17
source to target input, detailed, 13-30to 13-31
source to target input, process, 13-12
source to target input, steps, 13-13 to 13-15
target input, detailed, 13-19 to 13-29
target input, process, 13-8
target input, steps, 13-9to 13-11
time lag, 13-16
installing JInitiator, 9-2
Internet Explorer, 9-4
Netscape, 9-5
prerequisites, 9-5
interest and exchange rate forecasts
data movement routines
sample call, 3-23
Interest Rate interface, 11-12

interest rate variable

physical data model, 2-19
interest rate variable (described), 2-19
Internet Explorer, installing Jinitiator, 9-4

J

JInitiator, version, 9-2

L

LEDGER_STAT
data movement routine
data filtering, 3-12
data forecasting, 3-12
sample call, 3-17
data movement routines
sample call, 3-15
LEDGER_STAT table
data movement routine, 3-11
LEDGER_STAT writeback
features, 7-2
FS.WB_CATALOG
example, 7-5
FS.WB_ENTRY dimension, 7-11
FS.WB_PROP dimension, 7-10
parameters, setting, 7-9
FS.WM_CATALOG
example, 7-6
FS.WM_MAP parameters, 7-15
FS.WM_SET parameters, 7-15
parameters, setting, 7-13
FS.WM_MAP
aggregation code, selecting, 7-18
mapping Express dimensions, 7-15
mapping hierarchies, 7-18
key steps, diagram, 7-4
key steps, explained, 7-5to 7-8
load procedure, example, 7-23
load process, overview, 7-3
load utility (FDM), executing, 7-28
log file, 7-12
parameters
data rules, 7-21
data rules, fiscal year values, 7-21
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data rules, year-to-date values, 7-22
table integrity, 7-19
table integrity, NA values, 7-21
table integrity, nodes, 7-21
table integrity, orphans, 7-21
table integrity, validating financial
elements, 7-20
table integrity, validating leaf values, 7-20
table integrity, zero values, 7-21
program
executing, 7-26
prerequisites, 7-26
syntax, 7-27
staging table and views, creating, 7-9

user-defined planning items, loading data, 7-22

loan fees, for cash flow calculations, B-21
logging in, 9-7
pre-login page, 9-2
server does not respond, 9-3
URL, 9-2
logical data model, 2-1to 2-3
account officer plans, 2-3
capital budgets, 2-3
external influences, 2-3
financial forecast, 2-2
human resource planning, 2-3
internal influences, 2-2
models, 2-3
login
timed out, session, 9-10
troubleshooting, 9-11
diagnosing, 9-12
login failure
Express server nonresponsive, 9-9
incorrect username or password, 9-9
JInitiator not installed, 9-8

M

matching data, data movement routines, 3-15
maturity mix assumption interface
chart of account dimension, 14-11
column size, changing, 14-14
constraints and logic
mix breakouts, contiguous, 14-19

Index-6

mix breakouts, nullifying, 14-20
mix elements for all mix breakouts, 14-21
mix percent, 14-19
mix percentage, cumulative, 14-19
term, 14-19
copy across organizational unit
dimension, 14-24
copy across time and organizational unit, 14-24
copy across time dimension, 14-22
currency dimension, 14-13
data
selecting. See Selector
data display, changing, 14-14to 14-15
default values
explained, 14-1
font color, 14-14
input constraints and logic, 14-18 to 14-21
inputting revised values
using copy across, 14-18
inputting values, 14-15to 14-21
constraints and logic, mix breakouts,
contiguous, 14-19
constraints and logic, mix breakouts,
nullifying, 14-20
constraints and logic, mix percent, 14-19
constraints and logic, mix percentage,
cumulative, 14-19
constraints and logic, term, 14-19
mix element constraints and logic for all mix
breakouts, 14-21
new assumption data, 14-17
override values, 14-17
revised values, 14-18
revising input values using revert to
feature, 14-18
inputting values in the grid, 14-17
interface components, 14-2 to 14-13
leaf values
error message, 14-16
selecting, 14-16
maturity mix scenario dimension, 14-12
maximizing the interface, 14-15
mix breakout dimension, 14-10
mix element
linked to chart of account, 14-9



mix element dimension, 14-4
amortization term, 14-6
mix percent, 14-5
prepayment method, 14-6
prepayment value, 14-7
rate cap life, 14-8
rate decrease life, 14-8
rate decrease period, 14-7
rate floor life, 14-8
rate increase life, 14-7
rate increase period, 14-7
repricing frequency, 14-6
residual value percent, 14-6
spreads, 14-5
tease discount, 14-8
term, 14-5
mix elements required, 14-10
Mix Override variable, 14-3
navigation, 14-17
opening the interface, 14-13
options menu, 14-21to 14-25
copy across organizational unit
dimension, 14-24
copy across time dimension, 14-22
copy across time organizational unit
dimensions, 14-24
reverting to default values, 14-22
organizational unit dimension, 14-12
override values
explained, 14-1
font color, 14-14
read-only cells, 14-14
forecasted data, 14-14
historical data, 14-14
read/write cells, 14-14
revising input values
using copy across, 14-24
using revert to default values, 14-25
row size, changing, 14-14
saving inputs, 14-26
strategy dimension, 14-12
time dimension, 14-11
time dimension, ordering values, 14-11
using the maturity mix assumption
interface, 14-13to 14-15

maturity mix assumptions
assigning, 3-36
data movement routine
sample call, 3-25
maturity mix data model, 2-21to 2-28
business requirements, 2-22

creating a maturity mix scenario, 2-22

distributing mix forecasts and data, 2-22

FS.MIX_DEFAULT variable, 2-24
FS.MIX_MAP, 2-26
FS.MIX_OVERRIDE, 2-26
time values, 2-23
maturity mix interface
reverting to default assumption values,
maturity mix scenario, in maturity mix
assumptions, 14-12
menu bar
file menu, 10-3,10-4, 10-5
help menu, 10-5
options menu, 10-4
mid-period timing, cash flow calculations,
mix breakout dimension, in maturity mix
assumptions, 14-10
mix element dimension values
amortization term, 14-6
frequency, 14-6
mix percent, 14-5
prepayment method, 14-6
prepayment value, 14-7
rate cap life, 14-8
rate decrease life, 14-8
rate decrease period, 14-7
rate floor life, 14-8
rate increase life, 14-7
rate increase period, 14-7
residual value percent, 14-6
spread, 14-5
tease discount, 14-8
term, 14-5
mix element dimension, in maturity mix
assumptions, 14-4
mix element values
linked to chart of account, 14-9
Mix Override variable

dimensions in maturity mix assumptions

14-22

B-2
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chart of account, 14-11
currency, 14-13

maturity mix scenario, 14-12
mix breakout, 14-10

mix element, 14-4
organizational unit, 14-12
strategy, 14-12

time, 14-11

in maturity mix assumptions, 14-3to 14-13

mix percent, in maturity mix assumptions,

N

Netscape, installing JInitiator, 9-5
new business
timing, 3-37
volumes, cash flow calculations, B-5
non-interest expense, B-22
non-interest income, B-22
non-rate related balances, cash flow
calculations, B-20
non-term financial instrument, cash flow
calculations, B-18
number of accounts, for cash flow
calculations, B-22

@)

Oracle Express
server
launching, 8-3
setting connection, 8-1
organizational unit
FS.FIN_DATA, 2-5
organizational unit dimension
in maturity mix assumptions, 14-12
seeded attributes, 2-12

P

pasting data, 11-6
Perform calculations dialog box, 11-9
physical data model, 2-4to 2-28

interest rate variable, 2-19

maturity mix data model, 2-21to 2-28

Index-8

planning items
correlation between OFA and Express,
pre-login page, 9-2

C-5

Prepayment Method, in maturity mix assumptions

Constant Prepayment Rate, 14-6
monthly prepayment speed, 14-6
Public Securities Association, 14-6
prepayment value, in maturity mix
assumptions, 14-7
PSA (Public Securities Association), 14-6
Public Securities Association, 14-6

R

rate cap life, in maturity mix assumptions,
rate decrease life, in maturity mix
assumptions, 14-8
rate decrease period, in maturity mix
assumptions, 14-7
rate floor life, in maturity mix assumptions,
rate increase life, in maturity mix
assumptions, 14-7
rate increase period, in maturity mix
assumptions, 14-7
read-only
in maturity mix assumptions, 14-14
setting parameters, 3-39
read/write
in maturity mix assumptions, 14-14
setting parameters, 3-39
reports
aggregating
sub-totals, 4-4, 15-9
totals, 4-4,15-9
aggregating totals, 4-4, 15-9
attribute
RPL Chart of Account, 4-16
closing, individual report, 15-6
dimension values, 4-14
dimensions
income statement, 4-15
report line item, 4-15
drill down feature, 4-8

14-8

14-8



features
for administering, 4-2
for generating, 15-2
financial elements, 4-2
income statement dimension, 4-15
income statement formulas, 4-16
detailed, 4-18
opening, multiple, 15-5
printing, 15-6
report line item dimension, 4-15
seeded, 4-4to 4-14,15-10to 15-15
customizing, 4-9
dimension values used, 4-5
formats, basic, 4-9, 15-10
formula-driven columns, 4-7
formula-driven rows, 4-7
listed, 4-10to 4-14
listed, client/server version, 4-10 to 4-12,
15-10 to 15-12
listed, Web-enabled version, 4-12 to 4-14,
15-13 to 15-15
prerequisites, 4-6
Year Total column displayed, 4-8
reports, administering, 4-1to 4-26
reports, closing
Reports list, 15-4
reports, generating, 15-1to 15-15
reports, interface, 15-3
reports, opening
individual report, 15-4
Reports list, 15-4
reports, opening and closing, 15-3 to 15-6
reports, timed out, WebAgent, 15-6
reports, updating content, 15-5
repricing frequency, in maturity mix
assumptions, 14-6
RES_DTL_XXXXXX tables
data movement routine
sample call, 3-15, 3-17
data movement routines, 3-13
residual value percent, in maturity mix
assumptions, 14-6
reverting to default assumption values, 14-22
Risk Manager, calculating runoff, B-2
rollover behavior, cash flow calculations, B-19

RW_SRC dimension, 5-14

S

sample call
appending data, 3-15
data movement routines
hierarchies (FS.LOAD_HIER), 3-10
interest and exchange rate forecasts, 3-23
LEDGER_STAT, 3-15
maturity mix assumptions, 3-25
RES_DTL_XXXXXX tables, 3-15
LEDGER_STAT, 3-17
matching data, 3-15
RES_DTL_XXXXXX tables, 3-17
Save changes dialog box, 11-10
SAVE _PRG dimension, 5-13
saving data, 11-9
Exit application dialog box, 11-11
Perform calculations dialog box, 11-9
Save changes dialog box, 11-10
SCALAR variables, custom distribution
routine, C-7
SELECT_ACROSS_DIM dimension, 5-9
SELECT_DOWN_DIM dimension, 5-10
Selector
find value feature, 12-7
searching for avalue, 12-7
interface
Available box, 12-4
components, 12-2
find value feature, 12-7
Organize By list box, 12-4
Select Values For list box, 12-3
Selected box, 12-4
tool bar, 12-8
leaf values, selecting for the maturity mix
assumption interface, 12-32
opening the interface, 12-1
selecting values for the main forecasting
window, 12-8
selecting values in the interface, 12-5to 12-6
tools, 12-8to 12-10
common functions, 12-9to 12-10
family relationships, described, 12-11
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grayed-out (unavailable), 12-9
options, choose matching values, 12-17
options, choose values by attribute, 12-15
options, choose values by family, 12-11
options, sorting data in Selected box, 12-28
options, values in arange, 12-24
options, values meeting measurement
conditions, 12-22
options, values meeting value
conditions, 12-18
resizing the dialog boxes, 12-10
spread assumptions
other dimensions, 11-3
rate/spread information, 11-3
time, 11-2
time periods, 11-3
spread assumptions, allocating, 11-1
spread, in maturity mix assumptions, 14-5
statistical data, B-24
strategy dimension
FS.FIN_DATA, 2-6
strategy dimension, in maturity mix
assumptions, 14-12
SUBMIT_PRG dimension, 5-13
submitting data, 11-11

T

tax equivalency, for cash flow calculations, B-24
tease discount, in maturity mix assumptions, 14-8
teaser rates, cash flow calculations, B-18
term, in maturity mix assumptions, 14-5
time dimension

FS.FIN_DATA, 2-6

run requirements, 3-31
time dimension, in maturity mix

assumptions, 14-11

time lag, using, 13-16
tool bar

calculate icon, 10-6

full solve icon, 10-7

help icon, 10-7

loginicon, 10-6

partial solve icon, 10-6

save icon, 10-6

Index-10

Selector icon, 10-6

spread assumptions icon, 10-7
tools, input and calculation. See input tools
transfer pricing accrual method

default setting, 3-41
transfer pricing accrual methods, listed, 3-41

U

URL, logging in, 9-2
user-defined dimension
FS.FIN_DATA, 2-7

\Y,

VALIDATION_PRG dimension, 5-16
variables
correlation between OFA and Express, C-5

wW

WRITE_SRC dimension, 5-15
WRTBACK_PRG dimension, 5-15
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